This page intentionally left blank.
Dedication

For my baby daughter, Mattie Alleen, who was born during the writing of this book.
About the Author

Curt Simmons is a technology author and trainer who focuses on Windows operating systems and Internet technologies. He has written almost 20 computing books on a variety of topics, from high-level network titles to operating system guides. Curt is also the author of How to Do Everything with Windows Me and How to Do Everything with Your BlackBerry, both published by Osborne/McGraw-Hill. Curt enjoys working with new operating systems and wireless gadgets, and when he is not training or writing books, he spends his time with his wife and children. Visit Curt on the Internet at http://curtsimmons.hypermart.net or send him an e-mail at curt_simmons@hotmail.com

About the Reviewer

Joe Bowers currently works at Aromatique, a manufacturing company in Heber Springs, Arizona, as the network administrator in a Windows NT/2000 environment. He also administers the Aromatique Web site. Joe has worked there 11 years—6½ of them at his current position. He has over 15 years experience with computers and PCs. Joe beta-tested the following Microsoft products: Windows 95, Windows 98, Windows ME, Office 97, Windows 2000, and Windows XP. Joe considers himself an expert in both hardware and software, as he has used both extensively for many years, including building many home systems for friends and family.
# Contents at a Glance

## Part I  
**Getting to Know Windows XP**

<table>
<thead>
<tr>
<th></th>
<th>Getting to Know Windows XP</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Exploring the XP Desktop</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>Managing Your Computer with the Control Panel</td>
<td>19</td>
</tr>
<tr>
<td>3</td>
<td>Configuring System Settings</td>
<td>49</td>
</tr>
<tr>
<td>4</td>
<td>Managing Components, Programs, Folders, and Files</td>
<td>87</td>
</tr>
<tr>
<td>5</td>
<td>Using Accessories</td>
<td>111</td>
</tr>
<tr>
<td>6</td>
<td>Managing Hardware</td>
<td>131</td>
</tr>
<tr>
<td>7</td>
<td>Using Printers, Fax Machines, Scanners, and Digital Cameras</td>
<td>153</td>
</tr>
</tbody>
</table>

## Part II  
**Getting Connected: The Internet and XP Networking**

<table>
<thead>
<tr>
<th></th>
<th>Getting Connected: The Internet and XP Networking</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Creating Connections to the Internet</td>
<td>177</td>
</tr>
<tr>
<td>9</td>
<td>Surfing the Internet</td>
<td>195</td>
</tr>
<tr>
<td>10</td>
<td>Running Outlook Express</td>
<td>223</td>
</tr>
<tr>
<td>11</td>
<td>Home Networking</td>
<td>247</td>
</tr>
<tr>
<td>12</td>
<td>Advanced Networking</td>
<td>261</td>
</tr>
<tr>
<td>13</td>
<td>Users, Groups, and Permissions</td>
<td>273</td>
</tr>
<tr>
<td>14</td>
<td>Internet Connection Firewall, Remote Desktop, and Network Bridging</td>
<td>289</td>
</tr>
</tbody>
</table>

## Part III  
**Cool Things You Can Do with Windows XP**

<table>
<thead>
<tr>
<th></th>
<th>Cool Things You Can Do with Windows XP</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Playing Games</td>
<td>307</td>
</tr>
<tr>
<td>16</td>
<td>Using Windows Media Player 8</td>
<td>323</td>
</tr>
<tr>
<td>17</td>
<td>Windows Movie Maker</td>
<td>347</td>
</tr>
</tbody>
</table>
### Part IV: Optimizing, Troubleshooting, and Fixing Windows XP

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>Taking Care of Windows XP</td>
<td>371</td>
</tr>
<tr>
<td>19</td>
<td>Disk Management</td>
<td>395</td>
</tr>
<tr>
<td>20</td>
<td>Solving Problems</td>
<td>415</td>
</tr>
</tbody>
</table>

### Part V: Appendixes

<table>
<thead>
<tr>
<th>Appendix</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Installing Windows XP</td>
<td>461</td>
</tr>
<tr>
<td>B</td>
<td>Keyboard Shortcuts</td>
<td>475</td>
</tr>
<tr>
<td>C</td>
<td>Windows Media Player Keyboard Shortcuts</td>
<td>481</td>
</tr>
<tr>
<td>D</td>
<td>Windows Movie Maker Shortcuts</td>
<td>485</td>
</tr>
<tr>
<td></td>
<td>Glossary</td>
<td>489</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>495</td>
</tr>
</tbody>
</table>
# Contents

Acknowledgments .................................................. xix
Introduction ...................................................... xxi

## PART I

**Getting to Know Windows XP**

<table>
<thead>
<tr>
<th>CHAPTER 1</th>
<th><strong>Exploring the XP Desktop</strong> .................................. 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Starting Your Computer ......................................... 4</td>
</tr>
<tr>
<td></td>
<td>Getting to Know Your Desktop .................................. 6</td>
</tr>
<tr>
<td></td>
<td>Checking Out Recycle Bin ........................................ 9</td>
</tr>
<tr>
<td></td>
<td>Understanding the Taskbar ........................................ 13</td>
</tr>
<tr>
<td></td>
<td>Exploring the Start Menu ......................................... 14</td>
</tr>
<tr>
<td></td>
<td>Logging Off Your Computer ....................................... 15</td>
</tr>
<tr>
<td></td>
<td>Restarting or Turning Off Your Computer ...................... 16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHAPTER 2</th>
<th><strong>Managing Your Computer with the Control Panel</strong> .......... 19</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Accessing the Control Panel .................................... 21</td>
</tr>
<tr>
<td></td>
<td>Accessibility Options ........................................... 24</td>
</tr>
<tr>
<td></td>
<td>Keyboard .......................................................... 24</td>
</tr>
<tr>
<td></td>
<td>Sound .............................................................. 27</td>
</tr>
<tr>
<td></td>
<td>Display ........................................................... 28</td>
</tr>
<tr>
<td></td>
<td>Mouse .............................................................. 29</td>
</tr>
<tr>
<td></td>
<td>General ............................................................ 29</td>
</tr>
<tr>
<td></td>
<td>Add Hardware ...................................................... 30</td>
</tr>
<tr>
<td></td>
<td>Add or Remove Programs .......................................... 31</td>
</tr>
<tr>
<td></td>
<td>Administrative Tools .............................................. 31</td>
</tr>
<tr>
<td></td>
<td>Date and Time .................................................... 31</td>
</tr>
<tr>
<td></td>
<td>Display ............................................................ 34</td>
</tr>
<tr>
<td></td>
<td>Folder Options ................................................... 34</td>
</tr>
<tr>
<td></td>
<td>Fonts .............................................................. 34</td>
</tr>
<tr>
<td></td>
<td>Game Controllers .................................................. 34</td>
</tr>
<tr>
<td></td>
<td>Internet Options .................................................. 34</td>
</tr>
<tr>
<td></td>
<td>Keyboard ........................................................... 35</td>
</tr>
<tr>
<td></td>
<td>Speed .............................................................. 35</td>
</tr>
<tr>
<td></td>
<td>Hardware ........................................................... 36</td>
</tr>
</tbody>
</table>
## Chapter 3: Configuring System Settings

### Customizing Your Start Menu and Taskbar
- Using the Start Menu  50
- Customizing the Start Menu  54
- Customizing the Taskbar  60

### Configuring Your Display
- Themes  61
- Help! I can’t remove a theme!  62
- Desktop  63
- Screen Saver  71
- Appearance  75
- Settings  77

### Configuring Folder Views
- General  78
- View  80
- File Types  81
- Offline Files  82

### Configuring Folder Views and Toolbars
- Toolbars  82
- Status Bar  85
Installing a Plug-and-Play Device ........................................ 136
Installing a Non–Plug-and-Play Device .............................. 137
Removing a Plug-and-Play Device from Your Computer ......... 137
Using Device Manager ..................................................... 139
Examining a Device’s Properties ....................................... 141
General ......................................................................... 141
Driver .......................................................................... 142
Resources ....................................................................... 145
Driver Signing ................................................................. 146
Using Hardware Profiles .................................................. 148
Creating a New Hardware Profile ..................................... 148
Configuring the Hardware Profile ................................. 149
Deleting a Hardware Profile ........................................... 150
Hardware Troubleshooting Tips ....................................... 150

CHAPTER 7 Using Printers, Fax Machines, Scanners, and Digital Cameras . 153
Checking Out the Printers and Faxes Folder ....................... 154
Installing a New Printer .................................................. 154
Configuring Your Printer .................................................. 160
General ................................................................. 160
Sharing ........................................................................... 160
Ports .............................................................................. 161
Advanced ................................................................. 163
Security and Device Settings ....................................... 165
Managing Print Jobs ......................................................... 165
Troubleshooting Common Printer Problems ................... 167
Printed Text Is Garbled ..................................................... 167
The Printer Does Not Work ............................................. 167
Printing Is Very Slow ..................................................... 168
A Certain Document Will Not Print .............................. 168
Print Quality Is Poor ......................................................... 168
Fax Support in Windows XP ................................................ 169
Using Scanners and Digital Cameras with Windows XP .... 171
Installing Scanners and Cameras ..................................... 172
Managing Scanner and Camera Properties ..................... 172

PART II Getting Connected: The Internet and XP Networking

CHAPTER 8 Creating Connections to the Internet .................. 177
Internet Connections 101 .................................................... 178
Connecting with a Dial-Up Connection ............................ 179
Connecting with a Broadband Connection ..................... 179
Configuring Your Modem ................................................ 181
Installing a Modem .......................................................... 181
Configuring Modem Properties ..................................... 181
Creating Connections to the Internet ............................................. 188
Creating Connections Using the Network Connections Folder ...... 189
Editing a Dial-Up Connection .................................................. 192
  General ................................................................. 193
  Options ............................................................... 193
  Security ............................................................... 194

CHAPTER 9
Surfing the Internet .............................................................. 195
Understanding Internet Terms and Technology ....................... 196
Understanding the Internet Explorer Interface ......................... 197
  What About Netscape? ................................................. 197
Configuring Internet Explorer Through Internet Options ............ 201
  General Tab ............................................................ 201
  Security Tab .......................................................... 203
  Privacy ............................................................... 203
  Content Tab .......................................................... 205
  Connections Tab ...................................................... 207
  Programs Tab .......................................................... 208
  Advanced Tab .......................................................... 209
Windows Messenger ............................................................. 210
  Setting Up Windows Messenger ..................................... 211
  Using Windows Messenger Service ................................. 211
Using MSN Explorer ............................................................ 212
Using NetMeeting .............................................................. 215
  What You Need to Use NetMeeting .................................. 216
  Setting Up NetMeeting ............................................... 216
  Placing a NetMeeting Call .......................................... 218
  Setting Up Remote Desktop Sharing .................................. 220
  Configuring NetMeeting Options ..................................... 220
Using the Web Publishing Wizard ......................................... 222

CHAPTER 10
Running Outlook Express ......................................................... 223
How E-mail Works .............................................................. 224
Setting Up Outlook Express ................................................... 225
Checking Out the Outlook Express Interface ............................... 228
Sending and Receiving E-mail ............................................... 230
  Sending an E-mail ..................................................... 230
  Attaching a File to an E-mail ....................................... 232
  Receiving Messages .................................................. 233
  Receiving Attachments ............................................... 234
Changing Outlook Express Views .......................................... 235
Creating Message Rules ....................................................... 236
  Creating a New Rule .................................................. 237
  Managing Message Rules ............................................. 238
  Blocking Senders ...................................................... 238
## Table of Contents

**Chapter 11: Home Networking**
- Windows Networking Basics
- Planning Your Home Network
- Understanding Internet Connection Sharing (ICS)
- Using the Home Networking Wizard
- Setting Up Your ICS Clients
- Internet Explorer
- Outlook Express
- Using My Network Places
- Creating a Direct Cable Connection

**Chapter 12: Advanced Networking**
- Internet Information Services
- Disk Quotas
- Windows XP in Windows Network
- Virtual Private Networking
  - Configuring Your Windows XP Computer for a VPN Connection
  - Allowing Other Computers to Connect to Your Computer
- Using HyperTerminal

**Chapter 13: Users, Groups, and Permissions**
- Understanding User Accounts
- Managing User Accounts
  - Create a New Account
  - Changing an Account
  - User Logon/Logoff
  - Managing User Accounts with Computer Management
- Managing Groups
- Understanding Permissions

**Chapter 14: Internet Connection Firewall, Remote Desktop, and Network Bridging**
- Internet Connection Firewall
  - Understanding How ICF Works
  - Issues with ICF
### PART III

**Cool Things You Can Do with Windows XP**

<table>
<thead>
<tr>
<th>CHAPTER 15</th>
<th><strong>Playing Games</strong></th>
<th>307</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Managing Game Controllers</td>
<td>308</td>
</tr>
<tr>
<td></td>
<td>Windows XP Games</td>
<td>310</td>
</tr>
<tr>
<td></td>
<td>Games Installed with Windows XP</td>
<td>311</td>
</tr>
<tr>
<td></td>
<td>Playing Games on the Internet</td>
<td>313</td>
</tr>
<tr>
<td></td>
<td>Installing and Playing Your Own Games</td>
<td>317</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting Game Problems</td>
<td>318</td>
</tr>
<tr>
<td></td>
<td>Using Volume Controls and Sound Recorder</td>
<td>319</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHAPTER 16</th>
<th><strong>Using Windows Media Player 8</strong></th>
<th>323</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Getting to Know Windows Media Player 8</td>
<td>324</td>
</tr>
<tr>
<td></td>
<td>Now Playing</td>
<td>325</td>
</tr>
<tr>
<td></td>
<td>Media Guide</td>
<td>331</td>
</tr>
<tr>
<td></td>
<td>Copy from CD Audio</td>
<td>331</td>
</tr>
<tr>
<td></td>
<td>Making a Copy</td>
<td>332</td>
</tr>
<tr>
<td></td>
<td>Configuring CD Audio Options</td>
<td>333</td>
</tr>
<tr>
<td></td>
<td>Media Library</td>
<td>335</td>
</tr>
<tr>
<td></td>
<td>Adding an Item to the Media Library</td>
<td>336</td>
</tr>
<tr>
<td></td>
<td>Creating a Playlist</td>
<td>336</td>
</tr>
<tr>
<td></td>
<td>Adding Files to a Playlist</td>
<td>337</td>
</tr>
<tr>
<td></td>
<td>Managing and Playing Your Playlist</td>
<td>337</td>
</tr>
<tr>
<td></td>
<td>Radio Tuner</td>
<td>339</td>
</tr>
<tr>
<td></td>
<td>Using Stations</td>
<td>340</td>
</tr>
<tr>
<td></td>
<td>Using Station Finder</td>
<td>340</td>
</tr>
<tr>
<td></td>
<td>Copy to CD or Device</td>
<td>341</td>
</tr>
<tr>
<td></td>
<td>Skin Chooser</td>
<td>342</td>
</tr>
<tr>
<td></td>
<td>Media Player Configuration Options</td>
<td>344</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CHAPTER 17</th>
<th><strong>Windows Movie Maker</strong></th>
<th>347</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Why You Need Windows Movie Maker</td>
<td>348</td>
</tr>
<tr>
<td></td>
<td>What Is Not So Great About Windows Movie Maker</td>
<td>349</td>
</tr>
<tr>
<td></td>
<td>Getting Ready to Use Windows Movie Maker</td>
<td>350</td>
</tr>
<tr>
<td></td>
<td>Checking Out the Movie Maker Interface</td>
<td>353</td>
</tr>
<tr>
<td></td>
<td>Recording and Importing Video</td>
<td>354</td>
</tr>
<tr>
<td></td>
<td>Working with Collections and Clips</td>
<td>357</td>
</tr>
</tbody>
</table>
Making Movies ........................................... 358
Splitting Clips ......................................... 359
Combining Clips ......................................... 359
Getting Familiar with the Workspace .............. 360
Creating a Storyboard .................................. 361
Trimming Clips .......................................... 363
Creating Transitions .................................... 364
Audio Files and Your Movies ......................... 364
Adding Audio to a Movie ............................... 365
Adjusting Audio Levels .............................. 366
Mixing Audio ........................................... 366
Saving Movies .......................................... 367
Using Your Movies on the Web ....................... 367

PART IV Optimizing, Troubleshooting, and Fixing Windows XP

CHAPTER 18 Taking Care of Windows XP ............. 371
Hard Disk Basics ...................................... 372
File System Basics .................................... 373
  FAT32 .................................................. 373
  NTFS .................................................. 373
Hard Disk Properties .................................. 374
  General Tab ......................................... 375
  Tools .................................................. 378
  Hardware .......................................... 384
  Sharing .............................................. 385
  If You’re Using NTFS Drives ....................... 385
Scheduled Tasks ....................................... 389
  Scheduled Task Wizard ............................. 389
  Managing Scheduled Tasks ......................... 390

CHAPTER 19 Disk Management ......................... 395
Disk Management ...................................... 396
  Understanding Dynamic Disks .................... 396
  Understanding Disk Status .......................... 399
  Formatting a Disk .................................... 401
  Creating a New Volume .............................. 402
  Assigning a Different Drive Letter and Path to a Volume 404
  Extending a Volume ................................ 404
  Other Volume Solutions ............................ 404
  Windows XP Fault-Tolerant Support ............... 405
Windows XP Backup and Restore .......................... 406
   Backing Up Data ........................................ 407
   Using Backup Recovery ............................... 410
   Using Backup Advanced Mode .................... 411
Removable Storage ...................................... 412

CHAPTER 20  Solving Problems .......................... 415
System Information ...................................... 416
   System Summary ...................................... 417
   Hardware Resources ................................. 417
   Components .......................................... 419
   Software Environment ............................... 420
   Internet Explorer ................................... 422
   Applications ......................................... 423
   System Information Tools ......................... 423
   Dr. Watson ........................................... 425
Performance Monitor .................................. 425
   Performance Monitor Interface .................. 425
   Using Performance Monitor ....................... 427
Using System Properties to Optimize Windows XP ........ 432
   Performance Options ............................... 434
Automatic Updates .................................... 437
Troubleshooting Tips .................................. 439
   Using CTRL+ALT+DEL .............................. 439
Using Windows Help .................................... 442
   Help Home .......................................... 443
   Index .................................................. 443
   Favorites ............................................ 444
   History ............................................... 444
   Options .............................................. 444
   Support .............................................. 444
   Searching Windows Help ......................... 446
   Using Windows Troubleshooters .................. 447
Using Safe Mode ....................................... 449
Using System Restore .................................. 449
   System Restore Requirements .................. 450
   Enabling System Restore ......................... 450
   Creating Restore Points ......................... 452
   Running System Restore ......................... 454
   Undoing a Restoration ............................ 456
<table>
<thead>
<tr>
<th>PART V</th>
<th>Appendixes</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPENDIX A</td>
<td><strong>Installing Windows XP</strong> .................................................................. 461</td>
</tr>
<tr>
<td></td>
<td>How To… ......................................................................................... 462</td>
</tr>
<tr>
<td></td>
<td>Upgrading to Windows XP ..................................................................... 462</td>
</tr>
<tr>
<td></td>
<td>Check the System Requirements ....................................................... 463</td>
</tr>
<tr>
<td></td>
<td>Back Up Your Data ............................................................................ 468</td>
</tr>
<tr>
<td></td>
<td>Check Out Your Device Drivers ........................................................ 468</td>
</tr>
<tr>
<td></td>
<td>Check for Viruses and Disable Antivirus Software ................................ 470</td>
</tr>
<tr>
<td></td>
<td>Shut Down All Programs ..................................................................... 470</td>
</tr>
<tr>
<td></td>
<td>Upgrading Your Computer ................................................................... 471</td>
</tr>
<tr>
<td></td>
<td>Installing Windows XP on a Computer with No Operating System ........... 472</td>
</tr>
<tr>
<td></td>
<td>Preparing for a Clean Installation .................................................. 473</td>
</tr>
<tr>
<td></td>
<td>Activating Windows XP ...................................................................... 474</td>
</tr>
<tr>
<td>APPENDIX B</td>
<td><strong>Keyboard Shortcuts</strong> .................................................................. 475</td>
</tr>
<tr>
<td>APPENDIX C</td>
<td><strong>Windows Media Player Keyboard Shortcuts</strong> .................................. 481</td>
</tr>
<tr>
<td></td>
<td>Media Player Menu Shortcuts ............................................................. 482</td>
</tr>
<tr>
<td></td>
<td>Media Player Features Shortcuts ...................................................... 483</td>
</tr>
<tr>
<td></td>
<td>Skin Shortcuts .................................................................................. 484</td>
</tr>
<tr>
<td>APPENDIX D</td>
<td><strong>Windows Movie Maker Shortcuts</strong> ................................................. 485</td>
</tr>
<tr>
<td></td>
<td>Glossary ............................................................................................ 489</td>
</tr>
<tr>
<td></td>
<td>Index ................................................................................................. 495</td>
</tr>
</tbody>
</table>
I would like to thank everyone at Osborne for giving me the opportunity to write this book. Thanks to Gretchen Ganser, my acquisitions editor, for getting me started. Also, a big thanks to Emma Acker and Alissa Larson for keeping things moving in the right direction. Thanks to Laura Stone for the editorial eagle eye and Joe Bowers for the fine technical review. Finally, thanks to my agent, Margot Maley, and to my family for being so supportive of my work.
This page intentionally left blank.
Windows XP, which stands for *experience*, is the latest operating system from Microsoft, and I don’t mind telling you that you are in for a real treat! How would you like an operating system that is friendly, easy to use, makes the best use of the Internet, and rarely—if ever—locks up or acts weird? You would? I thought so. Windows XP is all of these things and more. I have been using Microsoft Windows since the days of Windows 3.x, and I can wholeheartedly say that Windows XP is the absolute best operating system Microsoft has ever produced.

Why, you might ask? Windows XP gives you the power of Windows 2000 with the friendliness of Windows Me. It has the power and tools to make it a top-notch operating system, but it also has the ease of use and fun stuff you demand. Top that off with a new interface and tons of new features, and you get Windows XP.

You might be wondering, “If XP stands for experience, is Windows XP right for me if I am new to computing?” The answer: absolutely! XP provides for a full range of experience with this new operating system. It is the easiest operating system Microsoft has ever produced—you’ll be a pro in no time—but it is also the most powerful. If you’re just starting out, all you need is Windows XP and this book, and you’ll have the operating system mastered quickly and easily.

Speaking of this book, *How To Do Everything with Windows XP* is designed to be your one-stop source for help in using Windows XP. This book helps you get started in Chapter 1 and even covers advanced networking topics in Chapters 11 and 12. You will learn what you need to know quickly and easily, and often in a step-by-step format.

This book starts you out at ground zero. In Part I, “Getting to Know Windows XP,” you learn all about the Windows XP interface (such as your Start menu). You also learn how to start the computer and shut it down, manage your computer with the Control Panel, configure system settings and folders, install applications, use accessories, and manage hardware and printers—plus much more!
In Part II, “Getting Connected: The Internet and XP Networking,” you learn all about getting connected to the Internet with your Windows XP computer. You’ll find out how to use Internet Explorer 6, Outlook Express, and MSN Explorer—plus, you will learn how to create a home network using Windows XP. This part also covers more advanced networking topics, such as Virtual Private Networking and Windows security and user management, as well as Remote Desktop and Windows XP’s Internet Connection Firewall.

In Part III, “Cool Things You Can Do with Windows XP,” we check out the fun stuff XP provides. You learn about playing games on Windows XP, how to use the XP Media Player, and how to use the Movie Maker tool for editing and saving your own home movies.

In Part IV, “Optimizing, Troubleshooting, and Fixing Windows XP,” you learn about the tools and utilities Windows XP provides to make your work with Windows much easier. You’ll learn about disk management, System Information, Windows Help and Support, System Restore, and much more!

Finally, the book wraps up with several appendixes that show you a bunch of keyboard shortcuts, and you’ll find an appendix that covers installing Windows XP as well. In fact, if there is something you can do with Windows XP, this book talks about it somewhere!

I’ve written this book in an easy-to-read format. You can read the entire book cover to cover, or you can skip around and find specific information you need—the choice is yours. To help you along the way, this book includes

- **How To sidebars** These boxed sidebars tell you how to do things, usually in a step-by-step format. Be sure to check them out—they are full of quick and helpful information.

- **Did You Know sidebars** These boxed sidebars contain ancillary information you might find useful and even entertaining. I’ve put great material in these sidebars, but it is extra stuff, so you can skip over them if you like.

- **Note icons** These provide you with helpful information. You should always read every Note icon you see.

- **Tip icons** These provide you with a friendly piece of advice or a little extra information that might make your work and play with Windows XP easier. Be sure to read them!
Shortcut icons  These show you quick and easy ways to do tasks. Take note of these and you can make your work with Windows XP much more efficient.

Caution icons  These point out a potential problem or pitfall—so beware!

Well, that’s about it. Are you ready to experience Windows XP? Then it’s time to get started. Before you do, though, I would love to hear from you. Visit me on the Internet at http://curtsimmons.hypermart.net or send me e-mail at curt_simmons@hotmail.com.
This page intentionally left blank.
Part I
Getting to Know Windows XP
This page intentionally left blank.
How To…

- Start Your Computer
- Explore Your Desktop
- Examine Icons
- Manage and Configure the Recycle Bin
- Use the Taskbar and Start Menu
- Log Off, Restart, and Shut Down Your Computer

You got what you asked for—at least what most of you asked for! For years, computer users have been saying, “We want a robust, stable operating system that plays nicely with hardware and makes it easy to do just about anything.” Windows XP is your dream come true. Combining the power and stability of Windows 2000 and the friendliness of Windows Me (plus a whole bunch of new stuff), Windows XP is the new operating system of choice for both home and business use.

If you are new to Windows, or perhaps to computing in general, this chapter was especially written for you. Windows XP is a powerful system that can do practically anything you need (except paint your house), and it is the easiest operating system to use that Microsoft has ever produced. In this chapter, you’ll discover your way around Windows XP by learning about the basic system features that will enable you to use your computer effectively and efficiently.

Starting Your Computer

If you have just purchased a new computer with Windows XP preinstalled, your first task is to unpack it, attach your peripherals (which are your keyboard, mouse, printer, speakers, and so forth), and then start the computer. Your computer comes with a booklet that explains how to attach your peripherals and start the computer. Most computers have a power switch on the back of the case that you must switch on. Some models have an On switch on the back and also another button on the front of the case that gives you easy starting access. You have to check out your computer’s documentation to find your On switch.

Once you flip the switch and your computer has power, you will most likely see a brand-name screen, or maybe even a black screen with a bunch of information about your computer’s hardware, and then you will see the Windows XP starting
screen as your computer boots up. If this is the first time to boot a new computer that has Windows XP preinstalled, it may ask you some questions to customize your computer and finish the installation. See Appendix A for more information about installation. At some point, Windows XP will ask you to enter a username and a password. This is the username and password you will use each time you log on to Windows. Windows XP is a very secure operating system, so you can expect usernames and passwords to be very important. You can learn all about Windows XP user-management in Chapter 13.

**What Really Happens When a Computer Starts**

So you want to know what really goes on when you turn on your computer. Your computer follows a boot process that loads Windows XP, called the boot or startup sequence. This process loads all of the operating system files so you can actually use Windows XP. Here’s what happens:

1. When you first turn on your computer, a power-on self test (POST) process occurs. Your computer checks its hardware and memory and then begins to load your operating system.

2. Windows XP has a database of information called the Registry where information about your computer is kept. The Registry is loaded first so it can be read in order to boot Windows XP.

3. Next, Windows loads a file called System.ini. The System.ini file is used to load older system configuration information.

4. Next, Kernel32.dll is loaded. Kernel32.dll is the main operating system code used by Windows XP.

5. After Kernel32.dll is loaded, Gdi.exe and Gdi32.exe are loaded. These files give you the graphical Windows user interface.

6. Next, User.exe and User32.exe are loaded. These files provide code necessary to manage the user interface, including your windows.

7. Resources and Fonts load next.
Getting to Know Your Desktop

Windows XP uses a Desktop for the standard user interface, as have previous versions of Windows, like Me and 2000. The Desktop is the place where you access your system components, applications you want to use, the Internet, and basically everything else. Think of the Desktop as, well, a desktop. The ideal desktop has everything you need within quick and easy reach. On your computer, the same idea holds true.

As you can see in Figure 1-1, the Desktop contains an open area, the Recycle Bin (usually on the right-hand side), a Taskbar at the bottom that contains the Start button, and a notification area on the lower-right side of the screen.

The items you see on your Desktop may vary from those shown in Figure 1-1, especially if you have just bought a new computer with Windows XP preinstalled. The manufacturer of your computer (such as Compaq, HP, or Dell) may have set up a number of preconfigured options and even advertisements. In short, if you have a new computer, you may have a lot of…well, junk, on your Desktop, and Windows XP itself even includes several advertisements as well. You may see an icon to join MSN Internet (which Microsoft really wants you to do, by the way), and several other ISP advertisements, and you may have all kinds of other stuff, depending on your computer manufacturer.

You also have a number of shortcuts. Shortcuts are simply icons on your desktop that enable you to quickly and easily access some system component or
application without having to wade into the operating system and retrieve it. A shortcut icon appears on your desktop with a little arrow in the corner, as shown in Figure 1-2.

Shortcuts can be helpful, but too many clutter up your desktop and make it confusing. The good news is that you do not have to keep any advertisements or shortcuts on your desktop that you do not want. Simply delete them. When you delete a shortcut, you are not deleting the program, just the little icon on your Desktop that points to the program. This feature lets you decide what should be on your Desktop and what should not.
Delete a Desktop Item

You can easily delete a Desktop item, such as an advertisement or an unneeded shortcut, by following these steps:

1. Place your mouse on the icon you do not want, and right-click it.
2. From the menu that appears, click Delete.
3. A message appears asking if you are sure you want to delete the item. Click the Yes button.

Mouse Terminology

In case you are very new to computing, let me give you some quick tips about using your mouse. Your mouse has a right mouse key and a left mouse key. When you hold the mouse, you use your index finger to operate the left mouse key and your middle finger to operate the right mouse key (the wire connecting the mouse to your computer should be going away from your body if you are holding the mouse correctly). If you are left-handed, you can configure your mouse to operate correctly with your left hand—see Chapter 2 for details. When this book gives you mouse directions, here’s what they mean:

- **Click**  Click the left mouse key with your index finger one time.
- **Right-click**  Click the right mouse key with your middle finger one time.
- **Double-click**  Click the left mouse key with your index finger two times very quickly.
Checking Out Recycle Bin

By default, Windows XP only provides you with one desktop icon, which is the Recycle Bin. If you have used Windows in the past, you may be thinking, “Wait a minute—where is My Computer, My Network Places, and the usual stuff I see?” It’s still around, don’t worry; but in an effort to make the desktop cleaner and more configurable for your needs, common icons, such as My Computer, now reside on the Start menu. So, what is the Recycle Bin? The Recycle Bin is a place where you put garbage. You can remove old files and items you no longer need with the Recycle Bin.

Want to know a secret? When you delete a file from your system (anything at all, a document, picture, shortcut—whatever), it isn’t really deleted. It is sent to the Recycle Bin, where it waits to be deleted. Why? The Recycle Bin is an excellent Windows feature that prevents you from losing data that you may actually want to keep. When you delete an item from your computer, it is removed from its current location and placed in the Recycle Bin. It stays in the Recycle Bin until you choose to empty the Recycle Bin or the Recycle Bin becomes too full. Only then is the item deleted forever.

I will give you an overview of the other Desktop elements because we will use them extensively throughout the book. However, the Recycle Bin is covered only in this chapter, so I’ll spend a little more time with it to make sure you know “how to do everything.”

Using the Recycle Bin

As mentioned previously, any time you delete an item, it is sent to the Recycle Bin. You can open the Recycle Bin and see what is inside by just double-clicking the Recycle Bin icon on your Desktop (you can also right-click the icon and click Explore). You can see the items in the Recycle Bin that are waiting to be deleted, as in Figure 1-3.

In the View menu, you can select thumbnails, tiles, icons, list, or details. With these choices, you can see large icons, small icons, a list of files, or even a detailed list telling you the item’s original location and the date it was moved to Recycle Bin.

You see that you have two buttons available in the Recycle Bin Tasks window, which is found on the left part of the Recycle Bin. You can click the Empty Recycle Bin button, which permanently deletes the items in the Recycle Bin. Once you
choose to empty the Recycle Bin, all items in the Recycle Bin are permanently deleted from your computer. You cannot recover these items once they have been emptied from the Recycle Bin.

You can also empty the contents of your Recycle Bin by simply right-clicking on the Recycle Bin icon on your Desktop and clicking Empty Recycle Bin on the menu that appears.

You also have a Restore All button in the Recycle Bin Tasks window. What if you accidentally delete a file and it is moved to the Recycle Bin? No problem—you can use the Restore All button to move the file back to its original location on your computer. So, what if you have 30 files you have deleted and you want to restore only one of them? No problem—just select the file in the list by clicking it. The Restore All button changes to Restore This Item. Click the button and the file is put back in its original location.
You can also move an item out of the Recycle Bin by just dragging it to the Desktop. Put your mouse pointer over the file you want to take out of the Recycle Bin, and then press and hold down your left mouse key. Continue holding down your left mouse key, drag the item to your Desktop, and let go of the mouse key. The item will now reside on your Desktop.

Changing the Recycle Bin’s Properties
You can also change the Recycle Bin’s properties, which basically changes the way it behaves. Right-click the Recycle Bin on your Desktop and click Properties on the menu that appears. You see a Recycle Bin Properties window that has a Global and Local Disk tab, as shown in Figure 1-4.

First, you see two radio buttons that enable you to either configure your drives independently or use the same settings for all drives. This feature applies to you only if you have more than one hard disk in your computer. In most cases, the

![Recycle Bin Properties Window](image)

**FIGURE 1-4**  Access this window to change the Recycle Bin’s properties.
default setting that configures all of your drives the same way is all you need. Next, you see a check box that tells your computer to delete items immediately instead of moving them to the Recycle Bin. As you can guess, this feature automatically deletes items when you click Delete. This provides you absolutely no protection in the event that you accidentally delete a file you want. Let’s say you are writing your life’s story and you accidentally delete the document. If you select this check box, the document will immediately be gone from your computer—you will not be able to retrieve it. I strongly recommend that you do not click this check box to enable this option. No matter how good your computing skills, you will make a mistake from time to time and accidentally delete something. Recycle Bin is your safety net so you get that document back. By clicking this check box, you have no protection—so don’t do it!

Next, you see a sliding bar that represents the maximum size the Recycle Bin can grow. Like everything else on your computer, the Recycle Bin stores items in a folder on your hard drive. The sliding bar enables you to set a limit for how big the Recycle Bin can grow before it forces you to empty the contents and permanently delete items from your system. By default, this setting is configured for 10 percent. This means that 10 percent of your hard drive’s space can be used before the Recycle Bin tells you to empty it. That is, if you have a 10GB hard drive, you can store up to 1GB of deleted data in the Recycle Bin before it must be permanently removed and deleted from your computer. Under most circumstances, this 10 percent setting is all you need, but you can change it to a higher or lower percentage if you want. Just be sure to ask yourself why you are changing the setting and make sure you have a good reason for doing so.

Keep mind that you do not have to wait until your Recycle Bin is full to empty it—and, in fact, most people don’t. Some people empty it every time they put documents in it, while others empty it on a weekly basis after they have reviewed its contents to make sure nothing was accidentally deleted. There is no right or wrong approach, of course; just find what works best for you.

Finally, you see a Display Delete Confirmation Dialog check box at the bottom of the Global tab. This tells Windows to give you that aggravating “Are You Sure?” message every time you delete something. This option is selected by default, and although the configuration message is sometimes a pain, it is a good safety check, so I recommend that you leave this setting enabled.

Aside from the Global tab, you have a Local Disk tab—you may have several of these tabs if your computer has more than one hard drive. You can’t do anything
on these tabs if you selected the Use One Setting for All Drives radio button on the Global tab. If you want each drive to have different settings and you selected this option on the Global tab, then you can configure each drive independently. The tabs have the same options, such as the slider bar for the percentage of the hard drive you want to use for the Recycle Bin. The real question is, why would you configure drives differently? The answer is all about drive space.

Let’s say your computer has two hard drives. One has 5GB while the other only has 1GB. You can spare 10 percent of the 5GB drive for the Recycle Bin, but what if your 1GB drive is already crowded? You might not want 10 percent of that drive used for Recycle Bin, so you can give it a lower percentage, such as 5 percent. Again, under normal circumstances and with most computers, you don’t need to worry about any of this, but its good to know the options are there in case you have some specific hard drive space issues.

**Understanding the Taskbar**

The Taskbar is the small bar you see at the bottom of your Desktop, and shown in Figure 1-5.

The Taskbar contains your Start menu, which is explored later in this chapter, and some built-in icons for Internet Explorer, Outlook Express, MSN Explorer, Show Desktop, Windows Media Player, and View Channels. Any applications you open or any Windows that you have minimized also show up on the Taskbar. Just click any of these to open them or bring them up on your Desktop so you can work with them.

You also see a separate box on the right side of the Taskbar. This is called your System Tray, or Notification Area, and it contains your clock, probably a volume control icon, and maybe several other icons, depending upon what is installed on your computer. The System Tray is just an easy way to access some applications you may use frequently. If you right-click on any of the items in the System Tray, you can usually close or remove the item from the System Tray, or you can click Properties so you can configure the item. For example, if you right-click your clock in the System Tray, you can click Adjust Date/Time. This action opens a simple window where you can change the current date and current time. These settings are easy and self-explanatory.
How to Minimize, Maximize, and Close Windows?

Any window that is open on your Desktop can either be maximized or minimized (or closed). If you look in the upper-right corner of a window, you see three buttons; an X, a square, and a flat line. The X button closes the window, the square button maximizes the window so that it takes up your entire Desktop area, and the flat line minimizes the window so that it disappears from your Desktop and appears on your Taskbar. To maximize a minimized window on your Taskbar, just click it and it will jump back onto your Desktop as the active window. This feature enables you to have several windows open at one time without mass confusion on your Desktop.

Exploring the Start Menu

If you have ever visited a theme park, you know there is typically one main entrance that leads you to all of the attractions the park has to offer. Windows XP’s main entrance is the Start menu, which appears on your Taskbar in the lower-left portion of your screen.

The Start menu is your gateway to most Windows components and the applications that you install. If you have used Windows before, the Start menu is certainly nothing new. However, in Windows XP, the Start menu has been completely redesigned so you can access your programs, documents, and common Windows components more easily. If you click the Start button with your mouse, a pop-out menu appears, as shown in Figure 1-6.

Because the Start menu has been redesigned in Windows XP, I’ll devote more time to it in Chapter 3, where you can learn all about the available options and how to configure the Start menu so that it is just right for you.
Logging Off Your Computer

Several people may use your Windows XP computer. For example, at home you and some family members may share the computer; or if your computer is on a network, several different users may access it. In Windows XP, all of your settings and documents are tied to your user account. This way, several people can use the same computer and have different computer settings, documents, and even e-mail accounts. If someone else uses your computer, Windows XP keeps track of that person’s settings, as well as your own settings.

With all of this in mind, Windows XP enables you to log off the computer so that someone else can log on without having to restart the computer. To log off, just click the Start menu and click Log Off. A dialog box appears asking if you want to Switch User, which allows someone else to log on to the computer, or you
can choose to simply log off. If you choose to switch users, the current user’s applications continue to run in the background while the new user logs on. If you choose to log off, all applications are closed. Either way, you are taken to the Windows XP logon screen where you can select your username and password to log on.

**Restarting or Turning Off Your Computer**

When you have finished using Windows XP, you can choose to shut down the computer, or, in the case of problems or if something new is installed, you can restart it. To shut down or restart your computer, click the Start menu, and then click Turn Off Computer. A dialog box appears that contains three button options, shown in Figure 1-7. The options are as follows:

- **Hibernate**  This setting saves all of your current Desktop settings to your hard disk and then shuts down.
- **Turn Off**  This option shuts down Windows XP safely. No power will be running in the computer once it is shut down.
- **Restart**  This option shuts down Windows XP and immediately restarts it again.

*You should always shut down your computer or restart it using this dialog box option. Do not shut down or restart by turning the power off and back on. While this method does work, it may damage your operating system. Always use this command so that Windows can properly shut down and restart.*

![Options for turning the computer off](image)
To Turn Off or Not to Turn Off, That Is the Question!

I teach several online courses, and as I’m teaching, students frequently want to know about turning off the computer and restarting. Should you leave your computer on when it is unattended, or should you always shut down? Does shutting down frequently damage your computer?

These are common, but very important questions. First things first: you can shut down or restart your computer without damaging your system or hardware—but you shouldn’t be shutting down or restarting a bunch of times during the day. For any given day, you should be shutting down and/or restarting only once or twice. Many people get up in the morning, turn on the computer, and leave it on for the entire day. This is perfectly fine.

Computers today support a number of power management features that enable the computer to go into a “stand-by” mode when it is not being used. I’ll show you how to configure these options in Chapter 3. With power management features enabled, you really don’t have to turn off your computer at all! I have five computers in my study, and they all remain turned on twenty-four hours a day, seven days a week. The only exception is if I am traveling. If am going to be away for several days, only then do I turn off the computers.
This page intentionally left blank.
Managing Your Computer with the Control Panel
How To…

- Access the Windows XP Control Panel
- Discover XP Categories
- Access Control Panel Icons
- Use Control Panel Icons to Configure Your Computer

Quick: How many of you know how to set the clock on your VCR? I thought so. The proverbial joke about using VCRs and staring at those blinking 12:00’s certainly has a great element of truth. The reality of electronic devices and computers is simply this: you don’t have to know everything about the device or computer in order to use it. You need to know some basic functions, but for the most part, you can ignore many features and use the product without problems. However, if you know how to set the VCR clock, you can record all kinds of television shows automatically and use a number of other management features of your VCR. True, you don’t need to know how to set the clock, but you can use your VCR much more effectively if you do.

Windows XP, along with other computer operating systems, is much the same. You don’t have to know a whole lot in order to use XP, but if you know how to configure its features and functions, it will do a lot more for you. While it is true that computer operating systems are becoming more complex with each new release, they are also becoming easier to use because you have more management tools. One of those tools in Windows XP is the Control Panel. The Control Panel gives you a number of tools that allow you to determine how various components of Windows XP look and act. If you know how to use those tools, you gain greater control over XP, and—just as with your VCR clock—your XP system will more effectively meet your needs. In this chapter, you’ll learn how to manage your Windows XP computer using the tools provided in the Control Panel. This chapter explores all of the Control Panel options; shows you what they do; and then shows you how, when, and why to configure them. Because of their specific nature, some Control Panel tools are best explored in other chapters, and I’ll direct you to those chapters in such cases.
Accessing the Control Panel

You can access the Control Panel in three major ways. First, you can click the Start menu and click Control Panel. This is probably the most common and easiest way of accessing the Control Panel. Second, you can access the Control Panel from within any other XP window by simply typing Control Panel in the Address dialog box found on the window. This will cause the current window to change to the Control Panel. Finally, many folders give you a link to the Control Panel (as long as they use the XP view) in the See Also dialog box. For example, if you happen to be in My Computer, just click the Control Panel link in the Other Places box to switch to the Control Panel. No matter how you get there, when the Control Panel opens, your initial view will appear as shown in Figure 2-1.

FIGURE 2-1 Windows XP Control Panel
If you’ve used any version of Windows before, you will first notice that the Control Panel in Windows XP looks a little different. The Windows XP Control Panel is divided into **Categories**. If you click a Category, the window presents a list of tasks you may want to perform and related Control Panel icon(s) you may want to choose, as you can see in Figure 2-2.

Now, before you get too concerned about the differences, let me tell you that the task and icon options are essentially the same. For example, as you can see in Figure 2-2, I have the option to change the Desktop background or screen saver, and so on. If I click one of these tasks, the Display Properties window opens so I can make the change. Or, I can simply click the Display icon option and open the same set of windows. There is no difference—it’s just that the task option tries to help you locate the tasks you want to perform in case you don’t know which Control Panel option to select. Notice that when you use this option, you’ll also get some See Also suggestions and Troubleshooter options in the boxes on the left.

Now, all of this may sound great, and it can be helpful. However, there are two important things you need to know. The Category view does not provide you access to every Control Panel tool that is available—it only provides you access to the more commonly used tools. Even though Microsoft considers the tools found

---

**FIGURE 2-2** The Control Panel now gives you a task or icon option.
in Category view the most common, there are many Control Panel tools that are not available from this view. So, in order to see all of your Control Panel options, click the Switch to Classic View link found on the left side of your Control Panel. This will give you the typical icon list found in previous versions of Windows, as you can see in Figure 2-3.

**TIP**

You can switch back and forth from Category view to Classic view by simply clicking the link in the Control Panel box found on the left side of the window. You can access items in either view as needed—just use whichever view you like best.

Now that you have taken a look at XP’s Control Panel views, let’s turn our attention to the programs Control Panel offers. In the following sections, we will explore all of the Control Panel icons, and you will learn what you can do with each. In order to see all of the Control Panel icons, you need to use the Classic view; so just click the Classic view link in the Control Panel box to switch to that view.
Accessibility Options

Accessibility Options enable you to configure your computer’s input and output behavior for people with certain disabilities. These options make computing much easier for these individuals. Windows XP provides excellent support for accessibility configuration, and you use this icon in the Control Panel to configure most of them.

If you double-click Accessibility Options in the Control Panel, a Properties window appears with several different tabs that you can configure for your needs. The following sections tell you about each of them.

Keyboard

The Keyboard tab enables you to change the way your keyboard inputs information to the Windows XP operating system (see Figure 2-4).
The following sections explain the available options.

**StickyKeys**
First, you see that you can enable StickyKeys. The StickyKeys option is provided so that you do not have to hold down several keys at one time on the keyboard. For example, let’s say that you want to press CTRL+ALT+DEL at the same time (which opens the Close Program window). Normally, these keys are pressed at the same time, but StickyKeys enables the keys to “stick” so that you can press CTRL, then press ALT, and then press DEL, one at a time. This is an excellent feature for people who can only use one hand on the keyboard. To enable StickyKeys, just click the Use StickyKeys check box, and then click the Settings button.

When you click Settings, a new window appears with a few check boxes. First, you can enable the StickyKeys shortcut, which enables you to turn on StickyKeys by pressing the SHIFT key five times in a row. You can also select or deselect these options:

- Press modifier key twice to lock. This option specifies that the CTRL, SHIFT, or ALT key remains active if you press it twice (press it a third time to unlock it).
- Turn StickyKeys off if two keys are pressed at the same time.
- Make a sound when modifier key is pressed (CTRL, SHIFT, or ALT).
- Show StickyKeys status on screen.

Once you enable or disable these as desired, you can then use StickyKeys by pressing the SHIFT key five times in a row. A message appears on your screen telling you that the StickyKeys option is enabled, and a StickyKeys icon appears in your System Tray. Once you play around with StickyKeys, you’ll see how easy to use and how helpful this option is.

**FilterKeys**

FilterKeys are provided in Windows XP to help your operating system “filter” keystrokes. If a user has difficulty using the keyboard, FilterKeys can be used to ignore brief or repeated keystrokes. To use FilterKeys, just click the check box on the Keyboard window and then click the Settings button.

Once you click the Settings button, click the Use Shortcut check box so that you can turn on FilterKeys by pressing the right SHIFT key. You can use the remainder of this window to determine how FilterKeys behave by using (or not using) the following options:

- Ignore repeated keystrokes. For example, if I press the T key twice quickly, it will be filtered so that only one t appears on the screen. Click the Settings button to adjust the rate as desired.
- Ignore quick keystrokes and slow down the repeat rate.
- Beep when keys are pressed or accepted.
- Show FilterKeys status on screen.

As with StickyKeys, the FilterKeys option is easy to use. Play around with the settings to meet your specific needs.

**ToggleKeys**

The ToggleKeys option is a simple feature that tells the operating system to play a tone when you press CAPS LOCK, NUM LOCK, or SCROLL LOCK on your keyboard. To turn on this feature, just click the Use ToggleKeys check box. If you click the Settings button, a simple dialog box appears where you can enable a shortcut to turn on ToggleKeys by pressing and holding down the NUM LOCK key for five seconds.
Beneath the ToggleKeys settings on the Keyboard tab, there is a check box that enables additional keyboard help when using programs. This feature turns on keyboard help pointers that may be supported in some applications that you use.

**Sound**

The Accessibility Options Sound tab gives you two options to enable Windows sounds to help you. This tab, shown in Figure 2-5, contains two check boxes for these options.

The first option you have is the SoundSentry. Depending on what happens with Windows XP (or what you do), certain warning or notice sounds are made. The SoundSentry option enables these warnings to appear on your screen instead of as a sound. This feature is obviously helpful to hearing-impaired Windows XP users. To use the SoundSentry, just click the Use SoundSentry check box. If you click the Settings button, you can decide what the screen should do to give you the warning (such as flash the active title bar).

Your second option on this tab is to use ShowSounds. The ShowSounds option tells your programs to display text for any sounds or verbal speech cues.
they might give you. You enable this option by simply clicking the Use ShowSounds check box.

**Display**

The Display tab, shown in Figure 2-6, enables you to use high-contrast colors on your display to make reading easier.

To enable it, just click the Use High Contrast check box. If you click the Settings button, you can enable the shortcut, which is LEFT ALT+LEFT SHIFT+PRINT SCREEN, by clicking the check box for that purpose. You can also use this window to determine how high contrast should be used, such as white on black, black on white, or a custom combination. You can experiment with these settings to find which one works best for you.

Also notice on the Display tab that you can adjust the cursor settings. Use the slider bars to adjust cursor blink rate and its width. These settings can make the cursor easier to see.

![Accessibility Options](image)

**FIGURE 2-6** Use the Display tab to enable high-contrast settings.
Mouse
The Mouse tab provides you with a simple check box that enables you to control the mouse pointer on your screen with the numeric keypad on your keyboard, so that you do not actually have to use the mouse. Click the Settings button to enable the shortcut to this option, which is LEFT ALT+LEFT SHIFT+NUM LOCK. You also use the Settings page to control how fast the mouse pointer moves and related settings.

General
Finally, the General tab, shown in Figure 2-7, provides some basic control options for accessibility.

![Accessibility Options](image)

**FIGURE 2-7** Use the General tab to configure standard options.
You have the following options:

- Turn off accessibility features if idle. This feature enables a timeout period where accessibility features are turned off if the computer is idle for a certain period of time. Use the drop-down menu to select the desired idle time.
- Show a warning message when turning a feature on.
- Make a sound when turning a feature on.
- Support SerialKey devices. SerialKey devices are additional input devices attached to your computer (also called an augmentative communication device) that are used by people who cannot use a standard keyboard and mouse. This setting just tells Windows XP to support these devices.
- Administrative options. If you are an administrator for the computer, you can choose to apply all accessibility options that you have configured to the logon desktop (the area where you select your user account and enter your password) and for all new users. In this way, the accessibility options are available and configured for each person who uses the XP computer.

Add Hardware

The Add Hardware icon that appears in the Control Panel is actually a wizard you can use to help install troublesome devices on your computer. This wizard is explained in detail in Chapter 6.

Did you know? You Can Get Check Box Help

There are a lot of check boxes in Windows Control Panel pages that turn on or off certain features. Sometimes the explanatory text isn’t so easy to understand. Although this book explains all of these check boxes to you, you can also get additional help in Windows XP by right-clicking any check box text and clicking “What’s This?” Another dialog box appears that explains more about the check box item. Sometimes the help text that appears is great, sometimes not so great—but it is good to know this feature is available to you.
Add or Remove Programs

Add or Remove Programs enables you to install new programs, remove programs, add or remove components of installed programs, and install and remove Windows components. These features are explored in Chapter 4, so refer to that chapter for step-by-step information.

Administrative Tools

Windows XP includes a folder called Administrative Tools. In this folder, you will find several different tools that help you manage the Windows XP computer, including the Computer Management tool and a Performance Monitor. Because of the more complex nature of these tools, we’ll explore and use them in a variety of chapters throughout the book.

Date and Time

The Date and Time icon in the Control Panel enables you to set your operating system’s clock, as you might guess. When you double-click the icon, you see a simple interface that contains a calendar noting the current date. You can change the date by simply using the drop-down menus. Likewise, you see a clock with a drop-down menu where you can change the current time and the time zone. As you can see in Figure 2-8, this interface is very easy to configure.
You can click the check box at the bottom of the Date/Time window so that your computer automatically adjusts the time for daylight savings time. If you live in an area that does not use daylight savings time, keep this box unchecked.

If you need to adjust your computer’s date and time, you don’t have to use the Control Panel icon. Just right-click the time in your System Tray and click Adjust Time/Date. You can also just double-click the time. Either action opens the same Date and Time Properties window.

One item that is new with the XP Date and Time tool is the Internet Time tab, shown in Figure 2-9. The Internet Time option allows you to synchronize your computer with an Internet time server in order to make sure that your computer always has the exact time. This feature, if configured, occurs automatically and without interruption to you, but you must be connected to the Internet for synchronization to occur. Also, if you are using Windows XP in a corporate network that uses a proxy server or a firewall, the time synchronization feature may not be allowed, and consequently will not work.
CHAPTER 2: Managing Your Computer with the Control Panel

FIGURE 2-9 Using Internet Time to synchronize your computer’s time with an Internet server

Did you know?

**What Proxy Servers and Firewalls Are**

Many corporate environments use proxy servers or firewalls. In order to protect the internal network from the various risks posed by Internet traffic, proxy servers or firewall servers examine all traffic flowing into the network from the Internet. The configuration of the proxy server or firewall may cause some Internet traffic to be filtered, or not allowed to pass. Proxy servers and firewalls access Internet content for internal network clients, so that no client is ever in direct contact with the Internet. This feature ensures that the internal network is safe and that unauthorized content does not enter the network from the Internet.
Display
The Display icon in the Control Panel enables you to configure your desktop and other display settings so that your computer looks the way you want. There are a number of things you can do, and you can learn all about using the Display settings features in Chapter 3.

Folder Options
Windows XP enables you to configure the appearance of your folders. You have several options available, and you can learn all about them in Chapter 4.

Fonts
The Fonts folder in the Control Panel simply houses all of the possible fonts that your computer can use. When you open Fonts, you see a listing of all of the fonts available. There isn’t anything you can configure here, with the exception of removing or adding fonts to the folder. In general, this is not something that you need to do because Windows XP and your applications handle the fonts that are used. You can determine which fonts you want Windows XP and your applications to use by configuring the Display properties or configuring a specific application’s properties. You can also double-click any font in the Fonts folder to learn more about the font and to see a sample of how the font looks.

Game Controllers
The Game Controllers icon in the Control Panel provides a location to manage any gaming devices attached to your computer, such as joysticks and other playing devices. You can learn all about this icon in Chapter 15.

Internet Options
The Internet Options in the Control Panel can be used to configure, as you might guess, Internet Explorer. You can access this same properties sheet from within Internet Explorer itself, and these options are explored in Chapter 9.
CHAPTER 2: Managing Your Computer with the Control Panel

Keyboard

The Keyboard icon in the Control Panel enables you to configure how your keyboard operates. When you double-click this icon, you see two tabs, which are explained in the following sections.

Speed

The Speed tab enables you to configure how fast your keyboard responds to keystrokes. As you can see in Figure 2-10, the Speed tab gives you a few simple options for adjusting your keyboard’s speed.

First, you see two slider bars for character repeat. The first, Repeat Delay, determines how much time passes before a character repeats when you hold down a key. If you are a fast typist, you will probably want this setting moved to Short.

FIGURE 2-10 Use this tab to configure the speed of your keyboard.
You also see a Repeat Rate slider bar. The repeat rate slider bar determines how fast a character repeats when you hold it down. The repeat delay determines how fast the initial repeat begins, while the repeat rate determines how fast the characters are actually repeated. A medium setting (between slow and fast) is typically all you need.

At the bottom of the window, you see the Cursor Blink Rate. Use the slider bar to change the rate, and you can see the cursor blinking on the tab for test purposes. The best setting is typically toward the fast end of the slider bar.

**Hardware**

The Hardware tab simply lists the type of keyboard that is attached to your computer. You have two buttons available that allow you to troubleshoot the keyboard if you are having problems, or you can click the Properties button to access the device’s properties sheets. You can learn more about configuring devices for your system in Chapter 6.

**Mouse**

The Mouse is a universal input device that lets you point and click your way into Windows oblivion. The Mouse itself is a simple device, but, surprisingly, there are a number of configuration options for the Mouse that you can access by double-clicking the Mouse icon in the Control Panel. You have a few tabs and several different options, and the following sections show you how to configure your mouse so that it operates and behaves in a way that is best for you.

**Buttons**

The Buttons tab, shown in Figure 2-11, provides a place where you can determine how your mouse buttons or keys work.

First, you can check the box to Switch Primary and Secondary Buttons so that your mouse functions as either a right-handed mouse or a left-handed mouse. If you choose the right-handed option, the mouse buttons are as follows:

- **Left Button**  Select or drag
- **Right Button**  Context menu or special drag
If you choose the left-handed option, the mouse buttons are as follows:

- **Left Button**  Context menu or special drag
- **Right Button**  Select or drag

As you can see, selecting the left-hand option simply reverses which button performs which action.

Next, you can use the slider bar to speed up or slow down your mouse’s double-click speed. Most people use a Medium setting (where the slider bar is in the middle), but just find the setting that works best for you.

Finally, you have an option at the bottom of the window called ClickLock. ClickLock enables you to drag items around your Desktop without having to continuously hold down the drag button (left mouse button for right-handed users). Click the Turn on ClickLock check box to use it, and then click the Settings button.
that becomes accessible. The settings window simply gives you a slider bar so you can determine how long you have to hold down the left mouse button before it locks into place, allowing you to drag items without holding it down.

You’ll need to play around with the slider bar setting for ClickLock to find which setting works for you, but keep in mind that short ClickLock settings are usually more aggravating than helpful. This setting causes your left mouse key to lock very quickly every time you press it, so don’t start out with a short setting when you are configuring ClickLock.

**Pointers**

The Pointers tab, shown in Figure 2-12, provides a place to configure the way your pointer appears on your Windows XP computer. What you are doing may cause your mouse pointer to change its appearance. For example, a typical pointer is simply an arrow; but if your system is busy, your mouse pointer changes to an hourglass. You can use the Pointers tab to customize the pointers as you wish.

At the top of the window, you see a Scheme drop-down menu that enables you to select preconfigured Windows schemes. Scroll down and select some of

![FIGURE 2-12](image) Use the Pointers tab to select desired pointer appearances.
You Can Customize Scheme Options

The basic Windows XP schemes provide several different appearances for your mouse pointers. Some of the schemes provide pointers that are larger on your display than normal. These settings are very helpful to people with vision problems. As with many Control Panel settings, play around with the Pointer Schemes and find one that you like best.

them. You’ll see the various pointers change in the Customize window. Just select a scheme that you want and click Apply to use that scheme.

Aside from using the standard Windows XP pointer schemes, you can also create your own schemes by modifying the desired pointers. If you click the Browse button, you can choose to use a different cursor file, such as one you have downloaded from the Internet or obtained from a CD-ROM. You can then select a desired pointer, and create and save your own custom pointer scheme.

Create a Custom Pointer Scheme

To create a custom pointer scheme, just follow these easy steps:

1. Use the drop-down menu and select a scheme that is close to your desired scheme options.
2. Select the option in the Customize window that you want to change.
3. Click the Browse button and locate the desired pointer file you want to use.
4. Select the desired file and click OK.
5. On the Pointers tab, click the Save As button and give the scheme a name. Click OK.
Pointer Options

The next mouse configuration tab provides Pointer Options, as shown in Figure 2-13. This simple tab gives you a series of check boxes or slider bars you can use to configure how your mouse pointer moves around the screen.

There Are Two Types of Mouse Pointer Files

If you want to use different pointer files for your own custom configuration, you can use one of two types of files. First, you can use a standard cursor file, which ends with the .cur extension. Also, you can use an animated cursor file, which ends with an .ani extension. When you choose to browse for a different pointer file, Windows XP looks only for files with either a .cur or .ani extension.
You can play around with these settings to determine which (if any) of them you would like to use. The options are

- **Motion** Use the slider bar to determine how fast your pointer moves when you move your mouse. You can try different adjustments to find the speed you like. If you click the Accelerate button, you can also select how fast your pointer moves when you begin moving your mouse.

- **SnapTo** This option automatically moves your mouse pointer to the default button in any given dialog box. You can try this option to see whether you like it, but many users find SnapTo more aggravating than helpful (myself included).

- **Visibility** The visibility options control how your pointer looks when in motion—you have three check box options. First, you can choose to use a mouse trail, which leaves a disappearing trail when you move your mouse. Some people like this setting, some don’t (it gives me a headache), but you can experiment with it. Next, you can choose to hide your mouse pointer when you type. This just makes your mouse pointer disappear when not in use. Finally, you can choose to use the CTRL key to make your mouse pointer appear when you press the key.

**Wheel**

For mice that use a control wheel instead of right and left buttons, use the Wheel tab to determine how quickly the wheel moves the mouse. The configuration option here allows you to set how many lines are scrolled when you move the wheel, or you can choose to move through an entire page. Select the desired radio button and enter a scroll value to experiment with these settings.

**Hardware**

The Hardware tab lists the type of mouse that is attached to your computer. You have two buttons available that allow you to troubleshoot the mouse if you are having problems, or you can click the Properties button to access the device’s properties sheets. You can learn more about configuring devices for your system in Chapter 6.
Network Connections

The Network Connections icon in the Control Panel enables you to configure networking components so that Windows XP can participate on a local or remote area network. You can learn all about networking with Windows XP in Chapters 11 and 12.

Phone and Modem Options

The Modems icon in the Control Panel provides a place where you manage modems attached to your computer. In the past, modems were painfully difficult to set up and troubleshoot, but Windows XP makes modem configuration much easier. As you might guess, modem setup and configuration is a lengthy topic, and you learn how to do it all in Chapter 8.

Power Options

Windows XP is equipped to save energy by using power schemes that you can configure. These options can automatically turn off your monitor or hard drive after a certain period of inactivity. The Power Options in the Control Panel is also available within Display properties, and Chapter 3 explores this option.

Printers and Faxes

The Printers folder is devoted to any printers or fax machines attached to your computer, and includes a helpful wizard so you can set up these devices. As you can imagine, printing and faxing can be a complex topic, so check out Chapter 7 for all the details.

Regional and Language Options

Regional and Language Options in the Control Panel provides you a place to configure your computer to use different language symbols, currency, and other specific regional representations. For example, let’s say that you are using Windows XP in France, and you want Windows XP to calculate money in French currency. You can enable this option by using Regional and Language Options. When you open Regional and Language Options, you see a standard Regional Options tab, a Languages tab, and an Advanced tab. Each tab contains drop-down menus so you can select the desired regional settings.
Scanners and Cameras

Reflecting the popularity of scanners and digital cameras, Windows XP includes a Control Panel icon to help you manage these hardware devices. You can learn about the installation and management of scanners and cameras in Chapter 7.

Scheduled Tasks

The Scheduled Tasks folder in the Control Panel contains several wizards you can use to set up a variety of PC maintenance utilities to run in the background. These options are all covered in Chapter 18.

Sounds and Audio Devices

The Sounds and Audio Devices icon in the Control Panel provides a place to make some basic configuration changes to the way your Windows XP computer handles default Windows sounds, as well as any multimedia and sound devices attached to your computer. If you double-click the Sounds and Audio Devices icon in the Control Panel, the Properties page appears with five tabs, which are explored in the following sections.

Volume

The first tab, Volume, allows you to make basic settings for the volume level of your sound card or other device, as you can see in Figure 2-14.

The slider bar adjusts the overall volume for the device; but if you click the Advanced button, you’ll see the standard volume control interface for Windows, where you can control CD volume, microphone volume, and so on.

In the bottom part of the window are options for setting your computer’s speaker volume; and if you click the Advanced button, you can select the type of speakers you are using, such as desktop speakers, a headset, and so on. All of these settings are simple and self-explanatory.

Sounds

On the Sounds tab, shown in Figure 2-15, you can use different sound schemes to determine which sounds Windows XP plays for different events that occur. For example, when you receive an e-mail, Windows plays a sound. There are a number of these, and the default sounds are applied when Windows XP is installed, so you do not have to configure anything here—but you can make changes to suit your personal taste.
FIGURE 2-14 Use the Volume tab to make global volume changes.

FIGURE 2-15 Use the Sounds tab to change Windows XP sounds.
You can use the drop-down menu to select a Windows scheme, such as “Windows Default,” and then you can select each sound in the Sound Events window, click the Browse button, and change the sound as desired by selecting a different one. You can then save this new scheme using the Save As button.

At the bottom of the window, you see a slider bar to adjust the sound volume, and a check box that enables the volume control to be displayed in your System Tray. I recommend that you keep this check box selected so you can easily control the volume from your Taskbar.

Audio

The Audio tab (Figure 2-16) presents you with three different types of audio input and output: sound playback, sound recording, and MIDI music playback.

For each type, you can use the drop-down menu and select the preferred device. This means that a particular device on your computer should be preferred over other devices for that type of input or output. For example, I want Sound Playback to use my computer’s sound card to play sounds, so my sound card is the preferred device, as you can see in Figure 2-16. If you have multiple sound cards or devices that can be used, just use this drop-down menu to select the preferred device.
For each device, you also see a Volume button. Click this button to change the volume as desired. The Volume Control window presents simple slider bars that you can adjust as needed.

For the sound playback and sound recording options, you have an Advanced button. The sound playback Advanced option has two tabs. The first, Speakers, enables you to use a drop-down menu to select the speaker type that should be used, such as desktop speakers, headphones, and so on. The second tab, Performance, is the same for both sound playback and sound recording. The default settings are best, and you don’t need to change them under normal circumstances. If you do change them, you may experience some performance problems, so keep that in mind when playing around with these settings.

The sound card, microphone, and other sound devices on your computer should come with instructions about any special settings that need to be made. Check your computer documentation for details.

One final note about the Audio tab—there is a Use Only Default Devices check box at the bottom of the window. This check box makes sure that only the default devices installed on your computer can be used. Should you enable this option? If your programs require a certain sound card or device, then yes. If not, then don’t worry about this check box.

**Voice**

The Voice tab works in just the same way as the Audio tab, except you can configure voice playback and voice capture options.

**Hardware**

Finally, you have a Hardware tab. This window lists all the sounds and multimedia device categories for Windows XP. By clicking a category, you can see the actual device or software installed to manage that category. There isn’t much you can do here, but you can access the device’s troubleshooter and properties sheets. See Chapter 6 to learn more about hardware management.

**Speech**

The Speech icon in the Control Panel allows you to configure text-to-speech translation, as shown in Figure 2-17. This means that Windows XP can read to you any text in Windows that you want read.
By default, the Microsoft Sam voice is selected for you, which is the only voice option available in the default XP installation. You can use the Preview Voice buttons and the Audio Output buttons to hear the voice and to select the device that you want to use for voice playback (which is typically your computer’s sound card). You can also use the slider bar to slow down or speed up the rate at which the computer reads information to you.

**System**

The System icon in the Control Panel contains seven different tabs, such as Hardware, System Restore, Automatic Updates, Remote, and others. These tabs manage different components of your Windows XP system, and they are explored in various other chapters throughout this book.

*Shortcut*

You can also quickly access this same properties sheet by right-clicking My Computer on your Desktop and clicking Properties.
Taskbar and Start Menu

The Taskbar and Start Menu icon enables you to configure these items to suit your needs. You can learn about Taskbar and Start menu configuration in Chapter 1.

User Accounts

Finally, the last icon in the Control Panel is the User Accounts icon. This icon gives you an interface where you can create new user accounts and manage existing user accounts so that different people can log on to your Windows XP computer. Without a valid username and a password, different users cannot log on, so you use this window to create these accounts. There are a number of issues related to user account management, which you can learn all about in Chapter 13.
How To…

- Customize Your Start Menu and Taskbar
- Customize the Appearance and Behavior of the Windows XP Desktop
- Customize Your Folders

One of the first reports ever given about Windows XP, several months before it was available to the public, concerned Windows XP’s new Start menu and new interface. Windows XP does provide you with a significant interface makeover from earlier versions of Windows, and once you begin making your way around Windows XP’s interface, you may decide that you want to change some things about the way Windows XP looks and behaves. That’s fine, and Windows XP gives you a number of different options for configuring the interface, including folder view options, so that Windows XP is easy to use and helpful to you. In this chapter, you’ll explore how to customize your Start menu, Taskbar, XP Desktop, and folder view.

Customizing Your Start Menu and Taskbar

When you first booted Windows XP, one of the first things you probably noticed is that Windows XP’s Start menu looks different from that of previous versions of Windows. If you’re new to Windows, then this isn’t such a shock; but for the rest of us, the new Start menu takes some getting used to. It’s simple enough, however, and the next two sections show you how to use and customize the Start menu.

Using the Start Menu

The XP Start menu, shown in Figure 3-1, gives you an easy place to access the most common Windows configuration items, as well as items that are popular specifically to you.

There are two primary portions of the new Windows XP Start menu, as you can see in Figure 3-1. The left side of the Start menu lists programs, and the right side provides access to common Windows folders, as well as Help, Search, and Run. I mentioned earlier that the Start menu lists items that are popular to you—this means that if you open a program, the Start menu will remember it and place an icon in the Start menu so you can more easily open the program next time.

Let’s consider an example. I recently installed Microsoft Word on my XP system. In order to open Word, I have to click Start | All Programs | Microsoft
Word. Once I open Word for the first time, the Word icon is added to my Start menu, as you can see in Figure 3-2. The next time I want to use Word, all I have to do is click Start and click the Word icon.

In a nutshell, the Start menu is simply adding shortcuts to itself on your behalf. You can easily manage these icons by right-clicking them. This action gives you typical menu options, such as open, send to, copy, remove from this list, rename, and properties for the shortcut. If you want to remove the shortcut from the Start menu, just click Remove from this list of options. This action removes the shortcut only from the Start menu—it does not remove the program from your computer, so don’t worry.
When you right-click an item, you also see an option called Pin to Start Menu. This action simply moves the item to the top-left portion of the window, where it will always be visible. You’ll notice that Internet Explorer and Outlook Express are available there by default, but you can remove them if you like by right-clicking the items and clicking Remove From This List.

Finally, you can also click All Programs to access typical Windows menus and installed applications.
If you want to use IE and Outlook Express from the Start menu, they have easy usage options if you right-click the icons. For example, you can choose to read e-mail, browse the Internet, or even access Internet Properties. See Chapter 9 for more information about configuring Internet properties.

On the right side of the Start menu, you see common Windows items that you will need to access. The items are

- **My Documents, My Pictures, and My Music** The My Documents folder is the default storage location for files of all kinds, including pictures, music, and movies. My Documents contains default subfolders of My Music, My Pictures, My Videos, and Remote Desktops.

- **My Computer** My Computer is the default folder that stores information about drives connected to your computer.

- **My Network Places** My Network Places contains information about other computers and shared folders on your network. You can learn more about My Network Places in Chapter 11.

- **Control Panel** The Control Panel is the default location for managing all kinds of programs and services on your XP computer. Chapter 2 is devoted to the Control Panel.

- **Network Connections** Network Connections is a folder that contains your dial-up and broadband connections, as well as local area network connections. You can learn more about Network Connections in Chapter 8.

- **Help and Support** Windows XP includes a help and support feature that can answer your questions and even locate answers on the Internet. See Chapter 20.

- **Search** The search feature enables you to find items on your computer or items on the Internet, including other people!

- **Run** The Run dialog box can be used to quickly start programs or connect to network shares.

- **Log Off/Turn Off Computer** These standard icons enable you to log off or shut down/restart the computer. See Chapter 1 for details.
Customizing the Start Menu

To customize the Start menu, you need to access the Start menu’s properties. To access the Start menu’s properties, open the Control Panel, double-click the Taskbar and Start menu icon, and then click the Start Menu tab. If you don’t see a Taskbar and Start Menu icon, switch the Control Panel to Classic view using the Control Panel link in the left side of the window.

You can also access the Start menu’s properties in two other quick ways. First, you can right-click any empty area of the Taskbar and click Properties, and then click the Start Menu tab. Even easier, just click Start, then right-click an empty area of the Start menu, and then click Properties.

No matter how you’ve chosen to get there, you arrive at the Start Menu properties sheet, shown in Figure 3-3.

You have the option on the Start Menu properties page to use either the current Start menu or the Classic Start menu, which is simply the Start menu found in previous versions of Windows. Because the two are different, the following sections explore the configuration of each.

XP Start Menu

To continue using the XP Start menu, click the Customize button. Doing this takes you to a Customize Start Menu window, which has a General and an Advanced tab. On the General tab, shown in Figure 3-4, there are three different customization options:

- **Icon size**  You can choose to use large or small icons on the Start menu. Small icons may be harder to see, but you can put more shortcut icons directly on the Start menu. Large icons are selected by default.

- **Programs**  This drop-down menu changes the number of program shortcut icons that appear in viewing range when you click Start. Basically, it just changes the size of the Start menu. By default, your Start menu displays five program shortcut icons; the maximum is nine.

- **Show on Start menu**  This option allows you to show Internet and e-mail on the Start menu, and then provides a drop-down menu for selecting the application (Internet Explorer and Outlook Express, by default). If you have other browser or e-mail clients installed on your computer, you can use the drop-down menu and select a different browser and/or e-mail client, or just clear the check boxes if you don’t want these items displayed at all.
On the Advanced tab, there are some additional options that you may find very useful, shown in Figure 3-5.

First, you see a few check boxes collectively called Start menu settings. You have two options:

- **Open submenus when I pause on them with my mouse**   This check box simply asks you whether you want a pop-out menu to appear when you put your mouse over an item on the Start menu, or you want to have to click the item to see the pop-out menu. By default, folders such as My Documents and My Computer are stored as links on the Start menu. You must click them to open the folders in a different window. However, with this option selected, a menu automatically appears when you hover your mouse over the choice on the Start menu. For example, let’s say I have a folder called My Stories in My Documents. Without using the menu option, I have to click My Documents and then open My Stories. Using the menu option, if I point to My Documents on the Start menu, a pop-out menu appears...
showing my other folders, such as My Stories, and I can just click My Stories to directly open it. If you want to use the menu option, I’ll show you how later in this section.

At first glance, it may seem that the hover option is best; but if you have all folders on the Start menu configured to display submenus, then every time you roll over one of the folders with your mouse, a menu will pop out. Some people find this very aggravating. You can play around with these settings and find the solution that is right for you.

- **Highlight newly installed applications** When applications are first installed on your XP computer, they are highlighted until you use them for the first time. This serves as a simple reminder that you have new stuff you haven’t used. If this gets on your nerves, just clear the check box.

The next part of the Advanced tab gives you a scroll window where you can select the folders and Windows items that appear on the Start menu and choose.
how those items are displayed. For example, the Control Panel, by default, is shown on the Start menu as a link. You can change this behavior so that it is shown as a menu or not at all. Simply scroll through the list and click the desired check boxes and radio buttons to determine what Windows items you want to include and how those items are presented (link or menu). You may want to experiment with these settings until you find the combination that is right for you—remember, you can make changes to these settings as many times as you like.

The last part of this configuration window allows you to show recently used documents on the Start menu. For example, let’s say that you’re writing your life’s story. Once you open the document and then close it, the Start menu will put it in Recent Documents, which is a folder that will now appear on the Start menu. Then, you can easily access the document from the Start menu the next time you need it.

**Classic Start Menu**

The Classic Start menu can be used instead of the new XP Start Menu. On the Start Menu Properties dialog box, click the Classic Start menu option. This option
Did you know?

What to Do If You Have Too Much Stuff in Recent Documents

As a writer, I use a lot of documents, as you might imagine. Although the Recent Documents folder is very useful to me, it can get way too overcrowded, so that it becomes more confusing than helpful. So, what do you do if you need to remove some documents from Recent Documents—or even all of them. First, let me clear up an important item. Like all items on the Start menu, Recent Documents simply stores shortcuts to those documents, not the actual documents themselves. You can remove some items from Recent Documents—or all of them—without deleting any of the actual documents from your computer. In fact, you can remove anything from the Start menu without damaging or deleting items on your computer, because all of the items on the Start menu are just shortcuts.

So, if you want to remove items from Recent Documents, you can do one of two things. First, you can click Start | Recent Documents and, on the pop-out menu that appears, right-click any item you don’t want in the folder and click Delete—doing this just deletes the shortcut, not the document itself. Second, if you want to completely empty every document from the folder, just access the Advanced tab of the Customize Start Menu window and click the Clear List button.

allows you to use the Start menu that was seen in previous versions of Windows. If you want to use the Classic Start menu, select the radio button and click the Advanced button, which gives you a single Customize Classic Start Menu interface, as seen in Figure 3-6.

You’ll see that you have the same basic Start menu options, just in a different format. If you want to add items to the Classic Start menu, click the Add button and a wizard will help you select items on your computer to add. Use the Remove button to remove items, and the Advanced button opens Windows Explorer so you can manually add and remove items that you want. You can also re-sort the items and clear recent documents, programs, Web sites, and so on. The Advanced window option that you see enables you to, among other things, display a number of Windows items and use expandable (menu) folders. These items are self-explanatory—feel free to experiment and try new configurations.
Add More Start Menu Shortcuts

Always keep in mind that the Start menu contains just shortcuts to items that you want to easily access. Therefore, you can add just about anything to the Start menu. You can place an icon, folder, document, or essentially anything else on the Start menu, and here’s how:

1. When you locate an icon, folder, document, or other Windows item that you want to add to the Start menu, right-click the item and click Create Shortcut.
2. Normally, a message will appear asking whether you want to put the shortcut on the Desktop. Click Yes.

3. On the Desktop, use your mouse to drag the new icon to the Start button on your Taskbar, and then release it. The shortcut will be copied to the Start menu and will appear in your list of items.

Customizing the Taskbar

Along with Start menu properties, you can customize your Taskbar as well. You can access the Taskbar and Start menu properties by double-clicking the icon in the Control Panel. Or, just right-click any empty area of the Taskbar and click Properties, and then click the Taskbar tab, as shown in Figure 3-7.

You have two basic customization areas—Taskbar Appearance and Notification Area. In the Taskbar appearance area, you have a few check box options that enable certain features. They are

- **Lock the Taskbar** You can drag the Taskbar to different places on your Desktop. For example, if you want the Taskbar on the top of the screen instead of the bottom, just drag it to the top. If you use the Lock the Taskbar check box, then the Taskbar will be locked on the bottom of the screen and you will not be able to move it.

- **Auto-hide the Taskbar** This feature keeps the Taskbar out of your way. When you are not using the Taskbar, it disappears below your screen view. When you need it, just point your mouse to the location of the Taskbar and it will reappear. Some people like this setting, so be sure to experiment with it.

- **Keep the Taskbar on top of other windows** As you are using various windows, they may cover up portions of the Taskbar. This setting always keeps the Taskbar on top.

- **Group similar Taskbar buttons** This feature keeps similar items together. For example, if you open two Web pages and then minimize them both, they will appear next to each other on the Taskbar.

*You can learn more about general Taskbar usage in Chapter 1.*
CHAPTER 3: Configuring System Settings

The Notification area, also called the System Tray, is the small icon area on the right side of your Taskbar. It has icons for a number of functions that are working on your computer and can notify you of certain application functions. You have two simple check box options here. You can choose to show the clock in the System Tray, and you can choose to hide inactive icons. The hide inactive icons feature simply “cleans up” the System Tray area so that only active icons are seen. You can try both of these settings to see if you like them.

Configuring Your Display

One of the primary places you configure the way your Windows XP system looks is through your Display properties. If you remember from Chapter 2, Display is an icon in the Control Panel that you can open to configure various settings that affect the appearance of your Windows XP display. Just click Start, point to Settings, click Control Panel, and then double-click the Display icon to open the properties sheets. Once you open Display Properties, you see several tabs, all of which are explored in the following sections.
The Display icon officially resides in the Control Panel, but you don’t have to open the Control Panel to access the properties sheets. Just find an empty area on your Desktop (a place where there is no folder or icon), and then right-click the Desktop and click Properties. The same Display properties sheets appear.

**Themes**

A *theme* is a group of settings that are applied to Windows XP under a single name. The settings usually relate to each other, creating a theme of some kind. If you’ve used Windows before, you are familiar with the concept of themes. Windows 95 gave you some sounds options, and Windows 98 gave you a whole list of themes that completely revamped the desktop, such as Mystery, The 70’s, and Underwater. However, you are not used to seeing a Themes tab, shown in Figure 3-8, on Display Properties. The Themes option is placed here in Windows XP because the default Windows XP interface is one among a number of themes that you can choose. You can use the XP interface; you can change to a different theme; or you can even use a “Windows Classic” theme, which basically gives you the plain-vanilla Windows interface you saw in Windows 9x, Me, and 2000. Simply use the drop-down menu to select a desired theme, and click Apply to see all of the settings the theme has to offer. You can also modify any theme (including the default XP interface theme) by making modifications to the other tabs available on Display Properties.

### Help! I can’t remove a theme!

In the Windows courses that I teach, students are often frustrated by themes. Let’s say you choose the Underwater theme, which is also available in previous versions of Windows. If you decide you no longer want the theme, how can you remove it? Because themes change all kinds of settings, including icons and fonts, manually removing a theme’s settings can be difficult. The best way to remove a theme is to simply return to the Themes tab and select a different theme. Alternatively, you can choose the XP theme or Windows Classic in order to return to a default Windows interface. You can then make the customization changes you want on the other Display Properties tabs.
CHAPTER 3: Configuring System Settings

The second tab you see on the Display Properties sheets is the Desktop tab (formerly called Background), shown in Figure 3-9. The Desktop tab lets you decide how your Windows XP Desktop area should look. In other words, the Desktop tab lets you decide what color, style, or even picture appears on your Desktop.

Windows XP gives you several built-in options that you can choose for your background in the list on the Desktop tab. If you scroll through the list, you see that there are two kinds of files present. Some files give your Desktop a pattern, while others give your Desktop a picture.

**Desktop**

The second tab you see on the Display Properties sheets is the Desktop tab (formerly called Background), shown in Figure 3-9. The Desktop tab lets you decide how your Windows XP Desktop area should look. In other words, the Desktop tab lets you decide what color, style, or even picture appears on your Desktop.

Windows XP gives you several built-in options that you can choose for your background in the list on the Desktop tab. If you scroll through the list, you see that there are two kinds of files present. Some files give your Desktop a pattern, while others give your Desktop a picture.
If you look in the list on the Desktop tab, you see that each file has a name and an icon picture next to it. Background patterns and pictures are simply JPEG, BMP, GIF, and related picture file formats (which you commonly see on the Internet), as well as HTML files (which are also used for Web pages).

On the Desktop tab, you can select one of the files and it will appear in the test monitor window on the Background tab. By default, pictures are set up to stretch across your screen so that they take up the entire Desktop area, and patterns are set to tile so that they repeat until the entire Desktop area is used. This process causes the pattern to fill the entire test screen, so you can see how it looks before you decide to use it. You can also use the Center option in the drop-down menu to center the pattern in the middle of the test screen, which will give you a different look. If you like what you have selected, click the Apply button at the bottom of the window and the new pattern will be applied to your Desktop. If you don’t like it, just pick something else on the Desktop tab. You can look at all of the patterns and even reapply different patterns until you find the one you want.
If you choose to center a picture or pattern, you have an area of your Desktop still showing. Windows XP enables you to alter the color of the remaining Desktop area. For example, let’s say you choose a wallpaper from the list on the Background tab and you center the picture. You will have additional leftover background space. You can use the color drop-down menu and select a color for the remaining portion of the Desktop area.

Do you have to use an additional background picture or pattern? It is important to remember that all of this stuff is optional. Windows XP gives you a basic background upon installation; if you are happy with that background, you don’t have to change anything. However, all of the options explored in this chapter are provided so you can configure your Windows XP computer to look the way you want. If you want to use something different, just click the Browse button to locate the file on your PC or even the Internet. Windows XP can display any common graphics file format as wallpaper for your Desktop. Be creative!

Once you have finished your background pattern and selected anything else from the Background tab that you want to use for the main pattern, just click Apply and then click OK. As you can see in Figure 3-10, I have set a picture in the center of my Desktop and stretched the picture so that it takes up all of the Desktop space. This feature allows you to display family pictures—or whatever pictures you would like—on your Desktop. If you currently have picture files stored on your computer (such as GIF, JPEG, or BMP files), you can simply browse and select the desired picture. See the following How To box for step-by-step instructions.

Did you know?

Which File Types You Can Use for Your Desktop

JPEG (as well as GIF) files are standard file types for pictures and graphics used on the Internet. When surfing the Net and looking at pictures or graphics, you are usually looking at JPEG and GIF files. HTML files are Web pages. You can display an entire Web page as your background if you like, and you’ll see how to do this later in this chapter. In a nutshell, virtually any picture on the Internet can be used on your Windows Desktop, as long as it is a BMP, JPEG, GIF, DIB, or HTML file or document.
FIGURE 3-10  You can use a picture and color to customize your Desktop.

How to ...  Browse for Pictures

To browse and select a personal picture to use as wallpaper, follow these steps:

1. On the Desktop Properties Background tab, click the Browse button.

2. In the Browse window that appears, navigate to the location on your computer where your picture files are kept (such as the My Documents or My Pictures folder).

3. Once you locate the desired picture, select it and then click the Open button in the Browse window.

4. The picture will appear in the test window on the Desktop tab. Click OK for your picture to be displayed on your computer’s Desktop.
Finally, you also see a Customize Desktop button found toward the bottom of the Desktop tab. If you click this button, you are taken to the Desktop Items properties page, which contains a General and Web tab.

On the General tab, shown in Figure 3-11, you can choose which Desktop icons you want to display, such as My Documents, My Computer, My Network Places, and Recycle Bin. All of these items are selected by default. You also see a window showing the default icons that are used for each of these items. If you want to use different icons, click the Change Icon button and select different icons from the provided list. If you manage to get them all fouled up, just click the Restore Default button to return to XP’s default icon settings.

Finally, at the bottom of the tab, you see the option to use the Desktop Cleanup Wizard. The cleanup wizard is configured to run every 60 days by default, but you can run it at any other time by clicking the Clean Desktop Now button. This wizard simply removes old shortcuts and puts them in a folder called Unused Shortcuts. If you create a lot of shortcuts and don’t use them very often, this wizard can help keep your Desktop free of clutter. The wizard is easy to use, and the upcoming How To box walks you through it.

The Desktop Items Web tab, shown in Figure 3-12, allows you to place a complete Web page on your Desktop.

You can use the wallpaper feature to place an HTML file on your Desktop, and the Web page option places an actual Web page there that can be synchronized with the real Web page on the Internet. To place a Web page on your Desktop, click the New button and enter the URL in the New Desktop Item dialog box, as shown in Figure 3-13. You’ll need an Internet connection to complete the addition of the Web page.
Use the Desktop Cleanup Wizard

1. On the Desktop Items General tab, click the Clean Desktop Now button.

2. The Desktop Cleanup Wizard welcome screen appears. Click Next to continue.

3. In the Shortcuts window, review the list of shortcuts and click the check boxes next to the ones that you want to remove. The wizard may select some of them for you, so make certain you want any selected items removed before continuing (if you don’t, just clear the check boxes).
Notice that each shortcut has a date next to it, noting the last time it was used. Click Next when you’re done.

![Desktop Cleanup Wizard](image)

4. Click Finish.

Once you click OK, a confirmation message appears. If the Web site requires you to enter a password, click the Customize button and enter it; otherwise, just click OK.

**TIP**
When you choose the Web Page option, the entire Web site is downloaded and stored on your computer so that you can use the site, just as if you are actually using a browser.

**TIP**
Once you have your Web page displayed on your Desktop (and perhaps gallery items as well), you can click the Lock Desktop Items check box on the Web tab so that no items can be moved or resized by accident. In other words, once your Desktop is just as you want it, use the lock feature so that you or someone else doesn’t accidentally change the desktop.
FIGURE 3-12 Desktop Items—the Web tab

FIGURE 3-13 New Desktop Item
Screen Saver

The Screen Saver tab provides two functions: it enables you to configure a screen saver for your computer and to configure power management options. A screen saver is a simple program that runs once your computer has been idle for a certain period of time. In the past, the screen saver protected monitors from “screen burn.” When a monitor was left unattended for too long and one continuous picture or window was displayed, the image could burn itself onto the monitor and always be sort of floating in the background. Monitors today aren’t really susceptible to this problem, so screen savers are used more for decoration. The following two sections explore both screen savers and Windows XP’s power management features.

Using a Screen Saver

The Screen Saver tab is easy to use, as you can see in Figure 3-14. Just use the drop-down menu to select a screen saver, and a sample of it will be displayed in the test window. Once you find one you like, click the Apply button.

Once you select a screen saver that you want to use, you have a few other button options as well:

- **Settings** The Settings button, which opens a small window specific to the screen saver, allows you to configure the screen saver. These settings are easy and self-explanatory. You can play around with them to find the settings you want.

- **Preview** If you click Preview, your screen first goes blank, and then the screen saver begins, so you can see if you like it. Just move your mouse to get control of your system again.
Wait  This scroll box enables you to set the amount of time that should pass before the screen saver comes on. The default time is 14 minutes. There is no right or wrong setting, but to protect your screen, keep the setting under 30 minutes; also, do not set the time setting so low that it comes on after one minute or so of inactivity—you’ll find this setting very aggravating!

Return to the Welcome Screen  This check box option returns you to the Windows Welcome screen when you move your mouse to regain control of the system. In other words, you’ll have to log back in each time the screen saver comes on. In previous versions of Windows, the Screen Saver tab offered a “Password protect” option—this is the same thing, but it is enabled with your user account so that you have only one password to remember.

Several 3-D screen savers are available on the Screen Saver tab. While these are cool and perfectly safe to use, 3-D graphics are much more CPU intensive for your computer to run. If you want to conserve energy and CPU power, don’t use the 3-D screen savers.
Did you know?

You Can Use Your Own Pictures for a Screen Saver

Windows XP offers a My Pictures screen saver. This feature lets you use any pictures on your computer for a screen saver. The system rotates through the pictures after a specified period of time. You designate a folder the program accesses, such as My Pictures, where the pictures are stored. You can then set transition effects as desired. Just select My Pictures Slideshow in the screen saver list, and then click the Settings button to set it up.

Using Power Options

The Screen Saver tab also provides a button to access energy-saving options: the Power button. After pressing the button, the Power Options Properties window appears (which has the same properties sheets you see if you click Power Options in the Control Panel), as shown in Figure 3-15.

On the Power Schemes tab, you have a few options for managing how your computer conserves energy when it is idle. First, you see a drop-down menu called Power Schemes. There are a few basic schemes:

- **Home/Office Desk**  When using this scheme, your monitor is automatically turned off after 15 minutes of inactivity, hard disks after 30 minutes, and your system goes on standby after 20 minutes.

- **Portable/Laptop**  This scheme uses the same settings as Home/Office Desk.

- **Presentation**  This setting is used for laptops, or computers used for teaching or presentations. Essentially, the power options are turned off and the system never goes on standby.

- **Always On**  This scheme automatically turns your monitor off after 30 minutes of inactivity, your hard drives after 1 hour, and your system never goes on standby.

- **Minimal Power Management**  This setting simply turns your monitor off after 15 minutes, but never the hard drive.

- **Max Battery**  This setting contains the same settings as Minimal Power Management.
Okay, here’s the deal. You can use a particular scheme and change any of the settings you want by using the drop-down menus. For example, let’s say I want to use the Home/Office Desk scheme, but I do not want my monitor to turn off until 30 minutes of inactivity. No problem, just use the drop-down menu for the monitor and change it to 30 minutes. You can also change all of the settings and click Save As to create your own scheme. Just give the scheme a name, and it will appear in your scheme list.

Power Options Properties also has an Advanced tab (which really isn’t that advanced). You have only two check box options that you can enable if you want:

- **Always show icon on the Taskbar**  This option puts a power icon on your Taskbar.

- **Prompt for password when computer goes off standby**  This option requires you to reenter your password when your computer goes off standby before you can use the system again. This feature helps prevent anyone from gaining access to your system when you are away from it.
On the Hibernate tab, you can enable the hibernate feature by clicking the check box to turn it on. Hibernation allows Windows XP to store information that is in memory on your hard disk before it shuts down. When the computer is brought back online, XP can remember its previous state so that you do not lose any data.

The APM tab, which stands for Advanced Power Management, is used by computers that support the APM standard. Basically, APM allows your computer to use less power, and it gives you information about battery life if you are using a battery (such as with a laptop). There’s nothing for you to configure, and if this tab tells you that your computer supports APM, you can enable it by clicking the single check box option.

The final tab is UPS, which stands for Uninterruptible Power Supply. UPS devices are basically batteries that give your desktop computer enough power to remain online in the event of a power failure. This gives you enough time to do proper shutdown of the system. The UPS feature is typically employed on server systems and rarely on desktop systems, but if you have a UPS, you can enable it on this tab. Be sure to follow the UPS manufacturer’s suggestions for configuration and settings.

### Appearance

The Appearance window, shown in Figure 3-16, enables you to pick an appearance scheme for your Windows XP computer.

You have a few standard options here:

- **Windows and Buttons** You can use the drop-down menu to choose either XP style or Windows Classic style.
How to Do Everything with Windows XP

There are a number of color schemes available. Use this drop-down menu to select one you like. You can experiment with this setting and change it at any time.

You can choose normal, large, and extra large from the drop-down menu.

Click the Effects button to open the Effects window, which gives you some basic check box options, such as fade and shadows under menus.

If you click the Advanced button, you can make specific font and color changes to different windows components, such as menus, buttons, active title bar, and a host of others. Under most circumstances, you will not want to edit all of the settings, but if you want to change something specific, just select it using the drop-down menu and configure the available options for it.

FIGURE 3-16 Use the Appearance tab to pick an appearance scheme.
Settings

The final Display Properties tab is the Settings tab. You use this tab to manage the actual video-card hardware that resides within your computer. There are a few basic options, as you can see in Figure 3-17.

First, you see a Screen resolution slider bar. You can adjust the resolution to suit your needs, and, as you adjust it, you will see that your Desktop area gets either larger or smaller (including your icons) depending on the location of the slider bar.

You also see a Color quality drop-down menu. This menu enables you to select the number of colors Windows XP can use to generate all of the graphics and pictures that appear on your monitor. True Color (32 bit) is the highest color scheme that you can use, and, depending on the quality of your video card, you may have only a few color options available. The higher resolution provides the best color performance.

You also have an Advanced button. This option opens the properties pages for your video card. In general, the default settings found on these pages are all you need, and you really should not change any of them unless your video card documentation tells you to do so. If you’re having problems with your display, click the Troubleshoot button to get help from Windows XP.

![Figure 3-17 The Settings tab for configuring your video adapter card](image)
### Configuring Folder Views

Aside from using an appearance scheme so that you folders appear with a certain color and font, Windows XP also includes several capabilities that enable you to customize your folders. Keep in mind that a folder is simply a storage location. Windows XP has several folders it creates and uses, and you can create your own as well (see Chapter 4).

*Folder options do not affect folder toolbars, but you can change folder toolbars, which you will learn about later in this chapter.*

You can configure folder options from either one of two places. First, you can double-click the Folder Options icon in the Control Panel, or you can configure folder options from within any Windows folder. For example, you can double-click My Computer, click the Tools drop-down menu, and then click Folder Options. Doing this opens the same folder options you see when you open the Control Panel icon. You can use the Tools menu to access folder options from any folder in Windows XP.

*It is important to note here that if you access folder options within a window and make changes, you are making changes to the appearance of all of your folders. In other words, you cannot individually configure folder options for each folder—one setting applies to all folders in Windows.*

Once you open Folder Options (regardless of where you open it), you see a simple interface with three tabs.

### General

The major appearance changes you can make to your folders is performed on the General tab, which presents you with a list of radio buttons, shown in Figure 3-18.

You have three different categories from which you can choose a radio button option:

- **Tasks** This option enables you to display Web content in your folders, including the blue links in the left side of your folders (which jump to another location when you click them). Web content also enables your folders to display HTML documents and graphics files. For example, let’s say you have a picture file called “My Dog.” With the XP default view, a thumbnail icon appears showing you what the picture looks like. If you want to keep Web items in your folder, just keep Show Common Tasks in Folders selected. If not, select Use Windows Classic Folders.
My Computer and the Control Panel are always displayed with the Web page view, even if you do not select the Web page view option.

- **Browse Folders**  This option enables you to choose how your folders are displayed when you are browsing through a folder structure. For example, let’s say you open My Computer and then you open the Control Panel. You can have My Computer open in a window, and then have the Control Panel open in a separate window. Or, you can choose to use the same window so that with My Computer open, when you open the Control Panel, it replaces what you see in My Computer. There is no right or wrong option, but if you work with a number of windows at one time, you may find the Open Each Folder in the Same Window option less cluttering to your Desktop.

**TIP**  When using the Open Each Folder in the Same Window option, use the Back button on the folder’s toolbar to return to a previous window. For example, if you open My Computer and then the Control Panel, just click the Back button to return to My Computer—just as you would when surfing the Internet.
Did you know?

Your Folders Can Take You to the Internet

One of the design goals Microsoft has for Windows XP is to make the operating system more integrated with the Internet. Notice that when in Web view, your folders look a lot like the Internet Explorer browser. This similarity is by design, and, as you might guess, you can jump from a local folder to the Internet without even changing to a different window. In the folder’s address bar, just select what is currently listed, press BACKSPACE or DELETE, type the Internet URL you want, and press ENTER. Your computer will launch an Internet connection (if you are not currently connected) and take you to the Internet site—very cool!

- **Click Items**  
  You can have your mouse clicks act as though your Windows XP interface is the Internet. On the Internet, you simply click once with your mouse to open any item—all Internet movement is performed through Hyperlinks that connect Web pages and Internet sites together. You can have your computer act this way as well, so that you only have to point to an item to select it, and then click it one time to open it (no more double-clicking). You can enable this option and try it out—it does take some getting used to, however. Just click the Single-click radio button option to enable it.

**View**

The View tab contains a number of check boxes that enable you to make a number of different decisions about files and folders. The options found here concern the display of certain file types, folder views, and other lower-level settings. Windows XP does a good job of configuring the common settings, and changing them may cause problems—so my recommendation is that you not make any changes to the options found on this tab unless you have a very specific reason to do so. Because you probably don’t need to use these options, I will list here only some of the more common ones and indicate whether they are enabled by default.

- **Display all Control Panel options and all folder contents**  
  Do you remember how the Control Panel only displayed the most common icons? If you don’t like that feature, click this check box to turn it off (this option is not selected by default).
I Do not show hidden files and folders and Hide protected operating system files These two separate options, both of which are enabled by default, keep the hidden files and folders in Windows XP from being shown. Windows XP hides folders that hold operating system files, as well as many of the individual files that make Windows XP run. Obviously, you don’t need to do anything with these files, and Windows XP hides them to help prevent tampering or accidental deletion. You should leave these settings as they are so that Windows XP continues to hide system files and folders.

I Hide extensions for known file types This option provides for hiding file extensions. For example, let’s say you create a Microsoft Word document called Cat. The document’s official name is Cat.doc. The hide extensions option hides the .doc extension and all other extensions for files that Windows recognizes. This makes your folder files cleaner and easier to read. This option is enabled by default.

I Remember each folder’s view settings You can use the View menu in a particular folder to determine how the folder appears and what you can view (you can learn about these options later in this chapter). This setting tells Windows to remember each folder’s view settings. This option is enabled by default and you should keep it enabled.

File Types
The File Types tab provides you with a window that lists every type of file supported in Windows XP. Your operating system and applications do a great job of managing this list, so you do not need to perform any configuration here unless explicitly instructed to do so by some application.
Removing file types from this list can prevent certain application files from functioning in Windows XP. Do not remove any of these files! Let Windows XP and your applications manage this task.

Offline Files
Offline files allow Windows XP to store network files locally on your computer, and then synchronize your local copy with the network copy. For example, let’s say that a document resides on a network server, but you need to take that document home on your laptop one evening and make some changes to it. With offline files, the document is stored on your local computer instead of the network server. You can work with the file and make changes to it when you are not connected to the network. Then, when you reconnect to the network, the local file can be synchronized with the network file. In other words, the changes you made at home are added to the network file so that the network file is up-to-date.

The Offline Files tab, shown in Figure 3-19, enables you to turn on offline file support and configure some basic functions for offline files. Typically, the default check boxes are all you need here. You can also learn more about Offline files and synchronization in Chapter 5.

Configuring Folder Views and Toolbars
Once you have made some decisions about how you want your folders to appear using the Folder Options, you can customize your folder views and toolbars. When you open a folder, you see a View menu, shown in Figure 3-20.

Most of the options you see on this menu are self-explanatory, and you can try the different setting options to determine what you like best. The following sections explore your major options.

Toolbars
First, you have the Toolbars item—when you hold your mouse over it, a submenu pops out. This submenu allows you to select the toolbar items you would like to use. Some of these are enabled by default, but you can enable or disable them by just clicking them with your mouse. You have these options:

- **Standard Buttons**  Enabled by default, this option provides you with the standard toolbar buttons, such as Back, Forward, Up one level, Search, and so forth. You need these, so keep this option enabled.
CHAPTER 3: Configuring System Settings

- **Address Bar**  Enabled by default, this option gives you the address bar, so you can move to different areas of your computer or even the Internet. For example, you could access a folder by simply typing the path to the folder (such as `C:\My Documents`) or an Internet address.

- **Links**  This option, which is enabled by default, gives you a Links button on your toolbar so you can access links or resource locations that you commonly use.

Aside from these standard options, you can also lock the toolbars and you can click Customize. This option opens a Customize Toolbar window, as shown in Figure 3-21, where you can add and remove various toolbar buttons and options. This feature allows you to configure your folder toolbars so they are exactly what you want!

---

![Folder Options](image)

**FIGURE 3-19** The Offline Files tab
FIGURE 3-20  The View menu for making changes to your window’s appearance

FIGURE 3-21  The Customize Toolbar window for creating custom toolbars
Create a Customized Toolbar

Follow these easy steps to create a customized toolbar:

1. In a desired folder, click View, point to Toolbars, and then click Customize.

2. In the Customize Toolbar window, select any item in the left portion of the window that you want to add to your toolbar, and then click the Add button. Continue this process until you have moved all options that you want.

3. In the right portion of the window, select any item that you do not want to use on your toolbar, and then click Remove. Continue this process until you have removed any options you do not want.

4. In the right portion of the window, select an option and use the Move Up or Move Down buttons to adjust the order of the items on the toolbar, as desired.

5. Click Close when you are done.

Status Bar

The Status bar is just the small bar that runs along the bottom of your window. It tells you what is going on when you are trying to use or connect to other resources. This bar works just like the Status bar in Internet Explorer, and you can choose to use it or not by clicking Status on the View menu.

Explorer Bar

This option has an additional pop-out menu that lists various Explorer items you can select, such as Search, Favorites, and so forth. If you select one of these items, an additional pane appears in your window to provide the Explorer option. For example, if you select the Search option, the window provides a search section. You can experiment with these setting to find ones that are useful to you.
Icon Appearance

The remainder of the View menu contains a number of different icon and list options to determine how the contents of a folder are displayed. For example, you can use large icons, small icons, a list, and so forth. Just click these options to experiment with them until you find the appearance that you like best.

You can also learn more about files and folders and how to use folder menus in Chapter 4. You’ll also note that the View menu has a Customize This Folder option. This option essentially allows you to share the folder on a network, and you can learn all about sharing in Chapter 11.
Chapter 4

Managing Components, Programs, Folders, and Files
How To…

- Install and Remove Windows XP Components
- Install, Manage, and Remove Programs
- Create and Configure Folders and Files

The Windows XP operating system is a rich, robust system that is full of tools and features to help you make the most of your computing experience. Moreover, you can also easily add new programs and even Windows XP components so that your computer will do exactly what you need it to do. From Microsoft Office and Adobe Photoshop to games and tax programs, there are multitudes of programs that you can purchase and install on Windows XP, as well as several additional XP tools that are not included by default. In this chapter, we’ll look at how to manage programs and components on your XP system, how to add and remove them, and how to manage folders and files so you can keep up with the files you create.

Managing Programs with Windows XP

Programs are pieces of software that you install on Windows XP in order to perform some task. Programs can come in many forms, such as applications, games, utilities, and so forth. The purpose of a program is to give you some functionality that is needed. For example, Windows XP does not ship with any advanced photo editing software. In order to perform photo editing on Windows XP, you need a program that provides this functionality, such as Adobe Photoshop. The program is installed on Windows XP from a CD-ROM; after installation, you can use the application on your Windows XP computer.

If you purchased your computer with Windows XP preinstalled, you probably have a number of programs that are already on your computer. These programs are sold as a bundle and are preinstalled with Windows XP. Just click Start | More Programs to see all of the programs that are currently installed on your computer.

In Windows XP, new programs that you have not opened are displayed in yellow when you look at them in Start | All Programs. Once you open a program, this highlight is removed so you can keep track of which programs you have explored and which ones you have not. If you don’t like the highlight feature, you can remove it by accessing the Start menu properties and removing the feature. See Chapter 3 for more information about Start menu customization.
In order to install a program, you should first make certain that it is compatible with Windows XP. Before you purchase a program, check out the label on its box—it should tell you right on the box that the program will work with Windows XP. The odds are also very good that applications that functioned well under Windows 98/Me and/or Windows 2000 will work with Windows XP, although compatibility cannot be guaranteed.

Once you are sure your program will work under Windows XP, you simply need to install the program. There are two ways to install a program, which are explained in the following sections.

**Using a Program’s Setup Feature**

Programs that you purchase are placed on a CD-ROM for easy installation. In fact, most programs today have an auto-start file to help you get the program installed. For example, when you place the CD-ROM into the CD-ROM drive, the disk spins, and then a dialog box appears on your screen asking whether you want to install the application. This procedure varies from manufacturer to manufacturer, so you’ll need to follow the documentation that came with the program you purchased.

If you put the CD-ROM into the CD-ROM drive and nothing happened, you can manually start the setup program by opening My Computer. Right-click the CD-ROM icon, and then click either Install or AutoPlay. If you still have problems, right-click the CD-ROM icon and click Explore. You’ll probably see some folders and files once you open the CD-ROM. Find an icon called Setup.exe, as shown in Figure 4-1. (You may not see the .exe extension if you enabled the Hide Extensions for Known File Types option for your folders; see Chapter 3 for more details.) Double-click the Setup icon and the installation should start.

You should always examine the setup instructions that come with any program. Programs are different, so be sure to follow the manufacturer’s instructions for installing the program on your computer.

Once you have started the installation, just follow the instructions that appear.

**Installing Programs Using Add/Remove Programs**

As you might guess, you can also use Add/Remove Programs in the Control Panel to install a program. You’ll see an Add New Programs button on the left side of the screen, shown in Figure 4-2. Once you click the button, you can click the CD or Floppy button to begin an installation from a floppy disk or CD-ROM. If you want to download something from the Windows Update site, click the Windows Update button. Essentially, the Install option found here just looks for the Setup.exe file
floppy disk or CD. To use this option, see the step-by-step instructions in the upcoming How To box.
Use Add/Remove Programs to Install a Program

To install a program using Add/Remove Programs, follow these easy steps:

1. Click Start | Control Panel.
2. Click the Add/Remove Programs icon.
3. In the Add or Remove Programs window, click the Add New Programs button.
4. In the window that appears, click the CD or Floppy button.
5. The Install From Floppy Disk or CD-ROM wizard appears. Click the Next button.
6. Windows searches your floppy and CD-ROM drives for the next Setup.exe program and gives you the location, as shown below. If this is not correct, use the Browse button to browse to the correct location.

7. Click Finish, and installation begins. You may need to respond to other prompts, depending on the setup routine.
Uninstalling a Program

Just as you can install programs on Windows XP, you can also uninstall them. For example, let’s say that you use a particular application and, at a future date, you purchase a different application to replace your older one. If the application you purchase is not an upgrade to the old one, you may want to remove the old application from Windows XP. After all, the application takes up disk space; and because you’re not going to use it any longer, you don’t need it cluttering up your system.

Once you remove an application from your system, you will not be able to use any of the files generated by that application. For example, if I remove Microsoft Word from my computer, I will not be able to open and read any of my Word documents. Make sure you no longer need an application before removing it from your computer.

There are two ways to remove a program from your computer, which are explained in the following two sections.

Using a Program’s Uninstall Option

Some programs come with their own uninstall option. You can just put the CD-ROM into the CD-ROM drive, let it automatically begin, and a window appears that
allows you to install additional components or to remove existing ones—or the entire program. Microsoft Office, for example, has this feature. Some programs also have an uninstall routine built right in. You can click Start | Programs, point to the program’s folder, and a menu pops out with an uninstall option. Not all programs have this feature, so don’t worry if you do not see this option.

## Using Add/Remove Programs

If you have a tricky program that doesn’t help you with the uninstall, you can, once again, use Add/Remove Programs in the Control Panel. When you open Add/Remove Programs, you see a list of programs. The programs listed in this window are installed on your computer. To remove one of them, simply select it and click the Change/Remove button. Follow any additional prompts that appear.

Some programs give you a Change button and a Remove button, while some give you only a Change/Remove button. If you have programs that can be upgraded or if additional parts of the program can be installed, you’ll see both Change and Remove. This arrangement allows you to install additional portions of the program or to simply remove it from your computer.

### Did you know?

#### How a Program Is Removed?

When you choose to uninstall a program, Windows XP takes a look at the program and all its components, and then deletes the files from your computer in an organized manner. When programs are installed, various files are used so the program can communicate with Windows XP and interact with it. In some cases, files are present that help the program function with other programs on your computer. Windows XP makes certain all of these files are deleted properly so that an uninstallation of one program does not damage another program or Windows XP.
If All Else Fails…

Sometimes, you end up with programs that really like you and do not want to leave your computer. There is no uninstall option on the CD-ROM, and the program is not listed in Add/Remove Programs as an option you can uninstall. Although this normally does not happen, you can still remove the program by deleting its folder. This is not a recommended action, because you may experience problems by forcing an application to delete itself. However, this option can be used when absolutely necessary. See the upcoming How To box for step-by-step instructions.

Under no circumstances should you delete a program’s folder if you can use the CD-ROM or Add/Remove Programs option. Deleting the folder does not allow Windows XP to properly delete and clean up after the application, so this should be considered a last-resort option. Also, before using this option, check your program’s documentation for specific information about uninstalling the program from Windows XP.

How to...  Forcefully Remove a Program

In the event that you cannot use Add/Remove Programs or the program’s uninstall option, you can forcefully remove a program by following these steps:

1. Open My Computer and double-click your C drive icon.

2. Locate a folder called Program Files and double-click it. You may need to click the “View All Contents” link as prompted.

3. Look through the folders and find the one that has the program you want to uninstall. Typically, the name of the folder will state the program’s name or the manufacturer’s name.

4. When you have found the folder, right-click it and click Delete to remove it from your computer. Make sure you are deleting the correct folder before completing the action.
If trying to install or uninstall a program has left you with a bunch of problems, Windows XP offers a System Restore feature that can help you get things sorted out. See Chapter 20 for details.

Downloading Programs from the Internet

The Internet contains a wealth of applications that you can download and use on your computer—many of them for free. For those that are not free, you can often download an evaluation version of a program to see if you like how it works on your computer before actually purchasing it. There are also all kinds of utilities for Windows and games you can download as well.

When you choose to download an application from the Internet, you click a link on the Web site that starts the download to your computer. When this happens, a dialog box, such as the one shown in Figure 4-3, appears so you can choose whether to open the application from its current location or save it to disk. If you choose to open the application, the setup files are downloaded to you and setup begins. If you do not, the files are all saved to a place that you specify on this window (such as your Desktop or My Documents folder). You can then start setup yourself when you are ready. There is no right or wrong here, just a matter of preference.

![File Download](image)

**FIGURE 4-3** This dialog box appears when you begin to download a program from the Internet.
You Can Save a Downloadable Program to a Disk

If you choose to save a program to disk when you start the download, the program is downloaded to you in a compressed format. This practice saves time when downloading. Usually, the application will appear as a simple icon. Double-click the icon to uncompress and start the installation. Windows XP includes compression software so you can open and use compressed folders (see the section “Using Folder Compression,” later in this chapter). For specific installation steps, refer to the Web site where you downloaded the program.

Using Windows XP’s Compatibility Mode

Windows XP includes a new feature called compatibility mode that allows it to act like a previous version of Windows—specifically, Windows 95, 98, Me, NT, or

About Downloaded Programs and Viruses

Internet programs are a great way to get utilities, applications, and games for your computer—and computer viruses as well! Computer viruses are made up of code that often hides within other code—such as in a setup program for an application. In order to protect yourself, I highly recommend that you purchase some antivirus software for your Windows XP computer. This software watches for viruses, identifies them, and kills the ones on your computer. Visit your local computer store or an Internet store to shop for antivirus software.

Aside from using antivirus software, another great way to keep from getting a computer virus resides right in your own head—common sense! Be wary of downloading programs from Internet sites that do not appear to be on the up and up. Your best bet is to download software from respected Internet sites and companies. When in doubt—don’t!
2000. The purpose of compatibility mode is to allow you to use older applications that might not work with Windows XP. When in compatibility mode, Windows XP acts like the previous version of Windows (which you select), so that the application is tricked into thinking it is installed on the correct operating system. This feature allows you to use older applications that are not 100 percent compatible with XP.

It is important to note that compatibility mode is intended for standard applications, and even games. However, compatibility mode is not designed for use with programs that run portions of your system configuration. For example, antivirus programs that are not compatible with Windows XP should not be used, because the program may damage your system in compatibility mode. The same is true for disk management utilities and backup software. In other words, if the application is used to manage the operating system or some portion of the operating system, it should not be used with compatibility mode—you need to upgrade and get the compatible version of the software.

The Program Compatibility Wizard is available in Start | All Programs | Accessories. The following How To box shows you how to use compatibility mode.

**How to ... Use Compatibility Mode**

To use XP’s compatibility mode, follow these steps:

1. Open the Program Compatibility Wizard found in Start | All Programs | Accessories.
2. Click Next on the Welcome screen that appears.
3. In the next window, choose a radio button option and click Next. You can choose to view a list of programs, use the program currently in your CD-ROM drive, or locate the program manually.
Managing Windows XP Components

Windows XP provides a way for you to include additional Windows components that are not installed by default. This way, you don’t end up with a bunch of operating system junk that you’ll never use. However, unlike Windows 9x and Me, most of the components that you will use are already installed on your computer, so the odds are good that you will never need to add or remove Windows XP components. If you need to, however, this section will show you how to do everything with Windows XP.
how to use the Add/Remove Windows Components feature of Windows XP. It is important to note here that the components available to you depend on whether you are using the home or professional version of Windows XP. The professional version has more options and more networking components than are needed by home users, so don’t be surprised if your component list doesn’t quite match the examples you see in the following sections.

**Installing Windows Components**

Installing Windows components is very easy. Once again, you’ll use Add/Remove Programs in the Control Panel (that’s right, Add/Remove Programs). If you have used Windows 2000 before, the Add/Remove Windows Components feature will look very familiar. Even if you haven’t, the tool is easy to use. For step-by-step instructions, see the following How To box.

---

**How to ...**

**Install Windows Components**

To install Windows components, follow these steps:

1. Locate your Windows XP installation CD-ROM and insert it into your CD-ROM drive.
2. Open the Control Panel and double-click Add/Remove Programs.
3. Click the Add/Remove Windows Components button on the left part of the window.
4. The Windows Components Wizard appears. Select the category desired and click the Details button.
5. In the Subcomponents menu that appears, shown next, select the component you want to install (the check box next to the component becomes selected). There may be additional subcategories as well. If you select the item and the Details button is not grayed out, then there is an additional subcategory to view. Also notice that the wizard gives you a description of the item you want to install, the amount of disk...
space required, and how much disk space you have available. Make your selections and click OK (and possibly OK again) until you have returned to the main window.

6. Click OK. Windows XP examines your system and installs the component you selected.

7. The completion window appears. Click Finish.

Removing Windows Components

Just as you can install any Windows components you want to use, you can also uninstall components that you do not want. This action frees up more disk space on your computer that can be used for other purposes. In order to remove a component, just uncheck the selected check box so that Windows will remove it. You may need your installation CD-ROM for this action as well.
Managing Folders and Files

As you may have learned from the first few chapters of this book, Windows XP manages data by using various folders to store that data. Just as you would not dump a bunch of single papers into a filing cabinet and expect to find what you need, Windows XP uses folders to keep operating system files, program files, and even your own files organized. In this section of the chapter, you will learn how to manage your files and folders.

Before we begin, I would like to offer a big warning. You can manage your own folders and files, but you should never make changes to any of the folders and files found in C:\Windows. These folders and files are used by the Windows XP operating system to function. Tinkering with them can—and probably will—cause Windows XP to stop working. So, manage your own files and folders and let Windows XP manage its files and folders.

Creating, Renaming, and Deleting Folders

You use folders in Windows XP to store data, such as documents, pictures, spreadsheets, you name it—any type of file or application can be stored in a folder. Depending on your needs, you may not require additional folders. After all, Windows XP automatically tries to place files in your My Documents folder or one of its subfolders, such as My Pictures. However, you may need to create your own folders to manage data. For example, each time I begin work on a new book, I create a folder on my computer where I store all of the files for the book. Within that folder, I then create additional folders for each chapter. This way, there is a specific folder for each chapter document and the graphics files for that chapter, so I can keep it all organized. You can create folders within folders, and folders within those folders to as many levels as you want or need.

Although folders are great, don’t get too wild with folder creation. Too many folders can be more confusing than helpful, so keep your folder structure in check to make sure that it actually meets your needs.
The good news is that you can easily create, rename, and delete folders as needed. To create a new folder, open the folder that you want to create the new folder in, such as My Documents or simply your C drive. Click the File menu, point to New, and then click Folder. A new folder appears. Press the BACKSPACE key on your keyboard and type a desired name for the new folder.

If you want to create a new folder directly on your Desktop, just right-click an empty area of your Desktop, point to New, and click Folder.

At any given time, you can rename a folder by simply right-clicking the folder and clicking Rename. Then press the BACKSPACE key and type a new name, and press the ENTER key. This feature makes it easy to keep your folders organized, and to move your folders from place to place as needed.

Finally, you can delete any folder by right-clicking the folder and clicking Delete. This moves the folder to the Recycle Bin. Do keep in mind that everything in the folder is deleted as well, including files, applications, and other folders—anything at all.

Using Folder Menus

Windows XP folders contain a standard set of menu options at the top of the folder: File, Edit, View, Favorites, Tools, and Help. You can use these different menus to perform various actions with respect to folders and to the files within a folder. Many of the options are self-explanatory, and this section describes the most commonly used menu features.

File Menu

First, the File menu enables you to manage files and folders. Aside from using the File menu to create a new folder, you can also select a file or folder, click File, and then perform any of the following options:

- **Preview** For picture files, the Preview option opens Image Preview so you can quickly take a look at the file.

- **Open** This feature opens a window that allows you to select an application with which to open the file. You can use this option if you are having problems opening a file.
CHAPTER 4: Managing Components, Programs, Folders, and Files

- **Edit**  This option opens a program that can edit the file. For example, if you select a picture file and then click Edit, Paint will open by default.

- **Print**  Use the Print option to print the file.

- **Send To**  This feature enables you to send a folder or file to a particular location, such as a floppy disk or an e-mail message. You can also right-click any folder or file and get this same option.

- **New**  This pop-out menu enables you to create another folder or a specific type of file. You also see a list of file types available, which vary depending on the applications installed on your system. This feature enables you to start a new file of your choice directly from this location.

- **Others**  In the lower part of the menu, you can perform other basic tasks, such as creating a shortcut for the item, deleting it, renaming it, and even closing the item.

**Edit Menu**

The Edit menu provides you with several easy features so you can manage the folders or files within the folder. These features are easy to use, and the following list points them out to you.

- **Undo Delete**  Accidentally delete something? No problem, just click this option to restore what you deleted (if you have performed no other operations since you deleted the item).

- **Copy, Cut, and Paste**  You can copy, cut, and paste items from one folder to another using these commands. Let’s say you want to remove a document from one folder and place it in a different folder. Just select the document, click Edit | Cut, open the folder where you want the document, and click Edit | Paste.

  You can use keyboard shortcuts to accomplish the Copy, Cut, and Paste actions as well. See Appendix B for a list of helpful keyboard shortcuts!

- **Move or Copy to Folder**  You can move or copy items to another folder by using these options. When you click one of them, a window appears where you can move or copy the file or folder.
Do you need to copy or move several items to the same target folder? You can do them all at the same time! Just select the first item and hold down the CTRL key on your keyboard; then click the remaining items you want to move or copy—all of the items you click will be selected. Then just click Edit and select the option you want. Doing this moves or copies all items at the same time. You can perform this same operation when cutting, deleting, moving, or copying items manually.

**Select All and Invert Selection**  Use Select All to select all items in the folder. This feature is helpful if you want to copy or cut all items in a particular folder. You can also use Invert Selection to give you the exact opposite of what is currently selected. For example, let’s say you have five files in a folder. Two of the files are selected. If you use Invert Selection, the two previously selected files will not be selected and the three previously unselected files will be selected—this feature is helpful if you tend to do things completely backward from time to time.

**View Menu**
The View menu enables you to configure the appearance of your folder, and you can learn about this option in Chapter 3.

**Favorites Menu**
For Web-enabled folders, the Favorites menu works just like Favorites in Internet Explorer (and is, in fact, exactly the same). See Chapter 9 for details.

**Tools Menu**
The Tools menu contains just a few folder items you should know about:

**Map Network Drive**  For computers connected to a network, you can use this item to map a network drive. This feature enables you to use a network folder and have an icon on your computer so that the folder looks like it is local to your machine. To map a network drive, just click the option in the Tools menu. A dialog box appears, shown in Figure 4-4, where you can select a drive letter that is not in use, and then enter the network UNC path to the shared folder you want to map to.
A UNC (Universal Naming Convention) is a method used to connect to network folders or files on Windows networks. The UNC path is represented by two backslashes (\), then the name of the computer you want to connect to, then the share name, and then the file name. Each portion of the path is connected by a single backslash. So, if I want to connect to a shared folder called “fishing” on a computer named Curt123, and I want to access a particular file called “bass,” then the UNC path is \curt123\fishing\bass.
Disconnect Network Drive  If you no longer want to use a particular network drive, use this option to permanently disconnect it from your computer.

Synchronize  This synchronize option enables you to have a folder on a network server and the same folder on your computer. As you work with the contents of the folder, you can use this option to synchronize the two folders so that they contain the same data. To use the synchronization feature, just click the option and then click the Setup button to set up the folders you want to synchronize. You can learn more about the synchronization feature in Chapter 5.

Help Menu
The Help menu gives you a quick and easy way to open Windows XP Help Files.

* TIP *
Folder toolbars contain a number of icons that essentially repeat what is available in the menus. The difference is that they give you an icon you can click for easy access. For example, by clicking buttons on the toolbar, you can cut items, undo a delete, copy to a folder, and so on. You can also create customized toolbars, which are described in Chapter 3.

Sharing a Folder
Windows XP contains networking capabilities so your computer can share folders and printers on a network. It is important to note here that you cannot share individual files—you can only share folders, which give access to files. For example, let’s say I have a Word document called “My Dog.” I can’t share My Dog by itself, but I can put My Dog in a shared folder so that others on the network can access the document.

You can share any folder in Windows XP by right-clicking the folder, clicking Properties, and then clicking the Sharing tab. If the folder you want to share resides within another folder, you can just right-click the folder you want to share and click Sharing.
It is important to note here that Windows XP must have its networking components configured before any folders can be shared. If you don’t see the sharing option, you do not have your networking components. See Chapter 11 to learn how to set up Windows XP for networking.

The Sharing tab, shown in Figure 4-5, is very easy to configure. Just select the Share This Folder on the Network check box and enter a share name for the folder. If you want other people on your network to be able to make changes to the contents of the folder, click the Allow Network Users to Change My Files check box. Remember, the name you give a folder is how the folder will appear to other users, so make the name easy to understand—something like “Public Docs,” not “Pubdcs,” which no one can decipher.

In Windows XP, some folders that are tied to your user profile are automatically shared with the other people who use your computer (called local users), if there are any. The My Documents (and all subfolders, such as My Music and My Pictures), Desktop, Start Menu, and Favorites folders are automatically shared among local users. However, if you want to keep one or more of these folders private so that only you can view it, click the “Make this folder private” check box. Note that this option only works on My Documents, Desktop, Start Menu, and Favorites folders, and any subfolders of these folders; it is grayed out for any other folders you create because these folders are automatically private. If you create your own folder that you want to make available to local users, you don’t have to share it on the network—you can just drag it to the Shared Documents folder on your computer, and all local users will be able to access it.

Using Folder Compression
Windows XP includes a built-in feature to help you conserve disk space: folder compression. Compression shrinks the normal size of a folder and its contents in order to free up more disk space that you can use for other purposes. Compression in Windows XP is quick and easy to use.
Creating a Compressed Folder

You can create a compressed folder just as you create any other folder. In the folder where you want to create the new compressed folder, click File and point to New, but click Compressed Folder instead of just Folder. If you want to create a compressed folder on your Desktop, right-click an empty area of the Desktop, point to New, and then click Compressed Folder. Either way, a new compressed folder appears. Compressed folders have a zipper on them so you can identify them, like this icon.

FIGURE 4-5 Use this window to share a folder on a network.
Adding Items to and Removing Them from a Compressed Folder

You can add files and folders to a compressed folder and then remove them just as you would in any other folder in Windows XP. Once you drag a file or folder into a compressed folder, the item is compressed. Once you drag the item out of the folder, it is automatically decompressed—there’s no configuration you have to worry about. Additionally, you can perform all other actions with the file, such as opening, renaming, deleting, and so forth—just as you would if the file were in a regular folder.

Using Extraction

Compressed folders in Windows XP use the WinZip technology to compress folders. A part of that technology is the “extraction” option. This feature enables you to pull every item from a compressed folder and place them in a folder that is not compressed. This action extracts—or decompresses—the items so they are no longer compressed. If you right-click a shared folder, you will see the extraction options. You can extract the folder to a different folder or other location, or even choose to e-mail the compressed folder. No matter what option you choose, the WinZip utility opens and helps you with the procedure. If you choose the Extract All option, a little wizard begins so you can choose where you want the folder extracted to.

Along with extraction, you also see an “encryption” option when you right-click a compressed folder. This option enables you to assign a password for the folder. For example, you can encrypt a folder and e-mail it to a friend who uses Windows XP; your friend would have to enter the correct password in order to open the encrypted, compressed folder.

Removing Compression from a Folder

So what do you do if you have a compressed folder that you do not want to be compressed any longer? You simply right-click the folder and click Extract All, which essentially re-creates the folder and all data—just without the encryption.

TIP

Although anything residing in a folder can be compressed, you should not compress folders that contain programs. Compression may prevent the program from operating correctly.
About Files

As you have already learned, files are placed in various folders on your computer for safekeeping and organization purposes. Files are created by various programs you have installed on your system and have different file extensions. For example, a Microsoft Word document has the .doc extension, while a document you create with Paint might have the .bmp extension (bitmap). In short, there has to be some kind of program to create a file of any kind. The good news about files is that you really do not have to manage them individually. You can right-click any file and see the same options you get with a folder, such as Send To, Copy, Cut, and so on. You can also drag and move files around to different locations on your computer without damaging them.

Did you know?

How to Solve File Extension Mysteries

There are a number of reasons why a file may not get an extension or may not have one. For example, have you ever received a file in an e-mail and not be able to open it? There are two possible causes of this problem: either you do not have an application that can read the file or the file extension is missing. Such conditions cause your computer to say, “I don’t know what this file is or which application to open it with.” In these instances, you normally get a window asking you to pick an application to attempt to open the file. If you have a file that does not have an extension and you know which application is supposed to open it, you can easily fix the problem by right-clicking the file, clicking rename, and giving the file a name with the extension, such MyDog.doc. This helps your computer know what application to use so the file can be opened.
Chapter 5

Using Accessories
How To…

- Access Windows Accessories
- Use Windows Accessories
- Configure Windows Accessories

Windows XP continues to provide a group of programs on your computer collectively called “accessories.” Accessories are just that—programs that help you do some kind of job or specific function. They are not large applications, like Microsoft Word or Microsoft Excel, but rather are small programs that are designed to help you in some way. If you’ve used accessories in Windows Me or Windows 2000, you won’t find many surprises here, but there are a few new utilities you’ll find interesting. If you are new to Windows in general, then this chapter will show you a new world of stuff available on your XP operating system.

As you might guess, a few of the accessories or accessory categories deserve their own chapters or by their nature belong in a different chapter. For example, Windows Movie Maker naturally needs its own chapter, and you can learn all about it in Chapter 17. You can locate the accessories on your Windows XP computer by clicking Start | More Programs | Accessories. You see a pop-out menu listing the accessory programs.

Accessibility

In Chapter 2, you learned about the Accessibility options found in the Control Panel. You have a few other accessibility options in your Accessories menu as well. Accessibility refers to a number of Windows XP tools that make Windows XP easier to use for people with certain disabilities. If you point to Accessibility, an additional pop-out menu appears, which provides five additional options.

Accessibility Wizard

The Accessibility Wizard is a Windows XP feature that helps you set up and make decisions about the appearance and functionality of your computer so that it meets your needs. The wizard is easy to use and understand—just follow these steps:

1. Click Start | More Programs | Accessories | Accessibility | Accessibility Wizard.
2. Click Next on the Welcome Screen.
3. In the Text Size window, use your mouse to select the size text you want Windows XP to use. Make your selection and click Next.

4. In the Display Settings window, you see some check box options that enable you to select how your display appears. You can choose to change the font size, use Microsoft Magnifier, or disable personalized menus, as shown in Figure 5-1. You may also be able to use a lower screen resolution, depending on your video card. Make your selection and click Next.

   You can also configure your own Display settings to meet your personal needs. See Chapter 3 for details.

5. Next, the Set Wizard Options window appears. This window gives you a series of check boxes where you can select the type of disability you have, so the wizard can help you select some options. For example, if you select the “I am blind or have difficulty seeing things on my screen” check box, the wizard continues and enables you to select various scroll bars, icons, display settings, and so forth. The other options available, shown in Figure 5-2, provide different features, depending on your needs. Select the check box that best describes your needs and click Next.

![Accessibility Wizard](image-url)  
**FIGURE 5-1** Selecting Accessibility display setting options
6. Depending on your selection in step 5, your wizard options will vary. Continue to follow the wizard steps until you reach a summary screen. Review your settings, and then click the Finish button to complete the wizard. The options you selected will then be configured on your computer.

**Magnifier**

The Accessibility options in Accessories also include a Magnifier. The Magnifier gives you a window at the top of your desktop that magnifies whatever you point at with your mouse, and the objects can become quite large.

If you choose to use the Magnifier option, a Magnifier Settings window appears when you first click Magnifier in the Accessibility window. This simple
CHAPTER 5: Using Accessories

window, shown in Figure 5-3, gives you a few options for the operation of the Magnifier. You can choose from the following settings:

- **Magnification Level**  The default setting is 2. You can try different settings to find the one that is right for you.

- **Follow Mouse Cursor**  Selected by default, this option has the Magnifier show whatever you are pointing to with your mouse—this setting is recommended.

- **Follow Keyboard Focus**  If you begin using your keyboard, the Magnifier follows what you do on the keyboard. This setting is enabled by default and also recommended.

- **Follow Text Editing**  When typing a document, the Magnifier follows the cursor and magnifies the text as you type or edit.
Invert Colors  This option inverts (or reverses) the colors in the Magnifier. It is not selected by default, but you may find this setting makes things easier to see if you have certain vision problems.

Start Minimized  This option tells the Magnifier to start as a minimized option on your computer.

Show Magnifier  This option is selected by default, and it automatically shows the Magnifier at the top of your screen.

Narrator
Microsoft Narrator is designed to help people with low vision problems. Narrator can read items on the screen to you, so that your work with Windows XP is easier. It is important to note that Narrator only works in English, and it may not work with every program installed on your computer.

In order for Narrator to work, your computer must have a sound card and speakers of some kind.

If you choose the Narrator option, a configuration window appears, as shown in Figure 5-4. You have a few options so that you can configure how Narrator works.

![Figure 5-4](image)

The Narrator configuration window
CHAPTER 5: Using Accessories

- **Announce events on screen** This option has Narrator announce new windows that appear or system messages.
- **Read typed characters** This option has Narrator read typed characters out loud.
- **Move mouse pointer to the active item** This option automatically moves your mouse pointer to the active window item for you.
- **Start Narrator minimized** This option starts Narrator as a minimized item.

The Narrator option can be really helpful, although it can be a little aggravating at times because it reads all items in any given window (such as the title, menus, buttons, address bar, and so on); but if you have vision problems and need a little assistance, Narrator can be a really helpful tool.

*If you need to make changes to the voice used for Narrator, you can click the Voice button in the Narrator configuration window, or you can just access Speech in the Control Panel for the same options.*

**Onscreen Keyboard**

The next Accessibility option in Accessories is the onscreen keyboard, which gives you, well—an onscreen keyboard! The keyboard appears on your screen, and you can use your mouse to click the keys, just as you would tap keys on a regular keyboard. The onscreen keyboard is a limited version, but you can learn about other options available to you at [http://www.microsoft.com/enable](http://www.microsoft.com/enable).

**Utility Manager**

Utility Manger is a little tool that enables you to easily manage all of the Accessibility tools. You can easily start Utility Manager at any time by pressing the Windows key and the U key at the same time. Utility Manager, shown in Figure 5-5, gives you a simple window that tells you which Accessibility tools are currently running; this may help in troubleshooting problems. You can also use the check box options to have the desired utilities start when you log on, when you lock your Desktop, or when Utility Manager starts.
Communications

The Communications option in Accessories provides you with a pop-out menu with a variety of communications tools. Use this menu to access the Network Setup Wizard, Internet Connection Wizard, NetMeeting, Remote Desktop Connection, and so forth. As you might guess, these options are explored in the Internet and networking chapters of this book, which are found in Part II.

Entertainment

Want to have some fun with Windows XP? You access some of the options in the Entertainment menu, such as your Volume Control, Sound Recorder, and Windows Media Player. Volume Control and Sound Recorder provide you with simple interfaces where you can adjust your computer’s sound output and record...
your own voice, provided that you have a microphone attached to your computer. You can learn all about Windows Media Player in Chapter 16.

**Games**

The Games menu contains a number of games that are installed by default on your computer. Some you can play locally, and some require an Internet connection. Either way, you can learn all about playing games in Chapter 15.

**System Tools**

The System Tools menu gives you several tools that can help your Windows XP computer run better and solve problems. As with the other major menu sections, these tools deserve their own chapters, and you can learn about them in Part IV of this book. If you want to use the File and Settings Transfer Wizard, simply start the wizard and follow the steps. You’ll need your Windows XP CD-ROM and a removable disk (floppy or CD, for example) to complete the transfer to another computer.

**Address Book**

The Address Book found in Accessories is actually the address book built into Microsoft Outlook Express, which is a part of your Windows XP operating system. The address book feature is very easy to use and a great way to keep up phone numbers, e-mail addresses, and such. You can learn more about it in Chapter 10.

**Calculator**

Windows XP provides you with a quick, onscreen calculator that you can access at any time using Accessories. Your onscreen Calculator works just like any other calculator—use it to count your money, pay your bills, or figure out how much you owe the IRS.

A quick note about the calculator: you can use the View menu to see a standard calculator or a scientific calculator—or both, as shown in Figure 5-6. Then use the calculator just as you would a desktop version, but with your mouse or keyboard keypad.
Command Prompt

The Command Prompt in Windows XP is the same as the one found in Windows 2000—from the Command Prompt, you can run programs and utilities, try to fix problems, and make use of a number of other command line functions and features. In most cases, you’ll find command line syntax and options from the Help files of various Windows XP programs and utilities. If you are interested in using the Command Prompt, check the Help files of the desired application to find out how the Command Prompt might be useful for the task you are currently performing.

You can also access the Command Prompt by clicking Start, then clicking Run, and then typing command or cmd in the dialog box, and pressing OK.

Notepad

Accessories also includes a simple text editor program—Notepad. You can open any kind of text-based document in Notepad and make changes to it. Advanced computer users often use Notepad to make text-based changes to Windows configuration (which is not something you should try on your own!). You can use Notepad for simple tasks, such as typing a message of some kind, sending it via e-mail, or printing it on your printer.
Notepad, shown in Figure 5-7, enables you to open, create, and save text files. You can use the Edit menu to perform cut-and-paste operations and to choose the font you would like to use. Also, you can use the Search menu to find specific words or phrases within the text document.

However, Notepad is simply a basic text editor. You cannot format paragraphs or text (making text italic or bold, for example), and you cannot create any tables or use other word processing features. Notepad simply does text—nothing else. Also, Notepad has a limit of 64K, so any document larger than this must be used in another application, such as Microsoft Word.

Paint

Windows Paint is a lower-level graphics creation program that enables you to generate or open various graphics files and save a created graphics file as a bitmap, JPEG, TIFF, GIF, or other standard file format types. You are limited to what you can do with Paint, but you may find its moderate functionality useful in a variety of ways.

The best way to learn to use Paint is to simply open it up and play around with the toolbar and menu options. You can spend about half an hour playing with Paint, and you’ll discover most all there is to know. I’ll use this section to get you on your way.

First, you can use Paint to open any standard graphics file, such as a BMP, TIF, JPEG, GIF, and so forth (see Figure 5-8). Once you have the graphics file open, you can click any of the toolbar buttons to make changes to the graphic. Your toolbar options include paintbrush, pencil, spray can, text, and various line shapes.
Aside from using the Paint tools to draw or change an existing file, you can create your own file by clicking the File menu and clicking New. This opens a blank document window in which you can try your own artistic skills. Your options are limited, but Paint is a useful accessory to view and change image files, save them, and change file types. Spend some time experimenting with Paint’s features.

**FIGURE 5-8** Use Paint to create and edit graphics files

Aside from using the Paint tools to draw or change an existing file, you can create your own file by clicking the File menu and clicking New. This opens a blank document window in which you can try your own artistic skills. Your options are limited, but Paint is a useful accessory to view and change image files, save them, and change file types. Spend some time experimenting with Paint’s features.

**How to ... Adjust an Image**

You can also use Paint to make adjustments to an image by using flip, rotate, invert colors, and other appearance options. Just open the image you want to make changes to, and then click Paint’s Image menu and select a change you would like to make. You can experiment with these options to find one that meets your needs.
Synchronize

The Synchronize tool found in Windows XP (which is the same one found in Windows 2000 and Windows Me) enables you to synchronize data on your computer with data on a network. For example, let’s say that you have a collection of Word documents. You regularly edit those documents, but they are centrally located on a server on your network. You want to keep a copy of those documents on your laptop computer so you can work on them during your bus ride home. If you work on those documents offline, they will have to be synchronized with the network server so that they will be up-to-date. Sure, you can manually copy those documents to the server—but for files you use regularly, why not have XP do the synchronization automatically for you? The following sections will show you how!

Making Files Available Offline

Using the Synchronization feature is easy. Begin by clicking on Synchronize in the Accessories menu. Doing this opens the Items to Synchronize window. In order to use the Synchronization feature, you must have files made available to you offline. For example, let’s say you want to use a network folder called “Company Docs.” You want to make this folder available locally on your laptop so you can access it whenever and wherever you want. This is called making the folder available offline. A copy is stored on your computer so that you don’t have to be connected to the network to access the folder’s contents. Making folders available offline is easy in Windows XP—check out the instructions in this How To box.

How to ... Make Folders Available Offline

1. Access the network folder that you want to make available offline.
2. Right-click the network folder and click Make Available Offline.
3. Windows XP will automatically begin the synchronization process, copying the folder with all its documents to your computer’s hard drive. If there are subfolders in the folder you want to make offline, you are prompted about making those offline as well. The synchronization...
Once you have made offline folders available, you can then set up synchronization so that it will occur with your offline folder and the online folder as you specify. Access the Synchronization tool in Accessories and then click the Setup button. You see a Synchronization Settings window with three tabs.

The first tab is Logon/Logoff, shown in Figure 5-9. As you can see, you are able to select which folders you want to synchronize whenever you log on or log off your computer (either one or both actions). Simply select the desired offline folders and choose the automatic synchronization method check box options that you want. You can also have Windows prompt you before synchronization occurs by selecting that available check box option.

window shows you progress as the copy action is performed, as shown here. Once synchronization is complete, the network folder appears on your computer in My Network Places.
The On Idle tab gives you the same kind of interface as the Logon/Logoff tab. You can choose which offline folders you want to synchronize, and then use the Advanced button to specify how much idle time should pass before synchronization occurs. For example, let’s say that you want your computer to synchronize offline folders as often as possible, especially when you have stepped away from your desk. No problem—just use the On Idle tab to select the network folders, and then click the Advanced tab and enter a time value, such as 15 minutes. With this configuration, the computer will synchronize every time it is idle for 15 minutes. If your computer remains idle, you can have synchronization reoccur at specified intervals, such as every hour. This feature is helpful if other people are regularly making changes to the network folders you have saved as offline folders. Using this configuration, you are more likely to always have up-to-date information.

The Scheduled tab allows you to create a schedule that defines when offline folder synchronization should occur. For example, let’s say you have an hour-long lunch break each day at work, and you want your XP computer to synchronize offline folders with the network during your lunch break. In order to create this configuration, you need to create a schedule that specifies the time and days of the week that synchronization should occur. On the Scheduled tab, simply click the Add button to create the schedule—after that, complete the steps in the following.

![Synchronization Settings](image)

FIGURE 5-9 The Logon/Logoff option for synchronization
How To box for the creation of a schedule. Once you have created schedules that you need, you can always edit or delete them using the available buttons on the Scheduled tab of the Synchronization Settings window.

Create a Synchronization Schedule

1. On the Scheduled tab, click the Add button. Doing this opens the Scheduled Synchronization Wizard. Click Next.

2. In the Connections window, select a connection; then select the desired offline folder(s) that you want to synchronize by clicking their check boxes.

   **TIP**

   *You can create different schedules for different offline folders as needed.*

3. In the next window, shown here, use the drop-down menus and radio buttons to select the start time, the start date, and how often the synchronization should occur (such as every day, weekdays, and so on). Make your selections and click Next.
Once you have automatic synchronization set up, there’s nothing else for you to do. Synchronization of offline folders will occur automatically as configured. However, if you need to manually synchronize the offline folders at an unscheduled time, just open Synchronize in Accessories, click the folders you want to synchronize, and then click the Synchronize button on the main Items to Synchronize page.

**SHORTCUT**

*If you need to see the documents in an offline folder, you can easily do so from the Items to Synchronize window by selecting the desired folder and clicking the Properties button.*

**TIP**

*Synchronization can use any kind of connection on your computer to connect to the network—whether a typical LAN connection or a dial-up/broadband connection. Just use the Setup button to select the desired connection for the synchronization that you want to perform.*

**Windows Explorer**

Another accessory you find in the Accessories menu is Windows Explorer. In previous versions of Windows, Explorer was considered the main tool that you used to browse and manage files and folders. In Windows XP, as well as Windows 2000 and Window’s Me, Explorer is considered an accessory because the Web view features of these operating systems make Explorer not so indispensable. However, Explorer is still available if you like working with it.

Windows Explorer provides you a single interface to view all of the folders on your computer and to make additions to or deletions from them. As you can see in Figure 5-10, Windows Explorer presents your entire folder in a hierarchy. You simply click the plus-sign box next to what you want to expand, and continue to click the plus-sign boxes until you reach the folder you want. Once you reach that folder, select it to see all of its contents in the right pane.

As you can see in Figure 5-10, Windows Explorer is a great way to browse through your folders, especially those folders in a folder in a folder in a folder…
How to Do Everything with Windows XP

(you get the picture). So, from this single interface, you can find what you need and even make changes. Essentially, everything on your computer’s hard drive, CD-ROM, floppy, and other data storage devices can be viewed from Windows Explorer. Explorer has an icon view in Windows XP by default, and you may find this helpful or aggravating, depending on your point of view.

If you don’t like the Tile/Icon view, just click the View menu and select the List or Details option.

Windows Explorer is actually just a folder in Windows XP. If you click any of the Windows Explorer menus—such as File, Edit, or Tools—you notice that the options are the same as in any folder in Windows XP (see Chapter 4). The good thing about Windows Explorer is that you can create and remove folders and files from a single location. Also, I think Windows Explorer is a good tool to use because it helps you visually examine the folder structure on your computer. You can then make decisions about any changes that need to be made. Without this view, it is sometimes hard to keep an accurate picture in your mind of what data is stored where on your computer.
WordPad

WordPad is a text editor like Notepad, but it functions more like a word processing application. Keep in mind, however, that WordPad does not by any stretch contain the functionality of most major word processing applications, such as Microsoft Word, but it does contain enough functions to be very useful. With WordPad (see Figure 5-11), you can edit and create text just as with Notepad; but WordPad supports major formatting features, such as the use of various fonts and text styles. When you save a WordPad document, the formatting is maintained as well. You can use WordPad for all kinds of documents, and while you can use tabs and different paragraph schemes, you cannot create tables or spreadsheets within the documents. However, for a free text editor, this one is certainly not bad at all.
How to Do Everything with Windows XP

How to ... **Format Text in WordPad**

You can easily format text in WordPad. Just type the text you want, and then highlight the text using your mouse. Then, you can use the WordPad toolbar to select a format button, such as bold, italic, font changes, and so on. You can also click the Format menu to see a list of other options.
How To…

- Install New Hardware
- Manage Hardware with Device Manager
- Install New Hardware Drivers
- Use Multiple Hardware Profiles
- Troubleshoot Hardware Problems

The term *hardware* refers to devices that your operating system uses in order to accomplish some task. Your keyboard, mouse, CD-ROM drive, floppy drive, modem, and sound card, plus the multitude of other devices found on your computer, are all collectively called hardware. In the past, installing new hardware devices was very difficult; but since the days of Windows 95, installing and configuring hardware has become much easier. Windows XP continues this advancement—in fact, Windows XP can often automatically install and configure new hardware without any help from you.

However, Windows XP is a new operating system—one built on the power of Windows 2000. Because of this, you may experience hardware problems if you have upgraded from previous consumer versions of Windows, such as Windows 95 and Windows Me. Simply put, Windows XP is a powerful system, and it must have powerful and compatible hardware on which to run. If you purchased a new computer with Windows XP preinstalled, you have nothing to worry about unless you want to add something new. Still, hardware does not have to be a computing monster, and this chapter shows you how to install, configure, and troubleshoot hardware problems in Windows XP.

Understanding Hardware

If you are like me, it’s usually helpful to understand a potential problem before you try to solve it, so this section tells you a bit about hardware—why it has been a problem in the past and what Windows XP does to reduce hardware problems. In the past, computer operating systems were “dumb,” in the sense that you had to tell them what hardware devices were installed or connected to the computer. You had to specify what sound card, video card, printer, modem, and other hardware devices were installed on your computer. You then had to provide a driver for those
hardware devices. A driver is a piece of software an operating system uses to communicate with a particular device. For example, in order for your operating system to communicate with your modem, there has to be a driver present so the operating system can manage and use the modem. Each hardware device has its own driver—usually provided by the hardware device manufacturer. So, in order to make the hardware work, you had to install it, provide a driver, and then (usually) configure the operating system to work with the device, and vice versa (as well as keep the device from interfering with other devices). As you can imagine, this process became very maddening for even the experienced user.

All of this began to change with Windows 95. Windows 95 introduced a technology called plug-and-play (which was often referred to as plug-and-pray). The idea was to create an operating system that was “aware” of its environment. The operating system could automatically detect when new hardware was added and attempt to install it. You might have to provide a driver for the hardware, but Windows 95 also had its own database of generic drivers that could be used for typical pieces of hardware. All of this sounded wonderful—but if you have used Windows 95, you know that plug-and-play was not perfect. It didn’t work well with some hardware, and some hardware didn’t work well with plug-and-play.

Windows 98, Windows 2000, Windows Me, and Windows XP all use a more grown-up version of plug-and-play. Windows XP has a very extensive driver database, so it can automatically detect and install most devices without your help at all. This is a great feature, because most of us would rather do something else than tinker with hardware installation. Windows XP can take care of the entire process—most of the time without any intervention from you.

Plug-and-play in Windows XP is designed to install devices on and remove them from your computer without any intervention from you. How does it work? Here’s the chain of events that occurs when you install or connect a new device to Windows XP:

1. Windows XP detects that a new hardware device has been added to the system. You will usually see a bubble message appear in your Notification Area telling you so.

2. Windows XP installs the new device and finds a generic driver for the device in its database.

3. Windows XP allocates resources to the device so the device can work with your computer.
How Plug-and-Play Grew Up

Want some extra details about plug-and-play? Then here they are. Windows 95 achieved plug-and-play operation through the Advanced Power Management (APM) Basic Input/Output System (BIOS), or a plug-and-play BIOS. APM BIOS enabled the system to detect when devices were installed on or removed from the computer. Plug-and-play in later versions of Windows—such as Windows 98, Windows Me, and Windows 2000/XP—uses an OnNow design called Advanced Configuration and Power Interface (ACPI), which provides better plug-and-play in addition to power management. The ACPI makes possible a number of plug-and-play features in Windows XP:

- **Automatic detection of hardware changes**  Windows XP knows if a device is added or removed from your computer without any input from you. When a change is detected, Windows XP tries to automatically install the device or remove it from the system.

- **Automatic resource allocation**  Each hardware device on your computer uses resources, such as Interrupt Request Lines (IRQs), Input/Output ports, DMA channels, and a number of other boring items. Windows XP manages all resource allocation for hardware devices to ensure that devices have the resources they need but do not interfere with the operation of other devices.

- **Automatic Driver**  Windows XP contains an extensive driver database. When a new device is detected and installed, Windows XP tries to install a driver for the device without any help from you.

That’s it—in most cases, you don’t even have to reboot the computer. When you remove a device from your computer, Windows XP

1. Detects that a hardware device has been removed.
2. Removes the device from the system and uninstalls the device’s driver.
The Golden Rules of Windows XP Hardware

In the introduction to this chapter, I mentioned that Windows XP will demand hardware that can handle the power of Windows XP. In order to avoid hardware problems, you should follow some simple XP hardware rules.

First of all, if you have purchased a new computer with Windows XP preinstalled, the hardware that was also installed on the computer will work fine with Windows XP. The computer manufacturer works with Microsoft to ensure that your computer’s hardware is compatible, so you have no worries if you fall into this category.

However, what happens if you later want to upgrade to a different device or upgrade an older computer to Windows XP? What if you want one of those new, awesome video cards or a new modem? No problem. You can purchase a new device and add it to your computer, and you can often upgrade an older computer to Windows XP. If you follow some basic rules, you are likely to have few or no problems with hardware. Here they are—the golden rules of Windows XP hardware:

- If you want to upgrade a computer to Windows XP from a previous version of Windows, you must check out the computer’s hardware carefully and compare it to the hardware requirements of Windows XP (see Appendix A). XP may not run on older hardware, and the older computer may not have enough RAM to power the XP operating system. Do your homework first!

- Buy only plug-and-play–compliant hardware. How do you know? Because the new hardware device will say “plug-and-play” right on the box. There is little hardware out there these days that is not plug-and-play, but if a device doesn’t say “plug-and-play” on the box, keep moving—don’t buy it!

- Look for a Microsoft seal of approval or a “compatible with Windows XP” statement on the box as well. A lack of these doesn’t mean the device will not work, but it should be a warning sign to you. Approved, well-tested hardware will tell you on the box that it is compatible with Windows XP.

- Check out the Windows XP Web site at [http://www.microsoft.com/windowsxp](http://www.microsoft.com/windowsxp) for up-to-date information about hardware compatibility.

- Stick to recognizable brand names. Remember, as with most things in life, you get what you pay for. If you choose to purchase FlyByNight’s Jiffy Modem on the Internet for $9.95 (with a set of steak knives), don’t be surprised if it doesn’t work well.
Installing a Plug-and-Play Device

Now that you know about the rules for purchasing a new hardware device, installing it is rather anticlimactic. If the device is plug-and-play and supported by Windows XP, installing the device should be very easy. Just follow these steps:

1. Shut down Windows XP and turn off your computer. Attach the new device to the correct port or slot on the back of your computer. If the device is an internal device, unplug your computer from the power outlet and follow the manufacturer’s instructions for removing the computer’s case and installing the device in the correct slot.

   **CAUTION**

   You absolutely must unplug your computer from the power outlet before removing the case. Just because your computer is turned off does not mean that power is not flowing to some of its components. Play it safe and unplug the computer!

   **TIP**

   Always check the device manufacturer’s documentation that came with the hardware device for instructions. Most hardware manufacturers include specific step-by-steps that tell you exactly what to do in order to install or attach the device to your computer.

2. If the device is an internal device, replace the computer cover and plug the computer back in. If the device is external, make sure it is attached to your computer correctly and then turn on the device.

   **TIP**

   In some cases, you should not turn on the external device before booting Windows XP. Check the device documentation to make sure.

3. Turn on your computer and boot Windows XP. Windows XP will automatically detect the device and install it on your computer. With some types of devices, some instructions may appear. Just follow them as directed. In most cases, installation is handled automatically, and you will receive a bubble message from the Notification Area telling you that the device has been installed.
Removing a Plug-and-Play Device from Your Computer

If you want to remove a plug-and-play device from your computer, Windows XP will automatically detect the change and remove the internal software and driver. Just shut down Windows XP and remove the device. If you are removing an internal device, remember to unplug the computer from the power source. Once you are done, reboot Windows XP. Windows XP will detect that the device is missing and uninstall the driver for the device.

You can also manually remove a device from Windows XP without physically removing it from your computer. See “Using Device Manager,” later in this chapter.

Installing a Non–Plug-and-Play Device

As I mentioned, virtually all hardware devices sold today are plug-and-play compliant. However, it is possible for a hardware device to work under Windows but not support plug-and-play. Also, you may have an older device that you want to use that does not support plug-and-play. In order to accommodate these needs, Windows XP includes an Add Hardware Wizard in the Control Panel. This wizard (which has been around since Windows 98) is designed to help you install non-plug-and-play devices, as well as troublesome plug-and-play devices. Before I show you how to use the wizard, I do want to note here that you should use plug-and-play hardware if at all possible. You’ll see the best performance and experience the fewest problems if you use plug-and-play hardware that is compatible with Windows XP. In most circumstances, you should never have to use the Add Hardware Wizard. With that said, however, you can try to use devices that are not plug-and-play with the Add Hardware Wizard. To use the Add Hardware Wizard, follow these steps:

1. Click Start | Control Panel.
2. Double-click the Add Hardware icon.
3. Click Next on the Welcome screen. The wizard tells you that Windows XP will now search for any plug-and-play devices on your computer. A report appears containing all currently installed devices.
4. If the device is in the list but is not working, select it and click Next to have Windows try to troubleshoot it for you. If the device is not in the list, follow the remaining steps.

5. Select the Add a New Hardware Device option, shown in Figure 6-1, and click Next. The next window asks whether you want Windows to search for the device again or you want to manually select it from a list.

6. Make your selection and click Next.

7. If Windows does not find the device or you want to select from a list, the hardware types window appears. Select the type of hardware you want to install and click Next.

8. Depending on the type of device you select, a new wizard may appear (such as in the case of a modem). You can also click the Have Disk button if you have installation files on a floppy disk or CD-ROM. Make your selection and click Next.

9. Follow any additional screens that may appear and click Finish.

---

**FIGURE 6-1** Add Hardware Wizard
Using Device Manager

Once you install devices on your computer, you can manage them in a few different places. First, for certain devices—such as printers, scanners, cameras, and modems—you have an icon in the Control Panel. These devices require more management than others do, so Windows XP helps you by giving them a specific Control Panel option (these are also explored in later chapters). Next, all devices installed or attached to your computer can be managed from a tool called Device Manager.

You can access Device Manager in one of two ways. First, right-click My Computer and click Properties. Click the Hardware tab. Notice that you can access the Add Hardware Wizard and Device Manager from this tab. Just click the Device Manager button to open it. You can also access Device Manager using the Computer Management tool found in Control Panel | Administrative Tools, shown in Figure 6-2. Either way, the Device Manager interface is the same.

As you can see, Device Manager provides an interface similar to Windows Explorer. You see different categories of hardware devices, each with a plus sign next to them. Click the plus sign to expand the category to see the actual devices. For example, in Figure 6-3, you can see some expanded categories.

Notice that at the top of the window, you can click the View menu to choose to view devices either by type (which is the view in Figure 6-3) or by connection. These options show you how different hardware devices are connected and how they are using resources on your computer. This view option can be helpful when troubleshooting.
What an IRQ Is

Devices installed on your computer use Interrupt Request Lines (IRQ) to gain access to the processor. Your computer’s processor is the brain of the computer; it performs all computations and calculations. Most system components use the processor to accomplish tasks. The IRQ enables the device to get to the processor. Because processors in Windows XP can handle only one processor task, or thread, at a time, the IRQ enables the device to get access to the processor in an organized way. The IRQ prevents two different devices from trying to access the processor at the same time (although certain devices can share an IRQ). IRQ conflicts were very common device problems in the past, but Windows XP automatically handles these settings for you. With Windows XP using newer hardware, IRQ conflicts are now quite rare.
Examining a Device’s Properties

As I noted in the previous section, you can use Device Manager to examine specific properties for a device. Just select the device in the Device Manager, right-click the device icon, and click Properties. Once you access the properties sheets, you see several tabs for the device. What you see may vary according to the device, but you typically see three basic tabs—General, Driver, and Resources. The following sections explore each of these.

General

The General tab simply gives you information about the device, but one piece of information can be particularly helpful. Along with information on the type of device, manufacturer, version number, and so on, there is a message about the status of the device, as shown in Figure 6-4.
As you can see in Figure 6-4, the device is working properly. If it were not working properly, you would see a message here telling you what might be wrong (such as a bad driver).

At the bottom of the window, you see a button that will open the Windows Troubleshooter to help you solve any existing problems with the device. You also see a drop-down menu that enables you to disable the device. This feature allows your system to stop using a device even though it is still installed, which can be helpful when troubleshooting problems.

**Driver**

As you might expect, the Driver tab, shown in Figure 6-5, gives you information about the device’s driver. You can use this tab to see the publisher of the driver and its date, and whether or not the driver is digitally signed. A digitally signed driver means that the publisher has included a digital signature to ensure that the driver is authentic. Microsoft recommends that you use only signed drivers to ensure compatibility with Windows XP. There are also four buttons that allow you to manage the driver—Driver Details, Update Driver, Roll Back Driver, and Uninstall.
If you click the Driver Details button, a window appears that gives you more information about the driver. Typically, this is not information that you will need, but it may be useful to support personnel should you ever need to get telephone or Web support from Microsoft.

If you click the Update Driver button, you can install a new driver for your device. From time to time, hardware manufacturers publish new device drivers. You can download these new drivers from the manufacturer’s Web site and install them on your computer. These new drivers often resolve conflicts or problems, and ensure compatibility with your operating system. When you want to install a new driver, simply access the Driver tab for the device, and then click the Update Driver button. This action opens a Hardware Update Wizard; the upcoming How To box shows you how to use it.

The next button on the Driver tab is the Roll Back Driver option. Let’s say you download a new driver for a hardware device. You use the Update Driver option to install the new driver, but now your device is not working. You want to return to using the old device driver, but how? In the past, that process could be difficult, but Windows XP includes a very helpful roll-back feature. When you install a new driver, a backup file is created, and the old driver is saved on your computer’s hard drive.
disk. In the event that you want to roll back to the old driver, simply click the Roll Back Driver button, and the new driver will be removed and the old one reinstalled. If you like to install new hardware and are constantly on the prowl for better drivers, this feature can be a real lifesaver.

The final option is the Uninstall button. The Uninstall button simply removes the driver from your computer, which essentially uninstalls the device from the operating system. If you click this option, a warning message appears asking whether you are sure you want to continue.

*Remember, if you simply remove a device from your computer, Windows XP will detect the removal and automatically uninstall the driver. Under most circumstances, you don’t need to use the Uninstall option on the Driver tab, but the option is made available to you if you want to uninstall the driver without physically removing the device from your computer. However, the next time you reboot, Windows will redetect and reinstall the device unless you physically remove it from the computer.*

**How to Do Everything with Windows XP**

**TIP**

**Install a New Driver**

To install a new driver, follow these steps:

1. On the Driver tab, click the Update Driver button, and the Hardware Update Wizard appears. You have two radio button options: You can install the software automatically or select the driver that you want to install.

2. If you choose the automatic option, Windows searches its driver database for the best driver and installs it (after this choice, skip to step 5). However, if you have obtained a new driver from the device manufacturer, you should choose the install from a list or specific location radio button, click Next, and follow the next steps.

3. In the selection window that appears, shown next, choose the location that Windows should search for the new driver, or you can choose the Don’t Search option so that you can manually choose the location of the new driver. For example, if you have the driver on floppy disk, you can...
Resources
The Resources tab, shown in Figure 6-6, tells what computer resources the device is using. For some devices, you can use this tab to manually change the resource allocation that Windows XP has established for the device. As you can imagine, you have to know what you’re doing before tinkering with these settings, and I do not advise you to make changes here without qualified assistance.

**CAUTION**
Making incorrect changes on the Resources tab can cause the device to stop functioning and may cause other devices to stop functioning as well.
The best thing about this tab is that it tells you if there are any conflicts with other devices. As you can see in Figure 6-6, there are no conflicts with this device. However, if there were conflicts, this dialog box would indicate the kind of conflict and the other device that was conflicting with it. Again, this information is very helpful when troubleshooting a device that is not working properly. It is important to note that not all devices give you a Resources tab, so don’t worry if you don’t see one for the particular device you are inspecting.

**Driver Signing**

Windows XP also includes a device driver signing feature that checks device drivers for digital signatures. A *digital signature* is essentially a stamp on a piece of software that says “I am who I say I am.” This certification is intended to assure you that the driver that you are downloading or installing is actually from the desired source. In short, driver signing is a security feature that helps you use new drivers and that allows XP to inspect each new driver to ensure integrity.
If you access System Properties in the Control Panel (or just right-click My Computer and click Properties), you can click the Hardware tab and then the Driver signing option. You see a single window, shown in Figure 6-7, that gives you three options. The options are

- **Ignore**  This setting ignores all driver signing and allows you to install drivers without any checks from Windows. This setting is not recommended because it essentially turns driver signing off.

- **Warn**  This setting checks each driver file for a signature. If one is not found, a warning message is presented before you install the driver. At that point, you can choose whether to install the driver or not. This setting is recommended and is selected for you by default.

- **Block**  This setting does not allow you to install any unsigned drivers.

You also notice an administrator option check box at the bottom of the window. This feature allows any user with an administrator account to apply the desired driver signing setting to all users. For example, let’s say that your XP computer is used by several people at work; however, you are the only local administrator. You can choose the driver signing setting you want and then use the administrator check box option to apply the setting to all other users. By doing this, you can configure the desired level of security, and no other user can change it. If you want to learn more about users and groups in Windows XP, see Chapter 13.
Using Hardware Profiles

Hardware profiles enable your computer to provide different hardware configurations. For example, let’s say that you want a laptop computer to load all devices in one profile, but only a few necessary ones when you are traveling. You can create two different hardware profiles for each need. When you start your computer, you will be prompted for the hardware profile you want to load.

Under most circumstances, you probably will not need different hardware profiles. The best example is when using a laptop computer, although some people choose to use different hardware profiles for different users. For example, let’s say you are teaching your five-year-old how to use your computer. You can create a hardware profile that disables the CD-ROM drive, printer, and modem, for example, so that the child can’t do anything to damage these devices (and believe me, I know a thing or two about teaching a five-year old to use a computer).

Creating a New Hardware Profile

Windows XP has a default hardware profile that uses every device on your system. If you access System properties in the Control Panel (or right-click My Computer
and click Properties) and then click the Hardware tab, you see the Hardware Profiles button. Click this button and you can see the Hardware Profiles window, which lists your Original Configuration (Current), as shown in Figure 6-8.

If you want to create a new hardware profile, simply click the Copy button. This feature enables you to copy the default hardware profile that uses all devices, and then make changes to it as you want. When you click the Copy button, a little dialog box appears prompting you to give the new profile a name. Enter a name and click OK. The new hardware profile now appears in the list.

**Configuring the Hardware Profile**

Once you have created the new hardware profile, you’ll want to decide on its configuration. First, reboot your computer. You’ll see a menu appear where you can select either the original profile or the new one you just created. Select the new one in the list and click OK. Once Windows XP boots, you can then use Device Manager to disable any devices you do not want used under this new profile. From that point on, those devices will not be available in the profile, but your original profile configuration will not be changed.

![Hardware Profiles Window](image)

*FIGURE 6-8* Your computer has an original hardware configuration profile.
Deleting a Hardware Profile

If you decide that you no longer want to use a hardware profile you created, you can easily delete it from your computer by accessing the Hardware Profile tab, selecting the profile you no longer want, and then clicking the Delete button.

Hardware Troubleshooting Tips

I wish I could tell you that you will never have hardware problems with Windows XP. Although many of you will escape hardware difficulties, I’m afraid some of you will have problems (I have had problems as well). Fortunately, hardware problems do not have to be too difficult to solve if you take appropriate actions. So, here’s a list of my best troubleshooting tips regarding Windows XP hardware.

- Relax. If a problem occurs or you can’t get a device installed, work through the problem calmly and slowly. A hardware problem or failure will not cause your computer to disintegrate, so work slowly and carefully.

- If plug-and-play doesn’t seem to be working well on your system, use Add/Remove Windows Components (located under Add/Remove Programs in the Control Panel) to ensure that Universal Plug and Play is installed. Choose the Networking Services category and then click the Details button. In the selection window that appears, shown in Figure 6-9, make sure Universal Plug and Play is selected. If it is not, just select it and click OK to install it.

- If you are trying to install a new device, verify that the device is plug-and-play and that it is supported by Windows XP.

- Check the device to make certain it is attached to the correct port or installed in your computer correctly. Reread the installation instructions and don’t forget to power down and unplug your computer!

- Check your Windows XP installation CD-ROM. When the auto-screen appears, click Documentation. You will find a bunch of Readme files. These are text files that contain information about known problems or hardware incompatibilities. Check out these files to see whether your device is listed and a solution is provided.

- Use Windows Help to access the Hardware Troubleshooter. This feature can often help you solve problems with a particular device (see Chapter 20).
If a device is installed but not working or not working properly, check the General and Resources tabs of the device’s properties sheets in Device Manager. These tabs may tell you what is wrong with the device.

If a hardware device is installed and not working well, the odds are very good that a driver problem exists. Check the manufacturer’s Web site for an updated driver.

If you cannot get the device to work properly, call the manufacturer for technical support. Often users are hesitant to seek telephone help, but these services are provided to help you solve problems. Take advantage of them!

If you are still having problems, call Microsoft Technical support. You should have a telephone support number and related information with the documentation that came with Windows XP. Again, don’t hesitate to get help from Microsoft if you need it.

FIGURE 6-9  Universal Plug and Play
This page intentionally left blank.
How To…

- Install a Printer
- Manage Printers
- Use the Print Queue
- Manage Faxes
- Install and Configure Scanners and Digital Cameras

Windows XP continues the tradition started with Windows 98—support more hardware and make it easy to install and use. In Chapter 6 you learned about installing and managing hardware in Windows XP. In this chapter, we explore some specialized hardware devices, specifically printers, scanners, and digital cameras. For years, both desktop and home-based computing have supported printers; then later, scanners; and now, finally, those wonderful digital cameras that all of us enjoy. Windows XP makes using these devices easier than ever, and in this chapter you’ll learn how to install and manage them.

Checking Out the Printers and Faxes Folder

Like its predecessors, Windows XP contains a Printers folder (now called Printers and Faxes) that stores information about any printers or fax machines connected to your computer and enables you to set up new printers and virtual fax machines. The Windows XP Printers and Faxes folder is found in the Control Panel. If you open the folder, you see a simple interface (shown in Figure 7-1) that gives you an icon for any existing printers that are set up on your computer. You also see a wizard that helps you set up new printers and a setup icon for virtual fax machines.

Installing a New Printer

You can use the Add Printer Wizard in the Printers and Faxes folder to help you install a new printer on your computer. Before tackling the wizard, however, you do have a little work to do away from your keyboard. First, make certain that your printer is compatible with Windows XP. If you are thinking of buying a new printer, read the label carefully. The printer should explicitly say that it is compatible with Windows XP.
The odds are very good that if a printer is compatible with Windows 2000 or Windows Me, it will work just fine under Windows XP. The only potential problem could be an incompatible driver. Check out Chapter 6 for more information about device drivers.

Before starting the wizard, you also need to unpack, set up, and attach your printer’s cable to the correct port on your computer. You will probably be using a parallel port on the back of your computer, and your computer may even have a picture of a printer next to the port where you should connect it. You may also be using a USB printer, in which case, connect the printer USB cable to the USB port or hub. The important thing here is to break out the printer manufacturer’s instruction booklet and take a few minutes to read through it. The instruction booklet will tell you exactly how to attach your printer to the computer and how you should proceed with the setup. In fact, some printers are shipped with their own setup program found on a CD-ROM. The key to success is to simply read and make sure you know what you are supposed to do to get the printer correctly installed on your computer.

Once the printer is attached to your computer and you have read the printer documentation, you may need to use the Add Printer Wizard to get the printer installed (check the instructions that came with your printer). If you need to use
the Add Printer Wizard, it is very easy. Make sure your printer is attached to your computer correctly and that it is turned on. Then, just follow these easy steps:

1. In the Printers and Faxes folder, double-click the Add Printer Wizard.
2. Click Next on the Welcome screen.
3. The next window gives you two radio buttons for selecting either a local printer or a printer connection (network printer), as shown in Figure 7-2. A local printer means the printer is attached directly to your computer. If you are on a network and you want to use a printer attached to another computer, then click the Network option. Make your selection and click Next. (If you are installing a network printer, skip to step 8).
4. Setup searches your computer for a printer. If setup finds one, the printer is automatically installed. If the printer is not found, a message appears asking whether you want to install the printer manually. Click Next.

![Add Printer Wizard](image)

**Figure 7-2** Select a local or network printer.
5. Select the port your printer is attached to, as shown in Figure 7-3. Under most circumstances, your printer will be attached to the printer port, LPT1. You can use the drop-down menu to select a different port, or you can use the Create a New Port radio button. Typically, however, you will need to use LPT1. Consult your printer’s documentation for more details.

6. In the Install Printer Software window, shown in Figure 7-4, select the manufacturer of your printer in the left window and select the printer model in the right window, and then click Next. If you have an installation disk, click the Have Disk button to install the printer software from a floppy disk or CD-ROM.

7. In the Name Your Printer window, type a friendly name and click either Yes or No in order to use the printer as the computer’s default printer. Click Next.
8. The next window asks you whether you want to share the printer so that others on your network can use the printer. Choose the desired radio button (see Chapter 11 to learn more about sharing devices and information on a network).

9. The next window asks you whether you want to print a test page. Simply choose either Yes or No, and click Next. Click Finish to complete installation.

10. If you chose to install a network printer in step 2, a window appears so you can enter the network path (UNC) to the printer or queue name, shown in Figure 7-5, or you can connect using a URL. If you are not sure, just click the Browse button to locate the network printer you want to use. In an office network, consult your network administrator for the correct printer connection information. Make your selections and click Next.

11. Set up locations for the network printer. Enter a friendly name for the printer and click the Yes radio button if you want your Windows programs to use this printer as the default printer. Click Finish.
FIGURE 7-5 Enter the network path or queue name of the network printer.

**Did you know?**

**About Configuring Network Permissions and Access**

It is important that your Windows XP computer be configured to use a network and share resources on a network. Also, the person who owns a network printer can allow you to use the printer or not—depending on what permissions he or she assigns. Just because you see a printer on your network does not mean that you have permission to use it. When in doubt, ask a network administrator. If you are trying to connect to a printer in a home network, make sure the shared network printer is set up, functioning, and available. You can learn how to set up your computer for network service in Chapter 11.
Configuring Your Printer

Once you install a printer, a printer icon appears in the Printers folder representing the printer. You can use this printer icon to access the printer’s properties sheets so that you can configure a number of different options for your printer. There are several options available, and some of them are a bit confusing. However, the following sections explain each of the options to you. To access the printer’s properties, right-click its icon in the Printers folder, and then click Properties. You see a printer Properties window with several tabs. Depending on your printer, you may have more tabs than the ones listed here—consult your printer documentation for more information about configuration options for your printer.

General

The General tab gives you the name of your printer and contains two basic options. This tab gives you information about the printer, and also gives you two button options. First, you have the option to print a test page. Just click the Print Test Page button to use this feature. Once you click the button, a window appears asking you whether the test page was printed correctly. If it was not, click No, and the Windows Help files open to help you solve the problem. The second option is Printing Preferences. When you click this button, the Printing Preferences window appears, as shown in Figure 7-6, where you can choose to print pages in portrait, landscape, front to back, and so on. You see both a layout and a paper/quality tab, and the options here are self-explanatory.

Be sure to check your printer’s documentation for special instructions about quality settings and features that may be available to you.

Sharing

The Sharing tab allows you to share the printer. If you want to share the printer, simply click the Share Name radio button and enter a desired name. Network users will see this name when they want to connect to the shared printer. Windows XP also has a feature that allows you to provide different drivers to network users. Remember from Chapter 6 that a driver is a piece of software that your computer uses in order to communicate with some device. Different operating systems use different drivers. If you want to allow Windows operating systems other than XP to connect to and use the shared printer, then you can configure drivers for those systems. When network users connect to your computer, your XP computer automatically downloads the printer driver to their computers. However, if a
Windows 95 computer wants to connect, the drivers used for XP probably will not be compatible. So, using the additional drivers option, you can simply choose to provide the appropriate drivers for that operating system. Just place a check in the check box next to the operating system that you want to select and click OK, as shown in Figure 7-7. You may need to provide your printer’s floppy disk or CD-ROM drive so that XP can get the needed driver files.

**Ports**

The Ports tab enables you to make changes to the physical or logical port that is used for printing. For example, the typical printer port is labeled LPT1. However, configuration issues with your computer may make it necessary to connect the printer to a different port. If you are using a network printer, you may need to change the port that is printed to as well. The Ports tab enables you to make these changes by changing the current port, as well as adding, removing, and deleting ports. All of these actions tend to be more advanced, and under most circumstances, you should never have to make any configuration changes here. However, if you need to adjust or change ports that are in use, Windows XP provides the Add, Remove, and Configure port options to make port configuration easy.
It is important to remember that you do not need to change printer ports unless you have physically moved your printer to a different port on your computer, or the network path to a particular network printer has changed.

**About Printer Pooling**

In some network environments, printer pools are used. A *pool* is a collection of identical printers that are seen as one logical printer. For example, let’s say you print to a printer named “Company.” To you and the computer, Company appears as one printer; but with pooling, Company can actually be five printers, for example, that are connected together. This feature allows all users to print to the same printer instead of there being five individual printers on the network. If you need to enable printer pooling on your XP computer and have several printers connected to different ports, you can click the check box option available on the Ports tab. Also refer to your printer’s documentation for more information about pooling options.
Advanced

The Advanced tab, shown in Figure 7-8, isn’t really all that advanced—it just provides you with a bunch of configuration options for printing that are not necessarily related to each other. The following options are available on this tab:

- **Availability** Use the radio buttons to configure the time that the printer is available. By default, the printer is always available; but you can place restrictions on when the printer can be used, if necessary. This setting is typically used in network environments where you want to make certain that users can print only during work hours.

- **Priority** This setting can range from 1 to 99, with 1 being the default. This setting simply tells you that higher priority documents will print before lower priority documents (with 99 being the highest). You typically do not need to make any changes to this setting.

- **Driver** From time to time, your printer manufacturer may produce a new driver for your printer. The new driver may increase performance or solve compatibility problems with a new version of Windows. If you need to
update the printer driver, you can do so by clicking the New Driver button on this tab. This action opens a portion of the Update Driver wizard that can help you install the new printer driver. See Chapter 6 for more information about device drivers.

- **Spooling feature** This simply means that print jobs are stored on your hard disk while the computer waits for the printer to be ready. For example, let’s say you print ten Word documents. It may take several minutes to print the documents; so while one document is printing, the others wait in the spool until it is their turn. Why? The answer is simple: spooling moves the documents to the hard disk so you get control over your application without waiting for them to print. Without the spool, your application would be tied up until the print job finishes. With the spool, you can return to work or play and not have to wait for the file to print. You have the following spool options:

- **Spool print documents** This option is enabled by default and tells your printer to spool print jobs to your hard disk. You should leave this setting enabled.

- **Start printing after last page is spooled** This option holds the print job until the application spools all of the pages. This frees your application up faster, but delays printing longer.

- **Start printing immediately** Printing begins as soon as the first page is spooled. In other words, printing starts faster because XP does not wait until the entire document is spooled. This is the default setting.

- **Print directly to printer** This option does not spool print jobs, but sends them directly to the printer. This setting will cause your application to wait until the document finishes printing before you can work on other tasks. In other words, this setting does not use the spool. I do not recommend this setting, because you’ll end up waiting for jobs to print before you can continue to work or play.

- **Hold mismatched documents** Documents that do not match printer setup configuration are simply held in the queue instead of being printed. This setting can be helpful in troubleshooting mismatch problems.
CHAPTER 7: Using Printers, Fax Machines, Scanners, and Digital Cameras

- **Print spooled documents first**  Documents sent to the spool are always printed first. This setting is enabled by default.

- **Keep printed documents**  This setting tells the spooler not to delete documents out of the spool once they have been printed. Typically, you should not enable this setting.

- **Enable advanced printing features**  This option, enabled by default, gives you advanced printing options, which will vary with the type of printer. You may be able to manage page order, pages per sheet, and other printing options. Consult your printer’s documentation for more information.

The final portion of the Advanced tab allows you to access printer defaults (Printing Preferences window) and print processor options; you can also set up a separator page here. You should not make changes to the print processor configuration unless your printer documentation tells you to do so. The other setting options are self-explanatory.

**Security and Device Settings**

The Security tab allows you to configure the users and/or groups that can access your printer if it is shared on a network. This tab is the same Security tab found in all sharing features of Windows XP. See Chapter 13 to learn more. The Device Settings tab may contain additional configuration options, such as paper feed options, depending on your printer. See your printer’s documentation for more details.

**Managing Print Jobs**

Once your printer is set up and configured the way you want, you can print all kinds of documents and files—almost anything you like. As you are printing documents, a small printer icon will appear in your System Tray. This icon represents the “print queue,” which is the line of documents in your print spool that are waiting to be printed. You can manage the print queue by right-clicking this icon and then clicking the printer’s name. Doing this opens a small print queue window, as shown in Figure 7-9.
As you can see in Figure 7-9, there is a document waiting to be printed. You can take several actions by using the menus to manage documents that are in the print queue. On the Printer menu, you can

- **Pause Printing** This action stops all printing.
- **Use Printer Offline** This action enables you to send jobs to the print queue, but they are not printed until you are ready.
- **Purge Print Documents** If you accidentally print a bunch of documents, you don’t have to waste your paper and ink. Just use the Purge print documents option to dump everything out of the print queue.

On the Document menu, you can

- Select a print job in the list and click Pause to stop printing.
- Select a print job in the list and click Cancel to cancel it.

You can perform the same management action using the Printers and Faxes folder. Using the default XP folder interface, the Tasks list in the Printers and Faxes folder gives you a quick link so you can see what is in the queue, pause printing, and even adjust printer preferences and delete printers.

If you use the Document menu, you can pause printing, resume printing, restart printing, and even cancel documents that are currently in the print queue. For
example, let’s say that you want to print ten documents. You send all of them to the print queue, but you suddenly realize that you do not want to print the ninth document. You don’t have to waste your paper—just open this print queue window, select the ninth print job, and use the Document menu to cancel it.

You can also remove any document from the print queue by simply right-clicking the document in the queue and clicking Cancel.

**Troubleshooting Common Printer Problems**

Windows XP includes better printer support than previous versions of Windows, so troubleshooting does not have to be a major chore. Keep in mind that you should consult your printer documentation when you experience a problem, because there may be issues specific to your printer you need to resolve. The following sections tell you about some of the most common printer problems and their solutions.

You can use the Windows Troubleshooter tool to help you solve problems. See Chapter 20 for more information about troubleshooting.

**Printed Text Is Garbled**

You have a document you want to print, it is nice and neat on the screen, but when you print the document, the text comes out garbled. This is a common problem that is typically caused by one of two things. First, the document that you are trying to print may be damaged or corrupt. You can test this by printing a different document. If the text still appears garbled, the most likely cause of the problem is your printer driver. Your printer driver may not be compatible, the wrong driver may be installed, or the driver may have become corrupt. Use the Details tab of the printer’s properties sheets to reinstall the driver.

**The Printer Does Not Work**

If your printer does not seem to work, make sure it is turned on and that it is attached to the correct port on the back of your computer. If it is, you may need to reinstall the driver and reboot Windows XP. Sometimes internal problems can prevent a printer from working, and a reboot may take care of the problem. If these actions do not solve the problem, consult your printer documentation. You may have a printer hardware problem.
Check Your Hard Disk Space

You can easily check the amount of free disk space on your computer by double-clicking My Computer, right-clicking the hard disk icon, and clicking Properties. Consult the General tab. You will see a pie graph showing how much hard disk space is used and how much is free.

Printing Is Very Slow

If printing to a local printer is very slow, you may be running low on hard disk space. Remember that your printer uses part of your hard disk space to spool documents for background printing. You should have at least 10 MB of free hard disk space available.

If you have enough free disk space, check your spool settings on the printer properties Advanced tab to make sure spooling is enabled. Also, try defragmenting your hard disk. For more information about defragmentation, see Chapter 19.

A Certain Document Will Not Print

If you have a certain document that will not print, try to print a different document from within the same application. If you can print another document within the same application, the problematic document is most likely corrupt. If printing is sporadic with the application or several applications, turn the printer off, wait 10 seconds, and turn it back on. This may resolve the problems (you may try rebooting as well).

Print Quality Is Poor

If your files will print, but the print quality is poor, there may be changes you need to make to printer-specific tabs within the printer’s properties pages. Consult your printer documentation for help.
Fax Support in Windows XP

Fax modems have been around for some time now, and support for fax modem capabilities continues in Windows XP. Using a fax modem, you can fax documents to other fax machines, just as you would with a physical fax machine. Faxing tends to be application specific, but I will mention a couple of things about faxing with Windows XP. First, if your modem is installed, you can double-click the Fax icon in the Printer and Faxes folder and access the Fax Console, as shown in Figure 7-10. The Fax Console allows you to manage incoming and outgoing faxes, as well as send faxes from this simple console (which looks a lot like Outlook Express).

If you want to send a new fax, Windows XP even includes a wizard to help you set up the fax job—which you learn more about in the following How To box.

FIGURE 7-10 The Fax Console
To use the Send Fax Wizard, follow these steps:

1. In the Fax Console, click File | Send a New Fax, or just click the New Fax icon on the toolbar.

2. The Send Fax Wizard appears. Click Next on the Welcome screen.

3. In the Recipient Information window that appears, enter a recipient’s name in the To field, and a fax number, as shown next. If you want to send the fax to more than one recipient, click the Add button to enter additional recipients. Click Next when you’ve finished.

4. In the Preparing a Cover Page window, use the template drop-down menu to select a desired cover page template, and then enter text for the subject line and a note if desired. Click Next when you’ve finished.
5. In the Scheduling Transmission window, select when you would like to send the fax and at what fax priority you would like to send it. Click Next.

6. In the Delivery Notification window, select whether you would like to receive a delivery notification message when delivery is complete. You can even choose to send yourself an e-mail confirmation. Make your selections by clicking the desired radio buttons and then click Next.

7. Click Finish.

Using Scanners and Digital Cameras with Windows XP

During the past few years, the popularity of scanners and digital cameras has exploded. After all, we all like to use electronic pictures that we can print, e-mail to friends and family, or just store on the computer’s hard drive instead of an album under the couch. Because of these devices’ popularity, Windows XP includes a Scanners and Cameras folder in the Control Panel that looks much like the Printers and Faxes folder. This folder first appeared in Windows Me, and you can use the Add Device Wizard to add scanners and cameras to your system, and then manage them from this folder.

Did you know?

Windows XP Archives Faxes

By default, Windows XP keeps track of all faxes that are sent or received. Open the Printers and Faxes folder, right-click the Fax icon, and click Properties. Click the Archives tab, and you will see that all incoming and outgoing faxes are archived in the Inbox and Outbox. You can easily access these folders from within the Fax Console. The archive enables you to browse sent and received faxes at any time.
Installing Scanners and Cameras

Installing a scanner or digital camera is a lot like installing a printer. First, always consult the documentation and instructions that came with the scanner or digital camera for setup and management instructions. Some models have their own installation disk or CD-ROM, so be sure to carefully check out the documentation. Also, make sure any scanner or camera you purchase is compatible with Windows XP.

You can use the Add Device Wizard in the Scanners and Cameras folder in the Control Panel to install a new scanner or camera. You may not need the wizard, however. In many cases, Windows can automatically detect your scanner or camera; but if it does not, then you can use this wizard to assist you. Like the Add Printer Wizard, the Add Device Wizard is easy to use. Just connect the scanner or camera to your computer, turn it on, and then follow these easy steps:

1. Double-click the Add an Imaging Device check box in the Scanners and Cameras folder in the Control Panel.
2. Click Next on the Welcome screen.
3. Select the make and model of your camera or scanner, or click the Have Disk button to install it from a floppy disk or CD-ROM. Make your selection and click Next.
4. Select a port for the device (refer to your scanner or camera’s documentation), and click Next.
5. Give the device a friendly name, and click Next.

Once you have your scanner and/or camera installed on Windows XP, you will see icons for them in the Scanners and Cameras folder, shown in Figure 7-11.

Managing Scanner and Camera Properties

You can right-click a scanner or camera icon in the Scanners and Cameras folder in the Control Panel and click Properties to access the device’s properties sheets. As you might guess, the contents of the properties sheets depend on the type of device and the make and model, much like with printers. Various options are available to you. For example, you can have a camera or scanner always save files
to a certain folder, and for some devices you can manage color settings here. Check your scanner or digital camera documentation for information about configuring these properties sheets.
This page intentionally left blank.
This page intentionally left blank.
How To…

- Configure Your Modem
- Set Up Dialing Rules and Options
- Create Internet and Dial-Up Connections
- Create Broadband Connections
- Edit Dial-Up Connections

Simply put, Internet connections give you access to the Internet. Connections provide a way to connect your computer to an Internet Service Provider (ISP) so that you can use the Internet and send and receive e-mail. In the past, connectivity to the Internet was one of those “extra” computing services—something only advanced computer users wanted. Not so today—virtually every computer is sold with the hardware and software necessary to connect to the Internet, and more and more computer users every day are joining the World Wide Web.

Like previous versions of Windows, Windows XP provides you with the software you need to connect your computer to the Internet. Internet connectivity in Windows XP is easier than ever, and some helpful wizards will guide you every step of the way. In this chapter, you’ll see how to set up your computer with an Internet connection so that you can be surfing the Internet in no time!

Internet Connections 101

Before we jump into the business of creating and managing Internet connections, let’s first make sure you’re up to speed about those connections. An Internet connection allows your computer to access the Internet: you can send e-mail, look at Web pages, and download information with your Internet connection. An Internet connection is achieved through an Internet Service Provider (ISP). You pay the ISP a fee (usually monthly, but there are annual and semiannual plans as well) to access the Internet. The Internet itself is free, but generally, you must pay an ISP for the access.

Think of the Internet as a busy freeway. In order to get on the freeway, you must drive onto an access ramp so your car can enter the traffic. The Internet is the same. In order to access the busy “information highway,” you must have an on-ramp so your computer can get into the traffic. The ISP is your on-ramp. All information you send and receive over the Internet comes through server computers at your ISP before reaching your computer. So, your ISP can also be thought of as the
middleman that stands between you and the Internet. The connection to the Internet, then, is a physical connection between your computer and your ISP. There are a few different types of connections, but they fall into two distinct categories—dial-up and broadband. Dial-up connections use a modem, and broadband connections use other types of connection hardware. The following two sections explore both of these types.

**Connecting with a Dial-Up Connection**

The most common type of Internet access is a dial-up account. With this type, your computer uses a modem connected to your phone line to dial an access number—just as you would make a telephone call. Once the ISP answers the call, your computer sends username and password information so it can be authenticated by the ISP. After the ISP authenticates your information, you can use the Internet through the ISP. Dial-up access is the most common type of access, with 56Kbps modems being the most common modem speed. Virtually all new computers sold today are equipped with a modem—it is considered a standard piece of hardware. All computer operating systems, including Windows XP, give you software wizards and helpful information so you can easily set up an Internet connection with your modem—you’ll explore modem configuration later in this chapter.

**Connecting with a Broadband Connection**

Today’s Internet contains rich multimedia and surfing experiences. You can view all kinds of graphics, listen to music, and even watch movies and concerts over the Internet. Although a great addition, multimedia and the cool Web pages of today are much larger in size than they once were—and 56K modems are quite slow. Therefore, many people are turning to broadband “always on” Internet access. Broadband Internet access gives you much faster speeds than dial-up connections, and they are always on. This means that you do not dial any kind of access number—your computer is always connected to the ISP, and, therefore, it is always connected to the Internet. If you want to use the Internet or e-mail, you simply open your browser or e-mail client and begin using the Internet—there’s nothing for you to connect to or anything else to do.

There are three main types of broadband connections, and the following bullet list reviews them for you.

- **Cable**   Cable Internet access uses existing cable TV connections to provide Internet access over the cable line, just as television programs are accessed over the cable line. To use cable access, your computer is outfitted with a
special cable network card. You can then connect to a cable outlet and use the Internet at any time. Cable Internet access can provide speeds around 400 Kbps; however, cable lines are shared by users—so if there is a lot of traffic, your speed may be slower. Your ISP will provide you with a cable network card for your PC.

- **DSL**  
DVD (Digital Subscriber Line) typically provides you with a dedicated, secure line that connects directly to your ISP. This copper line connects directly to a switchboard of sorts at the phone company, which connects to your ISP. DSL is the most popular type of broadband connectivity available today, and it can give you super-fast speeds—often up to 800 Kbps. However, DSL must be supported by your phone company and ISP, so it is typically limited to more populous areas at this time. In order to use DSL, a special DSL connection device is connected to your computer and the DSL line is run to your home.

- **Satellite**  
Satellite connections use a small satellite dish that mounts on your roof or to a pole in your yard. Information is sent and received over the disk to a satellite in orbit, which then beams data back to the ISP. Satellite connections are not that popular yet, but they are especially helpful to people who cannot get cable or DSL. I use a satellite connection because I live just far enough out of the city that I can’t get cable or DSL. Satellite connections can give you speeds of around 400 Kbps and are currently offered by major ISPs, such as MSN and AOL. In order to use Satellite access, you must have a satellite dish, connection cards for your PC, and special software to run the connection. Your ISP provides all of this when you purchase the satellite access.

---

**Did you know?**

**What Connectivity Costs**

As I mentioned, the Internet itself is free, but you must pay an ISP to provide you with a connection—and you’ll pay more for a faster connection. A typical dial-up connection will cost around $20 a month for unlimited access and an e-mail account. If you live in a city where several ISPs are competing, you may get unlimited access for as little as $10 a month.

Broadband solutions cost more than dial-up connections. Cable and DSL unlimited access with one e-mail account will typically cost you around $40 a month. Watch for special deals where the cable or DSL hardware and setup are
Configuring Your Modem

As I mentioned in the previous section, the most common type of Internet access is a dial-up account, which uses a modem in your computer. Unless you have paid for DSL, satellite, or some other broadband service (and the hardware to connect to your computer), you will access the Internet via your modem.

Configuring modems has been a painful experience for Internet users in the past. I remember staying up late at night and literally pulling my hair out trying to get a modem to work correctly. Although modems can still be complicated, we’re a long way from those days, and setting up your modem in Windows XP should be no problem.

Before getting into the details, I do want to mention that dial-up connections tend to be problematic for computer users, because you have two different components to work with. You have to configure the actual connection (which we will do in an upcoming section), and you have to configure your modem, which the connection uses. Just remember as you work with connections that successful Internet access requires the configuration of a connection and your modem. The following sections show you how to configure your computer’s modem.

Installing a Modem

Your computer probably has a modem currently installed—after all, modems are a standard piece of hardware these days. You may have purchased a different modem, a particular one you want to use—that’s fine, too. Windows XP should be able to automatically detect and install a plug-and-play modem, so modem installation works just like any other piece of hardware. Check out Chapter 6 for more information about installing devices.

Configuring Modem Properties

In order to make modem configuration easier, a Phone and Modem Options icon is included in the Control Panel. If you double-click the icon, you see a properties sheet that contains Dialing Rules, Modems, and Advanced tabs. The following sections show you what you can configure on each of these (and why you would want to).
Modems Tab

Today’s modems do a good job of setting themselves up. You don’t have to worry about inputting a lot of information to make the modem work, but you may want to adjust some of the settings to meet your needs. The Modems tab, shown in Figure 8-1, provides a simple interface that lists the modem(s) installed on your computer and provides you with a few buttons.

First, you see Add and Remove buttons at the bottom of the screen. If you click the Add button, the New Modem Wizard appears and searches for additional modems attached to your computer. If the wizard finds one, it automatically installs it. If it doesn’t, you can select it from a list. This is the same type of installation wizard you see when installing various other hardware devices (see Chapter 6). If you select a modem in the list and click Remove, the modem’s software is uninstalled from your computer. Under most circumstances, you don’t need to use either of these buttons—unless you just love modems and want to use two or three of them on your computer.

Next, you see a Properties button. Select the desired modem in the list (if there is more than one), and then click the Properties button to see specific properties. There are several properties tabs. First, the General tab, shown in Figure 8-2, simply tells...
you the status of the device (whether it is working or not). You can click the Troubleshooter button to start the Windows XP troubleshooter if you’re having problems with the modem, and you can also use the drop-down menu at the bottom of the screen to disable the device if necessary.

![The Modem Properties General tab](image)

**FIGURE 8-2** The Modem Properties General tab

So, you’re using a 56K modem—you should get 56K right? Wrong! First of all, as a result of regulations, the highest speed you are likely to get with a 56K modem is about 48K. Even then, the speed must be matched with your ISP’s modem, and telephone-line conditions can bring the speed lower. If you have used the Internet before, you may wonder why you get different connection speeds at different times. Local, ISP, and Internet traffic all affect modem speed.
You can use the Maximum Speed option on the Modem Properties General tab to set a minimum connection speed, but doing this may prevent you from getting a connection if your ISP’s modem can’t handle it. For example, let’s say that you want a minimum speed of 38K, so you use the drop-down menu, select 38K, and then click the check box so that your modem connects only at that speed. That’s all well and good, but what if the ISP modem you connect with isn’t doing 38K at the moment? You get disconnected. So, use these settings with care. Speed is important, but just getting there is nice, too.

On the Modem tab, you have three basic options. First, you can adjust the slider bar for the modem’s speaker volume. A lower setting is typically best here, unless you just love to hear that familiar modem connection noise. Next, you see a Maximum Port Speed drop-down menu. You can use this drop-down menu to set a maximum speed at which you want the modem to connect. Typically, you’ll leave this setting at the default so that you’ll get the highest connection speed possible. Finally, you see a Dial Control section with a Wait for Dial Tone Before Dialing check box. This check box is probably enabled and, typically, should remain enabled so that your modem checks for a dial tone before actually dialing the number.

On the Diagnostics tab, you can run a query, which is simply a test your computer runs with the modem to make sure it is working properly. You can also view a log file. The information you see here is basically a lot of commands, and many will not have much meaning to you, but it can be helpful if you have to call technical support concerning problems with your modem.

The Advanced tab gives you a single dialog box where you can enter additional modem string commands. You don’t need to do anything here unless your modem documentation or the technical support explicitly instructs you to make a change. The extra initialization commands entered here are most often used to solve problems with modem connectivity.

Finally, the Driver tab is like all such tabs for hardware in Windows XP. Use this tab to update or change drivers for the device. See Chapter 6 to learn more about drivers and the configuration options presented on this tab.

**Dialing Rules Tab**

The Dialing Rules tab, shown in Figure 8-3, provides a place to configure locations. In Windows XP, a location is a place for dialing up to the Internet where certain dialing rules are configured. For example, let’s say you use a laptop computer for your work. Some days you dial from the Dallas office, and some days you dial from the Seattle office. Depending on your location, the dialing rules and preferences you need will be different. Rather than having to manually reconfigure your dialing
rules each time you travel, you can simply create different locations and use those locations as needed. By simply clicking the desired location, you can use the rules configured for that location immediately and easily.

To create a new location, click the New button. The New Location window appears with three tabs. Also, if you want to make changes to a location, simply select the location and click the Edit button, which gives you the same tabs seen in the New Location window. Either way, you can create new locations or edit existing locations using these tabs, which are explored in the following sections.

**TIP**

*If you’re using Windows XP from a home or office on a desktop system that stays in one place, then all you need is the default “My Location,” which you can edit as necessary.*

**General**  The General tab, shown in Figure 8-4, enables you to make some basic dialing rules configurations. First, you can name the location by simply entering a recognizable name in the provided dialog box. If you travel, you may consider naming the location after cities or areas, such as Dallas, Canada, Northwest, and so on.
Next, use the Country/Region drop-down menu to select the country or region the location is in and then enter the area code. You then see a collection of options called dialing rules. These are simply dialog boxes where you enter information, if necessary, that tells Windows XP how to dial the connection. For example, if you need to dial 9 to access an outside line, there is a dialog box provided for entering this information. You also see configuration options to disable call waiting, and to use either tone or pulse dialing.

**Area Code Rules** In the past, dialing an area code typically meant making a long distance call. However, in many cities, several area codes are now considered local. Windows XP has to know how to handle different area codes, and that’s the reason for Area Code Rules. If you click the Area Code Rules tab, shown in Figure 8-5, you can generate a list of area code rules specific to a particular location. Obviously, area code rules from one location to the next may vary, so Windows XP gives you the option to configure area code rules on a location-by-location basis.
To create a new area code rule, simply click the New button, which opens the New Area Code Rule window, shown in Figure 8-6. Enter the area code for this rule in the desired dialog box. In the Prefixes section of the window, you can specify how prefixes are handled for the area code, such as to use all prefixes or to limit them to a specific set. Under the Rules section of the window, you can tell Windows XP to dial 1 in front of the area code or include the area code in all numbers.

As you generate your list of area code rules, you can edit them or delete them at any time using the Edit and Delete buttons on the Area Code Rules tab.

*It is important to create only area code rules that you actually need. Too many area code rules become more confusing than helpful.*

**Calling Card** The final location tab is Calling Card. In this tab, you can use the provided list, shown in Figure 8-7, to select the type of calling card you want to use, and then you can enter the account number and PIN. If you don’t need to use
a calling card for long distance calls, you don’t need to configure anything here, of course. If your calling card is not listed on the menu, then simply click the New button and enter the necessary information about your calling card.

**Advanced Tab**

The final Phone and Modem Options tab is the Advanced tab, which lists information about telephony software installed on your Windows XP computer. There is nothing that you need to configure in this window for your modem connection.

**Creating Connections to the Internet**

Once you are sure your modem is installed and you have configured any connection and dialing rules you need, you can then turn to creating your Internet connection. Remember, your Internet connection uses your modem to dial a connection, and your modem uses the modem settings to manage the call. Think of these two items as a duet—two pieces that work together to accomplish one goal.

Fortunately, creating connections to the Internet is made rather easy by the Internet Connection Wizard included in Windows XP. If you have used a previous version of Windows before, you are probably familiar with the Internet Connection Wizard. However, in Windows XP, the Internet Connection is hidden from view.
because Microsoft wants you to use the new Network Connection Wizard, explained in the next section. Still, if you would rather use the Internet Connection Wizard, it can be found in C:\Windows\Internet Explorer. Once you start the wizard, it walks you through a series of steps, collecting information from you in order to create a connection. The welcome screen for the Internet Connection Wizard is shown in Figure 8-8.

**Creating Connections Using the Network Connections Folder**

In the Control Panel, you’ll find a Network Connections folder. This folder looks similar to the Printers folder. There is a wizard to help you create different kinds of connections; you will see an icon for any connections that currently exist, as shown in Figure 8-9.
FIGURE 8-8  Use the Internet Connection Wizard to help you create an Internet Connection

FIGURE 8-9  The Network Connections folder showing existing connections and the Create a New Connection Wizard
Up to this point, we have explored connections in terms of the Internet. You can use the Internet Connection Wizard to create an Internet connection for an ISP—but why does Microsoft include yet another wizard here? The Internet Connection Wizard is used only for Internet connections. While it is true that you can use the New Connection Wizard for an Internet connection, you can also use this wizard to create other dial-up or broadband connections. For example, let’s say you work for a small company. Instead of using expensive networking technology for remote users, the company may implement dial-up accounts where you can dial up to a private server and get information from the network. Regardless of what it’s used for, the New Connection Wizard is very simple and straightforward. If you need to create an additional dial-up connection, just double-click the wizard to start it. Answer the questions it poses to you, and, once you have finished, a new connection icon will appear in the Dial-Up Networking folder.

Create a Broadband Connection

The New Connection Wizard gives you the option to create broadband connections for your computer. It is important to note here that you may not need to create a broadband connection if you are purchasing broadband connectivity. Typically, cable, DSL, and satellite all come with their own software, so make sure the broadband connection is something that will actually be useful to you before creating it. If you do need to create one, just follow these steps:

1. In Network Connections, click the Create a New Connection icon.
2. Click Next on the Welcome screen.
3. In the Network Connection Type window, select Connect to the Internet and click Next.
4. In the next window, choose to set up the connection manually, and then click Next.
5. In the Internet Connection window, select the Broadband connection radio button and click Next.
6. In the Service Name window, enter a friendly name for the service (such as the name of your ISP). Click Next.
7. In the Internet Account Information window, shown here, you can choose to make this connection the default connection, and you can enter your username and password used for the connection. Make your selections and click Next.

8. Click Finish to complete the connection. The new connection now appears in your Network Connections folder.

Editing a Dial-Up Connection

All connections you create within Windows XP are stored in your Network Connections folder in the Control Panel. You can open this folder, right-click a connection of your choice, click Properties, and make changes to the connection as needed. This is a great feature that prevents having to re-create connections when something changes. Different types of connections will have different tabs, but typically, most modem and broadband connection properties have General, Options, Security, Networking, and Advanced tabs. The Networking tab lists components that cannot be changed for a dial-up connection, and we’ll explore the Advanced tab in Chapter 14. The following sections, however, show you what you can configure on the General, Options, and Security tabs.
General

The General tab, shown in Figure 8-10, enables you to change the phone number the connection uses to dial your ISP. Phone numbers can frequently change, so access this tab to make adjustments as necessary. You can use this tab to tell the connection to use the dialing rules you have configured for your modem. You can also make configuration changes directly to your modem from this tab by clicking the Configure button. This action opens the Modem Properties window that we explored in the first half of this chapter.

Options

The Options tab gives you options for telling Windows XP how to handle dial and redial for your ISP. This tab, shown in Figure 8-11, simply gives you a number of check box options. You can choose to display progress while connecting, prompt for username and password, prompt for phone number, and so on. You can also determine how many redial attempts should be made before Windows gives up on the connection and how much time should be idle between each connection.
Does your Internet connection hang up by itself? For example, let's say you're surfing the Web and you take a break to eat a quick snack. When you return to your computer, the connection has been severed. How can you stop this behavior? Simple—use the Options tab and change the “Idle time before hanging up” drop-down menu to “never” (or at least to a longer period of time).

Security

The Security tab contains your username, password, and other security information your connection uses to authenticate with the ISP or dial-up server. You should refer to your ISP documentation or dial-up server authentication information before making any changes on this tab.

You may be familiar with Windows XP’s ability to share an Internet connection with other PCs in your home or office. You can learn all about this configuration option in Chapter 11.
How to Do Everything with Windows XP

How To…

- Use and Configure Internet Explorer, Windows Messenger, and MSN Explorer
- Check out NetMeeting
- Use the Web Publishing Wizard

Windows XP continues the Windows tradition of being an operating system that is easy to use on the Internet. As you learned in Chapter 8, creating connections to the Internet is quick and easy, and Windows XP includes all the software you need to use the Internet, and send and receive e-mail. In this chapter, we’ll consider the tools that allow you to surf the Internet, hold virtual meetings on the Internet, and publish information to the Internet. You can learn all about e-mail in Chapter 10. If you’re new to the Internet and this is your first attempt to surf, don’t worry, this chapter tells you everything you need to know!

Understanding Internet Terms and Technology

Windows XP includes two software tools that allow you to surf the Internet—Internet Explorer 6 and MSN Explorer. Both of these tools are Web browsers. A browser is simply a program your computer uses to access and view Web pages and content. At its core, the Web is made up of HyperText Markup Language (HTML) documents. HTML is a kind of programming language your browser reads to draw and create the nifty Web pages you see. HTML documents are transferred from place to place using the HyperText Transfer Protocol (HTTP). HTTP is a communications protocol that is a part of the Transmission Control Protocol/Internet Protocol (TCP/IP) suite of protocols. These common protocols and programming languages are universally used on the Internet. Now, do you really need to know anything about HTML, HTTP, or TCP/IP to use the Internet? Not at all—which is good news! But, it may help to know that just as you need Microsoft Word to read a Word document, you need a Web browser to access and read Web pages.

Internet Explorer and MSN Explorer are built right into the Windows XP operating system. You can find the Internet Explorer icon (a blue e) on your Taskbar if quick launch is enabled, and the MSN Explorer icon appears as a
What About Netscape?

Internet Explorer and MSN Explorer are an integrated part of the Windows XP operating system, an issue that has been the subject of various debates and lawsuits over the past few years. However, even though IE and MSN Explorer are integrated with Windows XP, you are still free to use Netscape Navigator or Communicator. In fact, if you bought Windows XP on a new computer, the computer vendor may have already put Netscape Navigator on the computer for you (see your documentation). If this isn’t the case, you can download Netscape Navigator from http://www.netscape.com and use the Netscape browser instead of Internet Explorer if you like—the choice is yours. However, because Internet Explorer and Windows Messenger are a built-in part of Windows XP, this chapter explores the usage and configuration only for these two. You might ask, “Which browser is best?” That depends on whom you ask, but from my point of view, they are both good browsers (and both essentially do the same thing and work the same way).

Understanding the Internet Explorer Interface

You can start Internet Explorer by clicking the Internet Explorer icon on your Taskbar. It is probably available on your Start menu as well. This action opens the Web browser and, if you have a dial-up connection to the Internet, probably launches the connection automatically. If you have not configured a connection for your computer, the Internet Connection Wizard appears instead of Internet Explorer. (See Chapter 8 to learn how to configure an Internet connection.)

One thing you’ll notice right away about Internet Explorer is that it looks a lot like any other folder on your computer. This is by design. Microsoft has made Windows XP integrate closely with the Internet so that your computer can look and feel more like a Web page. The Internet Explorer browser, like your Web folders, contains several menus across the top, toolbars, and a primary interface area, as shown in Figure 9-1.

At the top of the Internet Explorer window, you see several common menu options: File, Edit, View, Favorites, Tools, and Help. These menus are virtually...
the same as folder menus that you learned about in Chapter 4; however, there are a few differences that are specific to Internet Explorer. The following list highlights these menu functions and points out major features:

- **File**  This menu contains typical options: Open, Save, Save As, Print, and related file menu options. You also have a Send feature that enables you to send a Web page to a friend via e-mail, send the link via e-mail, or create a desktop shortcut to the page.

- **Edit**  The Edit menu contains your typical Cut, Paste, and Copy functions.

- **View**  The View menu enables you to control how your page is viewed by selecting different font sizes. You can also use this menu to change Internet Explorer’s toolbars.

- **Favorites**  The Favorites menu contains a few folders of generic favorites and channels that Microsoft configures for you. You’ll use this menu to
add favorites that you want to keep. For example, let’s say you find a Web page you really like. You don’t have to remember where the Web page is located on the Internet—Favorites can do it for you. Just click “Add to Favorites” to save the Web page to your favorites list. The next time you want to visit the page, just click the Favorites menu and click the page title you want to visit.

If you have a lot of favorite items, you can click “Organize favorites” to group them into different favorites folders. Doing this helps keep your favorites organized and easy to locate.

- **Tools**  The Tools menu enables you to send and receive e-mail using Outlook Express (see Chapter 10); synchronize with other Web folders; configure the Windows Messenger (which I’ll address in a moment); and access Internet Options, where you configure Internet Explorer (which I’ll also address in this chapter).

- **Help**  This option opens the Windows XP Help files for Internet Explorer.

Directly below the menus, you see the primary Internet Explorer toolbar. The options are fairly intuitive:

- **Back**  This button returns you to the previous Web page you visited. Think of each Web page as a page in a book. You can move back to previous Web pages using this button.

- **Forward**  In the same manner, you can move forward to other Web pages you have visited using this button.

The Back and Forward buttons only apply to your current surfing session. If the Forward button is grayed out, you haven’t moved back any, so you are not able to move forward.

- **Stop**  Is a page not downloading correctly or taking too long (or have you just changed your mind)? Click Stop to stop the download process.

- **Refresh**  Some Web page content changes frequently. Use Refresh to make sure you are looking at the latest version.
Home  This button returns you to your desired home page (see the next section on Internet Options for details).

Search  This action opens a search window hosted by the Microsoft Network (MSN). You can then perform a Web search for a topic of your choice.

Favorites  This button opens your favorites list in a different window.

History  Want to know what Web pages the kids have been visiting? Just click History to view a list of previously visited Web pages. But beware, you can edit the History by right-clicking a listing and clicking Delete—which your Internet-savvy children probably already know how to do.

The History list is a good way to find a Web page that you have visited, but forgotten its address.

Send Mail  This option opens an Outlook Express mail message. See Chapter 10 to learn more about Outlook Express.

Print  This option prints the current Web page.

Edit  You can play around with Editing a Web page and changing its content by clicking this button. IE selects a default editor for you, such as Microsoft Word if Word is installed on your computer; but you can change this default setting using Internet Options, which I’ll explore a little later in this chapter.

Discuss  If you want to use discussion and newsgroups, you can click this button to set up a preferred discussion server.

Windows Messenger  This option enables you to send and receive instant messages to other users.

Contacts  Access Outlook Express’s Address Book by clicking the button. You can learn more about the Address Book in Chapter 10.

Address  The address is the place where you enter the Web address of a site you want to visit. For example, to visit Microsoft, just type Microsoft.com here and press ENTER. Although all Web addresses require the http://www portion of the address, Internet Explorer can automatically put this part of the address, or Uniform Resource Locator (URL), in for you. If you want
to see a recent list of addresses you have visited, just click the down arrow at the end to access a drop-down menu.

- **Go** You can press this button after you enter a Web address in the Address dialog box. You can also just press ENTER to go to the Web page, which is probably a lot easier.

- **Links** This list (or drop-down menu, depending on your configuration) just gives you a list of predefined links—basically advertisements. However, you can right-click any of the default items and click Delete to get rid of them. Then you can simply drag any URLs from the Address line to the Links bar, and they will copy over to the Links bar for easy access!

### Configuring Internet Explorer Through Internet Options

You can make changes to the way Internet Explorer behaves so that the browser looks and acts the way you want. You have a variety of useful options, and I’ll guide you through them so you can decide which ones are the best for you. You can configure Internet Explorer through Internet Options, which is found in your Tools menu. When you open Internet Options, you find seven different configuration tabs, and the following sections show you what you can do on each tab.

#### General Tab

The General tab, shown in Figure 9-2, contains three major categories—Home Page, Temporary Internet Files, and History.

The home page is simply the Internet site you want Internet Explorer to connect to as a default site. Whenever you open Internet Explorer, it will always connect to this site first. If you want to change the site, just type a new URL in the dialog box. If you don’t want to use a home page, just click the Use Blank button.

The Temporary Internet Files section enables you to determine how temporary Internet pages are stored. When you surf the Web, your computer stores pages that you visit in a temporary folder. This speeds up your access to those pages when you revisit them. You can change the default options by clicking the Settings button. Doing this opens a Settings window, shown in Figure 9-3, where you can adjust how Internet Explorer uses the temporary pages.

By default, Internet Explorer automatically checks for new material. This setting ensures you that you are looking at the most current version of the Web
FIGURE 9-2  The General tab contains Home Page, Temporary Internet Files, and History settings.

FIGURE 9-3  Use this window to change the default temporary Internet page settings.
page, and I recommend you leave this default setting. You also see that you can adjust the amount of disk space that is used for temporary Internet files (123 MB). You can increase this setting if you like, but 128 MB is quite a bit of storage just for temporary Internet files, and this is probably all the space you need. You can also use the buttons at the bottom of the Settings window to view your temporary Internet files and objects, and you can move the temp folder to a different location on your computer (which doesn’t help anything, so it’s best to just leave it alone).

Finally, you also see a History section. Remember that History lists the sites that have been visited by Internet Explorer. By default, Internet Explorer keeps a history listing for 20 days—in other words, every site that has been visited in the last 20 days will appear. You can change or lower the period of time a history is kept, depending on your individual needs, and you can also click the Clear History button to clean out current history items.

At the bottom of the General tab, you see several buttons: Colors, Fonts, Languages, and Accessibility. These options enable you to change the way Internet Explorer looks and displays Web pages. These options are self-explanatory, so check them out if you want to make appearance changes.

**Security Tab**

The Security tab enables you to configure how Internet Explorer handles security issues on Internet or intranet sites, as shown in Figure 9-4. A typical home user does not need to make any configuration changes on this tab; and if you are using IE on a business network, you should not make any changes here unless instructed to do so by your network administrator. By default, the Internet option (shown in Figure 9-4) is set to Medium. This setting gives you all of the browser functionality, but prompts you before downloading questionable content. You can change this level by using the slider bar to access different settings. For each slider bar movement, you can read an explanation of how the browser behaves. Typically, however, the medium setting is best.

You can also use the Trusted Sites and Restricted Sites option. These options enable you to list sites that you know are safe or sites that you know are questionable. This, in turn, affects how your browser acts when handling these sites.

**Privacy**

The Privacy tab, shown in Figure 9-5, gives you a slider bar option so you can set a privacy configuration for your computer (first click the Default button on the tab). Web sites have become more interactive in the past year or so, and many of
FIGURE 9-4 Use the Security tab to manage the way Internet Explorer handles browsing security.

FIGURE 9-5 The Privacy settings tab
them want to collect information from you and your computer. This setting allows you to determine whether or not Web sites can set cookies with your browser and use personal information. By default, the medium setting is used, which is typically all you will need. You can click the Advanced button to alter the cookie settings as desired.

**Content Tab**

The Content tab enables you to configure how Internet Explorer manages different kinds of content from the Internet, as well as information about you. There are three sections on this tab—Content Advisor, Certificates, and Personal Information, as shown in Figure 9-6.

The Content Advisor enables you to manage how (and if) Internet Explorer handles different kinds of potentially offensive Web content. If you click the Enable button, you see a Content Advisor window, shown in Figure 9-7.

You see different categories of potential offensive material. You can use the slider bar to adjust the level of offensive content that users are able to view. This feature is great if you have children who use the Internet on your computer. You can enable this feature to prevent accidental access to offensive Web content.

![Internet Options window](image)

**FIGURE 9-6** The Content tab manages the way Internet Explorer handles Web content.
These settings are not foolproof. Internet Explorer examines the requested Web site for keywords that provide clues about offensive content. Internet Explorer can also use a site’s rating system to determine whether it is safe. As you can see, a lot of this is up to the individual site, so don’t think that your kids are safe when you enable these settings. You still need to monitor them, and you might consider investing in some other third-party software that can also help manage access to offensive Web sites.

Once you make some settings decisions, click Apply, and Windows XP will prompt you to enter a password. This prevents other users of your computer from changing the content settings. Also note that you can access the other Content Advisor tab to create a list of approved sites, and you can also make some basic changes on the General and Advanced tabs. Normally, however, you don’t need to use these tabs; if you do, you’ll find them self-explanatory.

The second part of the Content tab is Certificates. In some organizations, Internet Explorer is configured to use various digital certificates in order to verify certain Web site authenticity. Home users do not use certificate options, so you don’t need to configure anything here. There may be circumstances where you want to use a digital certificate to communicate with a highly secure Web site.
If this is the case, you will need to follow that Web site’s instructions about obtaining and using a digital certificate. If you are using XP in a business environment, your network administrators will manage these settings for you.

Finally, you can use the Content tab to change or turn off auto-complete. Internet Explorer tries to learn what Web sites and information you enter into Web pages. If Internet Explorer recognizes what you are typing, it will try to complete it for you. You may find this helpful or aggravating. At any rate, you can click the AutoComplete button to change the behavior. This button opens another window with some simple check box options you can consider. Also, you see a My Profile button where you can change personal information about yourself that Internet Explorer keeps.

**Connections Tab**

The Connections tab, shown in Figure 9-8, lists any Internet connections you have configured on your computer. You normally do not need to configure anything on this tab because you configure these options when you create a dial-up connection (see Chapter 8). However, you can use this tab to specifically tell Internet Explorer what connection to use if your computer has multiple connections. If you are on a network where your computer accesses another network computer to reach the Internet (a proxy server), you may need to perform some configuration here. Consult with your network administrator for specific setting information.

![Internet Options](image)

**FIGURE 9-8** You can manage connections from this tab.
About Proxy Servers and Firewalls

Most business networks do not maintain individual connections for each network computer. Instead, the network computers access the Internet through a proxy server. This proxy connects to the Internet and retrieves information for the client computers. In most cases, the proxy server contains additional security and content settings. These network environments may also use a firewall, which can be either hardware or software, that ensures (it is hoped) that no Internet interlopers gain access to the private network from the Internet. As you can see, Internet access can be quite an issue for network administrators.

Programs Tab

The Programs tab, shown in Figure 9-9, enables you to pick which programs on Windows XP perform what options. For example, by default, Internet Explorer uses Outlook Express for Internet mail (in other words, if you are visiting a Web page and click a “send e-mail” link, then Internet Explorer opens an Outlook Express mail message). However, you may want to use a different mail client you have

![Image of Internet Options dialog box](image)

**FIGURE 9-9** Use the Programs tab to change the default applications Internet Explorer uses.
installed on your computer. You can use this page to change the applications that Internet Explorer uses for HTML editing, e-mail, newsgroups, Internet call, calendar, and contacts list. If you plan to use both Internet Explorer and Outlook Express, then you won’t need to change any of these settings.

**Advanced Tab**

The Advanced Tab contains a bunch of check box options for a variety of processes. For example, you can change some browsing behavior, multimedia settings, and printing settings (among others) just by checking or unchecking different options, as shown in Figure 9-10.

The real question, of course, is what do you need to change? In reality, nothing—under most circumstances. Do not start making changes on this tab unless you have a specific goal in mind. For example, Internet Explorer does not print background colors and images on Web pages as a way of sparing your color ink cartridge from printing unnecessary graphics. However, if I want Internet Explorer to print them anyway, I can click the “print background colors and images” check box under Printing. The key is to identify a goal you want to accomplish and then see whether you can enable or disable that option on the Advanced tab. The most common settings are already configured for you.

![Internet Options](image)

**FIGURE 9-10** Use the check boxes on this tab to make configuration changes.
If you choose to ignore my advice and change a bunch of these settings, you can click the Restore Defaults button to put everything back to the original settings.

Windows Messenger

I have mentioned that Windows Messenger, formerly MSN Messenger, is available in the Internet Explorer browser. First off, MSN—the Microsoft Network—is both an Internet search engine and an Internet Service Provider (ISP). You can visit msn.com and read news, get information, and search the Web. You can also sign up with MSN, and for a monthly fee, MSN will be your ISP—your onramp to the Internet.

The Windows Messenger is included in Windows XP, and you do not have to be an MSN ISP customer to use the service. The service, in a nutshell, enables you to directly communicate with other Windows Messenger service participants. It is a quick and easy way to bypass your typical static e-mail. You can talk back and forth instantly and even use voice over the Internet instead of text. You can send files and pictures to others using this service, and Windows Messenger users can even use the service via Web-enabled telephones and personal digital assistants (PDAs). Overall, it’s a cool service that you’ll want to check out.

You Don’t Have to Sign Up for MSN to Use Windows XP

You’ll see MSN pop up from time to time and in various places in Windows XP—including the Windows XP help files and the MSN Explorer. This might make you think that MSN should be your Internet Service Provider—however, this is not the case. You don’t have to use MSN to use any of the MSN Windows XP features, so don’t think you have to use Microsoft’s ISP to make the best use of the Windows XP on the Internet. But, as you use Windows XP, you’ll definitely get the feeling that Microsoft would like you to be an MSN customer. That’s fine, but just remember: the choice is completely up to you.
This type of messenger service is offered by other major ISPs and Internet sites, such as Yahoo! and AOL.

**Setting Up Windows Messenger**

To set up Windows Messenger, just click the messenger icon on your Internet Explorer toolbar and then follow these easy steps:

1. When you click the Windows Messenger icon, a welcome dialog box appears. You can click the More Information button to read more about Windows Messenger, or just click Next to continue.

2. You need either an MSN/Hotmail e-mail account or a Microsoft Passport to use this service. The Passport is free (as is Hotmail). If you already have a free Hotmail account, just use your account name and password. If you don’t, click the Get a Passport button. This opens another Internet Explorer window where you complete an application page to get a passport. Follow the instructions that appear, and once you have a passport, you can continue with Windows Messenger setup.

3. Enter your Passport name and password, and then click Next.

4. Click Finish.

Windows Messenger sets up and its opening window appears on your computer, as shown in Figure 9-11. You may be prompted to download the latest version, and you should choose to do so in order to take advantage of the latest features.

**Using Windows Messenger Service**

As you can see in Figure 9-11, the Windows Messenger Service is an easy, scaled-down window option with a few buttons. You can use the window to set up your service for new contacts and other people with an MSN or Hotmail account, as well as for Microsoft Passport to send and receive messages. The window tells you which of your contacts are currently online and which are not. Messages are automatically displayed in the window as you receive them. This feature enables you to talk back and forth instantly. You can also place a phone call or call a pager number from the Windows Messenger window. As you can see, using Windows Messenger is very easy—just play around with it, get some of your friends signed up and online, and see how you like it!
If you are using your computer with Windows Messenger turned on and you need to step away for a moment, you can let your friends know you are away from your computer. Just click File and point to My Status, and a list of options appear, such as “out to lunch,” “be right back,” “on the phone,” and so on. Your messenger friends will see your status and know you are unavailable for the moment.

Using MSN Explorer

MSN Explorer can be used by anyone with a Hotmail or Passport account. You do not have to be an MSN ISP member.

MSN Explorer is also a Web browser, like Internet Explorer, but MSN Explorer can only be used by people who have an MSN ISP account, Hotmail e-mail account, or a Microsoft Passport. In short, if you are not a subscriber to one of these services, you can’t use MSN Explorer. The reverse, however, is also true—if you are an MSN ISP subscriber, you don’t have to use MSN Explorer—you can use a Web browser like IE or Netscape. MSN Explorer is used to browse the Internet, just like any other browser, and it also provides easy access to all of
the MSN subscriber features, as well as e-mail. In other words, it puts everything in one central location. There are, however, a couple of setup issues to consider before using MSN Explorer:

- Once you set up MSN Explorer, your e-mail is handled through Explorer—not another e-mail client like Outlook Express. In other words, Explorer forces you to use e-mail from the Explorer interface, and Outlook Express will no longer work for POP3 mail. However, you can use Outlook Express to get your Web-based mail, such as Hotmail. You can use Outlook Express for this purpose—you just won’t be able to connect to your regular ISP to download POP3 mail any longer. The problem is in POP3 (ISP-based) mail and Outlook Express.

- In order to read or write e-mail, you must be connected to the Internet.

Depending on your needs, these two issues may be enough of a deal killer for many—myself included. I am an MSN subscriber, but frankly, I want more control over my e-mail and settings, so I prefer to use Outlook and Internet Explorer. If you want to use MSN Explorer, however, it does have some nice features and a cool interface that is very easy to use. The following How To box shows you how to set up MSN Explorer.
To set up MSN Explorer, just follow these steps:

1. Click the MSN Explorer icon on your Taskbar (looks like a butterfly).

2. This opens an Explorer Getting Started page. Click the Type of Internet connection you use (dial-up, broadband, or local area network, for example), and click the Continue button.

3. MSN places a toll-free call to the Internet (if you are using a dial-up connection) and connects you with MSN. This sometimes takes a few minutes.

4. A message appears asking whether you want to sign up for MSN Internet access. Click either Yes or No, and click Continue.

5. A message appears telling you about upgrade issues, which are explained in the previous section. Click the Continue button.

6. Enter your MSN account information (username and password). Click Continue.

7. Enter your name on the next screen and click Continue.

8. Use the drop-down menu and select your occupation (or something close to it). Click Continue.

9. Enter your date of birth and click Continue.

10. Enter the ISP phone number that you dial to connect. Click Continue.

11. Additional screens may appear as necessary. Finally, you will be reconnected, and you will need to sign in with your username and password.

12. Once you’ve finished, you finally reach the welcome screen. Notice the tour that you can take to orient yourself with MSN.
Once you have MSN Explorer set up, you see that it looks a lot like Internet Explorer, but all things “MSN” are integrated into one location so that they are easy to use. If you need to make any changes, just click the Help & Settings link at the top of the window. Besides this, the Explorer is very intuitive, and if you spend some time working with it, you’ll be a pro in no time.

**Using NetMeeting**

NetMeeting is a tool that enables you to hold virtual private meetings or informal get-togethers over the Internet. Provided you have fast Internet access, it is a great way to spend time with family and friends, or even conduct business. In fact, many companies today use NetMeeting for virtual meetings and classes.

With NetMeeting, you can send voice, text, video, and all kinds of data. You can teach a class and, with the proper equipment, network the class over the
Internet. Students on the other end can ask questions and be directly involved with the class, just as if they were actually in the classroom. With a little organization, you can even have family visits. The possibilities are endless—as you’ll see, NetMeeting is a very cool tool that has many useful features.

**What You Need to Use NetMeeting**

NetMeeting is included with Windows XP, but to use all of its features, you need

- **Fast bandwidth**  Sadly, NetMeeting will not work well with a 56K modem. You can use NetMeeting with a modem, but many of its features will be too slow.

- **Sound card and speakers**  In order to hear voice transmissions, your computer must have a sound card and speakers installed.

- **Video camera**  Your computer needs a video camera installed in order to send video.

**Setting Up NetMeeting**

To set up NetMeeting, simply launch it, and a wizard helps you set it up. NetMeeting is found in Start | More Programs | Accessories | Communications | NetMeeting. When you click NetMeeting, a wizard appears to help you get started. The following steps walk you through this process:

1. The NetMeeting welcome screen appears. Read this screen and then click Next.

2. In the next window, shown in Figure 9-12, enter information about yourself. Note that your first and last name, and e-mail address are required. Click Next when you’ve finished.

3. In the next window, you can choose whether or not to log on to a directory service, which is the Microsoft Internet Directory. This option lists your name and contact information in the directory so that other people can get in contact with you. If you don’t want to meet new people using NetMeeting, choose the “Do not list” check box option. Make your selection and click Next.
4. In the next window, select the radio button that best describes your Internet connection (modem, DSL, or LAN, for example). Click Next.

5. The next window asks whether you want a shortcut on your Desktop and Taskbar. Clear the check boxes if you don’t want to use these. Click Next.

6. NetMeeting will now test your speakers. Close any open programs that are using your sound card, turn on your speakers, and then click Next.

7. In the Audio Tuning test window, click the Test button to hear a test sound. If the sound is not loud enough, turn up your speakers or sound control using the slider bar. Click Next when the sound is loud enough.

8. A microphone test window appears. If you want to use a microphone so others can hear you speak, use the microphone and read the paragraph on the page, and then click Next. The next window tells you whether your voice was heard.

9. Click Finish. The NetMeeting interface appears, shown in Figure 9-13.
Once NetMeeting is set up, you can see that the interface is quite simple, and, in reality, NetMeeting simply combines a number of different Internet tools into one interface. Using this interface, you can place Internet calls connecting you with another NetMeeting participant, chat, host a chat or meeting, transfer files, share applications, and send and receive live video and sound. On the NetMeeting window, you can see there are buttons for each of these features.

**Placing a NetMeeting Call**

Placing a NetMeeting call is much the same as using a telephone. Click the Call menu and click New Call to place a call, or just click the Telephone icon on the NetMeeting interface. In the Place A Call window, just enter the e-mail address, computer name, telephone number, or IP address of the other NetMeeting participant you want to call, as shown in Figure 9-14.
Once you have established a connection with another NetMeeting user, you can then begin to use NetMeeting’s features with the other person. You can do the following:

- **Send and receive live video using a video camera**  Press the start video button on the NetMeeting interface to start recording.

- **Send and receive live sound**  Press the sound/microphone button to begin sending and receiving voice transmissions.

- **Share programs**  Click the share program button. A window appears where you can determine which programs or files on your computer you want to share.

- **Chat**  Chat is a program that enables you to communicate with the other NetMeeting caller in real time. Just open the chat window and type your message.

- **Whiteboard**  The Whiteboard is a program that looks and works just like Paint. You can draw sketches on the Whiteboard, and your NetMeeting recipient will see the drawings on his or her Whiteboard.

- **Send Files**  You can send files of any kind to your NetMeeting recipient. Just click the Send Files button and determine which file on your computer you want to send.
These tools are very easy to use and have a simple interface. The best way to master them is to simply play with the tools during a call. A typical computer user can master all of these tools in half an hour of experimenting.

Setting Up Remote Desktop Sharing

Remote Desktop Sharing is a very cool feature of NetMeeting. With Remote Desktop Sharing turned on, you can call your computer from a different computer and manage your computer from the remote location. This feature is helpful if you are going to be away, but want to be able to access your computer at home. To set up remote desktop sharing, follow these easy steps:

1. In NetMeeting, click Tools | Remote Desktop Sharing.
2. Click Next on the Welcome screen.
3. Enter and confirm a password you want to use when contacting your computer. You should use a complex password made up of both letters and numbers. The password must be at least seven characters long. Click Next.
4. The next window asks whether you want to use a password-protected screen saver. When you access your computer from a remote location, Windows XP can lock your computer with the screen saver password option so that no one at your home or office can use the computer while you are accessing from the remote location. This setting is highly recommended. Click the Yes button and click Next.
5. The Screen Saver tab of Display properties appears. Enable the screen saver and provide a password here. Close the window.
6. Click Finish.

When you close NetMeeting, right-click the NetMeeting icon in your System Tray and click Activate Remote Desktop Sharing. Your computer is now ready to be accessed remotely.

Configuring NetMeeting Options

Like most Windows programs, you can click the Tools menu in NetMeeting and then Options to configure a number of important items. There are four tabs available to you, which are described in the following sections.
General
The General tab, shown in Figure 9-15, contains the information you configured during NetMeeting setup. You can change any of the information on this tab as needed. Also, if you click Bandwidth Settings, you can select a different connectivity option, such as DSL, modem, and so forth. The Advanced Calling button opens a window where you can enable a gatekeeper. In some networks, a single line is used to access the Internet, called a gatekeeper. In such cases, your computer needs to send and receive data through the gatekeeper. If you are in an environment that uses a gatekeeper, you can configure the option on this window.

Security
The Security tab enables you to manage how your computer handles incoming calls and outgoing calls. You can also choose to use a digital certificate for call authentication.

Audio and Video Tabs
The Audio and Video Tabs enable you to make changes and tweak the performance of audio and video transmissions. These tabs are easy to use and are self-explanatory.
Using the Web Publishing Wizard

Along with Internet Explorer, Windows XP includes a related tool called the Web Publishing Wizard, which is available in any Windows XP folder that contains content. In the Tasks dialog box, you see a “Publish this folder to the Web” link. This feature opens the Web Publishing Wizard, which can help you publish items to an Internet site. Often, ISPs give their customers a certain amount of server Web space. This means that you have a block of space on their server’s hard drive where you can put Web pages and pictures. Friends and family can then access the Web address and view your files on the Internet. This feature could also be used by an intranet Web server. Let’s say you have a small company that uses an intranet and you want to send files and folders to an address on that server. You can use the Web Publishing Wizard to accomplish this task.

Basically, all the Web Publishing Wizard does is gather information about what files you want to publish and which Web server you want to publish them to. The Web Publishing Wizard then takes this information, connects to the Web server, authenticates with it, and then transfers the files to the Web server. The wizard makes this an easy process for you.

In order to use the Web Publishing Wizard, you’ll need information from your ISP or intranet server on how to access the Web server so you can transfer your files. Once you have this information, just start the Web Publishing Wizard, enter the information as requested, and then let Windows XP handle the rest for you.

MSN also offers a Web storage solution so you can store files on the Internet as a simple backup method. Once again, you’ll need an MSN, Hotmail, or Passport account to do this. This is a very cool feature—it’s fun, free, and a big help; just choose the Publish option from the desired folder and choose the option to publish to MSN when the wizard appears. Follow the easy steps to complete it.
How To…

- Set Up Outlook Express
- Send and Receive E-mail
- Configure Interface Views
- Use Identities
- Create and Manage Message Rules
- Customize Outlook Express
- Use the Address Book

If you are like many of us, you didn’t have e-mail a few years ago, and the concept of e-mail didn’t seem very important. Today, e-mail is a daily part of your life, and you don’t know how you ever survived without it! That statement certainly describes me—I use e-mail every day for my work and to keep up with friends and family. Checking and managing the e-mail I receive consumes a significant amount of my time each day, and I don’t know what I would do without it.

Like previous versions of Windows, Windows XP provides you with Outlook Express, which is a free e-mail client. An e-mail client is simply a software program that allows you to send and receive e-mail and manage the e-mail that you receive. Outlook Express 6 is included with Windows XP; and if you have used previous versions of Outlook Express, you won’t find many differences in version 6. If you’re new to Outlook Express, however, this chapter is just what you need to get your feet on solid ground. In this chapter, you will learn how to set up Outlook Express, manage e-mail accounts, and make the most of the additional features offered by Outlook Express.

How E-mail Works

E-mail is primarily sent over the Internet in order to reach a certain person. Businesses and organizations also use e-mail, which is sent over their local network instead of the Internet; but most of us use e-mail that is sent over our telephone line to the Internet. Like everything else on the Internet, e-mail uses TCP/IP—the default protocol used for Internet communications.

Typically, e-mail uses Simple Mail Transfer Protocol (SMTP) in order to move mail from one place to another. An e-mail address is made up of a username and a
domain name, such as myname@mydomain.com. When you send an e-mail to someone, e-mail servers first examine the mydomain.com portion of the address in order to find a mydomain.com server. Once this server is located, the mail is sent to the server. This server recognizes mydomain.com as its own domain, so it examines the username to see whether there is a user by that name. If myname is, in fact, a user, the mail is held on the server until it is downloaded. If the name does not match, the mail is sent back to the sender with a “user unknown” message.

In many respects, e-mail is just like regular mail, where the address is inspected first, and then the name is inspected by the local post office. Of course, e-mail is a lot faster. You can send a message to any e-mail address anywhere in the world, and it normally arrives in less than a few minutes. Also, you can send any kind of electronic file as an attachment—pictures, documents, video, applications. . .you name it. Because it is so fast and can handle almost any kind of attachment, e-mail has become very popular in our fast-paced world.

Setting Up Outlook Express

When you install Windows XP, Outlook Express is installed by default. You can see the Outlook Express icon on your Taskbar, which looks like a letter with blue arrows around it. In order to use Outlook Express, however, you will need to set up your mail account so Outlook Express will know how to connect to a mail server to send and receive e-mail. This information is available from your ISP. You most likely received printed instructions about setting up your computer for a connection to the Internet (see Chapter 8). Once you have made this connection, you then use your documentation to set up Outlook Express. I would like to note here that you do not have to use Outlook Express in order to send and receive e-mail with Windows XP. You can use Netscape, Eudora, or some other mail client instead. However, this chapter focuses only on Outlook Express because it is included with your operating system.

To start, just click the Outlook Express icon on your Taskbar. Outlook Express opens, and you see the basic Outlook Express interface. On the Tools menu at the top of the screen, select Accounts. Then click the Mail tab on the Internet accounts window. Click the Add button on the right side of the window, and then click Mail. The Internet Connection Wizard appears, which will lead you through a series of steps where you will enter your username, password, and so on. Have this information ready, and then follow these easy steps to complete the wizard:

1. Enter your display name. This is the name that you want other e-mail users to see when you send mail. Typically, you want to use your real name here
and not something that can’t be recognized, such as “Biker Dad” or “Sweet Cakes.” However, if you want to be known by a nickname, that’s okay, too.

2. In the next window, shown in Figure 10-1, enter your e-mail address and click Next. If you already have an existing account, you can use that, or you can set up a free Web-based e-mail account on the Internet with Hotmail, which is a part of MSN.

*Hotmail is not the only free Web-based e-mail that is available. Yahoo.com, Netscape.com, Go.com, and many others also offer free e-mail accounts.*

3. In the next window, you’ll need to enter your e-mail server information, as shown in Figure 10-2. Almost all e-mail servers use POP3 (Post Office Protocol) to manage e-mail messages. Outlook Express needs to know if your server is a POP3 server, or a different kind of server, such as IMAP or HTTP. Check your ISP documentation. Then, enter the incoming mail server name and the outgoing mail server name. Typically, both of these

![Internet Connection Wizard](image)

*FIGURE 10-1* Select an existing or Web-based e-mail account.
names will be in the form of `mail.mydomain.com`. You’ll need to check your ISP documentation to know for sure. Enter the correct information, and then click Next.

4. In the next window, enter your logon name and your password. Check your ISP documentation to make certain you are entering the correct information—and do remember that passwords are case sensitive. Also, you should not select the secure password authentication check box at the bottom of the window unless your ISP documentation explicitly tells you to do so.

5. Click Finish to complete the wizard.

Outlook Express has the capability to support multiple accounts for the same user. For example, let’s say you have a primary ISP with an e-mail address of `myaddress@myisp.com`. However, you also have an e-mail account at `youraddress@youraddress.com`. Can you use Outlook Express to access information on both of those accounts?

Sure! All you need to do is configure both mail accounts using the previous steps. When you check your mail, Outlook Express will check both accounts.
Checking Out the Outlook Express Interface

Outlook Express provides an easy-to-read and easy-to-use interface where you can quickly view e-mail messages. By default, Outlook Express uses four major panes to separate different mail components. These four panes, or views, make mail usage easy, and you can customize this interface as well (I show you how later in this chapter). Figure 10-3 gives you a look at the default Outlook Express interface.

Let’s first take a look at your menu options. At the top of the Outlook Express window, you see common menus, such as File, Edit, View, Tools, Message, and Help. You have the standard options on these menus, such as open, save, cut, and paste; but you also have quite a few that are specific to Outlook Express. The following list highlights the most important features:

- **File** Using this menu, you can perform standard open and save functions; however, you can also create additional mail folders in which you can store mail. You can also import and export mail settings, messages, and address
books to and from other e-mail programs. You can also use this File menu to establish different identities. This way, two different people can send and receive mail using a single Outlook Express program. All of these options are easy and self-explanatory, but I’ll explore the Identities feature later in the section “Using Identities.”

- **Edit**  The Edit menu contains typical editing functions. Use the Edit menu to delete e-mail, move e-mail between folders, mark e-mail messages in various ways, and perform other standard editing tasks.

- **View**  You use this menu to change how current messages are viewed, as well as how the entire Outlook Express interface appears. See the “Changing Outlook Express Views” section later in this chapter for more information.

- **Tools**  The Tools menu enables you to send and receive e-mail, configure message rules, and customize Outlook Express. All of these items are explored in more detail later in this chapter.

- **Message**  The Message menu contains typical message functions, most of which you can perform using a toolbar button. You can also use this menu to block senders, create message rules, and “watch” messages or discussions. You can use Outlook Express to connect to newsgroups and flag messages so you can watch the message and all the replies. This is a great way to organize and keep track of information that is useful to you.

- **Help**  Get help from the Outlook Express help files or on the Microsoft Web site.

Below the menu bar, you see the standard Outlook Express toolbar. You’ll use this toolbar quite a bit when working with Outlook Express. You have the following standard buttons:

- **Create Mail**  Click this button to start a new mail message.

- **Reply, Reply All, and Forward**  If you select a message, you will see these options appear. You can reply to a message, reply to all message recipients, and forward a message to someone else.

- **Print**  Select a message and click this button to print the message.

- **Delete**  Select a message and click this button to delete a message.
Send/Recv  Click this button to see a drop-down list of choices. You can Send and Receive, Receive All, and Send All.

Addresses  Click this button to open the Address Book.

Find  Click this button to find specific messages. You can search by sender, message subject, or keywords.

The final part of the Outlook Express interface is comprised of the four primary panes, which are

Folders  The top-left pane shows your Outlook Express folder structure. You can easily move between your inbox, outbox, sent items, and deleted items, as well as additional folders that you can create using the File menu.

Contacts  The bottom-left pane shows your contacts. Contacts are people to whom you have sent e-mail. Outlook Express keeps up with your contacts and their e-mail addresses by maintaining this list for you.

New Mail  The top-right pane contains a message list. These are messages that you have received, but not deleted or moved into another folder.

Preview  The bottom-right pane contains the text of the selected message. This is an easy preview that allows you to skim through your messages without actually opening them.

Sending and Receiving E-mail

Once you have an account set up, you can send and receive e-mail. Sending and receiving e-mail is very easy, and the following sections show you how.

Sending an E-mail

To send a new e-mail message, just click the New Mail button on your toolbar. A new mail message appears, as shown in Figure 10-4. To send a new mail message, just type the recipient’s e-mail address in the To line and any additional e-mail addresses in the Cc line (if you want other individuals copied), enter a subject, and then just type your message in the provided message box—it’s that easy!
When you enter a subject, be as descriptive as possible. E-mail users will often get many e-mails on any given day. Descriptive subjects help identify important messages. Also, if your message is very important, you can attach a “high priority” notice with it. Just click the Message menu, point to Set Priority, and then click High.

When you’ve finished with your message, just click the Send button. You can now type another message if you would like. If you are currently connected to the Internet, the message is immediately sent. If you are not currently connected to the Internet, click the Send/Recv button on your Outlook Express toolbar. Doing this launches an Internet dial-up connection so the message can be sent.
Attaching a File to an E-mail

If you want to send an e-mail with an attachment, which is just a file of some kind, you can easily do so. Just click the New Mail button on your Outlook Express toolbar and follow these steps:

1. Enter the recipient’s e-mail address, cc addresses if desired, and a subject, and then type any text in the message area.

2. To attach a file, click the Insert menu, and click either File attachment or Picture. (You can also choose to include the text from a file, which enables you to browse for the file, and copy and paste the text from it.)

3. A browse window appears. Browse to the location of the file, and then select it.

4. Click the Attach button. The file now appears in your New Message window as an attachment, as shown in Figure 10-5.

Want to know an easier way to attach a file to a message? Just shrink your message window so you can see your Desktop, and then locate the file you want to include. Drag the file into the message portion of the window. Its name will appear in the Attachment line.

About Advanced Message-Editing Features

Outlook Express supports advanced message-editing features. As you are typing your new message, notice that you have bold, italic, bulleted lists, and other button features on the message toolbar. You can also cut, copy, and paste message text as well. You can use the Format menu to use different color styles in your message, and even use a background picture or graphic with the Message menu. You can also check your message for spelling errors by clicking the Tools menu and then clicking Spelling.

All of these features are really nice, but do be aware that not all mail clients can receive these formatting features. Even though you style your text and add a background, some of your recipients may only see plain text.
Before sending an attachment, you should consider putting the attachment(s) in a new folder and compressing the folder. Doing this makes your transmission time shorter. To learn more about folder compression, see Chapter 4.

Receiving Messages

When you are ready to check for messages, just open Outlook Express and click the Send/Recv button on your toolbar. Doing this launches an Internet connection, so mail can be downloaded to your computer. New messages appear in the New Message pane. If you click each message, you can read its text in the Preview pane, but do not assume that you see all of the message text in the Preview pane; scroll down with the slider bar to view all of the message. To open a message, double-click it. Doing this enables you to read the message in its own message window. Once you have received and read your messages, you can delete them or drag them to a desired folder for safekeeping.

FIGURE 10-5 Attach a file to your message with the Insert menu.

TIP
A great feature of Outlook Express is that deleted messages aren’t really deleted—they are just moved to the Deleted Items folder. You can click this folder and find a message that has been previously deleted, and reread it. You can also right-click the Deleted Items folder and click Empty Deleted Items to permanently delete the items if you need to free up disk space; however, I don’t recommend you choose this global delete option. Invariably, you will need to refer to a mail item you thought you no longer needed.

Receiving Attachments

Any attachments that are sent to you are automatically downloaded with the mail message. Messages with attachments have a small paper clip beside them in the New Message pane. In the Preview pane, you see a larger paper clip on the right side of the window. If you click the paper clip, a pop-out menu appears where you can either choose to open the attachment or save it to your computer (such as in the My Documents folder or your Desktop), as shown in Figure 10-6.

![FIGURE 10-6](Click the paper clip to get an e-mail attachment.)
Did you know?

About E-mail and Computer Viruses?

There’s a lot of talk and confusion about computer viruses and e-mail—and rightfully so. Computers do get viruses from e-mail. However, it is important to note that you cannot get a computer virus from simply the text of an e-mail. For example, let’s say you download your mail, you select a message, and the contents of the message appear in the Preview pane. Let’s say you even open the message and read it. You cannot get a computer virus this way. Computer viruses always come in the form of some kind of attachment. Opening an attachment can give your computer a virus. Virus attachments normally contain some kind of executable code that launches on your computer and does all kinds of annoying and nasty things. In short—don’t open attachments from someone you don’t know. Also, watch for the .exe and .vbs extensions on attachments (such as attachmentname.exe or attachmentname.vbs). These are executable files and are more likely to contain viruses than other attachments, such as a picture file. There are also “macro” viruses that can hide within word processing documents, such as a Microsoft Word document. All major brands of antivirus software include an “e-mail scan” feature that can check your e-mail attachments for viruses before you open them. This software is very inexpensive and a great investment.

Changing Outlook Express Views

As we have discussed, Outlook Express has a four-pane option that I think is great. However, you may not think it’s so great and you may want to change it. That’s fine, and easy to do as well. To change the appearance of the Outlook Express interface, click the View menu and click Layout. A single layout window appears, as shown in Figure 10-7.

As you can see, you have two sections—Basic and Preview Pane. You can select or clear the various check boxes to choose the different panes that you want. You can try different settings to find the one that you like best. Also, if you click Customize Toolbar, you can add other toolbar icon features, which are discussed in more detail in Chapter 3.

Aside from using the Layout feature, you can also customize the Current View, which enables you to determine which messages are displayed and which are hidden.
You can use different views by clicking the View menu and then pointing to Current View. You can then select a desired option from the pop-out menu. As with an appearance configuration, you may need to play around with the settings to find the ones that are right for you.

**Creating Message Rules**

Message rules enable you to control how various messages are handled by Outlook Express. Message rules are most helpful to people who receive a lot of e-mail or who receive a lot of “spam,” or junk e-mail. You can set up rules to help you manage messages so that Outlook Express can automatically delete certain messages or move certain messages to other folders.

Rules are easy to create, but be careful of “overdoing it.” Too many rules usually become more confusing than helpful, so plan carefully before you create a bunch of e-mail rules. Make sure you have a specific reason for a rule or specific problem you want the rule to solve.
Creating a New Rule

To create a new rule, just follow these easy steps:

1. In Outlook Express, click the Tools menu, point to Message Rules, and then click Mail.

2. The New Mail Rule window appears, as shown in Figure 10-8. In the top portion of the window, select a condition for your rule. Scroll through the list and click the check box next to the desired condition.

3. In the second portion of the window, select an action for your condition. Scroll through the list and click the check box next to the desired action.

4. Depending on your selection, you may need to enter a rule description or perform some editing. If a link appears (blue underlined wording), click on it to enter some additional information that is needed for the rule.

5. In the bottom of the window, give the rule a friendly name and then click OK.

FIGURE 10-8 Use this window to create new mail rules.
Managing Message Rules

Once you create message rules, you can manage them from the same Mail Rules interface. Just click the Tools menu, point to Message Rules, and click Mail. A window appears listing your current rules. You can use the provided buttons to create new rules, delete existing rules, edit existing rules, and perform related management features. This interface is very easy to use and self-explanatory.

Blocking Senders

Let’s say you meet Chatty Cathy in a chat room and you make the mistake of giving Chatty Cathy your personal e-mail address. Now Chatty Cathy writes to you everyday and sends you piles of junk mail. You decide you really don’t like Chatty Cathy and you don’t want any more mail from her. What to do? No problem. You can block Chatty Cathy so that your computer automatically moves Chatty Cathy’s mail to the Deleted items folder without informing you of the mail.

To use the Blocked Senders option, just click the Tools menu, point to Message Rules, and click Blocked Senders list. A simple window appears. Click the Add button, enter the e-mail address of the sender you want to block, and click OK. The sender appears in the Blocked Senders list, shown in Figure 10-9. You can modify this list at any time.

You can also use the Message menu to immediately (and easily) add a new person to your Block Senders list. When you get a message from someone and you know you don’t want any more messages from that sender, just select the message in Outlook and then click the Message menu and click Block Sender. That’s all you have to do. Additionally, you can also use the Message menu to create a rule from the message. Just select the message, click Message | Create Rule from Message, and you’ll see the same New Mail Rule window appear. These options just give you quick and easy access to the rule and Block Senders features of Outlook Express.

Using Identities

Let’s face the facts—everyone wants to use a computer, and no matter whether your Windows XP computer is a home or office computer, you may have multiple users. Microsoft recognizes this fact and has given you a number of new tools in Windows XP that enable you to easily manage multiple users on the same computer. Outlook Express also supports multiple people using Outlook Express with Identities. With Identities, several people can use Outlook Express and Outlook Express’s
Address Book. You see only your mail and your contacts, so it’s as though you are the only one using the mail client.

It's important to note here that Outlook Express provides only a moderate amount of security. You can require that different people log on to Outlook Express with a password, but your private folders are not really protected from someone who wants to snoop through them. The point here is that Outlook Express provides identities for a multi-user computer, primarily for home users where family members are not likely to spy on each other’s mail.

Creating an Identity

By default, Outlook Express creates the first identity for you, called “Main Identity.” If you are the only person using Outlook Express, then you are the Main Identity, and you don’t need to configure anything else. However, if you want additional people to be able to use Outlook Express, then you need to create identities for them. Creating and Managing Identities is very easy. To create a new identity, just follow the steps in the How To box.
Managing Identities

Once you have created the identities for Outlook Express, you can switch between them at any time. For example, let’s say that my wife wants to use Outlook Express to check her e-mail. She can simply open Outlook Express and then click File | Switch Identity. The Switch Identities dialog box appears, as shown in Figure 10-10. She simply selects her name from the list, enters a password if one is required, and clicks OK. The Outlook folders will change to her folders, and she is all set to check her mail, send mail, create message rules, or whatever else she needs to do.
Aside from adding identities and switching identities, you can easily manage them by clicking File | Manage Identities. This option opens a simple window where you can add or delete identities, and change passwords as needed. On this window, you can also choose a default identity, which Outlook Express opens to each time it is started. By default, the Main Identity is used each time Outlook Express is started, but you can easily change this setting by using the drop-down menu.

**FIGURE 10-10** The Switch Identities dialog box

Aside from adding identities and switching identities, you can easily manage them by clicking File | Manage Identities. This option opens a simple window where you can add or delete identities, and change passwords as needed. On this window, you can also choose a default identity, which Outlook Express opens to each time it is started. By default, the Main Identity is used each time Outlook Express is started, but you can easily change this setting by using the drop-down menu.

**Did you know?**

**About Identities and Accounts?**

When you first open Outlook Express, you need to create an account that tells Outlook Express how to check your mail, as well as where to send mail. Your account is specific to you—it contains your username and e-mail address. When a new identity is created and you switch to that identity for the first time, the Internet Connection Wizard will once again appear so that an appropriate account can be created for the new identity. This includes setting up a display name, e-mail address, mail server information, and so on. You’ll have to do this only one time, and Outlook Express will keep track of which identity uses which account.
Managing Your Accounts
When you first begin using Outlook Express, you set up an account so that your computer can send and receive e-mail from your ISP. Over time, that account information may change, or you may need to add other accounts. You can make changes to your accounts by clicking the Tools menu and clicking Accounts. This action opens a window where you can view your current mail account, news account, or even directory service account. Use the provided buttons to create a new account, edit an existing one, and perform other related account management tasks. Before making changes to an account or creating a new one, remember that you will need information from your ISP for the correct username, password, and e-mail server information.

Customizing Outlook Express
Outlook Express contains quite a few customization options that you can access by clicking Options. There are several tabs, but the good news is that each tab is rather easy. Most simply give you a list of check box options to choose from. The following list gives you an overview of what you can do on each tab. Remember, you can try different settings and change them later if you don’t like them, and one of the best ways to find the settings that work for you is to simply experiment with them.

- **General**  This tab contains information about the way your computer receives messages. The default options are all you need on most of this tab. If you want Outlook Express to automatically check for messages by launching a dial-up connection at specified intervals, you can select the option on this tab and enter the amount of time you want between checks (such as 30 minutes or so).

- **Read**  This tab contains settings for messages you have received. You can choose to view messages in various colors and fonts.

- **Receipts**  Some messages you receive (or send) can request a receipt—which is just a return e-mail notification that the message was read. Use the tab to enable this feature and determine how it should be used.

- **Send**  This tab contains basic settings for sending messages. Almost all options are enabled by default, and you should probably keep these options enabled for the best functionality.
I Compose  Use this tab to select font settings, business card settings, and to attach stationery to your e-mail messages. Remember that not all mail clients can read these style features.

I Signatures  You can automatically add a signature—such as your name and phone number—to all new messages you type. Use this tab to enter the text you want for the signature.

I Spelling  Use this tab to enable automatic spelling and spell settings.

I Security  If you want to use encrypted mail with digital certificates (which you probably won’t), use this tab to enable the option.

I Connection  This tab contains information about your dial-up connection. One item of interest here is that you can tell Outlook Express to automatically hang up the dial-up connection once mail has been sent and received. If you use the General tab to automatically dial a connection to get mail, you should use this option on the Connection tab so those dial-out sessions will be automatically terminated (unless you want your computer tying up the phone line all day).

I Maintenance  This tab contains options for Outlook Express to handle deleted items. The default settings are all you need here.

Using the Address Book

A great feature of Outlook Express is the Address Book. You can use the Address Book to store e-mail addresses, as well as postal address, phone numbers, and all kinds of other information. The Address Book is fully searchable and easy to use.

You can access the Address Book by clicking on the Addresses icon on the Outlook Express Taskbar. The Address Book provides you with a simple interface list of your contacts or groups, as shown in Figure 10-11.

Adding a Contact

You can easily add a contact to the Address Book by clicking the New button on the toolbar and clicking Contact. A window appears, shown in Figure 10-12, where you can enter the contact’s information. Notice there are several tabs where you can enter all kinds of information. You only need to complete the tabs you want—you can enter very little or a lot of information about each contact. When you have entered all of the desired information, just click OK. The new contact will be added to your contacts list.
FIGURE 10-11  Use the Address Book to keep track of people.

FIGURE 10-12  Enter the desired information for the contact and click OK.
Add Members to a Group

Once you have created a new group, you can easily add and remove members at any time. Just follow these steps:

1. Locate the group in your Address List.
2. Double-click the group icon to open the Group.
3. Click the New Contact button and enter the contact’s name and e-mail address and click the Add button.
4. Repeat step 3 to add more contacts to the group.
5. You can remove any contact in the group by right-clicking the contact in the contacts window and clicking Delete.
6. Click OK when you’ve finished.

You can use the same New feature to create a group. You can use the group feature to group your contacts as needed. Many users create a Distribution List of people to send fun e-mail to. When you want to send the group a message, just enter the group name on the To line of your new mail message, and everyone in the group will receive the e-mail. If you e-mail the same messages to a lot of people, this feature can make your life much easier.

Managing Addresses

As you can see, you can easily manage your Address Book by using the buttons on the toolbar. You can add new contacts or groups at any time, delete contacts or groups, launch a mail message from the Address Book, find contacts, and print the list. If you need to change a contact’s information, just select the contact in the list and click Properties. You can then make changes as needed. All of these features are quick and easy.
Managing Address Book Identities

As I noted in the “Using Identities” section, the Address Book is tied to your particular identity. When you log on to Outlook Express with a particular identity, your Address Book is set up for you. In actuality, the Address Book gives you a folder where all of your contacts and groups are stored and not mixed up with other users’ contacts and identities. This feature is useful and does not require any additional configuration from you—Outlook Express handles it automatically.

However, what if you want to switch identities while using the Address Book? When you’re using Outlook Express, it is important to keep in mind that the Address Book is tied to your identity—you can’t directly switch identities within the Address Book while in Outlook Express, but you can if you access the Address Book from the Accessories menu instead of Outlook Express. Just click Start | More Programs | Accessories | Address Book. The same Address Book opens, but if you click the File menu, you’ll see the option for switching identity (which does not appear if you access the Address Book within Outlook Express).

Now you might wonder: why go to all of this trouble? The answer is simple. If you are using Windows XP and you need to reference an e-mail address, the Address Book is provided in Accessories so that you do not have to open Outlook Express to access it. The identity-switching option is provided in Address Book so that if you are logged on to Outlook Express with one identity, but need to access the Address Book using another, you don’t have to wade through Outlook Express to switch identities first. In short, this option is provided to speed up your work and to make your life easier.
How to...  
- Plan a Home Network  
- Create Your Home Network  
- Use Internet Connection Sharing  
- Use My Network Places  
- Use a Direct Cable Connection

Windows XP continues the tradition first started in Windows Me of giving users easy-to-use tools for quickly creating home networks. Home networking in Windows XP has never been easier; and if you are interested in networking two or more home computers (or even a small office), this chapter is just for you. If your Windows XP computer is already a part of a corporate local area network, don’t worry: Windows XP contains all of the powerful networking features of Windows 2000 and some new features as well. We will consider all of these issues in the next three chapters. For now, however, let’s get our feet wet by talking about home networks and small office networks, and then you’ll see what Windows XP offers to make networking easy.

Windows Networking Basics

Before you jump into the home networking area, you need to know a few basics about what it takes to create a home network. Networks, on a simple level, require both hardware and software in order for one computer to communicate with another computer. First, computers have to be equipped with a network adapter card. Like a sound or a video card, a network adapter card is an internal card that fits into an expansion slot on your computer. The network adapter card enables information to flow to and from your computer. In the past, a special cable, usually an RJ-45 cable (which looks like a large telephone cable), connected to the network adapter card. The cables from all of the computers connected through a device called a **hub**, which is just a small piece of hardware with a bunch of ports. The hub routes information to and from computers so that the information travels to the right one.

Now if all that sounds a little overwhelming, don’t worry, there are other alternatives. With the growth of home networking, a number of solutions are
available where cabling and a hub are not needed. For example, you can purchase network adapter cards that plug into your phone jacks. The computers use the existing phone wiring in your house to communicate with each other at no expense and interruption to you. Some versions also use power outlets and even wireless technology so your PCs and peripherals can communicate with each other. The key is to shop around and find a solution (and dollar amount) that works best for you. And you can still use standard networking cabling and hubs (I do), which are not terribly expensive.

Many computers come equipped with a standard network adapter when you purchase them. Check your computer documentation to find out.

Besides the hardware, the Windows XP software must also be configured for networking. This includes turning on Microsoft file sharing and printer sharing, and configuring the TCP/IP protocol so that computers can understand each other. Fortunately, in Windows XP you get help in setting all this up from the new Home Networking Wizard, which we’ll explore later in this chapter.

TCP/IP (Transmission Control Protocol/Internet Protocol) is an advanced topic and one that leaves even network administrators with severe headaches from time to time. Fortunately, Windows operating systems have evolved to help humans deal with TCP/IP. In a TCP/IP network, each computer must have a unique IP address, which is a series of numbers, such as 131.107.2.200. In order for computers to communicate, you must configure each computer with an appropriate IP address in the same IP class as the other computers. Actually, it’s all more complicated than this, but you can see that it’s great to have Windows XP set this up for you. Windows XP, like Windows 98/Me/2000, can give itself a private IP address in an appropriate range reserved for small networks. Windows XP does all the work, and you don’t have to do anything—which is really nice!
Planning Your Home Network

Before trying to configure your Windows XP computer for networking, you have a few tasks to complete to make sure your home networking experience will be a positive one. I’ve arranged these tasks into a quick and easy, step-by-step format, so make sure you perform these before moving to the next section in this chapter.

1. If you have only one Windows XP computer, it needs to be the primary computer. For example, if you are using Windows XP and another computer uses Windows 95/98 or Me, Windows XP will be the primary computer on your network (sorry, using Windows 3.x is not supported). Shared peripherals, such as a printer or scanner, should be connected to the Windows XP computer. If you want to share one Internet connection, it should be on the Windows XP computer (especially if you are using a broadband solution, such as DSL)—although this is not a mandatory requirement, it does make the entire process a lot easier. Of course, if you have multiple peripherals, other computers can share those; but just remember that Windows XP will be your primary, or server, machine for your home network.

2. Make a list of all the hardware you will need. Inspect your computers to determine whether you have available expansion slots, or whether some computers already have a network adapter card. You’ll need to determine what kind of network you want (whether to use typical wiring or phone wire, for instance). You can learn more about these different kinds of networks on the Web or from your local computer store. Keep in mind that some solutions provide faster network transfer speeds. If your budget allows it, always go for the fastest solution you can obtain. Also, many home networking hardware components are sold as a single kit with a single instruction list. These kits are great solutions, as they make certain you have everything you need. Check out your favorite computer store for details.

   Your computer has different kinds of expansion slots. The most common used for a network adapter card are PCI and ISA (although you can use USB in some cases). More than likely, you will have available PCI slots, so you’ll want to buy a PCI network adapter. Consult your computer documentation for more information.

3. Once you determine which type of network you will use, buy the required hardware pieces and install them. Follow the manufacturer’s guidelines during the installation process.
Your computer must be powered down and unplugged from its outlet before installing a network adapter. See Chapter 6 for more information about managing hardware.

4. Check to make sure your computers and peripherals are connected together correctly, and check your Internet connection as well. Access the Windows XP Help files and search under “home networking” for more information.

**Understanding Internet Connection Sharing (ICS)**

ICS, first introduced with Windows 98, enables you to have one computer connected to the Internet and all other computers on the network share the Internet connection. This feature is specifically designed for home networks or small office networks with ten or fewer computers. Why is ICS so helpful? With ICS, you need only one Internet connection and one piece of hardware—each computer does not need its own modem or broadband hardware (such as a cable modem or DSL connection). Through sharing, you save money and aggravation because you don’t have to configure each computer for Internet use.

While you are designing your home network, you need to decide whether you want to use ICS. On a practical note, ICS is designed for use with broadband Internet access (such as ISDN, DSL, cable, or satellite). Although you can use ICS with a 56K modem, your modem will operate very slowly if several people are trying to use the Internet connection at the same time. This effect results from the 56K modem’s lack of sufficient bandwidth to perform at a desirable speed. However, if users on your network do not access the Internet at the same time, the 56K modem’s shared connection will be fine.

When you use ICS, your Windows XP computer should be the ICS “host.” All other computers on your network, called ICS “clients,” access the host to get information from the Internet. So, all Internet communications flow from your home network to the host computer and then to the Internet, and vice versa. Using this setup, your host computer has a connection to the Internet and a connection to your home network. All of the client computers need only a network adapter so they can connect to the host (again, versions of Windows earlier than 95 need not apply). As far as the Internet is concerned, it only appears as though one computer is accessing the Internet. You don’t have to use the Windows XP computer as the host—you can use a different computer, such as a Windows Me, but you will have fewer operational problems if the XP computer is the ICS host.
ICS does not work with some versions of AOL. Check with AOL to see whether your version is supported. It is also possible, although unlikely, that your ISP will charge you for multiple computer connections to the Internet. Check with your ISP to make certain you will not receive additional charges (and if you do, I would suggest you shop elsewhere).

Using the Home Networking Wizard

Once you have all of your hardware and your computers are connected to each other, you can run the Home Networking Wizard, which will set up home networking on your computers. The Home Networking Wizard is supported only on computers using Windows 98, Windows Me, or Windows XP. The following steps walk you through the Home Networking Wizard.

**Tip** You may have a custom setup CD, especially if you purchased a home networking kit. Refer to the kit’s documentation about setup, but if you have a custom CD for the kit you purchased, you need to use the kit’s setup program instead of the Home Networking wizard.

1. Turn on all computers on your home network so they are all booted and operational.

2. On your Windows XP computer, click Start | All Programs | Accessories, Communications | Networking Wizard.

3. Read the information on the Welcome screen and click Next.

4. The next window gives you more information about home networking. Make sure you have completed the preparation tasks listed, and then click Next.

5. The Select a Connection Method window appears, as shown in Figure 11-1. Essentially, the radio button options here ask you to describe how the XP computer connects to the Internet. (I’ll assume that the XP computers connect to the Internet, and the other computers on your network will connect to the XP computer.) Select the desired radio button, and then click Next.

6. The Internet Connection window appears. In the box listing all entries in your Network Connections folder, select your connection to the Internet; then click Next.

7. If you’re using a dial-up connection, then the wizard will prompt you to dial a connection to the Internet.
8. In the provided window, enter a description for your computer and a desired computer name. Take note that if you are using a cable broadband connection to the Internet, you should probably not change the name of your computer, because the Internet Service Provider (ISP) may require a certain name.

9. Review the changes that will be made to your computer and click Next. Windows XP automatically configures all of your computer’s software and hardware components for networking, according to the selections you made when running the wizard.

10. Click Finish. You will need to restart the computer for the new changes to take effect.

Once you have run the Home Networking Wizard on the XP computer, you need to run the wizard on each computer that you want to include in the home network. You can use your Windows XP CD-ROM to run the Home Networking Wizard on those computers.
So what do you do if you have problems connecting the computers together? Or what if you are really curious and want to know what the Home Networking Wizard did to your computer? The way to solve both of these problems is by checking out the properties of your local area connection, which is found in the Network Connections folder. Right-click the Local Area Connection, and you will see a General properties tab in the Local Area Connection Properties window (see Figure 11-2). Make sure that Client for Microsoft Networks, File and Printer Sharing for Microsoft Networks, and Internet Protocol (TCP/IP) are all selected—do not unselect them!

Essentially, the communications protocol (TCP/IP) is configured so that your computer can talk with other computers, and the client and file/printer-sharing software is configured so that your computer can function on a Microsoft network with other Windows operating systems. The computers on the network can share folders, printers, drives, and just about anything else. Just right-click the item you want to share and click Sharing to configure. See Chapter 4 for more information about sharing folders.
If you select Internet Protocol and click Properties, you will see that the Home Networking Wizard has given your computer an IP address and a subnet mask value, as shown in Figure 11-3. We can’t go into the intricacies of TCP/IP here, but I would bet your IP address is something like 192.168.0.1. If you are having problems connecting another computer on your network to the XP computer, try adjusting the problematic computer’s IP address and subnet mask. For example, you might want to give the other computer an IP address of 192.168.0.2 (or .3, or .4, or whatever). Just give the computer the same IP address as the XP computer with the exception of the last number (all IP addresses have to be unique—you can’t give two computers exactly the same IP address). Use the same subnet mask on each computer (computers cannot see each other if different subnet masks are used). Click OK; make sure Client for Microsoft Networks and File and Printer Sharing for Microsoft networks is enabled, and then click OK to exit the properties pages. After rebooting, the computer should now be able to share information. Again, if everything works according to plan, you would not have to make changes to any of these settings yourself—the Home Networking Wizard should do it for you.

**FIGURE 11-3** IP address values
Once the Home Networking Wizard has been run on your computers or you have fooled around with the local area connection settings manually, you can open My Network Places and see the other computers that are available on your network.

**Setting Up Your ICS Clients**

If you decided to use ICS, you now have an ICS host and ICS client(s). In order for your client computers to access the ICS host, you need to tell Internet Explorer, Outlook Express, and any other applications that use the Internet how to access the Internet through the ICS host. Without this configuration, your applications will think your computer has a direct connection to the Internet. This configuration is easy, and this section shows you how to make the change with Internet Explorer and Outlook Express. If you are using other browsers, e-mail clients, or applications, consult their documentation for specific steps—it will be very similar to what you learn here.

**Internet Explorer**

To configure Internet Explorer to access the Internet through the ICS host, just follow these easy steps:

1. Open Internet Explorer. If you get an error message about connecting to the Internet, click OK.

2. Click the Tools menu, and then click Internet Options. Click the Connections tab.

3. On the Connections tab, select any existing dial-up connections in the window and click Remove.

4. Because you have configured your computer for ICS with a host computer during the Home Networking Setup Wizard, your computer should use the default LAN setting to find the shared connection.

**Outlook Express**

To configure Outlook Express to access the Internet through the ICS host, you do not need to perform any configuration if you configured Internet Explorer. Outlook Express uses the connection settings Internet Explorer uses, so you don’t need to do anything with Outlook Express.
Using My Network Places

My Network Places is an icon on your Desktop that you can use to browse your network. With this feature, you can see all the computers on your network, and you can see what resources each computer shares. You can also right-click My Network Places on your Desktop and click Properties to see the specific network configuration, which is the same thing as opening the Network Connections folder.

When you open My Network Places, you will see a number of items (exactly what you see will depend on your network). You can open Entire Network to see all of the computers on your network. You can double-click a computer icon to view the resources available. Any resources you access will show up in this folder for easy future access, and the Home Networking Wizard is also available from this location.

One item here you may find very useful is the Add Network Place Wizard, which appears as a Create a Network Shortcut action link in the Network Tasks section of the folder. The Add Network Place Wizard lets you easily add a folder to My Network Places for a network resource. This way, you can easily access the resource in the future just by opening My Network Places. To add a network place, just follow the easy steps in the following How To box.

How to ...

Create a Network Place

1. Click the Create a Network Shortcut icon in the Network Tasks box.
2. Click Next on the Welcome screen of the Add Network Place Wizard.
3. Select another network location or MSN to store Web data, and click Next.
4. If you want to connect to a network folder, a browse window appears where you can locate it. Locate the folder that you want and select it; then click OK.
5. Enter a desired name for the network place (make it a friendly name so you can easily locate it).
6. Click Finish to save the network place.
Creating a Direct Cable Connection

Consider this scenario: Let’s say you have a PC at home and a laptop computer at work. From time to time, you want to transfer files from the laptop to the PC, but you do not want the trouble and expense of setting up a home network just for these file transfers. You could e-mail the files to yourself and download them from home, but the files are multimedia files and you have only a 56K modem—downloading would make you old before your time. Now what?

This solution to this problem is quite easy—you can use a direct cable connection between the two computers to move the files. Windows XP makes this option very easy, too, because its own Direct Cable Connection is available. To create a direct cable connection, you need a serial or parallel cable that you can use to connect the two computers together (a printer cable usually works great). Once you have your cable ready, follow the steps in the upcoming How To box.

You must use the same port on both the host and guest. In other words, you can’t use a parallel port on one and a serial port on the other.

How to Create a Direct Cable Connection

1. Open the Network Connections folder and click the Make New Connection icon.
2. Click Next on the Welcome screen.
3. In the Network Connection Type window, select “Set up an advanced connection” and click Next.
4. In the Select the Type of Connection You Want window, you can choose either to accept incoming connections, which allows the other direct cable connection computer to connect to you, or to connect to another computer. Since you are setting this computer up to be the host, click Accept Incoming Connections, and then click Next.
5. In the Devices for Incoming connections window, select the cable method that you want, such as your printer cable or LPT1, and then click Next.
The host computer is now set up. Next, go to the guest computer and repeat these same steps—just select the “Connect directly to another computer” option on the first page. Once this is done, you can move files between the computers through the connection.

6. You see a window asking whether you want to allow VPN connections. Click the Do Not Allow Virtual Private Connections radio button; then click Next. You can learn more about VPN connections in Chapter 12.

7. In the User Permissions window, select the check boxes next to the users who are allowed to connect to your computer, and then click Next. See Chapter 13 to learn more about user accounts.

8. The Networking Software window appears. Accept the default selections and click Next.

9. Click Finish to create the connection.

The host computer is now set up. Next, go to the guest computer and repeat these same steps—just select the “Connect directly to another computer” option on the first page. Once this is done, you can move files between the computers through the connection.
You can actually configure both the host and guest as direct cable connection computers by selecting the Connect Directly to Another Computer radio button. The next screen asks you to select either host or guest. You may find using this route quicker and easier.
Chapter 12
Advanced Networking
How to…

- Get to Know IIS
- Understand XP on a Corporate Network
- Use Virtual Private Networking
- Use Phone Dialer and HyperTerminal

In Chapter 11, you explored the primary features and functions of Windows XP networking. Windows XP makes networking a snap with built-in tools and features that help you create a home network in no time. However, Windows XP is also a complex networking system, able to function in large corporate environments and able to provide a number of advanced networking services and features. In this chapter, we’ll explore some of those networking features that XP makes readily available. It is important to note that this chapter applies primarily to Windows XP Professional, and the concepts and information presented here are intended primarily for Windows XP in a local area network—although some features can also apply to home or small office users. Also, some of the topics presented in this chapter are rather complex, so this chapter will also serve as a basic introduction to these more complex topics. For example, I’ll address Internet Information Services briefly, but you should be aware that entire books are available on IIS alone. So, if you’re ready to begin digging a little deeper into Windows XP networking, then this chapter is just for you.

Internet Information Services

Internet Information Services (IIS) is software that enables your Windows XP computer to function as a Web server. Available on Windows XP Professional, IIS allows your computer to host both Internet and intranet sites and make those sites available to other users. IIS, which was first introduced back in the Windows NT days, has come a long way over the past few years; because Windows XP is so versatile, IIS can function on XP rather than on a back-end server.

You can install all the IIS components using Add/Remove Programs and Add/Remove Windows Components. If you select Internet Information Services and click the Details button, you can review the various support services that you can install on your Windows XP computer, as shown in Figure 12-1.
As you can see in Figure 12-1, the installed IIS components enable your Windows XP to support a number of Internet services, such as the World Wide Web, FTP, and even Microsoft FrontPage. You can then use Web authoring tools, such as FrontPage, to create Web sites and then publish them on your computer.

IIS provides a management console called Internet Information Services, shown in Figure 12-2, which is found in your Administrative Tools folder in the Control Panel. When you publish a Web site on your computer using FrontPage or a related tool, you can then open Internet Information Services and view the Web site files, view and manage the properties for the Web site, create new virtual directories for the Web site, and so on. You can think of IIS as being the back-end software that manages the Web site and makes it available for users to access.

As I mentioned in the introduction, IIS is a complex topic; if you plan to use IIS to host a Web site, you’ll need to spend quite a bit of time studying it and examining connectivity issues with your computer. If you are on a corporate LAN and your computer will be used for an Internet or intranet site, you will certainly get help from network administrators. Otherwise, if you want to begin learning more about IIS, you can start with the Help menu in Internet Information Services, which provides a lot of information about this service.
If you are using Windows XP Professional at home and you have a broadband connection (such as DSL or cable), I would recommend that you do not install any IIS components. Doing so may create security holes in your computer and allow Internet hackers to get inside your files. Play it safe and keep the door closed to potential threats.

Disk Quotas

In the past few years, the concept of “user management” has become very important in networking environments. As networks have grown and the amount of data found on networks has grown, the need to manage users has taken hold in a number of different ways. One of those management methods is disk quotas, first introduced in Windows 2000.

Consider this scenario. Your XP computer resides on a network. It functions as your desktop computer, but it is also outfitted with three large hard drives. Users on your network store information in their own folders on those hard drives—effectively, your computer doubles as your desktop system and a file server. However, users have a tendency to store everything there, including pictures from Aunt Ruth’s birthday.
party and everything imaginable they have downloaded from the Internet. Because the storage availability on your computer is supposed to be for work-related files, the management of storage space becomes an issue.

Enter disk quotas. Disk quotas enable you to reserve a certain portion of hard disk space for each user and to enforce that “quota.” As users get close to their quotas, they receive warning messages telling them they are about to reach their storage limits. If they reach the storage limit, the disk quotas program can refuse to give them any more storage space.

The Quota feature is found as a tab on your computer’s hard drive’s properties pages, as shown in Figure 12-3. Disk quotas, which are configured for each hard drive individually, will be covered in more detail in Chapter 18.

**Windows XP in Windows Network**

It’s no secret that Windows XP is designed for high efficiency and operability in a Microsoft Windows XP or 2000 network. Windows XP is designed to take full advantage of all that Windows networking has to offer. You don’t have to be a networking guru
to understand this fact; and if you do work with Windows XP in an XP or 2000 network, you might hear some of these buzzwords from time to time:

- **Web Integration**  Windows XP is designed to use the Internet or an intranet without any difficulty. In fact, using the Windows XP default view, your computer acts more like a Web page anyway. When you jump to the Internet or an intranet, the information you see integrates with your folder views, so that your XP computer appears to be “one with the Internet.” With easy Web integration, networks can disseminate information to their employees more easily, and you can get what you need from the network more easily.

- **Active Directory**  The Active Directory is a Microsoft networking feature that enables administrators to organize and manage a highly effective and very large network. The Active Directory’s benefit from your point of view is simplicity. Using My Network Places, you can easily search your network and find what you need, and then you can create a network place so that it appears right on your computer. The Active Directory allows querying for all kinds of resources. For example, you can search for “printers” and find all of the printers in your network, or even just the ones in your department. The Active Directory is a powerful tool, and one that Windows XP makes full use of.

- **Group Policy**  Group Policy is a feature that network administrators use to manage user Desktops. Simply put, Group Policy lets administrators control the way your computer looks and what you can do with your computer. First introduced in Windows 2000, Group Policy is a powerful tool that allows administrators to configure your computer without any help from you, and even to install software without your intervention. On the down side, Group Policy allows network administrators to place restrictions on what you can and cannot do as well. The good news is that Group Policy is highly effective and makes computer environments easier to manage. Windows XP takes full advantage of Group Policy in Windows XP or 2000 networks.

- **Security**  In network environments, security is always a major concern. After all, you do not want intruders to gain access to computer data and steal company secrets. Windows XP provides the highest industry standards for security, and in a network environment, Windows XP can easily be configured to use the security standards that are in place for that network.
Virtual Private Networking

Virtual Private Networking (VPN) has been around for a few years, but it has recently become very popular. As a home user, you are probably not going to use VPN—but it is possible, and if you are part of a small office, you may find VPN quite helpful. If you are in a larger network, you may use a Windows XP laptop computer to connect to your corporate network using a VPN connection.

VPN enables Windows XP to create a private networking session using a public network. For example, let’s say you work for a company based in Seattle. You travel to Atlanta for a conference. While you are in Atlanta, you want to access your company’s network over the Internet. To ensure privacy, you can use a VPN connection. Or, what if your company has an intranet and you need to send very private files to another employee? You can create a VPN over the intranet for the file transfer.

**NOTE**

*Your private network must support VPN in order for it to work. Also, if your network uses an ISP to access the Internet, it must support VPN as well.*
Although Virtual Private Networking can be a complex topic, Windows XP makes the actual configuration of a VPN connection rather easy by using the New Connection Wizard. Before creating this connection, you’ll need to know the server or computer that your computer will be connecting to. This information is available from your network administrator. You will need to configure a dial-up connection using the phone number your computer needs to call in order to create the dial-up connection.

VPN uses a protocol called Point-to-Point Tunneling Protocol (PPTP). In order to send private communications over the Internet to and from a corporate network, PPTP hides the data you are sending inside a PPTP “packet.” A PPTP packet looks and acts like all of the traffic on the Internet, but it actually hides the real network data inside. Think of a PPTP packet as a Christmas present. The wrappings and paper hide what is inside the box. The PPTP packet allows the data to traverse the Internet unharmed. When it reaches the private network, the PPTP “cover” is stripped away, revealing the real data hidden inside. To use PPTP, both your private network and your ISP must support VPN. Windows XP also supports a new, more secure version of PPTP called Layer 2 Tunneling Protocol (L2TP). (This information may not be that useful to you, but you will sound cool throwing these terms out around the company water cooler.)
To configure a VPN connection, just follow these steps:

1. Click Start | Network Connections.
2. Double-click the New Connection Wizard, and then click Next on the Welcome screen.
3. In the Network Connection Type window, select the Connect to the Network at My Workplace radio button, and then click Next.
4. In the Network Connection window, click the Virtual Private Network Connection radio button, and then click Next.
5. In the Public Network window, select whether to automatically dial the connection and specify the connection you want to use. Click Next.
6. In the VPN Server Selection window, enter the host name of the computer you are dialing into or the IP address, as shown here.
When you're ready to create the VPN connection on your computer, refer to the steps in the How To box.

Allowing Other Computers to Connect to Your Computer

If you want to allow other computers to connect to your Windows XP computer, then you once again can use the Make New Connection wizards to configure your computer for incoming connections. to configure your computer for incoming connections, refer to the steps in the How To box.

How to ... Configure a VPN Incoming Connection

To configure a VPN connection, just follow these steps:

1. Click Start | Network Connections.

2. In the Network Connections window, double-click the Make New Connection icon and click Next on the Welcome screen.

3. In the Network Connection Type window, click the “Set up an advanced connection” radio button; then click Next.

4. In the Options window, click the Accept Incoming Connections radio button; then click Next.

5. In the Devices for Incoming Connections window, click the check box next to the device that you want to use to receive incoming connections (such as your modem). Click Next.
6. In the VPN window, you can choose whether to allow VPN connections to this computer. Choose either the “allow” or “do not allow” radio button, and then click Next.

7. The User Permissions window appears. Select the users who are allowed to dial in via this connection, and then click Next.

8. In the Networking Software window, you can choose the networking software that will be used. Typically, TCP/IP, File and Printer Sharing for Microsoft Networks, and Client for Microsoft Networks are selected. Click Next.

9. Click Finish.

Using HyperTerminal

HyperTerminal is an older utility included in Windows XP that enables you to directly dial another computer and trade files with that computer. You may be
thinking, “Wait a minute! Isn’t that what dial-up networking connections are for?”

Quite true, but the difference here is that you can use dial-up networking connections to connect only to other Windows computers. You use HyperTerminal to connect with computers that are not running Windows so that file transfer can occur. You can also use HyperTerminal to connect to computer bulletin boards and similar services. Obviously, the Internet replaces most of the need for HyperTerminal, since you can e-mail files to users on the Internet, regardless of what computer platform they are using. Still, HyperTerminal is useful to a number of people, and you can find it in the Communications menu in Accessories.

Essentially, HyperTerminal enables you to make connections to other computers. When you open HyperTerminal, a window appears, in which you can enter the name of the new connection and select a representative icon for it, as shown in Figure 12-4.

You then enter the phone number and configure dialing rules, much the same way you would for a typical dial-up connection. Once you enter the information, you can then call the remote computer and establish a dial-up session with it. Use the buttons on the toolbar to send and receive files, as well as manage the call.

![HyperTerminal](image)
How to Do Everything with Windows XP

How to…

- Understand XP Permissions
- Manage and Configure User Accounts
- Manage and Configure Group Accounts

Windows XP is designed to be a highly stable, highly secure desktop operating system for the home or office user. With Windows XP, you can easily allow other people to use your computer while preserving your settings and files. As far as users are concerned, each user can log in and log out of Windows XP and use the computer as if it were his or her own. For both the home user and the office user, this feature has far-reaching advantages. Managing permissions, users, and groups is not a difficult task, but there are a number of concepts you must remember and keep mind when working with these features of Windows XP. In this chapter, you will explore setting permissions, and how to manage and configure user and group accounts.

Understanding User Accounts

When Windows XP is first installed, there are two default accounts that are created: administrator and guest. The administrator account has control of the entire Windows XP computer—the administrator can do everything with the computer and make any changes he or she desires. The administrator account cannot be deleted or disabled, so you (as the administrator) could never lock yourself out of your own computer.

The second default account, the guest account, is provided for people who do not actually have a user account on the computer. The guest account does not require a password, but it also has no rights on the computer. The guest account is disabled by default, but it can be enabled if you need to use it.
So, Windows XP provides these two built-in accounts. From there, the issue of accounts and account configuration is all up to you. As you are reading this section, you may be wondering how accounts really affect you. If you are a home user and Windows XP is your primary home computer, you may be logging in with the default administrator account all of the time. This account gives you complete control over the system, and when I use Windows XP at home, that is what I do. Aside from default accounts, there are also user accounts that are created to meet the needs of an administrator. For example, at an office, you may have a user account so that you can use your computer as needed, but you can’t change anything on it. With your home computer you can, for example, use the administrator account yourself and configure other, more restrictive accounts for your kids or nosey neighbors—the choice is completely yours, and Windows XP makes user management easy.

There are three types of user accounts in Windows XP. The first is the administrator account, which is created by default. The administrator can make any change or do anything on the computer. The second type of account is the standard account. This account type is good for most other users. With the standard account, the user can install programs and hardware; change pictures and related personal data; and create, change, or remove his or her own password. The last type of account is the limited account. The limited account is the same as the standard account, except that the user cannot install new programs or hardware. This account type is great for kids, because it prevents them from adding or removing programs or hardware from the computer (which may end up putting you on the phone with technical support).

**Managing User Accounts**

You can easily manage user accounts in two different places within Windows XP—the Users icon in the Control Panel and the Computer Management console. We will start with the Users icon in the Control Panel. If you click the icon, the User Accounts window opens, which gives you an easy-to-use graphical interface, as you can see in Figure 13-1.
In the window, you see some tasks that you can perform and the current accounts that exist on your computer. You can easily create new accounts or change existing accounts, and the following sections show you how to perform these actions.

Create a New Account

You can create new user accounts at any time, giving others access to your computer. To create a new user account, follow these steps.

1. If you want to create a new account, click the Create a New Account link in the User Accounts window.

2. A New Account Name window appears. Enter the desired name for this new account and click Next.

3. The following window asks you to pick an account type, as shown in Figure 13-2. Choose either Computer Administrator or Limited by clicking
the appropriate radio button. If you’re not sure, select each one and read the bulleted list of actions that can be performed by the account type. When you’ve finished, click the Create Account button. The new account now appears in the User Accounts window.

**Changing an Account**

Any account that has been created can be easily edited or changed from the User Accounts window. One item that can be edited is the password, or you can create a password for an account, so that a password must be entered before logging on to the computer. Passwords provide security and prevent unauthorized individuals from logging on to a computer using someone else’s account. Depending on your needs, you may not want passwords attached to user accounts (such as for home use), but you should always keep the administrator account password protected so that little Johnny doesn’t decide to log on as you and remove all of your programs or delete your files.
In corporate environments, passwords are very important, and many highly secure environments go to great lengths to make sure passwords are complex enough that they cannot be easily broken. You may not need to worry about such matters; but if you are going to use passwords to protect your computer, you should use a combination of letters and numbers for the password, and it should be at least seven characters long. Also, passwords are case sensitive—Windows XP does not see CURT345 as the same password as Curt345. For security purposes, it is best to always use a combination of letters (both uppercase and lowercase) and numbers. The more random looking a password is, the more difficult it will be to break. Avoid using family names, pet names, phone numbers, birthdays, and other distinguishing words or numbers.

If you create passwords, Windows XP gives you the option of displaying a “password hint” that will appear on the Welcome screen. The purpose of the hint is to help you remember the password without giving it away to anyone else who accesses the Welcome screen (all users can see the hint). For example, you can use a password hint that reminds you of the topic of the password. On one of my XP computers, my password is OldHOuse49. My wife and I own a historical home that is always in some phase of remodeling, so for my hint, I put “where my money goes.” This reminds me of my old house, and hence my password.

To make changes to an existing user account, just follow these steps:

1. In the User Accounts window, click the Change an Account link.

2. A window appears asking you to pick an account that you want to change. Click the account that you want.

3. A window appears that allows you to change the name on the account, change the picture, change the account type, create a password, or delete the account. Just select the option that you want and follow the instructions. As you can see, each user account is represented by an icon. If you click Change Picture, a window appears, shown in Figure 13-3, where you can select a new picture or browse for a different one.

4. If you want to change a password for the account, click the Change Password option and enter the password as instructed on the password window, shown in Figure 13-4. You can choose to enter a password hint if you like.

5. Use the Back button to return to the change list, and then make any additional changes that you want.
FIGURE 13-3  The Change Picture window

FIGURE 13-4  The Change Password window
You Can Customize User Accounts with Pictures

User accounts are represented with a picture by default. When you see the Welcome screen, you simply click the user account picture to log on (and enter a password if necessary). You can change these picture icons using the Change Picture feature. You can select another picture from those provided, or you can browse and select your own. Virtually any type of graphics picture file can be used for your account icon picture (such as a GIF, JPEG, or BMP file). You can choose pictures that are interesting to you; for a family computer, it is fun to use a picture of each family member who has an account on the screen. When you see the Welcome screen, you see your family members, and you simply click your own picture to log on. This idea is great for computer users such as younger children who are just beginning to read. The possibilities are all yours—explore and have fun!

User Logon/Logoff

The final task you can perform on the User Accounts window is selecting the logon and logoff options. If you click this task option, you simply see two check boxes, shown in Figure 13-5—by selecting these check boxes, you can enable the Welcome screen and Fast User Switching. Fast User Switching allows you to switch to another user account without closing any programs. I recommend that you keep these two options selected.

Managing User Accounts with Computer Management

With the Computer Management console, you can manage local users and groups for your Windows XP computer. Computer Management is available in the Administrative Tools folder in the Control Panel (you must be logged on as administrator to use this tool). If you double-click the icon, you can expand Local Users and Groups, and then select either the Users or Groups container. As you can see in Figure 13-6, all users are listed in the right console pane with a description.

You can double-click any user account in the right console pane to open the properties sheets for the account. As you can see in Figure 13-7, by selecting the desired check box you can make a number of security-related changes, such as forcing a user to change his or her password at the next logon or restricting a user so that the password can never be changed. You can also disable the account from this location.
CHAPTER 13: Users, Groups, and Permissions

FIGURE 13-5   Select logon and logoff options

FIGURE 13-6   The Computer Management window
The Member Of tab lists the groups that the user is a member of. To add the user to a new group, use the Add button and select the group. You can use the Remove button to remove the user from any group, as well. (See the next section to learn more about groups.) Finally, from the Profile tab, there are a few dialog boxes where you can configure a path to the user’s profile (if profiles are used). Profiles are more widely used in larger networking environments, and this feature isn’t something you would typically enable for home or small office use.

**TIP**

If you want to create a new user using the Computer Management console, just right-click the Users container in the left pane and click New User.

### Managing Groups

Groups are an effective way to organize users in terms of permissions. In fact, facilitating the permissions function is basically the only reason group accounts exist. Let’s say that ten people use your Windows XP computer. Five of those users should be administrators, while the other five should have a limited account.
Reset a Password

Let’s say you are the administrator on a Windows XP computer. Joe, a standard user on your computer, has forgotten his password and can’t seem to remember it, even using the password hint. As an administrator for your computer, you have total control over the entire system, including passwords. You can use the Computer Management console to reset the password by simply right-clicking the account and clicking Set Password. A security warning appears, telling you that resetting a password is a final, drastic step that might cause the loss of some user information. You can click the Proceed button and then enter a new password in the dialog box that appears, so that the user can log on once again.

You can add those five users to the administrators group, and then manage them as one entity, rather than five different accounts.

On a grander scale, groups are used in large networking environments for resource access. Let’s say that your department has one printer. You want
everyone in your department to use the printer, but not users from another department. Sure, you can use the printer’s security tab and add each user from your department to the permissions list; but an easier way to manage the users is to create a group account for them once, and then use the group account to give them access to network resources, such as printers and shared folders.

If you click the Groups container in the Computer Management console, you see a list of default groups on the right side of the console. If you double-click a group, you see a listing of the members, which you can change using the Add and Remove buttons. You can also create a new group by right-clicking the Group container and clicking New Group. Doing this gives you a basic New Group window, shown in Figure 13-8, where you can name the group and add members to the group.

Understanding Permissions

Windows XP uses permissions to control what users can and cannot do, both on the local computer and on network shares. With permissions, you can give certain users or groups specific rights while withholding those rights from others. This feature enhances Windows XP’s versatility by allowing you to control both the entire computer and individual folders and files. So, in terms of security, permissions are used on the local machine to manage the actual user, defining what he or she can do on that machine, and on the network folders to control what users can do with the contents of these folders. You can think of user permissions as “user access rights,” while folder permissions are just that—permissions specific to a folder.

Through the NTFS file system, Windows XP offers superior file and folder security. NTFS supports a number of permission features; but in order to use NTFS permissions, your shared folders must reside on an NTFS drive. FAT32 also provides the simple folder permissions of Read, Change, and Full Control, but you do not get the fine level of control found in NTFS permissions. When you share a folder on an NTFS drive, you can right-click the folder and click Properties to see the Security tab, shown in Figure 13-9. You can select the desired group and select the Allow or Deny check boxes in order to configure permissions for that group, or you can click the Add button and add other users and/or groups so that permissions can be set for them as well.

For any folder you share on an NTFS drive, you can configure the permissions for each group and user. So what exactly do the permissions mean? Table 13-1 explains the different NTFS folder permissions available.
CHAPTER 13: Users, Groups, and Permissions

**FIGURE 13-8** The New Group window

**FIGURE 13-9** The Security tab
It is important to note that Table 13-1 reflects these permissions from a grant perspective. However, you can also deny permission for each of these on the Security tab of any NTFS shared folder. In other words, you can deny Write access so that a particular user or group could not make editing changes or add new content to the shared folder.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Control</td>
<td>Users or Groups with Full Control can perform any action, including deleting, with respect to a folder and all files or folders within that folder. Full Control should be assigned only to a select few people who need to be able to completely manage a folder’s contents.</td>
</tr>
<tr>
<td>Modify</td>
<td>Users or groups with the Modify permission can make changes to files and folders within the shared folder, but the permission does not give the right to delete any files or subfolders, or change the permissions on the folder. A user with Modify permissions cannot take ownership of the folder.</td>
</tr>
<tr>
<td>Read &amp; Execute</td>
<td>Users or Groups with Read &amp; Execute permission can examine all folder contents and open files, as well as launch applications; but users cannot make any changes to any files or folders within the shared folders or delete any of them.</td>
</tr>
<tr>
<td>List Folder Contents</td>
<td>This permission is the same as Read &amp; Execute, but it also allows you to view folder permissions for subfolders.</td>
</tr>
<tr>
<td>Read</td>
<td>This permission allows the user or group to read files within a folder. No changes can be made to the file or folder, however.</td>
</tr>
<tr>
<td>Write</td>
<td>This permission allows the user or group to make changes to files in the shared folder and to create new files in the shared folder. This permission is often used with the Read permission.</td>
</tr>
</tbody>
</table>

TABLE 13-1 File and Folder Permissions

**Did you know?**

Permissions “Stay in the Family”

As you are assigning permissions to folders, it is important to remember that “inheritance” is in effect for all subfolders. This simply means that a folder within a shared folder inherits the permissions of the parent folder unless you specifically change those permissions. For example, let’s say you have a shared folder called “Cat.” Inside Cat is a folder called “Dog.” Whatever permissions
Now that you have taken a look at NTFS permissions, you may think, “What if I need more control?” That’s a good question—what should you do if you need to finely tune permissions for a particular user? For example, let’s say that you want to give Bob Full Control permission to one of your folders, but you do not want Bob to be able to change permissions on the folder. How can you give Bob Full Control yet provide this one restriction.

For cases such as this, where a specialized permission needs to be made, you can access the Security tab of the desired folder and click the Advanced button. This action opens an Advanced Security Settings for Storage window, which you can see in Figure 13-10.

![The Advanced Security Settings for Storage window](image)

FIGURE 13-10 The Advanced Security Settings for Storage window

you have assigned for users and groups concerning the Cat folder will also apply to Dog, unless you specifically access the Security tab on the Dog folder and change them. The key is to remember that inheritance is in effect for folders and subfolders, and to think carefully when sharing folders. After all, if there are many subfolders, you may not want other users wading around in them.

Now that you have taken a look at NTFS permissions, you may think, “What if I need more control?” That’s a good question—what should you do if you need to finely tune permissions for a particular user? For example, let’s say that you want to give Bob Full Control permission to one of your folders, but you do not want Bob to be able to change permissions on the folder. How can you give Bob Full Control yet provide this one restriction.

For cases such as this, where a specialized permission needs to be made, you can access the Security tab of the desired folder and click the Advanced button. This action opens an Advanced Security Settings for Storage window, which you can see in Figure 13-10.
You can see the users and groups in the Permission Entries area that you have configured for the folder so far. If you select the one you want, you can then click the Edit button and see a Permission Entry for Storage window that more finely breaks down the possible actions of permissions, as shown in Figure 13-11. As you can see, I am assigning essentially all available permissions, except the Change permission option, which I am denying.

It is important to remember, though, that these advanced permission are options designed for incidental use. They are intended to give you flexibility in certain circumstances when the default permissions do not work well. Under most circumstances, however, the default NTFS folder permissions are all you need for effective folder security.

![The Permission Entry for Storage window](image-url)

**FIGURE 13-11** The Permission Entry for Storage window
How To…

- Use the Internet Connection Firewall
- Configure Remote Desktop
- Understand Network Bridging

As a network-ready computer, Windows XP brings more tools and services to the networking table than previous version of Windows. For both advanced users and home users, Windows XP is designed to function on a local network and the Internet; because Windows XP is a networking machine, Microsoft has included some additional tools in Windows XP that were not previously available in Windows. In this chapter, you’ll learn about three of those very important tools—Internet firewall, Remote Desktop, and Network Bridging. All of these networking topics are a little more advanced than simple file and printer sharing, but after learning a thing or two about these services, you will come to appreciate how they can help you.

Internet Connection Firewall

If the term “Internet firewall” sounds a little frightening, don’t worry. A firewall is actually a good thing. In networks, a firewall is any piece of computer software or hardware that protects a network from intruders. For example, let’s say that you own a small company that contains 200 computers. Each user needs to access the Internet every day, so there is a primary Internet link going from your company to an ISP. Although you want to use the Internet each day, you do not want people on the Internet getting inside of your private network and stealing information from you. What do you do? The answer is a firewall.

Firewalls use various kinds of protocol tactics to check traffic as it flows in and out of the network. Based on rules that are configured by system administrators, certain kinds of traffic are allowed or not allowed, and some kinds of traffic can even be seen as threatening. In short, the firewall acts as a very paranoid traffic cop who makes certain that no one gets inside the private network. Firewalls are nothing new; they have been around for years, and most large, private networks today use some kind of firewall technology (and they spend thousands of dollars on it each year).

You may think, “That’s great, but what does that have to do with me and my Windows XP computer?” Instead of firewalls that are limited to large networking environments, Windows XP includes its own firewall to help protect your computer.
from malicious people when you’re on the Internet. You can think of the firewall found in Windows XP as a personal firewall, and, indeed, other companies even produce firewalls for the typical home or small office user (such as Norton Internet Security).

The next question that may come to mind concerns the need for a firewall. After all, home users have been connecting to the Internet for years without a firewall on their computer. Why do we need one now? Any time you are using the Internet, your computer is open for potential attacks. With a dial-up connection, the attacks are limited because you are not connected to the Internet all of the time. However, with the explosive growth of broadband connections (DSL, cable, and satellite), the need for a firewall becomes very important because these computers are always connected to the Internet and, therefore, always exposed to danger. For this reason, the Internet Connection Firewall (ICF) is included with Windows XP and is available for your use.

**Understanding How ICF Works**

ICF is a software solution in Windows XP. This means that ICF uses code built into the Windows XP operating system to monitor and manage traffic. As you might imagine, the process of managing traffic can become a rather complex topic, so I’m going to give you the important aspects of the process here and skip the boring technical details.

ICF is considered a **stateful** firewall. This simply means that ICF works with your Internet connection to examine traffic as it is passing through the firewall both to and from your computer/network. Because ICF is stateful, it examines Internet traffic in terms of its live use. If something attempts to enter the firewall that is not allowed, ICF simply steps in and blocks the traffic from entering. Basically, no unallowed traffic ever passes the firewall. In order to use stateful inspection, ICF examines the destination of every piece of traffic coming from your computer or computers on your network. Whenever something is sent to the Internet (such as a URL request), ICF keeps a routing table to track your requests. When data comes to the firewall, ICF inspects it to see whether it matches up with requests found in the routing table. If so, it is passed onto your computer or the requesting computer on your network. If not, it is simply blocked from entering the firewall. The end result is that any traffic you want from the Internet can enter the firewall, and anything you have not requested is blocked.

**When communication is dropped, it is done automatically without any intervention from you. In fact, ICF doesn’t even tell you when communication from the Internet has been dropped.**
As you might imagine, ICF control is very helpful, but it can be a problem with some applications and services. Therefore, ICF can be configured to meet your specific needs.

**Issues with ICF**

Before we get into more detail about ICF configuration, let me point out a few issues concerning ICF’s default behavior. You should keep these issues in mind as you set up Internet connections or home/small office networks:

- ICF should be enabled on any shared Internet connection in your home or small office network. You do not have to use a home or small office network to use ICF—if you have only one computer and you want the additional protection, ICF works great on one computer, too.

- ICF works on a per-connection basis. For example, let’s say your computer has a DSL connection and a modem connection (you use the modem connection in the event that the DSL connection goes down). You need to enable ICF on both the DSL and modem connections to have full protection. ICF is enabled per connection—not per computer.

- In a small network setting using Internet Connection Sharing (ICS), you should certainly enable ICF on the ICS connection. However, if other computers on the network have other ways to connect to the Internet (such as through modems), you need to enable ICF on each of those connections as well. Again, ICF works on a per-connection basis.

- Any configuration changes you make to ICF are only for that particular connection—they do not transfer from connection to connection. For example, if you have two connections and ICF is enabled on each of them, you must individually configure each connection as needed.

- Outlook Express will work fine with ICF and will continue to automatically check for and download mail. Microsoft Office applications, such as Outlook 2000, will not be able to check mail automatically.

- ICF should not be enabled on any computer’s network adapter card that is used to connect to local computers. Doing so will prevent connectivity. ICF should only be used for connections to the Internet—not connections between computers on your private network.
It is also important to note that ICF, like ICS, is a home/small office solution. In environments where Windows XP is used with Microsoft DNS/DHCP and other large-scale networking services, ICF should not be used.

Enabling ICF

You can easily enable ICF when you create any new Internet connection. If you have configured ICS, then you were probably prompted to enable ICF as well. If you right-click any Internet connection found in the Network Connections folder and click Properties, you will see the properties sheets for that connection. Click the Advanced tab and you see the ICF check box, as shown in Figure 14-1.

As you can see in Figure 14-1, ICF is designed to work with ICS in order to protect your shared Internet connection, thereby protecting the computers on your network. In most circumstances, the check box option that enables ICF is all you need to click in order to protect your network. However, there are some additional configuration options that you can evoke if necessary, and the next section takes a look at those settings.
Configuring ICF Settings

If you click the Settings button on the Advanced tab, you see advanced settings that govern how ICF works and what kinds of applications and services it allows. Again, you typically do not need to configure anything here if you are simply using the Internet and accessing Internet mail. However, if you are using certain applications or you are providing certain types of content to the Internet, then you may need to configure some of these settings. The settings here can get a little complicated and tricky, however, so be forewarned!

Let’s start with the Services tab, shown in Figure 14-2. The Services tab provides you with a list of check boxes concerning services running on your computer or network that you are allowing Internet users to access. For example, let’s say that you are running a Web server on your Windows XP Professional computer. If ICF is in use, you need to select the Web server (HTTP) and possibly the Secure Web server (HTTPS) check boxes so that Internet users can access content on your Web server. When you click these check boxes and click OK, ICF basically reconfigures itself to allow certain kinds of content to pass through the firewall in order to meet these needs. Or, for example, let’s say you want to use...
Remote Desktop Sharing with someone on the Internet (which is covered later in this chapter). By default, ICF will not allow this kind of communication, but if you enable it here, ICF understands that Remote Desktop Sharing is okay and should be allowed.

If you want to enable one of the services listed on the Services tab, just click the desired check box. An additional window appears, shown in Figure 14-3, where you must enter the name or IP address of the computer on your network that runs the service. Under most circumstances, you do not need to change any of the port information, because Windows XP configures this information on its own. The computer name or IP address tells Windows XP which computer runs the service, so that only that computer receives the service traffic—not other computers on your network. As you can see, this is an additional security feature that keeps service traffic from entering computers that do not offer the service.

You can also add other services that are listed by default. Click the Add button and enter the service name and TCP/IP port numbers on which the service communicates. Obviously, this is an advanced configuration, but the option is provided for networks that use custom applications or those who want to provide custom services to Internet users.

What if you are not offering any services to Internet clients, but you only want to use the Internet for surfing and e-mail? Then, you simply do not need to do anything here. Make sure none of the check boxes are selected.

![Service Settings window](image)

**FIGURE 14-3** The Service Settings window
The next tab is Security Logging. The Security Logging option enables you to log unsuccessful inbound connections, unsuccessful outbound connections, or both. Keep in mind the ICF does not tell you when inbound communication is dropped from the firewall. However, if you are naturally curious or you believe there are regular Internet attacks on your computer, you can turn on the logging feature and then check out the log file periodically to see what is going on. By default, the security log is stored in C:\Windows\pfirewall.log, but you can click the Browse button on the Security Logging tab, shown in Figure 14-4, to change the location. Also notice that the log file has a maximum size of 4096 KB by default (4 MB). You can increase or decrease this space if you like, but this is plenty of room. To enable logging for successful connections and dropped packets, click the desired check boxes.

If you want to check out the log file, just browse to the location of the file and open it (it will open with Notepad). As you can see in Figure 14-5, the log file contains TCP addressing and port information, and is not exactly easy to read. However, you can see how many firewall drops occurred over a period of time.

The final tab is the ICMP tab. ICMP (Internet Control Message Protocol) is a protocol used on the Internet so that computers can send information to and from each other about network or transmissions problems. For example, if one computer...
is sending information to another computer and an error occurs, that computer can essentially use ICMP to tell the other what has happened. ICMP is used all of the time and can be very helpful to computers on the Internet.
However, some attacks from the Internet act like ICMP messages; so, by default, no ICMP messages are allowed on your network. Depending on your needs, however, you may want to enable some of these ICMP message types (or all of them). Just click the check boxes on the ICMP tab, shown in Figure 14-6, and you can select a message type and read more about it in the Description portion of the window.

The best advice I can give you is not to enable ICMP messages unless you are sure that you need them. Doing so just opens your computer or network to the possibility of attacks from the Internet. Of course, you don’t want to be overly paranoid either, so feel free to enable these as necessary.

**Remote Desktop**

Windows XP supports a very cool new feature called Remote Desktop. Consider this scenario: You use Windows XP Professional at the office, which is half an hour from your home. When you get home, you realize that you left some very important business unattended on your work computer. You also have a Windows XP computer at work—now, what can you do? No problem—you can use your home computer to connect with the office computer, and then you can use the office computer with Remote Desktop just as if you are actually sitting there. Sound too good to be true? It’s not—and this new feature works great.
Remote Desktop has a number of potentially exciting applications. You can access a remote computer and use the applications and information found on that computer seamlessly, just as if your hands were actually on the computer’s keyboard. Several different people can connect to one remote computer and work on a collaborative problem. You can even use Remote Desktop to connect to a friend or relative’s computer and help them solve problems through Windows XP’s Remote Assistance feature (see Chapter 20). The possibilities are endless—and with Remote Desktop, a needed remote computer is always at your fingertips.

Remote Desktop makes use of an older technology called “terminal services client.” Essentially, your computer can connect with a remote computer and, assuming proper permissions are in place, your computer can use the remote computer in a “dumb terminal” manner, just as though you were actually there. Remote Desktop obviously works on Windows XP; but using the XP installation CD-ROM, you can also add the Remote Desktop Connection tool to other Windows operating systems, such as Windows 9x, Me, NT 4.0, or Windows 2000.

### Enabling Remote Desktop

You can easily enable the Remote Desktop feature on your Windows XP computer so that others can connect to it, if you are currently logged on as the computer’s administrator. Access System Properties in the Control Panel and click the Remote tab. As you can see in Figure 14-7, you can enable both Remote Assistance and Remote Desktop on this tab.

**Did you know?**

**How Remote Desktop and Remote Assistance Work**

Remote Desktop and Remote Assistance use the same terminal services technology. The primary difference between the two is that Remote Desktop is based on your user account. Assuming you have proper account permissions, you can access a remote desktop and use all of the applications and files on the computer, just as though you were physically sitting there. Remote Assistance, on the other hand, uses an Internet connection to connect to a remote computer. You can see the other user’s desktop and communicate with the user via a chat dialog box. If the user gives you permission, you can then adjust settings on the user’s system.
If you click the Advanced button under the Remote Assistance portion of the window, you see a dialog box, shown in Figure 14-8, that enables you to allow the remote assistant to both view and control your computer, or to simply view your computer. You also see a default expiration date of 30 for remote assistance invitations, which is the number of times another person is allowed to connect. (See Chapter 20 to learn more.)

To configure the Remote Desktop option, simply click the Select Remote Users button. In the dialog box that appears, browse your local computer, or the Active Directory if you are on a corporate network, to locate the users for which you want to give permission to remotely access your desktop. Click OK when you’ve finished, and then click OK to exit System properties.
Using Remote Desktop Web Connection

Aside from a typical remote desktop connection using a local area network or virtual private network, Windows XP also supports connections over the Internet. This feature provides you with a Web utility that allows you to connect to the remote computer. In order to use the Web connection feature, it must first be installed. Follow the steps in the How To box to install the Remote Desktop Web Connection.

How to ... Install Remote Desktop Web Connection

To install the Remote Desktop Web Connection, follow these steps:

1. Open the Control Panel and double-click Add/Remove Programs.
2. Click the Add/Remove Windows Components button.
3. In the Setup window that appears, select Internet Information Services (IIS), and click the Details button.
4. Select World Wide Web service and click the Details button again.

5. In the Details window, select the Remote Desktop Web Connection check box, as shown here, and then click OK.

6. Click OK again, and then click Next. Windows XP will install and configure the component. You may need your Windows XP CD-ROM to complete this action.

7. Once the installation is complete, just click the Finish button.

Once Remote Desktop Web Connection is installed, you can connect to another Windows XP computer using a Web browser. This feature works great for connecting with other desktops while connected to your local area network, but I should also note here that Remote Desktop Web Connection works only on Internet Explorer 4.0 or higher.
Understanding Network Bridging

If you have read any of the documentation about Windows XP, you may have heard of a concept called network bridging. This feature sounds really important—and it is, so I want to mention it here as we wrap up the networking section of this book. First of all, there is nothing for you to configure or manage on your system—network bridging is a feature placed in Windows XP that is automatically handled by the operating system. Your only chore is to understand what it is and how it can help you.

Networks are ever-changing animals. One company will produce a product, which may be replaced by a different kind of product, and so on. Networking is always in flux, and, therefore, you may have a mixed network made up of different kinds of network adapter cards. For example, my office network uses Ethernet cards and hub. However, the Home PNA networks that use phone lines are really economical. What happens if I want to expand my office network using Home PNA without upgrading all of the network cards on the Ethernet network? In the past, you would just be out of luck, but Windows XP includes software that can bridge communications between two different kinds of networks. If my Windows XP computer contains both an Ethernet card and the Home PNA card, Windows XP can bridge the two automatically, so I can continue to communicate on the Ethernet network, as well as on the new Home PNA network. As you can see, this bridging feature can save you a lot of time, money, and headaches. Are your networks different? No problem, just connect them using Windows XP, and XP will handle the translation and adjustments for you automatically.

The Home Networking Wizard automatically creates bridges when two network adapters are found on the same computer. However, Internet connection cards, such as DSL modems and satellite cards, are not bridged with Internet network cards.
This page intentionally left blank.
Part III

Cool Things You Can Do with Windows XP
This page intentionally left blank.
Chapter 15
Playing Games
How To…

- Play Games
- Manage Game Controllers
- Use Volume Controls and Sound Recorder

Windows XP combines the best features of Windows 2000 and Windows Me. Windows 2000 provides a robust, highly stable operating system, but it was built only for business users and didn’t work with games very well. Windows Me was a consumer release built on the Windows 95/98 code. It played great but didn’t give you the stability that you needed. Windows XP combines both of those worlds by providing a highly stable and secure system that also plays well with games and multimedia. In this chapter, you’ll learn about two types of entertainment in Windows XP—game playing and sound recording. As you’ll see, playing games and working with gaming hardware is a snap in Windows XP.

Managing Game Controllers

Game controllers are hardware devices that you attach to your computer. These devices enable you to play a certain type of game that requires the device. A typical example is a joystick. If you’re as old as I am, you remember owning your first joystick and trying to play the home version of Pac Man on Atari or some related game system. That dates me a little, as joysticks have been around for some time now. In today’s gaming market, there are all kinds of gaming controllers—there are different kinds of yokes, gamepads, virtual reality devices, and many others.

No matter what you want to use, you’ll need to install it on Windows XP in order to work with the device. Installing a game controller is like installing any other piece of hardware in Windows XP. Typically, you just attach the game controller to the correct port on your computer (see the game controller’s instructions). Windows XP will normally recognize the added device and automatically install it without any intervention from you. For some advanced game controllers, you may have an installation CD-ROM or floppy disk. If so, just follow the game controller’s instructions for installation and you’ll be all set.

*NOTE*

Make sure that any game controller that you purchase is compatible with Windows XP. The device should tell you about compatibility right on the box.
Once you have attached the game controller to your computer, you can manage and troubleshoot the device using Gaming Options in the Control Panel. Simply open the Control Panel and double-click the Gaming Options icon. Remember, if you don’t see a Gaming Options icon in the Control Panel, switch the Control Panel to Category view. The Game Controllers window, shown in Figure 15-1, gives you a list of game controllers currently installed on Windows XP.

Using this window, you can add devices to and remove them from the computer; and you can access properties for the device—which may or may not have any configurable options, depending on the game controller. If you choose to add a new device, click the Add button, and the Add Game Controller window appears. From this window, you can select your device from the list and add it to your system, as shown in Figure 15-2.

Windows XP should automatically detect and install game controllers. Under most circumstances, you should not have to manually add controllers to your system. You can, however, try manually adding an item if you are having installation problems.

![Game Controllers](image)

**FIGURE 15-1** The Gaming Options window shows installed controllers.
From Other Options on the Add Game Controller window, you can click the Advanced button, which will allow you to select a preferred device. If you are using multiple game controllers on your XP computer, you can use this option to identify the device that you want to use most of the time. You also see a Troubleshoot button; if you click it, the Games and Multimedia Troubleshooter window appears, as shown in Figure 15-3. Select the radio button that describes your problem, click the Next button, and Windows XP will attempt to solve the problem for you. If you’re still having problems, see the troubleshooting section later in this chapter.

**Windows XP Games**

Let’s face it: for all the great tasks a PC can do, one of the most common things we all like to do on a PC is play games. Gaming technology has come a very long way in the past few years. With rich PC multimedia support, you can be transported into different worlds, create your own civilizations, race a car—you name it, you can do it in a game and experience awesome graphics and sound while playing. There are three major ways to play games on Windows XP. You can play basic
Games included with Windows XP, you can play Internet games, or you can install your own games that you purchase. The following sections explore these options.

**Games Installed with Windows XP**

Unfortunately, operating systems do not give you a bunch of powerful games for free. You have to purchase those on your own and install them on your computer. However, Windows XP does give you a few basic games you can play to pass the time. The included games with Windows XP are FreeCell, Hearts, Minesweeper, Pinball, Solitaire, and Spider Solitaire. Also included are several games that are designed for play with an Internet player. These games are Internet Backgammon, Internet Checkers, Internet Hearts, Internet Reversi, and Internet Spades.

If you want to play one of these games, click Start | All Programs | Games, and a pop-out menu appears where you can select the game of your choice. As with any Windows program, the game appears in a window with menu options, such as the Pinball game shown in Figure 15-4.
You Can Configure Games

Each game has a Game menu at the top of the window. Depending on the game you want to play, different options are presented. Some games allow two or more players; some have different settings, such as beginner, intermediate, and advanced; and Pinball even allows you to play the game in full-screen mode. Whenever you play a game, be sure to check out the Game menu options so you’ll know what is available to you.
Playing Games on the Internet

The Internet game options found on the Games menu require you to have an Internet connection. Accessing these games takes you to the MSN Gaming Zone on the Internet, where you can play against an opponent on the Internet.

The game will connect you to www.zone.com (“the Zone”), where information about your computer and an ID will be sent. No personal information is ever collected from you. Do you want to play? The following steps show you how it works.

1. Click Start | More Programs | Games, and then select an Internet game of choice. A window opens telling you about the game played on zone.com, as shown with Internet Checkers in Figure 15-5.

2. Click the Play button. The game uses your Internet connection to explore zone.com for another player.

FIGURE 15-5  Click the Play button to continue.
3. If a player is found, the game commences, as shown in Figure 15-6. Also see that you have the option to chat with other players as well (using a pre-selected list of comments, which prevents someone from calling you names you don’t like).

So, what happens if you really like playing Internet games but don’t want to play any of the ones available within Windows XP? You can just go to zone.com, download some software, and start playing all kinds of free games on the Internet with other people. Obviously, there are Internet gaming sites other than zone.com; but because the MSN Internet Gaming Zone is somewhat integrated with Windows XP, I do want to show you all you can do there. Just follow these steps to start playing other games on zone.com.

![Checkers on zone.com](image-url)
1. Open a Web browser, start an Internet connection, enter www.zone.msn.com in the URL dialog box, and press ENTER.

2. Toward the top of the page, click the Sign Up Now button, as shown in Figure 15-7.

3. The next window tells you that you’ll need to pick an online ID and password; then you’ll need to download a small software package so your computer can play games on the Zone. Click the Start button.

4. Enter a desired Zone name and password. Your name can only have letters, numbers, or underscores (no spaces). Click the Continue button. If the name is already taken, you are prompted to enter a different name.

5. Enter your e-mail address. The e-mail address is used only if Zone needs to contact you—your e-mail address is not given to other users. Enter your address and click Continue.
6. Click the Start Download button to start the software download. This will take a few minutes or less, depending on the speed of your Internet connection.

7. When the download completes, you see a spade on your screen and a button that says “Click here when you see the spade.” Click the button to continue.

8. When the download is complete, you can choose two different links—either to log on and play games or to see a tutorial. Make a selection to continue.

9. If you choose to log on and play games, an Install window appears, so final installation of the gaming components can be completed on your system. Click Install.

10. Read the licensing agreement that appears and click Yes—download continues for another moment or two. A window appears asking whether you want a shortcut to the MSN Gaming Zone on your Desktop. Click Yes or No.

11. The logon dialog box appears. Enter your username and password, and click OK.

12. Once you log on, you can access the Options menu at the prompt and click the Privacy tab to determine which people can see your username while you are online, as shown in Figure 15-8. Adjust these settings and click OK.

![Figure 15-8](image.png)  
Adjusting your privacy settings
13. You can now return to zone.com in your browser and select a game that you want to play. Depending on which game you want to play, additional downloads may be necessary. Just follow the instructions as they appear. In Figure 15-9, I’m playing You Know It! Trivia.

*Although most of the game playing sessions are free, you may have to purchase some games in order to play them on the MSN Gaming Zone.*

**Installing and Playing Your Own Games**

You can purchase many different kinds of games at your local computer software store or on the Internet. As you might guess, virtually anything you would want is available. The trick when purchasing any game is not to get caught up in the

**FIGURE 15-9** You Know It! Trivia on zone.com
excitement until you are sure the game is right for your system. As you consider purchasing a game, keep these points in mind:

- Check the minimum RAM requirements and make sure your computer meets them. A typical game will list the system requirements on the side of the box.

- You may require certain graphics and sound capabilities. Make sure your current video and sound cards can support the requirements (such as True Color).

- You may need certain gaming peripherals, such as joysticks and other controllers. Make sure you know what you’ll need before buying the game.

- Make sure the game is compatible with Windows XP.

With those considerations in mind, you simply buy the game you want, read the installation instructions, and follow them. Most games include one or more CD-ROMs that guide you through the installation process. Once you’ve finished, refer to the owner’s manual for information about playing the game, game options, and solving problems with the particular game.

**Troubleshooting Game Problems**

Naturally, it is impossible to offer ever solution to every problem you might encounter with a game, particularly one you install. Always begin with the game’s documentation. Sometimes there are known issues or common problems the documentation can help you solve. Also, you can use the Windows XP troubleshooter to help you solve a problem. However, I have listed some of the more common problems and their solutions in the following sections.

**A Game Controller Doesn’t Work**

If you have a joystick or some other kind of game controller that doesn’t work or is working erratically, first check the documentation for the hardware to see whether there are any immediate solutions recommended. Check the Game Options icon in the Control Panel for the presence of the device. If you don’t see it there, Windows XP doesn’t think it is installed on the system. Check to make sure the device is plugged in correctly, and follow the manufacturer’s instructions for installing the device. If the device works sporadically, you may need to access its properties in Game Options. Click the Settings tab, and click Calibrate to try to resolve the
problem. If calibration does not solve the problem, the odds are good that the
device driver is incorrect, corrupted, or needs to be updated. Try to reinstall the
device driver or obtain an updated one from the manufacturer’s Web site.

**DirectX Problems**

DirectX is a graphics software component used by many games. If you get
DirectX error messages, the odds are good that you need to install the latest
version of DirectX (found on the Windows Update Web site) or that you are using
a newer version of DirectX that your game does not support. Check your game
documentation for more information. If you are using an older video card, you
may also experience incompatibility problems with DirectX.

**Game Lockup**

Lockups are generally caused when a game attempts to use hardware in some way
that violates the integrity of the Windows XP operating system. This can cause a
hard lock. Press **CTRL+ALT+DEL** on your keyboard to get control of your system,
or you may have to restart it. If this continues to happen with one particular game,
there are probably software problems with the game. Consult the game documentation
for more information.

**Set Display Mode: DDERR_GENERIC**

This error message can commonly occur if your video card resolution settings are
too high for your video card to handle. You need to lower them to 256 colors on
the Settings tab of the Display properties sheets.

*Tired of playing a game, but you can’t seem to make it stop? Just press the
ESC key on your keyboard. This is a universal control that almost always
halts a game and gives control of the operating system back to you.*

**Using Volume Controls and Sound Recorder**

In the Entertainment menu in Accessories, you’ll find two simple utilities—
Volume Controls and Sound Recorder. These are simple to use, and I just want to
mention a few things about each of them.

Volume Control, shown in Figure 15-10, gives you a window containing
different slider controls so you can manage the volume of your speakers, microphone,
and other Windows sound options.
You can access the Volume Control by right-clicking the Volume icon in your System Tray and clicking Properties.

As you can see in Figure 15-10, the Volume Control window is a simple interface that is easy to use. One thing you might want to remember is that not all of your volume control options may be available by default. Click the Options menu and click Properties. You will see a list of volume controls you can add for different devices, as shown in Figure 15-11. Just click the check boxes of the ones you want to add, and then click OK. Beyond that, the rest is self-explanatory!

Sound Recorder gives you a little utility to record your voice (or whatever you want) using a microphone attached to your computer. The controls for the sound recorder, shown in Figure 15-12, are quite similar to those on a real tape recorder. Just click the record button to start recording. Once you have finished, you can save the recording as a file. The menu options you see give you standard choices, and you can play around with these settings to see which ones work best for you. Like Volume Controls, Sound Recorder is very easy to use—just spend some time with it and you’ll be a recording pro in no time.
FIGURE 15-11  Use this Properties menu to select controls for certain devices.

FIGURE 15-12  Sound Recorder can be used to record your voice.
This page intentionally left blank.
How To…

- Use Windows Media Player
- Record CD music
- Watch DVD
- Create and Manage Playlists
- Manage Your Media Library
- Configure Media Player

Windows Me introduced Windows Media Player 7, which was a gigantic improvement over previous versions of Media Player. If you have used Media Player 7, then Media Player 8 will not create much of a learning curve; but there are some new and very cool features of Media Player 8. With Media Player 8, you can play and manage all kinds of multimedia, from CD/DVD music and movies to all kinds of downloadable multimedia files. Media Player 8 also gives you great media management features, and in this chapter, you will learn about them all!

Getting to Know Windows Media Player 8

You can find Windows Media Player in Start | More Programs | Accessories | Entertainment | Windows Media Player. Depending on your system configuration, you may also have a shortcut to Media Player on your Desktop or on your Taskbar.

Once you open Media Player, you see a default interface. I say default interface because you can completely change the interface using a variety of skins, which you will learn about later in this chapter. The default interface provides you with a primary media area, a list of buttons on the left side of the Media Player (called Features), and a standard toolbar. When you first open Media Player, it attempts to connect to www.windowsmedia.com. If successful, you’ll see a media interface, as shown in Figure 16-1. If you’re not connected to the Internet, you’ll first see an error page, which is a little annoying but not a big deal.

You use Media Player by accessing one of the features on the left side of the Media Player. By default, the Player always opens to “Media Guide,” which gives you the Internet page found at WindowsMedia.com. Each feature does something different, of course, and the following sections explore those primary features.
Now Playing

Now Playing is your media play area and the primary area you will use—it lists or shows whatever type of media you are currently playing. Most types of media will automatically launch Windows Media Player. For example, let’s say you want to listen to your favorite CD. All you need to do is put the CD into the CD-ROM drive. Windows XP scans the CD, recognizes it as a music CD, and launches Window Media Player. Media Player begins playing the CD, which appears in the Now Playing area, as shown in Figure 16-2.

What if you decide to watch a home movie you have made with Movie Maker? No problem, the home movie is displayed in the Now Playing window, as shown in Figure 16-3.

So, what can you change and configure on the Now Playing interface? Because the primary purpose of Now Playing is simply to provide a quick and easy area to see and hear all multimedia, you do not have specific configuration options for the media, but you can adjust what is displayed in the Now Playing area and how it is displayed to you.
First, in the upper-right corner of the Media Player, you see the following three buttons:

- **Show/Hide Equalizer Settings**  This button lets you either show or hide the equalizer settings in the Now Playing window.

- **Show/Hide Playlist**  This shows or hides the playlist in the Now Playing window. If you are listening to a music CD, the songs on the CD are displayed in the Now Playing window if this option is enabled.

- **Shuffle**  This button shuffles your current playlist. This feature is cool if you want to play a music CD and not hear the songs in the same old order.

There is also a drop-down menu that can be used to select different media to play. If you use the buttons to remove the playlist and equalizer features from the
Now Playing window, the primary viewing window is simply centered, as shown in Figure 16-4 (Okay—I had to show off my new baby).

Use the standard buttons at the bottom of the Media Player to play the media, stop playing the media, adjust the volume, and use related stereo or video controls. You can find these same controls in the Play menu at the top of the interface. The little boxes with an arrow through them that you see at the bottom right of the interface enable you to shrink the interface to a compact mode or enlarge it back to full-screen mode.

Aside from the immediate options on the interface, you can use the View menu to change a number of items affecting the Now Playing area’s interface. The following list tells you what options are available to you and what they do:

- **Full Mode** The default display is shown to you in full mode. If you switch to compact mode, use this option to return to full mode.
Compact Mode  This option gives you a smaller interface. You have the same options, but some of them appear as pop-out menus. This option takes up less room on your Desktop. If you are in full mode, click this option to move to compact mode.

Now Playing Tools  This option provides a pop-out menu where you can choose to

- Show Playlist  This is the same as the button option found directly on the interface.
- Show Titles  This displays title information about the media (such as the artist and songs, name of the video, and so on).
- Show Visualizations  For audio media, Windows Media Player can give you visualizations in the Now Playing window. Visualizations are just interesting graphics files (I’ll address Visualizations in more detail later in this list).
Show Equalizer and Settings  This option gives you an equalizer and related video settings in the Now Playing area. You can use these controls to adjust playback quality. If you choose to show equalizer and settings, you can choose to use SRS WOW Effects, Graphic Equalizer, Video Settings, Media Information, Captions, and DVD Controls. Your choice here, of course, depends on the type of media that you want to play. If you choose to use the Show Equalizer and Settings option, a small drop-down menu is available on the Now Playing interface so you can easily switch controls as needed.

Show Resize Bars  Resize bars appear between the different options you elect to show on the Now Playing area. The resize bars enable you to adjust the size of the components as you desire.

Visualizations  I mentioned earlier that visualizations give you a graphical view while you are playing audio-only media. For example, when you play a CD, the visualization options display interesting graphical patterns that move to the beat of the music. If you like this feature, the pop-out menu that appears here allows you to select the visualization you want to use. You can also change the visualization directly from the Now Playing area by clicking the arrow buttons found under the graphical visualization window.

You can easily manage the visualization available to you by clicking Tools, then clicking Options, and then selecting the Visualizations tab. You’ll find a simple interface where you can add and remove visualization files.

How to ...

Get Visualizations from the Internet

Media Player gives you quite a few visualization options when you click View and point to Visualizations. However, if you are a visualizations junkie, you can also get more from the Web, and here’s how:

1. In Media Player, click the Tools menu and click Download Visualizations.
2. This action launches an Internet connection and takes you to the Windows Media Player site at http://windowsmedia.com/mg/visualizations.asp?.

3. In the Web browser, inspect the visualizations available, and then click the one you want to start the download process.

4. When the File Download dialog box appears, choose to run the program from its current location, and then click OK.

5. Once the download is complete, installation is automatically started. The visualization is installed and now available in Media Player. That’s all there is to it!

- **DVD Features**  The DVD Features controls enable you to manage playback quality if you are currently playing a DVD disk. You have a number of control options available, such as slow or fast motion, play one frame at a time, and so forth. If you’re not playing a DVD disk, this option is grayed out.

- **File Markers**  When playing video, you can use this option to view the different markers within the video file. This feature enables you to skip to different areas of the video.

- **Statistics**  When playing videos, access this option to view statistics about the video transmission quality. The statistics window, shown in Figure 16-5, may be particularly helpful when troubleshooting problems with streaming media.

---

### Did you know?

**What Streaming Media Is**

When you download video or music from the Internet or across any other network, the streaming media feature of Media Player enables you to begin seeing or hearing the media before it is completely downloaded. The download stream is held in a buffer, and then played to you as it is received. This feature enables Media Player to return network media to you more quickly and to compensate for transmission delays or problems.
CHAPTER 16: Using Windows Media Player 8

The final options in the View menu provide basic viewing capabilities.

Media Guide

The next feature in Media Player is the Media Guide, mentioned earlier in this chapter. This option connects you to WindowsMedia.com, where you can download all kinds of music and movie files. This is a fun Web site, so do check it out. Obviously, you must be connected to the Internet for the Media Guide to work.

Copy from CD Audio

The CD Audio feature, shown in Figure 16-6, gives you information about the music CD you are currently listening to. As you can see, you are given the names of the songs, their length, and standard information about the album.

In the upper right-hand corner of the interface, you see an Album Details button. You can click this button to get additional information from the Internet about the album. Sometimes this feature gives you additional information, sometimes not, depending on how the album is listed. You may also be able to purchase the CD online from this interface, as shown in Figure 16-7.

![Statistics](image)

**FIGURE 16-5** Use the statistics option to gain helpful information about your video transmission.

- **Full Screen, Refresh, Zoom** The final options in the View menu provide basic viewing capabilities.
The Get Names button on the interface takes you back into the additional album information downloaded from the Web. This simply gives you the names of the songs, which are typically available within the primary interface anyway.

Next, you see a Copy Music button, which may be what you really want to know about. You can copy any music track from a music CD so the track is stored on your hard drive. This feature has two benefits. First, you can store songs you really like directly on your hard disk so that Media Player can play them without the music CD. Also, you can generate your own collection of favorites and create a playlist (which you learn about later in this chapter). The following sections tell you how to copy and configure copies of songs.

**Making a Copy**

To make a copy of a song from a CD, just follow these steps:

1. In Media Player, click the CD Audio feature button.
2. In the list of songs, clear the check boxes next to the song(s) you do not want to copy. In other words, any songs with the check box enabled will be copied to your hard disk.

3. Click the Copy Music button. Depending on your configuration, you may be able to hear the song while it is being copied. The feature area shows you the progress of the copy as it occurs.

4. Once the copy is complete, the song is placed in your Media Library, which we explore in an upcoming section.

**Configuring CD Audio Options**

You can control how songs are recorded and managed by clicking the Tools menu in Media Player, and then clicking Options. Click the Copy Music tab, shown in Figure 16-8.
Under most circumstances, the default options configured on this tab are all you need, but there may be instances when you want to change the default behavior. The following options are found on this tab:

- **Copy music to this location**  By default, the location is C:\My Documents\My Music. If you want to change this default location, click the Change button and select a different folder on your computer’s hard drive.

- **Copy settings**  You can choose to copy music in either the Windows Media format or MP3—the choice is yours. The Protect Content check box simply means that Windows Media Player is keeping a license for you to copy the music and play it on your computer. It is illegal for you to e-mail copies of music to other people, however. Finally, you can choose a Copy Music at This Quality setting by adjusting the slider bar. The higher the quality that you copy, the greater the hard drive space that is consumed. Even at a lower quality, several megabytes of storage space will be needed for only a few songs.

**TIP**

*Music copies are automatically compressed to help save disk space. This is an internal feature that does not affect playback.*
Media Library

The Media Library feature is...well, a library. All of your saved music and video files are stored in the library under different categories so you can easily access them, as shown in Figure 16-9.

On the left side of the interface, you see various categories with plus/minus-sign boxes next to them. Click a category, and you can see the songs or videos in your library for that category. For example, when I expand Album, I can select an album and see a list of songs I have copied to my computer from that album in the right window pane. Just double-click a song or video clip to hear it or see it!

So, how can you use the Media Library? Keep in mind that the library’s purpose is to help you keep track of files that you want. The Media Library is able to detect the type of multimedia you are using and add it to the appropriate location in the library. You can search your library by clicking the Search button at the top of the interface, and you can perform standard add, remove, and delete functions.

---

**Did you know?**

**About Copying Music and Copyright Law**

Musicians, singers, and all kinds of other people (including writers!) make money from selling copies of their work. The copyright enables the publisher of the work to make copies and sell those copies to consumers like you and me. The creator of the work, such as the artist, receives royalties on each copy sold. The copyright protects the producer and the artist, and prohibits other people from making copies and selling or even giving them away.

When you make a copy with Windows Media Player, Media Player handles a license for you. This means you are licensed to copy the music from a CD and play it on your computer. However, it is illegal for you to give that music away to anyone else (or sell it, of course). This includes putting the music on a disk or CD, or even e-mailing it to another person.

---

**TIP**

If you delete items, they are stored in the Deleted Items folder until you empty the folder by right-clicking it and selecting the appropriate option. This helps ensure that you do not accidentally delete a file that you want to keep.
You can also use Media Library to create a playlist of your favorite tunes or videos. The following sections show you how to use these options.

**Adding an Item to the Media Library**

To add a new item to the Media Library, click the Add button (plus sign) on the interface. A submenu pops out that enables you to add a track that is currently being played, a file, or media found on the Internet. If you want to add a file, a typical browse window appears for locating the file you want to add. If you want to add something from the Web, a window appears in which you can enter the URL of the media item.

**Creating a Playlist**

At any given moment, I have about ten songs that I really love. The problem is that each song is by a different artist on a different CD. Media Player can solve that problem by allowing me to copy each of those songs and create a playlist so
that each song is played in an order I want directly from my hard drive. Sound interesting? Here’s how it works:

1. In Media Library, click the New Playlist button.
2. Enter a name for the new playlist in the dialog box that appears and click OK.
3. In the Media Library, expand the Playlists category to see your new playlist.

You can also import and export playlists in and out of Media Player. Just click the File menu, and use either the Import or Export option.

Adding Files to a Playlist

Once you have created a playlist, you need to add the items to it. Follow these steps:

1. In Media Library, find the item you want to add to the playlist and select it in the right pane.
2. Click the Add to Playlist button. A selection menu pops out so you can determine which playlist to add the file to (if you have more than one playlist).
3. Continue this process until you have all of the files that you want added to your playlist.

Managing and Playing Your Playlist

Once you have your playlist created, you can easily adjust the order of the items on it by selecting an item and using the up and down arrow buttons to move it around in the list, as shown in Figure 16-10. This feature enables you to set the order in which the songs are played, and you can come back at any time and adjust the order as desired.

You can also delete any item in the playlist by right-clicking the item and clicking Delete, or by just clicking the Delete icon on the interface. This action moves the file to the Deleted Items folder. To later restore a deleted item, just open the Deleted Items folder, right-click the file you want to get back, and click Restore.
To play your playlist, select it in the left pane and click the Play button (or right-click it and click Play).

**FIGURE 16-10** Use the up and down arrows to adjust the playlist order

To play your playlist, select it in the left pane and click the Play button (or right-click it and click Play).

**Did you know?**

**You Can Mix Media Files in a Playlist**

You can include any multimedia item currently in your Media Library in a playlist. This means you can mix music, video, radio stations—any multimedia item—together into a playlist. In the same manner, you can create a playlist that contains only music or only video. The choice is yours—just follow the same playlist creation process, regardless of the kind of media you want to use.
Radio Tuner

The Radio Tuner feature, shown in Figure 16-11, brings Internet Radio to Media Player. With a good Internet connection, you can listen to radio stations all over the world that stream data over the Internet.

How to ... Import and Export Playlists

You can import playlists from other locations, such as those found on Web sites, by first downloading the playlist to your computer and then using File | Import Playlist in Windows Media player. In the same manner, you can export your playlists using File | Export Playlist so you can share your playlists with others as well.

FIGURE 16-11 Use Radio Tuner to listen to Internet radio stations.
The Radio Tuner interface has two basic portions—Stations and Search Functions. The following two sections show you how to use each.

As I mentioned, the radio tuner feature uses streaming media. If you're using a dial-up connection, you may find that radio listening is somewhat choppy and unpredictable. This problem is caused by the low-speed modem connection, and I'm afraid there isn't much you can do about it. Like many Internet features today, Internet radio simply works better with a broadband connection. See Chapter 8 to learn more about broadband connections to the Internet.

**Using Stations**

In the Stations section of the interface, you see a drop-down menu where you can select preset options. Windows Media Player gives you a list of a few popular Internet radio sites to pick from. If you want to reach one of these, double-click the name in the list to connect to the site. You can create your own preset radio stations by changing the drop-down window to “My Stations.” Use the Edit, Add, and Remove buttons to manage your station list. However, you can’t add any stations to the list until you have located one using the Station Finder, which is explained next.

**Using Station Finder**

You locate Internet radio stations using the Station Finder window. To find a particular station, click the desired category button, or you can browse the stations by category (such as rock, gospel, jazz, and so on). When you find a station you want, just double-click it in the list—you will then be connected and able to listen to the station. If you want to save the station, click Add to My Stations to add the station to your presets, as shown in Figure 16-12.
Copy to CD or Device

The Copy to CD or Device feature, shown in Figure 16-13, provides an easy way to copy files from your Media Library to a portable device, such as a Palm unit, or even to a remote storage media, such as a Zip or Jaz disk.

As you can see, the interface is very simple. Use the drop-down menu to select the device you want to copy to, and then select the items you want to copy. Finally, click the Copy Music button. Your specified items are copied and you can now use them on your portable device.
Skin Chooser

Media Player includes a number of different skins—or interface overlays—you can apply to Media Player. These skins give Media Player completely different looks, which you may find very appealing or very aggravating—depending on your point of view. For example, you can choose a skin that looks like the inside of someone’s head, as shown in Figure 16-14; one that looks like a heart; and a number of other interesting options.

As you can see, these are just for fun—you still have the same functionality in Media Player, regardless of what skin you choose to use. To use a skin, select the one you want and click the Apply button. You can also click More Skins to connect to the Media Player Web site where you can download other skins—you’ll find several others available on this site.

Although skins are fun, I have found some of them are more aggravating than others. Sure, you maintain the same Media Player controls in each skin, but some of them seem to be more of a hindrance than a help. Experiment with the available skins and download some new ones so that you can find the one that is just right for you—and remember, you don’t have to use one at all.
Download a Skin

To download a new skin, follow these easy steps:

1. In the Skin Chooser feature, click the More Skins button.
3. Check out the skins available. When you find one you want to download, just click it.
4. Download begins automatically, and the skin is installed in Windows Media Player.
5. When the installation is finished, just click the Apply button to start using the new skin.
If you’re a skins fanatic, there are Web sites you can visit to download additional skins, such as http://www.skinz.org. Make sure the skin you select is compatible with Windows XP and Media Player 8, and do note that some Web sites contain skins that are not appropriate for children, so parents be aware.

Media Player Configuration Options

Aside from all the fun and frills of Media Player, you can click the Tools menu and click Options to do a few things that are more substantial. You see several different tabs with a number of options on each tab. Let me say here that the default options are typically all you need, so this is not an interface where you need to wade around and make configuration changes. However, there may be instances when you need to use these options. The following list tells you what is available on each tab.

- **Player**  This tab contains a number of basic check boxes. By default, your Media Player checks the Media Player Web site for updates to Media Player on a monthly basis. This setting is all you need. By default, Media Player opens and starts the Media Player Guide. You can change that behavior by clearing the check box on this tab.

- **Copy Music**  This tab enables you to make setting adjustments concerning the copying of CD music. See the earlier section, “Copy from CD Audio,” for details.

- **Devices**  This tab simply lists all devices found on your computer that can be used for media playback, such as your CD-ROM or DVD drive. If you select your drive and click Properties, a simple window appears, as shown in Figure 16-15. This tab allows you to choose whether to use analog or digital playback and copy. Typically, this tab is set to digital; but if you’re

---

**NOTE**

Notice the Download Codecs Automatically check box option, which is selected by default. A codec is a compressor/decompressor mathematical algorithm that is used for audio, video, and image files. The codec allows the file to be compressed and then uncompressed so that it can be read. Media Player must have codecs to be able to play files. If a codec is used to compress a file, then the same codec is used to decompress it. If Media Player does not have the correct codec, it will attempt to automatically download it for you. So, if you clear this check box option, Media Player will not be able to get the codecs it needs—leave this check box selected!
having problems, you can try the analog setting. The error correction feature, available only with digital playback, allows Windows to attempt to resolve problems found in the digital media. This setting can be used, but you may notice a negative effect on the performance decrease of your system—so I recommend you skip it unless you’re having problems with digital media.

- **Performance** These settings affect how Media Player uses your Internet connection. You do not need to configure anything here, but I will note that, by default, Windows Media Player can detect your connection speed to the Internet. This allows Media Player to determine how best to handle media downloads. Make sure you leave this setting as is, because Media Player will perform better if it can detect your Internet connection speeds. See Chapter 8 to learn more about Internet connections.

- **Media Library** By default, media library gives other applications that access the media library read-only access, and no access to anyone on the Internet. You should leave these settings alone.
Visualizations Use this tab to add and remove visualizations. Remember that you can also download new visualizations quickly and easily from the Tools menu.

Formats This tab lists the file formats Media Player uses. You don’t need to change anything on this tab. All of the options you see here are selected, and they should remain that way so that Media Player can work with your devices and all file types. Clearing any of these check boxes will stop some types of media from working in Media Player.

DVD The DVD tab gives you management options if you are using a DVD drive. The first is parental control. Let’s say you have some R-rated DVDs, and you don’t want your kids sneaking to the computer to watch them. Aside from locking up the DVDs, you can also use the DVD tab to enable parental control. Click the check box option and then use the drop-down menu to select the highest rating that requires a username and password. For example, if you select PG-13, then your children can watch G, PG, and PG-13 DVDs without entering a username and password. You must have Windows accounts set up on your computer for this feature to work, so see Chapter 13 to learn more about user accounts in Windows XP. The second section of the window allows you to select language settings for subtitles, audio, and menu. Use the drop-down menus to select the desired language, or you can leave these as “title default.”

Remember that the View menu has several DVD features that you can use. Experiment with these options so you will know the full range of DVD controls available to you.

Network This tab contains protocol usage settings and proxy server enabler settings. You don’t need to change anything here unless your computer is on a network that uses a proxy server. Unless a network administrator instructs you to make changes, leave this tab alone.

Finally, from time to time, you should check the Media Player Web site for updates that need to be made to Media Player. Media Player is an ever-growing animal, so you’ll want to have the latest and greatest. You can easily check for updates by clicking the Help menu and then clicking Check for Player Updates. This action connects you to the Internet, and it opens an installation options window so you can choose what new features you want to download and install.
How To...

- Import Data into Windows Movie Maker
- Use Windows Movie Maker
- Create and Edit Movies with Windows Movie Maker
- Use Audio with Movies

Over the past few years, computer users have demanded more from computer systems. We want computer systems that will perform the tasks that we need, but we also want computer systems that give us a digital playground. Windows XP helps meet this need by providing great digital media support, including support for digital video editing and analog-to-digital video conversion. That support is accomplished through a free application included in Windows XP, called Windows Movie Maker.

First introduced with Windows Me, Windows Movie Maker is a basic video editing tool that allows you to manage segments of video and even create your own video production. It has a number of useful features, and in this chapter, you’ll explore Windows Movie Maker and see how it can help you manage and create video files.

Why You Need Windows Movie Maker

If you are like me, you tend to use a lot of videotape. There’s everything from Aunt Ruth’s birthday party to little Johnny’s latest shenanigans. You may also have piles of still pictures lying around—most of them not even in an album. Windows Movie Maker is designed to help you both manage and edit your home videos and pictures. You can use Windows Movie Maker to organize the data, edit it, save it, and even share it with others over the Internet. In short, it gives you a way to manage those precious moments electronically and reduce the clutter around your house.

One of the greatest benefits of Windows Movie Maker is that you can take analog video (such as your typical camcorder or VHS tape), import the analog video into your computer, and then manage it electronically. “So what?” you might ask. The great thing about this feature is the fault tolerance—once the video (and even pictures) are stored electronically, you can create multiple copies of them. You could even store your movies on a Zip or Jaz disk and put it in a safety deposit box at your bank. If your computer has a CD burner (Read/Write CD-ROM), you
can store your movies on CD for safekeeping. Windows Me gives you the ability to safely and easily make copies of your life captured on film to ensure that nothing happens to those memories in the future.

Another great feature of Movie Maker is editing. In any given videotaping session, you are likely to have a lot of dull spots. Consider this personal example: During the writing of this book, my wife gave birth to our daughter, Mattie. A few weeks after the commotion of the new birth, we sat down to watch the hospital video. We saw heartwarming moments and memories we never want to lose, but we were also faced with miles of boring videotape. Not wanting to miss anything, we filmed everything. Although everything seemed important at the time, in retrospect, I don’t want to see hours of videotape basically saying: “Here we are, waiting for the baby. . . .”

With Windows Movie Maker, you can easily cut away the boring section of video and keep the good stuff. This feature makes watching your movies more interesting and entertaining, as well as shorter. Also, the editing features can help reduce the amount of storage space, and you can even join together unrelated clips of video.

Finally, you can have lots of fun with Movie Maker. Create your own home movies and edit in transitions, voice, background music, and much more. Get creative and stretch your brain—as you will see, there are tons of possibilities.

What Is Not So Great About Windows Movie Maker

Believe me, I’m not completely enraptured with Windows Movie Maker; so for all of you skeptics and otherwise curious readers who want to know what is not good about Windows Movie Maker, I’ll give you my two cents in this section.

First, Windows Movie Maker is a free application included with your XP system—this should indicate to you that video-editing software is not Microsoft’s main focus, and Movie Maker is, in fact, a basic video-editing package. It is not an advanced application. I’ve used other video-editing software from other vendors that was much, much better, so I don’t mind telling you up front that if you are really interested in getting into movie editing and production, you might want to look for a different software package that will really give you the power and tools that you need. However, Windows Movie Maker is free and readily available; and if you have basic video editing needs, Movie Maker will work just fine. Overall, the software is very intuitive and easy to use, as you will discover in this chapter.

There is one specific caveat regarding Windows Movie Maker: When you create movies in Movie Maker, you are forced to save those movies as a Windows Media Video File (WMV). You do not have the option to use other standard video
formats, such as AVI or MPEG. Windows Movie Maker can read these types of files, but you can’t save your work as one of them. The point here is that you will need a Windows computer that has Windows Media Player installed to be able to play Movie Maker files. That may not be a big deal—but if you want to play the video on a system that does not have Windows Media Player, such as a Macintosh, you may have some compatibility problems. Again, this may not be a problem for you, but I think Windows Movie Maker should give us more file format options than it presently does.

If you used Windows Movie Maker with a Windows Me computer, you may be wondering what is new and improved in Windows XP. Well, truthfully, nothing. The Movie Maker program was basically dumped into Windows XP as it existed in Windows Me; so if you already know how to use Movie Maker from Windows Me, you’ll find nothing new here. Apart from these considerations, Movie Maker is a great little tool, and the rest of this chapter shows you how to use it.

**Getting Ready to Use Windows Movie Maker**

If you read like I do, you may be tempted to skip over this section and get to the fun stuff, but I encourage you to read this section carefully to avoid a bunch of headaches and sorrow later on. Windows Movie Maker is a great tool; but in order to make it work, you have to spend a little time inspecting the hardware requirements. The trick, of course, is to get your analog or digital video and/or pictures inside your computer and to Windows Movie Maker.

First of all, let’s consider the basic system requirements you need in order to run Windows Movie Maker:

- **Pentium 300 MHz or equivalent**  If you’re using Windows Me on an older processor that is limping along, I’m afraid it won’t have the power Movie Maker needs to process graphics and sound.

- **64 MB of RAM**  You need this minimum amount of RAM for Windows Movie Maker to function properly. If you want to function well, you should have more RAM than 64 MB.

- **Up to 2 GB of storage space**  Movie files use a lot of storage space. Make sure your computer has plenty of room to store the movies you create.

- **A video card or video capture device**

- **A sound card or sound capture device**
Windows Movie Maker will look for and expect to find both a video and sound card or other capture device. If it doesn’t, you’ll receive a message telling you that your computer does not meet the Movie Maker requirements.

Now that you know the basic requirements, let’s spend a moment talking about getting video and pictures into your computer. First, if you are using a digital camera or camcorder, you’re not going to have any problems at all. Because the media is already digital, you simply connect your camera or camcorder into your computer, and follow the manufacturer’s instructions for saving the digital content to your hard disk.

For the best performance, your computer needs an IEEE 1394 card, so you can import movies from a digital camcorder into your computer (especially important if you’ll be using any streaming media devices). This type of card provides fast transfer from the camcorder to the computer and is highly recommended by Microsoft. You will need to do a little investigative work to determine whether your computer has this card, if your digital camcorder supports it, and if this transfer card is right for you. Go back to your computer and camcorder documentation for more information.

Windows Movie Maker can recognize all kinds of graphics files, from AVI and MPEG to basic Web files such as JPEG and GIF. Once the files are loaded and saved onto your hard disk, you can use Windows Movie Maker to import and begin working with them.

### What Files You Can Use in Movie Maker

Want to know exactly what files Windows Movie Maker supports? Here they are:

- **MPEG Movie Files**  MPEG, MPG, M1V, MP2, MPA, MPE
- **Video Files**  ASF, AVI, WMV
- **Audio Files**  WAV, SND, AU, AIF, AIFC, AIFF, WMA, MP3
- **Pictures**  BMP, JPG, JPEG, JPE, JFIF, GIF, DIB
But what about still pictures or analog video? What about a song you have written that you want to use as background music? Once you move out of the native digital arena, you then must use capture devices to move the analog information into your computer, where it is converted to digital information and saved. In order to do that, you need some kind of capture device that can import the data into your computer—these capture devices are video cards with video and audio input ports and sound cards with an audio input port. By connecting your analog camcorder or VCR to a video card, you can receive the analog data from the camcorder or VCR and convert it to a digital format for use on your computer. In the same manner, your sound card can convert music and voice data from an analog device into a digital format that can be used on your computer.

You may already have a video card and sound card that supports this process. If not, you can purchase new cards at your local computer store. They’re not terribly expensive, generally anywhere from $100 to $200, but do make sure they are compatible with Windows XP—check the Windows XP Web site (http://www.microsoft.com/windowsxp) for continually updated information about compatible hardware. Also, if you previously owned one of these cards under Windows 98/Me/2000, you may need to download new drivers from the card’s manufacturer for it to work correctly with Windows XP. Check out the manufacturer’s Web site to see if there is an update.

If you decide to buy a new card, make sure you know what kind of slot is available in your computer for the card—usually either PCI or AGP. Refer to your computer’s documentation for more information about available ports.

Once you connect your analog device to the capture devices, you can start the video on the analog device, and then use Windows Movie Maker to view and capture it—in a perfect world, anyway. Unfortunately, depending on your hardware, you can experience problems. Because of the variety of hardware available, it is impossible to solve all potential problems here; but I can give you a big tip that might save you some headaches. Usually, the capture device will ship with a CD-ROM containing the card’s drivers and a program or two to help you capture video. Use the card’s capture program and save the video in a common file format, such as AVI or MPG. You can then import the file into Movie Maker and begin your work from there. (See the upcoming section “Recording and Importing Video” for information about importing.)

Check out your capture device’s instructions. Most capture devices tell you exactly how to connect the analog device to the card and capture video—and most even provide the cables you’ll need to do so.
CAUTION Many capture devices save video files in their own default format, which may include compression not supported by Windows XP. When you start to save video using the card’s program, make sure you are saving it in a format that is supported by Windows Movie Maker.

Checking Out the Movie Maker Interface

Before you get started using Movie Maker, you’ll need to take a few moments to familiarize yourself with the Movie Maker interface. Fortunately, the Movie Maker interface follows the typical Windows program interface, so it’s not completely foreign to you. You can find Windows Movie Maker by clicking Start | All Programs | Accessories | Windows Movie Maker. The basic interface, shown in Figure 17-1, appears.

There are four major parts to the Windows Movie Maker interface:

- **Toolbars** At the top of the interface, you see the Windows Movie Maker toolbars. You first see the menu options, such as File, Edit, View, Clip, and so on. The menu options contain typical Windows menu features plus those specific to Windows Movie Maker. We’ll be using these throughout the chapter. You will also see the standard toolbar under the menus that presents typical toolbar options. Finally, you will see a third toolbar called the Collections/Locations Toolbar, which is used to manage the video collections you are working on at the moment. Collections are simply file folders used to hold portions of video or pictures—a simple way to organize your files.

- **Collections area** The middle-left side of the interface is called the Collections area. This area is used to view and manage collections of data and view clips that you are working on at the moment. Clips are pieces of video or pictures, and you’ll learn about those in a moment.

- **Monitor** The middle-right side of the interface is called the Monitor. When you are working with video or still shots, the picture appears here. You also have standard start and stop buttons (along with others) to view video.

- **Workspace** The bottom portion of the interface is called the Workspace. You use this area to edit video and/or combine still shots. You’ll learn how to use the Workspace later in this chapter.
Recording and Importing Video

Now that you have taken a look at the interface setup, you are ready to begin recording or importing video. You record video if you are streaming it live into your computer. For example, with your digital camcorder, analog camcorder, or other device (such as a DVD Player or VCR), you can begin the streaming process, which appears in the Monitor in Windows Movie Maker. To record the video as it appears, just follow these steps:
1. Begin playing the video from the desired device into your computer.

2. Click Start | Programs | Accessories | Windows Movie Maker to open the interface.

3. You will see the video appear on the Monitor. Click the Record button on your toolbar. A window appears where you can change the default recording options. Make sure the Create Clips check box is selected, and then click the Record button again.

4. The video is recorded by Windows Movie Maker, as shown in Figure 17-2. Notice that clips are being created and appear in the Collections area.

5. When you have finished recording, press the Stop button in the Monitor area.

6. Press the Save button on the toolbar, or click the File menu and then click Save Project As.

7. The Save As window appears. By default, the project is saved in the My Videos folder found in My Documents. You can select an alternative location if you want. The file is saved as a Windows Movie file (.mswmm).

Aside from recording video, you can also import multimedia files—both video and audio (as well as still pictures). In many cases, you will choose to use the

---

**Did you know?**

Projects Contain Clip Files

A *project* consists of a series of clips that you save together. The project is saved as a .mswmm file (Microsoft Windows Movie Maker). Each clip within the project is saved as a .wmv (Windows Movie) file. A clip that contains audio only is saved as a .wma (Windows Media Audio).
Import feature simply because you can work with previously saved files. To import a file that has been previously saved, just follow these steps:

1. In Windows Movie Maker, click the File menu and click Import.

2. The File Import window opens, shown in Figure 17-3. By default, the import feature looks in My Videos for a file to import, so you may have to navigate to another location on your computer where the file is stored. Windows Movie Maker looks for all kinds of media files—just select the one you want and click Open. Notice that there is a “Create clips for video files” check box. You should leave this check box enabled.

3. The file is imported into Windows Movie Maker. You can now work with it or save it as a project.
When you import a file, the actual source file that you choose to import is not moved from its current location. Windows Movie Maker imports and uses the data but does not change the location of the existing source file. You are then free to use the source file for other purposes as needed.

**Working with Collections and Clips**

As previously noted, collections are basically folders that contain clips of video or audio data. Collections provide a way for you to organize and save those clips as a project. Whenever you record or import media, Windows Movie Maker creates clips, by default. Windows XP creates clips to break apart video sequences into manageable chunks. Windows XP examines the video stream and attempts to segment it when the picture sequence changes. For example, I imported some video of a birthday party. One portion of the video contained the cake and presents, while the next showed the kids playing outside. Windows XP broke the two sequences into two different clips, which I can manage and use. This doesn’t always work perfectly, but it does work well enough so that Windows Movie Maker can help you manage and edit your video more easily.
If you right-click any collection, you can delete the collection (which deletes all of the clips belonging to that collection), rename it, or import or record more clips into the collection. Note that you can create collections within collections. Remember, collections are just folder structures that enable you to organize clips, so do what works best for you to keep your data organized in a suitable manner.

You can also right-click any clip and perform cut, paste, and copy functions (you can move clips from one collection to another), play a clip, or access a clip’s properties. The Properties window, shown in Figure 17-4, enables you to enter some basic information about the clip.

Use this window to give the clip a title, adjust the clip’s creation date, give the clip a rating (such as G, PG, or R), and give the clip a description. Of course, you don’t have to enter any of this information, but doing so may help you keep clips organized if you are working with many of them.

**Making Movies**

Now that you know how to record or import data and how to manage collections and clips, it’s time to turn our attention to making movies. Using Windows Movie Maker...
Maker, you record or import the clips you want to use, organize them into collections, edit them as desired, and then save the project. You are now ready to begin editing your video or still-shot clips. Keep in mind that you can combine video and still shots into one collection and blend them together as desired. You can also import background music and narrate a movie by recording your voice. The following sections show you how to perform all of these tasks.

**Splitting Clips**

Windows Movie Maker creates clips for you; however, you may need to split those clips into more manageable pieces. You can perform this function by using the *split* command. The following easy steps show you how:

1. Select the clip that you want to split in the Collections area.
2. In the Monitor area, click the Play button.
3. When the clip reaches the point at which you want to split it, click the Split Clip button in the Monitor area. You can also click the Clip Menu and click Split, or simply press **CTRL+SHIFT+S** on your keyboard. In the Collections area, the clip is split in two—the first part of the clip retains its original name, while the second clip contains the original name followed by (1), as shown in Figure 17-5. You can change the name as desired.

   *You’ll find helpful keyboard shortcuts for the split command, along with many others, on the inside back flap of this book.*

**Combining Clips**

Just as you can split a clip into two or more clips, you can also combine clips as needed. If you want to combine two or more clips, just follow these steps:

1. In the Collections area, select the clips that you want. Select the first clip, hold down the **SHIFT** key on your keyboard, and select the remaining clips that you want to combine.
2. Click the Clip menu, and then click Combine. The clips are combined using the first clip’s name.
Getting Familiar with the Workspace

The Workspace at the bottom of the interface is the area where you edit and assemble movies. If you examine the interface, shown in Figure 17-6, you see a few buttons on the left side of the area that correspond to areas in the Workspace. The areas are

- **Timeline**  Click the Timeline icon to make a timeline appear. You’ll use the timeline to assemble and edit video clips.

- **Video/Audio Area**  Here are zoom in and zoom out icons and an area where you can place video clips.

- **Audio clips**  At the bottom of the Workspace, you see an area where you can place audio clips. You use this area to overlap sound onto a movie.

**FIGURE 17-5**  Split existing clips into more manageable pieces.
Creating a Storyboard

You can use the Workspace to create a storyboard or to sequence your clips together. First, drag clips onto the Workspace area to create the storyboard. You can then edit them as desired for transition purposes. Begin by dragging the first clip in your movie to the video area of the Workspace. Once in position, you see the first frame of the video displayed and a gray area indicating the rest of the clip. Notice in the timeline that the time of the clip is displayed. This corresponds to the grayed, or blocked out, area in the video frame. By using the timeline, you can connect pieces of clips together while keeping a watch over the time frame of the whole movie, as shown in Figure 17-7.

The zoom in and zoom out buttons let you see more detail concerning the timeline. While zoomed out, the storyboard is shown to you in increments of ten seconds. You can zoom in and zoom out more to see the clips in whatever time measure you want.

Remember, feel free to mix video and still shots together on the storyboard. By default, imported still shots are given five seconds of time on a storyboard. You can change this default by clicking the View menu and clicking options. Change the default imported photo duration value from five seconds to a desired value.
Create a Title Slide

You can create title slides, or insert slides into your storyboard with other graphics or text. It’s very easy, and here’s how you do it:

1. Create the desired slide using a program like Paint or Microsoft PowerPoint.

2. Save the file as a graphics file in a format supported by Windows Movie Maker, such as a bitmap or JPEG.

3. In Windows Movie Maker, right-click the collection where you want the slide imported, and then click Import.

4. Browse and locate the slide and click Open. The slide is imported and now appears in your Collections area.

5. Drag the slide onto the storyboard to the desired location.

Preview Clips or Storyboards

As you are working with clips and constructing a storyboard, you’ll want to stop and preview how things are looking so far. Not a problem—if you want to preview a clip, right-click it and click Play. If you want to see an entire storyboard, right-click the storyboard and click Play Entire Storyboard/Timeline. If you don’t like right-clicking, click the Play menu to get the same options.
Trimming Clips

As you are working with clips in the storyboard, you will notice areas of your video that you want to cut out, or trim. These are often dead spots in the video where not much is happening. For example, let’s say you have been videotaping your dog. Your dog does this great trick, but to capture the trick, you end up filming a boring minute or two waiting for the dog to do his trick. Now you want to lose the boring time when you create the movie—no problem, just trim off the excess.

In reality, the trim feature is very powerful because it gives you a fine level of control over your clips. You can use the timeline feature in the Workspace and trim away seconds of a clip that you do not want to use. There are two ways to trim clips, and here’s the first:

1. In the Workspace, select the clip you want to trim. The first frame of the clip appears in the Monitor.

2. The trimming process keeps the portion of videotape that you trim and discards the rest. That seems a little confusing, but think of a piece of paper. You trim away the pieces you don’t want in order to keep the primary piece. With the trim feature, you set a beginning and an end trim point, and everything outside of the area is trimmed away. To begin trimming, click Play in the Monitor area.

3. Watch the clip until it reaches the place where you want to begin trimming. Click the Clip menu, and then click Set Start Trim Point. (Remember, anything previous to the beginning trim point will be discarded.)

4. When the clip reaches the point where you want to stop trimming, click Clip, and then click Set End Trim Point. All video outside of the trim area is cut away.

5. If you don’t want to keep the trim points, just click the Clip menu and click Clear Trim Points.

The second way you can trim clips is by using the timeline. Follow these steps:

1. In the Workspace area, select the clip in the storyboard that you want to trim.

2. Above the clip in the timeline, you see inverted triangles on the top edge of the video—one at each end. These triangles are the trim feature. You can slide them along the timeline to adjust the location of the trim. As you slide them, the clip is shown in the Monitor area, frame by frame, so you can see where to place the beginning and ending trim points.
As you can probably guess, the trim feature is very useful—but a little confusing at first. Spend a few moments playing with the feature until you get the hang of how it works.

Creating Transitions

Windows Movie Maker provides a default fade transition that you can use between clips. For example, let’s say your movie contains clips of your vacation in Hawaii. You can use Movie Maker to assemble the clips and place a transition between them so the flow from clip to clip is more natural and less choppy.

You can easily create transitions by using the Workspace. Follow these steps:

1. In the Workspace, make certain that the Timeline view is enabled.

2. Between the two clips where you want to make the transition, select the transition on the right side of the two clips, and then drag a portion of the right clip over the left clip, as shown in Figure 17-8. The overlapping area is the transition. From the first clip, the screen will fade into the next clip. You can make the transition as long or short as you like (but it can’t exceed the entire length of the clip).

3. Experiment with the transitions by altering the amount of overlap. Remove the transition by moving the clip back to its original position.

Audio Files and Your Movies

Once you have placed clips on the Storyboard, trimmed and transitioned as desired, you can add audio to your movie. For example, you can add narration, background music, or even additional background noise. If it’s an audio file, you can add it to your movie.
About Other Transition Options

As you plan transitions, keep in mind that you can import a variety of graphics file types into your storyboard. This feature enables you to place other kinds of transitional elements in between your clips. For example, you could use PowerPoint to create a slide to insert between your clips, or use Paint to create a graphic. You can have the clips transition into these slides as well. Be creative—explore and experiment!

You may think, “What about the audio on my existing video?” For example, let’s say you tape a family reunion. Everyone is talking and laughing, but you want to add soft background music to the movie. Can you add the music without ruining the original audio? Absolutely, and in this section I’ll show you how.

Adding Audio to a Movie

In the Workspace area, there is an audio portion of the storyboard at the very bottom. To record your voice, or some background music or sounds, you click the microphone icon. You should have your computer microphone connected and tested, or make sure that the other sound input device that you want to record is ready.

If you have an existing audio file you want to use, use the import feature to import the audio file into your existing collection, and then just drag the audio file to the audio portion of the Workspace.

To record an audio file, just follow these steps:

1. In the Workspace area, click the microphone icon.
2. A window appears listing the sound device that you will use to record the audio, as shown in Figure 17-9. If you have more than one sound device installed on your computer, use the drop-down menu to select a different device as desired. When you are ready, click the Record button. If you do not want to hear the existing video soundtrack while you are recording your narration, just click the Mute Video Soundtrack check box.
3. Give the file a name and save it. The file now appears in your Collections area.
Recording narration, or other background music or sounds, does not erase the original video soundtrack—it simply adds another stream of sound to the existing movie.

Adjusting Audio Levels
Once you add audio to your movie, you can adjust the audio level as needed. This is particularly helpful if you have two streams of audio—for example, a primary audio stream, such as voice, and a secondary audio stream, such as background music. By default, Movie Maker sets both streams to the same audio level, so you’ll need to adjust them for your movie. To adjust audio levels, just follow these steps:

1. In Windows Movie Maker, click the Edit menu, and then click Audio Levels.
2. On the slider bar that appears, move the slider as needed (see Figure 17-10). The video track contains your primary audio, and the audio track contains the secondary audio.

Mixing Audio
Feeling creative? You can create sound clips and have them overlap with each other. You do this the same way you create transitions in the Workspace. Just drag the audio files to the audio section of the Workspace, and then drag portions of
them together where you want. This way, you can have narration and a funny sound bite, or music and some additional narration or sound flowing over the top of it. There are all kinds of possibilities—don’t be afraid to experiment!

**Saving Movies**

As you’re working on your movie, you can save the entire project. Use the File menu in Movie Maker and choose Save Project or Save Project As. When you’re ready to begin working again, you can open the project and continue.

When your movie is finished, you can then save it as a movie file so that Windows Media Player and other media software can read and play the movie. To save the movie, click the File menu and click Save Movie. Once you save the movie, you can then view it with Windows Media Player.

**Using Your Movies on the Web**

As long as your friends and family have Windows Media Player on their PCs, you can e-mail your movies to them and they can watch them on their own computers. However, let me warn you that multimedia files, such as movies, can be quite large, so be wary of sending a movie to someone who accesses the Internet with a modem. You really need high bandwidth access, such as DSL or a cable modem, for sending or receiving multimedia files.

To send a movie over e-mail, just click the File menu and use the Send Movie To option. Choose either e-mail or Web server, and then follow the instructions that appear.
Copyright Laws Apply to Your Movies

As you are creating movies, it is important to keep in mind that copyright laws apply. If you are creating any items that will be used on the Internet, you are liable for using information (including music) in your movies that belongs to someone else. For home movies you create for fun, this isn’t an issue; but do investigate copyright rules before creating movies that are distributed to other people.
Part IV

Optimizing, Troubleshooting, and Fixing Windows XP
How to…

- Access Disk Properties
- Run Disk Tools
- Configure and Manage Scheduled Tasks

Windows XP is an advanced operating system that, for the most part, is able to take care of itself. Hardware management and even error correction, can be done automatically; unlike with computer systems of the past, you don’t have to spend much of your time thinking about care and maintenance. However, Windows XP provides you with tools that will help keep the XP system running at its peak. In this chapter, we’ll explore those tools, how you can use them, and how they help your system run better. Most of the tools you will see in this chapter have to do with hard disk maintenance. You should check out the information in this chapter, and be sure you also read Chapter 19, which covers more advanced disk management features in Windows XP.

Hard Disk Basics

Before we explore hard disk maintenance, we should first take a quick look at hard disk basics. After all, it is much easier to maintain and care for a part of your computer if you have some basic understanding of it. Every Windows XP computer has at least one hard disk. A hard disk is made up of a platter that holds magnetic material. This platter is hard, not flexible like other types of storage media, such as magnetic tape. When the operating system needs to either read or write information to the disk, the platter spins—often at over 100 m.p.h., and data is read from or written to the disk in small chunks called bytes. This is why you hear a churning noise from within your computer when you open or save files, open programs, or perform other memory-related actions on your computer.

You can think of the hard disk as the computer’s storage area. All applications, files, folders—practically everything that is installed or exists on your computer—resides on the hard disk, including the Windows XP operating system itself. Because the hard disk is one giant storage area, it is important to keep the disk in tip-top running shape, and the tools found in Windows XP can easily help you optimize the hard disk.
File System Basics

I mentioned in the previous section that a hard disk is a storage area where all files, applications, and other types of system information are stored. When you want to view a file or even open a program, Windows XP accesses the hard disk to retrieve the information. However, hard disks are basically blank slates, and Windows XP cannot store information on a hard disk until it has been formatted. Formatting is a process that logically divides the disk into sections so that information can be stored on the disk in an organized way. Think of the hard disk as a filing cabinet, and the file system as the folders that are placed in the filing cabinet. Windows XP uses a file system to organize data so that it can be easily recorded and retrieved. Without a file system, Windows XP would have no way to keep track of the information stored on the hard drive.

Windows XP supports two different kinds of file systems: FAT32 and NTFS. FAT32 was used by Windows 95/98, as well as Windows Me (and also supported by Windows 2000), and the NTFS was used by Windows NT and now Windows 2000. In truth, Windows XP works just like Windows 2000, because it can read either FAT32 or NTFS. Without getting into too many gory details, the following two sections tell you about each type of file system.

FAT32

FAT32—the acronym stands for File Allocation Table—is a basic file system that has been around for quite some time. FAT16 was the original FAT file system, and it was used to easily organize and manage small disks. FAT32 came onto the scene when large (over 1 GB) hard drives became popular a few years back. FAT32 is a simple file system that Windows XP can use to manage your computer’s hard disks. FAT32 supports very basic folder security.

NTFS

NTFS is a file system that was first introduced with Windows NT. NTFS is a much more complex file system than FAT32, and it supports both folder and file security. This means that you can place security restrictions on folders, and you can finely control access to resources with users and groups. NTFS is also supported in Windows XP and is considered a much more powerful file system than FAT32.

You can format your computer’s hard drive with either FAT32 or NTFS—Chapter 19 explores this issue in more detail.
Hard Disk Properties

As you have learned throughout this book, almost everything in Windows XP has “properties” pages—a place where you can get more information about a feature or component. Your hard disks, removable disks, and CD/DVD ROM drives are no exception. If you open My Computer on your Desktop, you’ll see an icon for each drive available on your computer. You will see your C drive; a floppy drive; a CD/DVD ROM drive; possibly other drives, such as a Zip or Jaz drive; and even portable devices are listed here if they are attached to your computer, as shown in Figure 18-1.

As you can see in Figure 18-1, my own computer has four hard disks (C, E, F, and H), a floppy drive, a CD-ROM drive, and a Zip drive. You can also inspect your computer’s disk drives using the Computer Management console found in Administrative Tools in the Control Panel, as shown in Figure 18-2. The Computer Management console is a powerful tool that we will explore in more detail in Chapter 19.

---

**FIGURE 18-1** Drives found in My Computer
If you right-click any of the hard disk(s) and click Properties, you see a standard properties sheet with four basic tabs. There are some maintenance and management features on each tab, and the following sections examine each of them individually. Also note that you can right-click any removable storage media, such as floppy drives and CD-ROM drives, and view their properties sheets as well.

The tools and options presented in the following sections apply only to writable disks—not read-only CD-ROM or DVD disks.

**General Tab**

One of the best things about the General tab is the pie graph, which you can see in Figure 18-3. You can access your drive’s General tab at any time and see exactly how much disk space is used and how much disk space is free (available for use). You get this usage information for any writable disk, including your floppy drive.
Aside from getting information quickly, there are only two things you can do on the General tab. First, you can enter a label for the disk. The label isn’t anything usable to you, so most people don’t put anything here. The other option on the General tab is the Disk Cleanup option, which you will find useful from time to time.

Disk Cleanup is a utility that inspects your hard disk and looks for files that can be safety deleted. By deleting unused or unneeded files, you free up disk space that can be used for other purposes.

To run the Disk Cleanup utility, just follow these steps:

1. On the General tab, click the Disk Cleanup button.

2. Disk Cleanup scans your disk, and then provides you with a window, shown in Figure 18-4, that has two tabs—Disk Cleanup and More Options. The Disk Cleanup tab lists categories of potential “delete” items and the amount of disk space you will gain by emptying each one.
3. To inspect a category, select it and click the View Files button. This feature enables you to specify which items within a category you want to delete.

4. When you are sure of what items/categories you want to delete, click the check boxes next to those categories; then click OK.

5. Also notice the More Options tab, shown in Figure 18-5. Disk Cleanup inspects basic temporary storage areas on your computer, but you can use the More Options tab to specify different cleanup options. The Clean Up buttons simply take you to other areas on your computer where you can remove unwanted items, such as Windows Setup and Add/Remove Programs.

![Disk Cleanup window](image)

**FIGURE 18-4** Disk Cleanup provides categories of items you may wish to delete.
It is important to remember that Disk Cleanup examines only certain areas of your computer, such as temporary files and downloaded Internet items. Disk Cleanup does not inspect every possible category of items that can be deleted—much of that work is left to you. So, how often should you use Disk Cleanup? A typical user should run this utility once every three months to see if there are unused files that can be deleted in order to free up disk space.

Tools
The Tools tab gives you three important tools you can use to keep your computer disks happy and working efficiently, shown in Figure 18-6. The following sections tell you all about these tools.

Error Checking
The first tool option you see is Error Checking, otherwise known as ScanDisk. If you click the Check Now button, the Error Checking tool is opened, shown in...
About Conserving Disk Space

If you have a newer computer, conserving disk space probably isn’t a big concern to you—after all, it is not uncommon for a typical computer to ship with a 13 GB or higher hard drive. That’s a lot of storage space; but if you use Windows Movie Maker and Windows Media Player a lot and hang onto all of your video and multimedia files, you will need a lot of disk space. Here are some quick and helpful tips to conserve disk space on your computer:

- Uninstall games and programs you do not use. Programs take up a lot of space; and if you aren’t playing all ten of those games you installed, then get rid of them. You can always reinstall one if you need it later—but in the meantime, free up that disk space!
- Old personal files can easily be saved to floppy or Zip disks for storage.
- Check Add/Remove Programs from time to time. If you download a lot of utilities from the Internet, you may need to remove unneeded or unwanted ones.
- Use folder compression (see Chapter 4). Compression helps save disk space and doesn’t interfere with your work.

Figure 18-7, so you can check your disk for errors. The small dialog box gives you the options to automatically fix errors that are found, and to scan for and attempt recovery of bad sectors.

If you don’t have the “Automatically fix file system errors” check box enabled, Error Checking will prompt you to “OK” its fix for every error it finds (which can get really annoying).

The “Scan for and attempt recovery of bad sectors” option allows Error Checking to check the file system of the disk and attempt to resolve any problems that exist with sectors on the physical disk. As a general rule, you should also enable this option when using Error Checking so that you can get a more thorough disk examination.
FIGURE 18-6  The Tools tab

FIGURE 18-7  Error-checking options
So, now that you know what the options are, what should you do? First, let me note that Error Checking is automatically run during reboot after an improper system shutdown. Let’s say your computer locks up, and you have to turn the power off, and then turn it back on. During reboot, Error Checking will check your file and folder structure. If you use your computer a lot, it doesn’t hurt to run the Error Checking test every few weeks, just to make sure your files and folders are up to par.

Error Checking may take half an hour or longer to run, depending on the size of the disk being scanned.

Disk Defragmenter

Windows XP includes a Disk Defragmentation utility that you can access from the Tools tab (or through Start | More Programs | Accessories | System Tools). Before you use Disk Defragmenter, I’ll need to tell you a little bit about fragmentation so you’ll understand the process.

Did you know?

How to Avoid Disk Errors?

Disk errors are a part of life and not anything to be too concerned about, as long as you allow Error Checking to fix them from time to time. Although a number of different actions and problems can cause disk errors, here are some “operation” tips to help you avoid them:

- Always use the Start menu to turn off your computer. This enables Windows to shut down in a proper manner. Avoid shutting down your computer by just turning off the power button.

- Uninstall programs by using the program’s uninstall feature or Add/Remove Programs in the Control Panel. Do not delete a program’s folder to uninstall it unless there is no other way.

- If you have a lock-up or some other problem that forces a hard reboot, allow Error Checking to run at reboot to catch any new errors.
Fragmentation is a normal part of disk usage, and it occurs at the file system level. Windows XP is not able to use a disk of any kind unless the disk is formatted. Formatting logically divides the disk into sectors and regions—basically making a grid out of the disk so that blocks of data can be stored on the disk. The grid allows Windows XP to keep up with which block of data is stored where; otherwise, the disk would become a big confusing mess. In order to create this grid, Windows XP uses a file system (FAT32 or NTFS), as discussed earlier in this chapter. Once the file system is in place, Windows XP can write and read data to and from the hard disk.

In Windows XP, data generally is stored on the disk in a “contiguous” manner. This just means that data is stored “in order.” For example, let’s say you’re working again on that “Great American Novel.” When you save the document, it is divided into pieces—or blocks of data—and stored in a “row” on the disk. Later, when you make changes to the document, those changes are stored at the end of the row. Over time, as you save, edit, and delete different files, changes to those files are moved to available, but noncontiguous, storage blocks on the disk, so that files become “fragmented”—in other words, they are not stored in a contiguous manner.

When you want to open a file, Windows XP must gather the fragmented pieces together from your hard disk. Because the “pieces” are in different places, this can take longer than it should. The short of it is simply that heavily fragmented drives can cause Windows XP to run slower than it should.

The defragmentation utility takes all of the data on your hard disk and reorganizes it so that it is stored in a contiguous format—or at least close to it. The defragmentation utility found in Windows XP is the same one found in Windows 2000. If you have used defrag in Windows Me or 9x, you’ll notice that the defragmentation utility in Windows XP looks different.

You will see a section listing all disks on the computer, as well as an analysis display and defragmentation display. Click the Analyze button to have XP analyze the disk to see whether it needs to be defragmented, as shown in Figure 18-8. Once the analysis (which is rather quick) is complete, a message appears telling you whether or not you need to defragment the drive.

If you want to defragment the drive, just click the Defragment button. You can watch the display change as the defragmentation utility reorganizes information. Note that the utility will not get 100 percent of your files reorganized—this is normal and nothing to be concerned about. Defragmentation may take some time to complete, especially for large hard drives, so do be patient.
Once defragmentation is complete, you can click the View Report button to find out more information about the condition of the disk. The report will give you overall information about the number of fragments, the disk size, free space, used space, and other related information.

So, how often should you defragment your drives? The simple rule of thumb is based on how often you use your computer. If you are a typical home user, you should run the defragmenter utility about once every two or three months. If you use your PC every day (all day) like me, and you use a lot of files, you should defragment your drives once a month. Doing this will help keep your file system in peak operating condition.
Backup
Windows XP includes a Backup utility that allows you to back up entire disks or individual folders to a backup storage location. See Chapter 19 to learn more about Windows Backup.

Hardware
The Hardware tab lists the disk drives on your computer and gives you information about each one (including whether or not the disk is working properly), as shown in Figure 18-9. You can also click the Troubleshoot button to get help if you are having drive problems; and you can click the Properties button, which opens the standard Device Manager properties sheets for the hard disk.

![The Hardware tab](image)
Share Drives

Let’s say you have a home network. One of your PC’s floppy or CD-ROM drives stops working. What can you do until it’s fixed? Easy solution—have the PC access a shared drive of the same type from another computer in the network. You can also share Zip or Jaz drives so that any computer on your network can access them as well. As you can see, sharing these drives can save you time and money, and it’s very easy to implement. To share a drive, follow these steps:

1. Right-click the drive you want to share in My Computer, and then click Properties.
2. Click the Sharing tab. If there is no Sharing tab, then networking is not set up on your computer. See Chapter 11 for details.
3. Click the Shared As radio button and give the share a recognizable name.
4. Configure permissions as desired.

Sharing

Just as with folders, you can share any drive on your computer so that others on a network can access it. The Sharing tab you see is just like all other Sharing tabs in Windows XP (you can learn more about network shares in Chapter 11). Under most circumstances, you would not want to give someone else full access to your entire hard drive, but you may want to give someone access to a CD-ROM or Zip drive.

If You’re Using NTFS Drives

If your drives are formatted with NTFS, you will see one or two additional tabs on the disk’s properties sheets. If you are using Windows XP Pro in a domain environment, you may see a Security tab where you can set permissions for various users and groups in your domain. Follow the instructions provided by your network administrator to use this tab. Finally, you see a Quota tab. Windows XP supports a
Disk Quotas feature, which first appeared in the Windows 2000 operating system. Disk quotas are designed for network computers where a computer’s hard drive is shared with other network users. For example, let’s say that your Windows XP computer is shared on a network. Your computer has two hard drives, one of which is shared. Network users can store documents in various folders on this drive, and, essentially, your computer acts like a file server. You can configure how much disk space users may consume on the drive using disk quotas. This feature prevents a user from storing information on the drive that may be inappropriate or unnecessary. If you are not sharing drives on a network, then you have no need to configure anything on this tab. However, if you are using your Windows XP computer as a storage/file server on a network, read on to learn about disk quota configuration.

The Quota tab, shown in Figure 18-10, allows you to easily set quota configurations for the particular hard disk you are working with. As you can see on the Quota tab, you have some standard configuration options, allowing you to

- Enable quota management (which is already done by default).
- Deny disk space to users once they have exceeded their quota limits. By default, quota management only warns users when they are over the limit; but if you need to impose strict quota limits, you can choose to deny them disk space until they remove files in order to free up usable disk space.
- Set a limit based on size (such as 1MB), as well as a warning level. For example, if you set a limit of 1MB of storage space, you might want to configure the warning level to appear when a user reaches 800KB.
- Log an event when a user exceeds the quota limit or meets the warning level.

Simply select these check box and radio button options as needed to configure quota behavior. Next, you need to click the Quota Entries button found at the bottom of the Quota tab. Doing this opens the Quota Entries window for the drive, as seen in Figure 18-11.

You use this window to create, edit, and manage quota entries. To create a new entry, follow the steps in the next How To box. You can also make editorial changes to any quota entries you configure, and you can delete entries by selecting the entry and then using the window menus.
CHAPTER 18: Taking Care of Windows XP

FIGURE 18-10 The Quota tab

FIGURE 18-11 The Quota Entries window
Create a Quota Entry

To create a quota entry, follow these steps:

1. On the Quota tab, click the Quota Entries button.
2. In the Quota Entries window, select Quota | New Quota Entry.
3. The Select Users window appears. Use the Object Types button and Locations button to select the desired user or group on your network. You can also use the Advanced button to perform a more detailed search of the Windows 2000 network directory (Active Directory). Once you have selected the desired user/group, the entry appears in the Select Users window, as shown here. Click OK.

4. The Add New Quota Entry window appears. You can choose not to limit disk space usage for that particular user, or you can limit disk space by placing a limit level and warning level as desired. Click OK when you’ve finished, and the new entry appears in the Quota Entries window.
Scheduled Tasks

Remember how I said that you should run Disk Defragmenter, Error Checking, and Disk Cleanup at regular intervals? What if you don’t want to remember and keep up with these housekeeping tasks? The good news is you don’t have to. You can use a Windows XP feature called Scheduled Tasks so you can schedule these utilities to run automatically on your computer at certain times and on certain days.

You’ll find the Scheduled Tasks as an icon in the Control Panel or in Accessories | System Tools. Scheduled Tasks is actually a folder, and when you open it, you see a Scheduled Task Wizard and two preconfigured scheduled tasks that automatically run on your computer. Windows XP needs these preconfigured tasks, so leave them in the folder. However, you can also create your own.

Scheduled Task Wizard

You can use the Scheduled Task Wizard to create additional scheduled tasks for your PC. The wizard enables you to select tasks, and then determine when they should automatically run on your computer. Fortunately, configuring the scheduled task is easy. Just follow these steps:

1. In the Scheduled Tasks folder, double-click the Scheduled Task Wizard icon.
2. Click Next on the Welcome screen.
3. In the next window, scroll through the selections and select a task you want to schedule, as shown in Figure 18-12. If the task you want is not available, click the Browse button and locate it on your computer. Click Next when you’re done.
4. Enter a name for the task (or accept the default) and click a radio button selecting how often you want the task to run, such as daily, weekly, monthly, and so on. Make your selection and click Next.

5. In the next window, select the days/times you want the task to run, as shown in Figure 18-13. This window may vary, according to your selection in step 4. Click Next.

6. In the credentials window, enter your username and password. Click Next.

7. On the completion window, click the Finish button. The scheduled task now appears in your Scheduled Tasks folder.

Managing Scheduled Tasks
Once you have created scheduled tasks, the icons for those tasks reside in the Scheduled Tasks folder. If you later decide that you do not need the scheduled task, right-click its icon in the folder and click Delete. In the same manner, you can choose to manually run the scheduled task at an unscheduled time by right-clicking the icon and clicking Run.
Another piece of good news is that you can access the task’s properties sheet and change basically anything you’ve configured with the wizard. This is a great feature because your needs may change, and you can alter a scheduled task without having to delete it and create a new one. To edit a scheduled task, just right-click its icon and click Properties. There are three tabs, and the following sections tell you what you can do on each.

**Task**

The Task tab, shown in Figure 18-14, allows you to change the location of a particular task and the settings for the task.

When a task is scheduled, the Scheduled Task Wizard notes the location of the program on your computer. When it is time to run the task, the scheduled task starts the program. However, what happens if that program is later moved to a different folder? The Scheduled Tasks Wizard will not be able to find the program, so it will not run. You can use this tab to change the location for the task so that it points to the new location of the program on your computer. In most cases, you won’t need to do this; but if you are running custom programs, you may need to change the information here if the program is moved.
Schedule

The Schedule tab, shown in Figure 18-15, gives you an easy interface where you can change the schedule of the task. Let’s say you originally scheduled Error Checking to run at 8:00 P.M. once every two weeks. However, you have been using your computer a lot in the evenings, and Error Checking has been interrupting you. No problem—just change the start time to a more convenient one on this tab. As you can see, you can change anything about the task’s schedule here.
Settings

The Settings tab gives you several good options—and ones that are not presented to you when you run the wizard, so you will want to check out this tab, shown in Figure 18-16.

As you can see, the options on this tab are rather self-explanatory, but I do want to mention a couple of things you might want to consider. Notice that you have the option to stop a task if it has run for a certain period of time. For longer tasks, such as disk defragmenting, this can be a good safety check, in case another program is interfering with the task and causing it to start over…and over…and over—you get the point. You should, however, not configure this setting too low; 24 hours is your best minimum.
Also, the idle time option can be very useful. You can schedule a task to run at a certain time, but what if you are using the computer when the task is supposed to run? Without the "idle time" feature enabled on this window, the task runs anyway and may interrupt your work or play. You can use the idle time feature so the task waits until the computer has been idle for a certain number of minutes, which you specify. If you use your computer a lot, this feature can be very handy!

Under power management, you should leave the options enabled concerning batteries if you are using a laptop computer. If you're not, you can clear these settings because they do not apply to a desktop PC anyway.

**TIP**

You can configure as many scheduled tasks as you like; however, each task should be configured to run at a different time. In other words, some programs, like Error Checking and Disk Defragmenter, cannot run at the same time. Also, use as many scheduled tasks as you need, but don’t over schedule them. Having too many tasks running at close intervals sometimes causes more confusion than necessary, and may degrade Windows XP performance.
How To…

- Configure Windows XP Disk Volumes
- Use XP Backup and Restore Features
- Explore Removable Storage

Windows 2000 introduced a number of new disk technology features that made disk management more dynamic and versatile and much easier. These same features now appear in Windows XP. As you work with Windows, the importance of effective disk management cannot be overstated—after all, it is the hard disk(s) on your computer that must store all of your information, including the XP operating system. The more you know about disk management and how to effectively administer and maintain hard disks on your system, the more likely you are to have a computer that runs in peak condition and to never lose data from your hard disk. In this chapter, we’ll explore several disk management features in Windows XP.

Disk Management

The Computer Management console, which is found in the Administrative Tools folder in the Control Panel, provides a section called Storage. If you click the plus sign next to Storage, as in Figure 19-1, you see three categories available, one of which is Disk Management. I’ll address Removable Storage later in this chapter, and you can learn about Disk Defragmenter in Chapter 18. The Disk Management console, by default, provides you with both a graphical and a list view of the drives on your computer. As you can see in Figure 19-1, I have three hard drives and a CD-ROM drive.

If you spend a few moments clicking around in the Disk Management interface, you’ll see that both the list and graphical portions tell the same things about your disks—the layout, type, file system, status, capacity, and so on. Disk Management in Windows XP and the options that are available will probably be new to you, and they will certainly be new if you have been using only Windows 9x or Me in the past. The following sections explore these management concepts and tasks so you can see how to manage the hard disks on your computer.

Understanding Dynamic Disks

Dynamic disks, which first came onto the scene with Windows 2000, give you more management and configuration options than “basic” disks. First, I need to
define these two terms. A *basic disk* in Windows XP refers to standard disk configurations in earlier versions of Windows, such as 9x and NT. With a basic disk, you can configure different drives by segmenting the disk into different partitions, and you can perform basic disk management tasks. *Dynamic disks*, on the other hand, give you more flexibility, allow you to make changes without rebooting, and use volumes instead of partitions. Essentially, from your perspective, a partition and a volume are really not different—they both logically segment the disk, but dynamic disks do not have volume number limits. You can also change drive letters and paths on the fly. In short, dynamic disks give you the full range of disk features available in Windows XP, while basic disks are supported for backward compatibility.

Now, if all of this seems like alien gibberish to you, don’t worry. If you are a home user or even an office user, you probably do not need to worry about the differences between basic disks and dynamic disks, and you probably will not need to make any disk changes at all. However, dynamic disks will be an important feature if your computer has several hard disks or if you are an intermediate-level user who wants to take full advantage of all Windows XP disk management has to offer.
If you are using a dual-boot system where multiple operating systems are available on your computer, do not convert any disks that house a “downlevel” operating system, such as Windows 9x or Me.

If you want to convert a disk to a dynamic disk, there must be at least 1 MB of free disk space on the disk for the conversion to take place. Once the upgrade is complete, you cannot reverse it unless you delete all of the volumes (and hence, all of the information) from the disk. You must also be logged on as the computer’s administrator to complete any disk conversion actions.

To begin, you must first convert any basic disks on your computer to dynamic disks. This process is easy and safe, and the following How To box gives you the steps.

You cannot upgrade removable media, such as CD-ROMs or Zip disks, to dynamic disks. Dynamic disks are supported only for fixed disks.

**How to Do Everything with Windows XP**

### Convert to Dynamic Disks

To convert a basic disk to a dynamic disk, follow these steps:

1. In the Computer Management console, expand Storage and select Disk Management.

2. In the Disk Management console in the right pane, right-click the Disk name (such as Disk 0, Disk 1, and so on) and click Convert to Dynamic Disk, as shown next. If you do not see the graphical view, use the View menu and choose Graphical view for either the top or bottom portion of the window.
3. In the Convert to Dynamic Disk window, select all of the drives that you want to convert. If only one drive needs converting, then that is all you will see here. If more than one needs converting, you have the option to select them and convert them all at the same time. This process is safe, so feel free to convert more than one disk at a time if needed. Make your selections and click OK.

4. A window appears listing the disk(s) that will be converted. Click the Convert button to continue.

5. A message appears telling you that you will not be able to start another operating system from any volume on these disks. Click Yes to continue.

6. The disk is converted and now appears as a dynamic disk in the console.

Understanding Disk Status

Dynamic disks provide status information to you in the Disk Management console. If you refer back to Figure 19-1, you can see that disks are shown as “Online” in the graphical portion of the window, and under the Status column they are shown as “Healthy.” There are a number of possible status indications that can be displayed, and these enable you to determine what might be wrong with a disk.
The actual disk state is shown in the graphical portion of the window under the disk number (Disk 0, Disk 1, and so on). Disks may display the following different states:

- **Online** The disk is functioning properly.
- **Online (Errors)** The disk is functioning, but input/output errors have been detected. Run the Error Checking tool by right-clicking the desired disk and then choosing Properties | Tools to try to correct the problems.
- **Offline/Missing** The disk is not functioning or is not accessible. Possible hardware problems may be causing this state. Right-click the Disk number in the console and try the Reactivate Disk option.
- **Foreign** A new disk from another Windows XP computer has been installed on your computer, but it has not been set up for use on your computer. Right-click the disk and click “Import foreign disk” to set it up for use on your computer.
- **Unreadable** The disk is not accessible because of failure or corruption. You can try to reactivate the disk.
- **Unrecognized** The disk is formatted with a file system that is not recognized. This error occurs when you install a new disk into the computer that came from another operating system. You can reformat the disk so that Windows can use it, but any existing data on the disk will be lost.

Aside from these disk states, each volume found on each disk also displays a status, which is seen in the Computer Management console. The following status readings may be seen:

- **Healthy** The volume is functioning properly.
- **Healthy (At Risk)** The volume is functioning, but errors have been detected. Run the Error Checking tool to attempt to fix the problems.
- **Initializing** You have created a new volume, and XP is preparing it for use. This status will change to Healthy once the initialization is complete.
- **Resynching** When mirrored volumes are resynchronizing, this error message occurs. A mirrored volume is used when two different volumes on different disks mirror each other in order to provide fault tolerance.
- **Regenerating**  When a RAID-5 volume is used, which is a fault-tolerant solution requiring three or more hard disks, this indicator will appear when data is being regenerated due to a disk failure.

- **Failed Redundancy**  In a RAID-5 volume, the underlying disk is no longer online.

- **Failed**  The volume cannot be automatically started and has failed.

### Formatting a Disk

In some circumstances, you may need to reformat a hard disk. When you format a disk, all information on that disk is erased and a new file system is created. Obviously, you will lose any data stored on the disk, so a format operation should not be taken lightly and should be performed only if absolutely necessary. The XP system does not allow you to reformat a disk that holds the XP operating system because this action would erase the operating system from your computer. However, if your computer has other hard drives, you are free to format those. To reformat a disk, simply right-click the drive (such as D, E, and so on) and click Format. The Format window appears, as shown in Figure 19-2. Use the drop-down menu to select the desired file system, and you can give the volume a label. You may wish to use the quick format option, which essentially erases the information from the disk and creates a new file system. Just click OK to continue.

---

**FIGURE 19-2**  The Format window
NTFS is the file system of choice for Windows XP. So what do you do if you upgraded to Windows XP and your disks are still formatted with FAT? How can you get NTFS without losing data on the drives. The answer is simple—you can use a `convert` command at the command prompt. The process converts the disk volume to NTFS and retains all of your information. The process is quick and painless, and the preceding How To box shows you how.

**Creating a New Volume**

Remember that a volume is simply a portion of a hard disk that acts like a separate disk. Volumes give you a way to organize hard drives for storage purposes. Think of a volume as a division in a filing cabinet. Depending on your storage needs, you may want to divide one or more of your computer’s hard drives into logical volumes.

Windows XP makes volume creation easy. At any time, you can create a new volume on any hard disk on your computer, provided there is currently enough free disk space to create the volume. Note that creating a new volume does not damage any existing information on your drive, so there is no danger to current data. To create a new volume, just follow the steps in the following How To box.
Create a New Volume

To create a new volume, just follow these steps:

1. On the disk where you want to create the new volume, right-click the Disk number (Disk 0, Disk 1, and so on) and click New Volume.
3. In the Select Volume Type window, select Simple volume and click Next.
4. In the Select Disks window, the maximum amount of free disk space that can be used is displayed in the right window, as shown next. You can choose to use this amount of free disk space by simply clicking Next, or you can adjust it in the “Select the amount of space in MB” field. Make your selection and click Next.

5. In the Assign Drive Letter or Path window, use the drop-down menu to assign a drive letter. You can also mount the volume to an empty NTFS folder. This feature allows the drive to act like a folder on your hard
Assigning a Different Drive Letter and Path to a Volume

You may need to reorganize volume labels or paths at different times, and the Disk Management console makes these changes easy. For example, let’s say I have a volume labeled Drive H, and I want to assign that volume to an empty NTFS folder and give it the friendly name “Documents.” I am then going to store all kinds of company documents on that volume and share the volume to the network. I can easily make this change by right-clicking the volume and clicking Change Drive Letter and Path. Select the volume you want to change and click the Change button. You’ll see a dialog box allowing you to make the desired change.

Extending a Volume

What happens if you are storing information on a particular volume and the volume begins to run short of disk space? If there is additional free disk space available on the actual disk the volume belongs to, you can easily make the volume larger by extending it. This action does not damage any of your current data stored on the volume and is perfectly safe. To extend a volume, right-click it and click Extend Volume. This action opens a simple wizard that guides you through the steps of making the volume size larger.

Other Volume Solutions

Windows XP Professional provides some additional management features that are not found in the Windows XP Home edition, and we will take a look at those in the rest of this chapter. Aside from simple volumes, Windows XP also supports other volume solutions, namely the spanned volume and the striped volume. You use the same New Volume Wizard to create these types of volumes, and the process is rather self-explanatory. To determine whether a spanned or striped volume is right for you, consider the following features of each.
Spanned Volumes  A spanned volume is a volume that combines various pieces of unformatted free space on several different hard disks to create one logical volume. For example, let’s say your computer has four hard drives. On three of the drives, you have 2MB of free space, and on the last drive you have 5MB of free space. Alone, none of these pieces of free space amount to much storage room, but the spanned volume allows you to combine all of these free spaces into one logical volume, which would be 11MB in size—something actually useful. To you, it appears as simply another volume to which you can save data. Windows XP handles all of the management tasks of writing and reading data to and from various disks for you. The result is you get more storage space by combining bits and pieces of storage on various drives that might otherwise not be useful. In order to create a spanned volume, you must have unformatted free space on at least two physical disks (up to 32 physical disks). The space you combine can vary—there are really no rules except the two-disk minimum. However, once you create the spanned volume, you cannot reclaim a portion of it without deleting the entire spanned volume. This means you would have to move any data to other volumes before deleting the spanned volume. Also, this solution offers no fault tolerance. If one of the hard disks fails, the entire volume is lost, even though the other disks may still be functioning with no problems.

Striped Volume  The striped volume is a lot like the spanned volume. You combine free pieces of disk space on 2 to 32 physical disks for storage purposes, but the striped volume writes data across the disk evenly and in blocks. This feature makes the read/write time faster, but requires the pieces of free space to be of equal size when creating the striped volume. The only reason for using a striped volume over a spanned volume is performance. The striped volume also provides no fault tolerance—if one disk fails, all data on the volume is lost.

To create a spanned volume or striped volume, just use the Disk Management console to select an area of free space on one of the disks, right-click it, and click Create Volume. Follow the New Volume Wizard steps to create the desired volume type and combine the desired areas of free space.

Windows XP Fault-Tolerant Support
Throughout this chapter, I’ve mentioned the term “fault tolerance” a few times. Data stored on a hard disk is always in jeopardy of being lost—permanently unless an external backup exists—should the disk fail in some way. Although an effective backup plan is your best defense against a hard disk failure (covered in the next section), Windows XP also offers two fault-tolerant solutions.
Fault tolerance simply means that Windows XP can tolerate a disk failure without losing data. These solutions require more than one physical disk and they can be quite effective. Although fault-tolerant configurations are typically handled by systems administrators and are outside the scope of this book, I do want to mention them to you. Should you want to implement either of these solutions, see the Windows XP help files for more information. Creation of fault-tolerant volumes is typically easy because wizards guide you along the way. Here are the options available to you:

- **Mirrored Volumes** A mirrored volume creates an exact duplicate of all information on one volume to another volume on a different disk. For example, let’s say you have a C drive on Disk 0. The mirror volume might be labeled “C Mirror” and reside on Disk 1. Should Disk 0 crash, the data can be recovered because an exact copy is always kept on Disk 1. Once you set up disk mirroring, Windows XP handles all of the mirror tasks for you. In other words, you don’t have to do anything to ensure that data is being copied to the mirror disk. The biggest problem with disk mirroring is megabyte cost. Because you are keeping an exact copy of an entire volume on another disk, you are using up a lot of potential storage space that could be used for other purposes.

- **RAID-5 Volumes** RAID-5 volumes are somewhat like a striped set. Blocks of data are written across at least three different disks in an orderly format and using a “parity” bit. If one of the disks fails, the RAID-5 volume can use the parity bit and re-create the lost data once a new disk has been installed. RAID-5 volumes are typically favored over mirrored volumes because they provide fault tolerance without wasting as much disk space.

**Windows XP Backup and Restore**

The importance of backing up your data cannot be overstated. When you save a file to a computer’s hard drive, it is safely held there until the next time you need it—unless something happens and the computer crashes. If you have used computers for any length of time, you know that sinking feeling in the pit of your stomach when you fear you have just lost an important file.

Backing up your data makes certain that the prospect of losing information never happens. Should something happen to your computer, the data is safely backed up somewhere else, and you can retrieve it once the computer is up and running again. Fortunately, Windows XP provides built-in backup and restore features that are easier to use and more flexible than ever before. In the following sections, you’ll learn all about backing up and restoring data on your computer.
Backing Up Data

You can back up data in a number of ways. You can save data to a floppy disk, CD-ROM drives that have write features, or even Zip disks. You can manually save the files you want; should a problem ever occur, you would still have your data. However, backing up important information this way is time consuming and heavily dependant on you. Why not let Windows XP handle this task for you?

Windows XP includes advanced backup features that enable you to store backup data to any kind of removable media (such as tape drives, zip drives, write CD-ROM drives, and so on), or you can even save backup files to another computer on a network. The idea is to get data copied off your computer so that it is in another location should your computer ever fail.

To help you accomplish your backup goals, Windows XP gives you a helpful wizard, which provides a number of different options. The following How To box walks you through this wizard and explains the available options to you.

**How to ... Use the Backup Wizard**

To use the Backup wizard, just follow these steps:

1. Click Start | More Programs | System Tools | Backup.
2. The Backup Utility Wizard appears. Notice that on the Welcome screen, you have the option to use Advanced Mode. I’ll explore that option for you later in the chapter, but for now, click Next.
3. On the Select an Option window, you have the options of performing a backup, restoring files, or preparing an automated system recover backup. Click the Perform a Backup radio button and then click Next.
4. In the next window, you can choose to back up everything on your computer, only certain drives and files, or only System State data. System State data refers to a collection of network and security settings, and you will not typically back up these unless specifically directed to do so by a network administrator. Make a selection and click Next.
5. If you chose to back up selected files, an Explorer-type window appears, where you can select the drives, folders, or even specific files that you
want to back up. Click the check boxes for the items you want to back up. Make your selections and click Next.

6. Choose the location where you want to store backup files. Use the Browse button to select a removable media drive or even a network location. If your computer has multiple hard drives, you can even save the backup file to a different hard drive. Also note that the backup file will be named backup.bkf by default. You can change this name if you like, but you should not change the .bkf extension. For example, I have renamed my backup file 0612.bkf to represent the date of the backup. Make your selections and click Next.

7. You now reach the completion window. You can click Finish to start the backup job. However, before doing so, notice that you have an Advanced button. This option will give you some additional backup features you may want to consider before performing the backup. Click the Advanced button.

8. In the Type of Backup window, you see a drop-down menu that allows you to choose a type of backup. By default, a typical backup is normal, which means a backup file is created. However, you can also choose other types of backup options—such as incremental, which backs up files only if they have not been previously backed up, or differential, which backs up files only if they have changed since the last backup. These backup options are important and do require some additional planning and study on your part. See the Windows XP help files for
more detailed information about these options. Also, you see a check box option to back up data that is in Remote Storage. Windows XP provides a Remove Storage feature, explored later in this chapter, which tracks data stored on removable storage, such as CD-ROMs, Zip drives, and other types of removable storage media. Make any desired selections and click Next.

9. The next window asks whether you want Windows XP to verify data once it has been backed up, which is a good idea. You can also use compression if it is available on the storage device. Also, you can choose to disable volume snapshot, which allows Windows XP to save files even if they are in use at the time of the backup. Make any desired selections and click Next.

10. In the Media Options window, you have the option to replace an existing backup file that might exist in the same location, or append the new backup file to the old one. By default, the append option is selected. Click Next.

11. You can choose a backup label, which is the date and time by default. You can change this if you want. Click Next.

12. You can choose to run the backup now or later. If you choose later, you’ll need to click the Set Schedule button to create a schedule when the backup should run.

13. Finally, click Finish. The Backup process occurs, and a window presents the status, as shown here.

![Backup Progress](image)
About Automated System Recovery

Windows XP provides a backup option called *automated system recovery*. This feature creates a backup file of your computer and formats a floppy disk for you to use in the event that you cannot start Windows. Should there be some catastrophic system failure, you can use the floppy disk to boot your computer, and then use the backup file to restore your system. This feature is very effective, and I would recommend that you create an automated system recovery backup file. You’ll need one floppy disk to create it, and the Backup wizard walks you through the few simple steps needed to create the file.

Using Backup Recovery

Okay, the moment you have dreading actually happens and, because of a system failure, you lose some files, or even a complete drive, on your computer. If you have followed an effective backup plan and you are regularly backing up data, you can recover that data quite easily by using the Backup Wizard. To recover backup data, follow the steps in the How To box.

How to ... Use the Backup Wizard

To use the Backup Wizard, just follow these steps:

1. Click Start | More Programs | System Tools | Backup.
2. Click Next on the Welcome screen.
3. In the Select an Operation window, choose the Restore Files from a Previous Backup radio button, and then click Next.
4. In the What to Restore window, select the files that you want to restore in the left window and the backup media to be used in the restore in the right window. Click Next.
5. Click Finish. You see a progress window that tells you when the backup is complete.
Keep in mind that the larger the backup or restore job, the more time will be required to complete the job.

Using Backup Advanced Mode

Once you’ve used the Backup Wizard a few times, you’ll become a pro in configuring backup jobs, and, in fact, the wizard will get a little tedious. Recognizing that this will happen, Windows XP provides an Advanced Mode feature, which you can click on the Welcome screen of the Backup Utility Wizard. This option opens the Backup Utility window, which contains Welcome, Backup, Restore and Manage Media, and Schedule Jobs tabs, as you can see in Figure 19-3.

If you spend a few moments looking around here, you’ll quickly discover that the tabs provided simply give you a way to configure backup and restore processes without the wizard. You can have the exact same options using these tabs without wading through the wizard screens. For example, in Figure 19-4, you see the Backup tab. On this tab, you can configure what you want to back up, and you can even click Tools | Options to get the advanced options that you have when using the wizard. There is absolutely no difference in using this interface or the wizard—you just may like this one more as you learn to configure backup jobs.
First introduced in Windows 2000, *Removable Storage* is a feature that Windows XP continues to provide. Removable Storage gives you and Windows XP a way to keep track of data that is stored on removable storage media, such as CD-ROMs, Zip disks, tape libraries, and related media. Windows XP can keep track of what data is stored on what media by organizing that data into libraries.

Removable Storage is also available in the Computer Management console, under the Storage portion of the console, as shown in Figure 19-5.

Removable Storage is designed to control devices that handle multiple items, such as CD changers or jukeboxes, which are used to store large amounts of data on removable disks. With these devices and Removable Storage, a bunch of disks or CD-ROMs can be managed and loaded. Windows XP keeps track of data that is written on each disk; it can access the appropriate disk (using the changer) in order to retrieve the data. As you can see, for environments that use such devices, the Remote Storage feature can be very important, but it is not a feature intended for the typical home or office user.
I’ll be brief and honest concerning Removable Storage—it can be helpful in certain circumstances where a large amount of data is being stored in many removable storage media disks; but for the most part, removable storage is confusing and not particularly helpful to the home or office user. In fact, Removable Storage is designed for a system that is primarily used as a file server or storage computer that connects with certain types of media devices. Because most all of you reading this book will not use the Removable Storage feature, I’ll not delve any deeper into the subject. However, if you want to learn more, there is detailed information in the Windows XP help files.

You don’t have to do anything with Removable Storage in order to store data on Zip, CD-ROM, or floppy drives found on your computer. Removable Storage is used to manage the storing of a lot of data on multiple disks, but is not a feature required in order to store data on removable media.
This page intentionally left blank.
How To…

- Use System Information
- Use the Performance Monitor
- Use Problem-Solving Tools
- Troubleshoot Your Computer
- Use System Restore

Windows XP is a complicated operating system, full of features and functions, many of which go on behind the scenes. As with any complex operating system, you may experience both performance and functionality problems from time to time. I’ll be the first to say, however, that Windows XP is as solid as a rock. Say goodbye to all those aggravating locks and weird behavior problems you saw in Windows Me and 9x. If you have used Windows 2000, you’ll see the same stability and performance in XP—with a friendlier attitude. In this chapter, we’ll explore some tools and optimization features that can help you run XP in tiptop shape and even get out of jams from time to time.

System Information

First introduced in Windows 98, System Information is a powerful tool that provides all kinds of information about your computer system, and it includes some additional tools that can fix problems on your system, as you can see in Figure 20-1.

You can quickly reach System Information by clicking Start \ Run, then typing **MSINFO32**, and then clicking **OK**.

If you take a look at the left pane, you see a list of information categories. If you click the plus (+) sign next to each category, you can select specific topics for which you want to gather information. It is important to note here that you cannot configure or actually do anything with System Information, with the exception of the troubleshooting tools, but System Information is designed to give you information. Why, you might ask? The answer is simple. The more information you can gather about your computer, the more likely you are to solve problems with your computer. On a more practical note, System Information is very useful to telephone support personnel who you may need to call in the event of a problem
you can’t solve. Although having outside support is very helpful, it is always best if you can solve your own PC problems; the next several sections tell you all about the information you can gain in each major category, and I’ll point out some tips for you along the way.

**System Summary**

When you first open System Information, the default view is the System Summary. This view just gives you an overview of your computer. You see everything from the operating system to the total amount of RAM installed on your computer. This page is excellent to access if you want a quick report about the basics of your computer. You can easily print this page.

**Hardware Resources**

The Hardware Resources category of System Information gives you a complete look at the hardware on your computer. This section is an excellent place to see exactly what is installed, what’s working and what’s not, and whether there are any conflicts (see in Figure 20-2).
Should there be any conflicts, you’ll see warning messages in yellow and conflict or error messages in red. This helps you quickly identify problems if they exist. By expanding Hardware Resources in the left pane, you see the following categories that you can select and view:

- **Conflicts/Sharing**  This option tells whether there are any hardware conflicts between devices. In some cases, hardware devices share certain computer resources, and this section tells you about those as well.

- **DMA (Direct Memory Access)**  This option tells you what devices have direct access to memory resources.

- **Forced Hardware**  If you have problems installing a device and it has been “forced” onto your system using manual settings, the device will be listed here.

- **I/O (Input/Output System)**  This information gives a report about input/output operation. Technical support personnel may find this information useful.
- **IRQs (Interrupt Request Lines)** Each device uses an IRQ to access your computer’s processor. This option tells you which device is using which IRQ.

- **Memory** This option provides a list of memory resource assignments per device.

### Components

The Components category provides a list of components installed and used on your system. Some of these have additional pop-out menus as well, as shown in Figure 20-3. System Information will display problems in yellow and red lettering so you can easily identify them.

You gain information about the following:

- **Multimedia** This option gives you information about your audio and video configuration.

- **CD-ROM** Information is listed here about your CD-ROM drive.

![System Information](image-url)
Sound Device Information about your sound card is listed here.

Display Information about your display appears here.

Infrared If you are using any infrared devices, they are listed here.

Input Get information about your keyboard and mouse or other pointing device here.

Modem Modem information is listed here.

Network Network adapters, protocols, and WinSock information is provided here.

Ports Get information about ports on your computer (such as serial and parallel ports).

Storage Get information about the drives on your computer here.

Printing Find out about printers and print drivers here.

Problem Devices If any devices are not working correctly, they are listed here. This is a very useful option to quickly find troublesome devices.

USB (Universal Serial Bus) USB configuration and devices are listed here.

Software Environment

The Software Environment category, shown in Figure 20-4, gives you information about the software configuration of Windows XP. If there are any problems or errors, you’ll see them appear in red or yellow. This category can be very helpful to technical support personnel who are helping you solve a problem with Windows XP.

You see the following information in this category:

Drivers This section lists the drivers that manage your computer’s software environment.

Signed Drivers This section provides a list of installed drivers that are certified by Microsoft.

Environment Variables This section lists items such as your TEMP file, which is used for temporary files and other variables in the software environment.
FIGURE 20-4  The Software Environment category

- **Print Jobs**  This option gives you the information found in your print queue.
- **Network Connections**  All network connections currently held by your computer are listed here.
- **Running Tasks**  This option lists all of the tasks on your computer that are currently running.
- **Loaded Modules**  This option lists all software modules currently loaded.
- **Services**  This section lists the services, such as automatic updates, fax, and much more, that are currently installed on your computer.
- **Program Groups**  This option lists all program groups currently configured on your computer.
- **Startup Programs**  This option lists all programs that are configured to run automatically when your computer starts up.
OLE Registration (Object Linking and Embedding)   Windows XP uses OLE to allow the various system components and programs to communicate with each other. OLE information is listed here.

Windows Error Reporting   This section provides a listing of software errors reported by the system.

The Windows Error Reporting section, which is new in Windows XP, is a great feature because it lists all of the application lockups and related service problems. If you are having trouble, this can be a great place to find the culprit!

Internet Explorer
This category, shown in Figure 20-5, provides information about the configuration of Internet Explorer.
You’ll find the following information in this category:

- **Summary**  Access this option for a quick summary of IE’s configuration.

- **File Versions**  This lists all files and file versions used by IE.

- **Connectivity**  Access this page to see a quick review of IE’s connectivity configuration. These are the settings you configure in Internet Options in IE.

- **Cache**  IE uses a cache to store temporary Internet files. Access this option to learn more about the cache size and see a list of objects in the cache.

- **Content**  Examine security and content settings here.

- **Security**  View zone security configuration here.

### Applications

Any applications that are installed on your computer are listed here. Click the plus (+) sign next to each one to learn about configurations specific to that application. This is a useful option to find out about problems and conflicts with any installed applications.

*If you are having problems finding the information that you need, try the quick search line that appears at the bottom of the System Information window.*

### System Information Tools

System Information also gives you a Tools menu that gives you easy access to some features and tools in Windows XP. If you check out this menu, you see right away that you can access the Backup tool, the Network Connections folder, the Add Hardware Wizard, and a Disk Cleanup. However, you can also access three additional tools that we have not discussed in this book, and the next three sections explore these tools and show you how they can help you.

### File Signature Verification Utility

In order to protect Windows XP, files that are in use by the operating system are *signed* by Microsoft to ensure compatibility and security. You can use the Signature Verification Utility to make certain that no other files are in use on your system that are not signed. By default, Windows XP gives you a warning message before you install unsigned files. You can use this tool to gather that information. When
you open Signature Verification, click the Start button to run the verification scan. Once the scan is complete, you see a report showing all of the unsigned files on your system. Generally, you don’t need to use this tool, but if you have installed some programs on your computer that are giving you problems, you can run this utility to check for signatures.

**DirectX Diagnostic Tool**

DirectX is a graphics technology that enables you to play really cool games. However, you can have problems with various versions of DirectX and its operation with your system components. The DirectX Diagnostic Tool gives you an easy interface with a bunch of tabs, as shown in Figure 20-6.

The DirectX Files tab of this tool reports a variety of information to you. The Display, Sound, Music, Input, and Network tabs give you information about how DirectX is interacting with these system resources. Each of these tabs also contains

![DirectX Diagnostic Tool](image)

**FIGURE 20-6** Use the DirectX Diagnostic Tool to solve compatibility problems with DirectX.
a test button so you can directly test how DirectX is interacting with the hardware. This is a great tool that can help you identify exactly which incompatibilities are occurring with DirectX and your hardware.

**Dr. Watson**

Dr. Watson is a Windows tool that can inspect your system and generate a detailed report after a system fault has occurred. Dr. Watson can tell you what went wrong and sometimes suggest what can be done to fix the problem. Should you ever need to contact technical support, they may have you run Dr. Watson in order to take a “snap-shot” of your system; once the snapshot is taken, the report can be used to potentially solve the problem.

You can run this tool yourself, of course. The results are usually easy to understand. If you see a particular application or device listed, you may need to try reinstalling the application or device in question—or just remove it from Windows XP altogether.

**Performance Monitor**

If you’ve spent any time with a Windows 2000 computer, you probably know a thing or two about Performance monitor. Performance monitor, which is included in Windows XP, enables you to gather real-time server data about the performance of various system components and processes. You can examine this data and locate potential performance problems. Once you identify the source of performance problems, you can then take an appropriate course of action to solve those problems.

Performance monitor may seem a little intimidating at first, and it can be a complex tool. Don’t worry, though—if you study this section and spend a little time with Performance monitor, you can learn a lot about the performance of your computer system quickly and easily.

**Performance Monitor Interface**

The Performance monitor tool is available in Administrative Tools in the Control Panel. Before showing you how Performance monitor works, I’ll give you a brief overview of the Performance monitor interface, as shown in Figure 20-7. If you have never used Performance monitor, it is important that you spend some time using it so you can learn how it works. Fortunately, the interface is rather easy and intuitive, and you can be a pro in no time after you begin working with it.
Performance monitor works by creating charts, graphs, or reports for counters that you select. A counter is a particular Windows XP component or service that can be monitored. By adding counters to the console, you can view information about the performance of a particular component or service. You can use as many or as few counters as you wish in order to gain the information that you need.

As you can see, the Performance monitor interface is a basic Windows interface. The left console pane contains the System Monitor and the Performance Logs and Alerts category. However, you primarily interact with Performance monitor by using the right console pane. There are three basic divisions of this pane, which are (from the top)

- **Toolbar** The toolbar contains icons you will use regularly to generate the types of charts and information that you want. The toolbar contains the following button options, which are seen from left to right in Figure 20-8: New Counter Set, Clear Display, View Current Activity, View Log File
Data, View Chart, View Histogram, View Report, Add Counter, Delete, Highlight, Copy Properties, Paste Counter List, Properties, Freeze Display, Update Data, and Help. You use the toolbar to manage the Performance monitor as needed.

- **Information area** The information area contains the chart, histogram, or report that you want to view. Click the desired button on the toolbar to view counter information in the desired format.

- **Counter list** The bottom portion of the window contains the counter list. All of the counters displayed in this list are currently being reported in the information area. You can easily remove or add counters to the list using the toolbar. Each counter in the counters list is given a different color for charting and histogram purposes.

### Using Performance Monitor

The primary functionality of Performance monitor is through the use of counters. Without counters, there is no way to break down performance information and view various components and services. As you might guess, there are a number of different counters that can give you information on all kinds of system processes and services.

With an understanding of the counters available to you, you can use Performance monitor to gain valuable data for making decisions about performance and optimization in your environment. You can monitor activity for a period of time and then save the data to a log file. You can even set up logs and alerts so that data will be gathered on a periodic basis automatically and you will be alerted if certain values fall below a baseline that you determine.

Your first action is to determine the manner in which you want to view information—in chart, histogram, or report view. The type of counters you choose to view may also impact your choice; but once you make the decision, you can then add the desired counters to the chart, histogram, or log. Adding counters is rather easy, and the following How To box shows you how to add counters.
To manage Performance monitor counters, follow these steps:

1. In the Control Panel, open the Administrative Tools folder and double-click the Performance icon.

2. On the Performance monitor toolbar, click the New Counter Set button, and then select the type of view you want (chart, histogram, or report).

3. Click the New Counter button. The Add Counters window appears, shown here.

4. Click the Performance object drop-down menu and select the object that you want to monitor. For example, if you seem to be having memory problems or your computer is running very slowly, you might want to choose the Memory or Processor object.
5. Next, select the desired counters in the Counter list by clicking the counter and then clicking the Add button. If you want an explanation of the counter, select it and click the Explain button. Also, notice that you can click the All Counters radio button to select all counters. For some counters, you can select an instance from the list that appears in the right dialog box. Continue to select the desired object/counters as desired until you have finished, and then click the Close dialog box.

6. The counters you selected are now added to the window and are charted (or reported, depending on your selection). You can change charting or reporting views at any time, and you can remove counters from the console by selecting the counter and clicking the Delete button.

7. If you want to save the data you are currently charting, you can right-click the chart and save it as an HTML file. You can also save the data as a Performance monitor Alert.

Using Counter Logs
Aside from the live collection of data, you can also set up a counter log so that desired counters are recorded and logged at the intervals you specify. This feature is very handy if you need to collect data over a period of time, but do not wish to do so manually. To configure counter logs, you simply create a new counter log, add the counters that you want to the log, and then configure the additional log elements. Configuration is easy; you can check out the following How To box for a walk-through.

How to ...

Create a Counter Log

To create a counter log, follow these steps:

1. In the left console pane of Performance monitor, expand Performance Logs and Alerts. Right-click Counter Logs, and click New Log Settings. Enter a name in the dialog box that appears and click OK.
2. The Log File Settings window appears with three tabs. On the General tab, shown here, you see the log name and the location where it will be stored (C:\PerfLogs, by default). Click the Add Counters button to add the desired counters that the log will record. At the bottom of the window, use the scroll boxes to determine how often data is collected (15 seconds is the default).

3. Click the Log Files tab. You can make changes on this tab to the manner in which the log file is saved and its maximum size.

4. Click the Schedule tab. Use this tab to determine when logging should start and stop. Click OK to save your changes.
Creating a Performance Alert

Performance monitor also provides a performance alert feature where you can configure a counter to be monitored against a baseline of performance. Then, if the performance measured by that counter falls below that configured baseline, a certain action or actions can be carried out. Performance monitor supports the actions of logging an event to the Application Event Log, sending a network message, starting a performance data log, or running a program for Performance alerts.

However, it is important that you configure alerts only for items that are very important. With too many alerts, you may end up with too much information that is difficult to sort through. So, determine what action you absolutely want performed when baseline levels are not met, and then configure those alerts accordingly.

Alerts are easy to configure, and the following How To box gives you a walk-through.

How to ... Create a Performance Alert

To create a performance alert, follow these steps:

1. Open Performance monitor.
2. In the left console pane, expand Performance Logs and Alerts. Right-click Alerts and click New Alert Settings. Enter a name in the dialog box that appears and click OK.
3. On the General tab, shown next, use the Add button to add desired counter(s), and then create a baseline with the Alert When the Value Is and Limit fields. When performance falls below the baseline, the alert
will be triggered. Also, determine how often you want to sample data that pertains to this alert by making selections at the bottom of the window.

4. Click the Action tab. Select the desired action(s) and configure the necessary options.

5. Click the Schedule tab. Configure the options to start and stop the scan at the desired times. Click OK to save the alert.

Using System Properties to Optimize Windows XP

You access System Properties in the Control Panel (or by right-clicking My Computer and clicking Properties if you’re using a My Computer icon). When you
access System Properties, you will find an Advanced tab on these properties pages, as shown in Figure 20-9.

In terms of performance issues, you have a Performance section on the tab, as well as a Startup and Recovery section (see Chapter 13 to learn more about user profiles). The following sections explore these options.

![Figure 20-9: The Advanced tab in System Properties](image-url)
Free Up System Resources by Removing Startup Programs

What if you examine the system resources setting and it shows 80 percent or higher usage? This is a good indication that too many programs are running on your computer. The likely culprits are your startup programs. Depending on your computer manufacturer, you may have many different programs and utilities that launch when you start Windows. You can change this process by removing some of these programs that are not needed. Doing this frees up more system resources for desired applications. To clean out your Startup folder, just follow these steps:

1. Click Start | Run, type **MSCONFIG**, and click OK.
2. In the System Configuration utility, click the Startup tab.
3. All items listed are started when Windows starts. To prevent some items from starting, clear the check box next to them. Generally, from the name of the startup you can tell what it is and whether you need it to start or not. If you are not sure what an item is, leave it checked.

Performance Options

If you click the Settings button under Performance, you see a Performance Options window with a Visual Effects tab and an Advanced tab. The Visual Effects tab gives you another place to manage the way Windows handles the user interface in terms of icons, animation, and so on. The more visual effects that are in use, the more system resources are consumed. Under most circumstances, you don’t need to do anything on the Visual Effects tab; but if you want to disable a visual effects feature, just scroll through the list and clear the check box next to the option.

On the Advanced tab, shown in Figure 20-10, you see that, by default, the processor and memory usage are optimized for applications. This means that processor cycles and memory usage are primarily configured to support applications over background or system process functions. For most users, these two settings should be left alone. However, if you are using your Windows XP Professional computer as
a network server or a Web server, you might consider changing these two settings to Background services and System cache. For most of us, though, these settings are just fine the way they are.

The final portion of the tab concerns virtual memory. Windows XP, like other Windows operating systems, is configured to use virtual memory. Your computer has a certain amount of memory installed (96MB, 128MB, and so forth). When you use your word processor, open applications, surf the Net, and so on, memory is used to hold programming information your computer needs to run the programs. When you have too many open programs, RAM begins to run low. In such cases,
Windows can use a portion of your hard disk to temporarily store information. This called virtual memory because it is not real RAM, but storage room borrowed from the hard drive. Windows XP is programmed to set its own Virtual Memory settings, as you can see in Figure 20-11.

You can change this option and configure the virtual memory settings yourself, but this action is not at all recommended. Your best performance option is to allow Windows to continue using its own virtual memory settings—believe me, they are the best!

![Virtual Memory settings](image)

**FIGURE 20-11** Virtual Memory settings
Automatic Updates

Automatic updates, first introduced in Windows Me, allow Windows to automatically check Microsoft.com for operating system updates, download those updates, and tell you when they are ready to be installed. It is a hands-off approach to keeping your computer current and updated. You can access the management window for automatic updates in System Properties under the Automatic Updates tab, as you can see in Figure 20-12.

The downloads your computer collects for you are free and are perfectly safe because they come directly from Microsoft. If you’re a little worried about your computer downloading information behind your back, don’t be—you’re in good hands.

Using the Automatic Updates tab, you can enable your computer to automatically download needed updates and prompt you to install them, have your computer tell you that a download needs to occur so you can manually perform the download, or choose not to use automatic updates at all. Just click the appropriate radio button on the Automatic Updates window. If Windows suggests an update, you can also say “No thanks,” by not installing the update. If you choose to not accept an update, it is kept on your computer system, and you can use the Restore Hidden Items button to see those updates again and install them at any time if you want. Remember, the automatic updates feature is great, but Windows XP still keeps you in control.

Did you know?

Virtual Memory Is Not a Replacement for More RAM

Many people who learn a few things about virtual memory think they can configure their own settings to make Windows use more hard disk space—a replacement for physical RAM. This simply is not the case. Windows XP can handle these settings, and overriding Window’s setting is normally a bad idea. Virtual memory is used for overflow information—it is not designed in any way to be a replacement for physical RAM chips. If you need a RAM upgrade, tinkering with virtual memory will not solve the problem—and, in fact, doing so may create more problems. My advice: leave this setting alone! If your system needs more RAM, your best bet is to part with a few hard-earned dollars and have more RAM installed on your computer.
There is one problem with automatic updates, and this concerns connectivity to the Internet. Automatic updates will work best with any “always on” broadband connection, such as cable, DSL, or satellite. With these kinds of connections, downloads can occur at any time without having to dial a connection to an ISP. Without always-on access, your computer will attempt to dial up a connection for you and download the files. This may not be a bad thing, but if you do not want your computer dialing up an ISP connection without you, you may want to consider turning off automatic updates. You can always try this feature, and turn it off if later it is not working for you.
Troubleshooting Tips

When you experience a problem in Windows, there are some positive actions you can take, and there are some panic-driven actions you can take that are usually not very wise. So, without getting into the murky details of troubleshooting, here’s my list of troubleshooting tips you should always follow:

- **Relax** If Windows XP experiences a problem, don’t get in a hurry. Your systems will not self-destruct to leak poisonous gas into the room and kill you. In other words, a problem with your system does not mean that it needs to go the computer ER—don’t get in a hurry.

- **Think** What were you doing when the problem occurred? Consider grabbing a piece of scratch paper and writing down exactly what you were doing—what applications were open when the problem occurred. If there are serious problems with Windows XP, you may need this information later.

- **Act** Try one thing at a time to resolve the problem. With each action you take, write down what you did. Do not randomly press keys—do one thing at a time in an organized manner.

Now, you may think, “But that’s just it—what action should I try?” The rest of this chapter answers that very question.

Using CTRL+ALT+DEL

Although you will not experience the system lockup problems that you did in previous versions of Windows, you may have an application that stops responding from time to time. In Windows 9x, this would often bring your entire system to a standstill, but that is typically not the case in Windows XP. A system lockup occurs when an application is naughty and doesn’t behave the way it should. The application can interfere with Windows XP functionality, causing the application itself to lock. This means that you can’t do anything with the application by clicking buttons or doing anything else. In some cases, two applications that are open can interfere with each other, causing them both to lock.

In the case of a system lock, you should use your keyboard and press CTRL+ALT+DEL one time. This action will open the Windows Task Manager dialog box, shown in Figure 20-13, where you can select the name of the program and click
End Task on the Applications tab. This action forces the task to end so you can get control of your computer. If you have any unsaved data in your application at the time it locked up, I’m afraid you will lose that data (save data frequently when working to avoid loss). While you’re looking at the Task Manager, you can also explore the Processes, Performance, Networking, and User tabs to find out current system information.
If you press CTRL+ALT+DEL twice, your computer will restart.

In some cases, CTRL+ALT+DEL will not give you control of the computer. This problem occurs when there are errors within Windows XP, possibly associated with an application, that cause the operating system to hard lock. In this situation, pressing CTRL+ALT+DEL doesn’t do anything. You can’t do anything by pressing keys on your keyboard, and your mouse pointer is gone. In such cases, the only way to get control of Windows XP is to turn off the computer using your computer’s power switch. Just crawl under your desk, turn off the switch, wait at least 10 seconds, and then turn the switch back on so your computer can begin rebooting. Error Checking will automatically run during the reboot, and you should let it finish its check for file system errors. Again, a complete hard lock is not common in Windows XP, but you may experience the problem just the same.

**Did you know?**

**Why You Should Wait 10 Seconds**

As a general rule, you should never reboot your computer using the power switch—always use the shut down or restart option in Windows XP. However, if your system locks up, you have no choice but to use the power switch. When this happens, turn the switch off, wait at least 10 seconds, and then turn it back on. Why 10 seconds? The power switch simply cuts the power to the computer, and 10 seconds gives your computer enough time to dump all of the data in RAM and stop the hard disk from spinning. If you turn the switch off and on too quickly, you could damage your computer’s components.
Using Windows Help

Windows XP has the best Help files that have ever been produced by Microsoft. They are easier to use, more attractive, and contain a wealth of information both locally on your machine and on the Internet. You can easily access Windows Help by clicking Start, and then clicking Help and Support. The Windows Help interface appears, shown in Figure 20-14.

There are several major parts of the Windows Help program. The Help screen shows a number of topics and tasks that you can select, as well as a search option and a place for getting outside assistance. The following sections address the Help features.

---

**FIGURE 20-14** The Windows Help interface
Help Home
When you first open the Help files, you find yourself in the Home section, shown in Figure 20-14. Home is the starting point of accessing Help; and as you can probably guess, Home is used to mimic a Web page because the Windows Help files are HTML based, just like a Web page. As you use Help, you’ll notice hyperlinks that enable you to jump from the Help files to additional help resources on the Internet.

In the left side of the Home window, you’ll see some generic categories that can help you get moving in the right direction, such as Networking, Games, Sound, Video, and so on. You also see sections where you can fix a problem or find more resources.

Index
The Index option in Help is just like any other index—the only difference is this one grabs the information for you instead of you having to look it up (see Figure 20-15).
In the left side of the window, you see the entire index displayed in alphabetical order. Just use the scroll bar to locate a topic you want, select it, and then click the Display button. The information about that topic appears in the right pane. You can read the information, click the Print button to print a copy (which is really nice!), and even reorganize the window by clicking the Change View button.

**TIP**

*If you don’t want to scroll down the list of index topics, you can just type something you want in the Search dialog box above the index. The closest matches to your search request will appear.*

**Favorites**

The Favorites option works a lot like Favorites in Internet Explorer. Whenever you find a Help page that you want to visit again, click the Add to Favorites button and the page will be added to a Favorites list. Whenever you want to see that list, click the Favorites menu option at the top of the window to see a list of your favorite Help topics.

**History**

Just like Internet Explorer, History keeps track of all of the pages you have visited on the Internet from the Help and Support interface. You can check out the History and revisit any of these pages by double-clicking the link that appears in the History list.

**Options**

This section allows you to change the interface of Help and Support and even share Help with others. The options presented here are very simple and self-explanatory.

**Support**

If you are having serious problems with Windows XP that you can’t seem to resolve, you can access the Support option of Windows Help (shown in Figure 20-16) so you can get help from one of two different places: MSN or directly from Microsoft.

First, you can use the Internet to complete an incident report that is sent directly to Microsoft. The Windows XP Web response team receives your report and will attempt to communicate with you via the Web in order to resolve your problem. When you click the option in the Support Help feature, an Internet connection is launched and Microsoft’s support site appears in the Help window, where you can begin filling out information to get help from Microsoft.
A new and cool feature of Support is the Remote Assistance feature. Let’s say you have a cousin who is a computer genius. You’re having problems with your computer and you want your cousin to take a look. Unfortunately, she lives a thousand miles away. What to do? No problem—as long as your cousin is using Windows XP or a later operating system, you can invite your cousin to take a look at your computer and see what you are doing over the Internet. The Support window gives you easy, step-by-step instructions to generate this remote Help connection. Check it out!

Your second option is to get help from MSN’s forums and discussion boards. These options are obviously not one-on-one solutions, but you might be surprised by the answers you can gain from these sites. You can learn all about problems and solutions other people have experienced, and you may find the answer to your problem right before your eyes!
Before submitting an incident report to Microsoft, you should visit the MSN options to see if you can solve your problem there. Again, the answer may already be right there, and you can fix your computer much faster this way.

### Searching Windows Help

Once of the primary ways you will use Windows Help is to search for topics. You use the Search feature to find information about a certain topic or troubleshoot a problem you are having. The Windows Help files support text searches, which simply means you can type a keyword or keywords into a Search dialog box. Windows XP will try to find topics that match your request. The Search dialog box appears in the upper-right corner of the Help window. Just type the subject you want and click Go. Windows Help will return all possible matches for your subject. For example, I have searched for the words “Media Player” in Figure 20-17. The results are displayed in the left side of window. I can double-click any of them to see the information in the right side of the window.

![Figure 20-17](image)

**FIGURE 20-17** Use the Search feature to find topics of interest.
20

Using Windows Troubleshooters

Within the Windows Help interface, you can access a very handy helpful component called a “troubleshooter.” A troubleshooter is an HTML interface that appears on the Help window. The troubleshooter asks you a series of questions and tells you to try different actions in order to resolve a problem you are having. There are many troubleshooters available in the Help files, and they are very easy to use. Just follow these steps:

1. Click Start | Help.

2. In the Help Search window, type the kind of troubleshooter you want. For example, you might type modem troubleshooter, ICS troubleshooter, or sound card troubleshooter, and so forth. To see a full list, just type troubleshooter.
Obviously, a troubleshooter does not exist for every possible problem you might experience with Windows, but there are troubleshooters for most hardware devices.

3. Begin the troubleshooter by clicking an appropriate radio button, and then click the Next button to continue, as shown in Figure 20-18.

4. Continue following the troubleshooter to attempt to solve the problem.
CHAPTER 20: Solving Problems

Using Safe Mode

Safe Mode is a Windows XP feature that enables you to start Windows with a minimal number of drivers. Safe Mode is used in instances when you cannot start Windows normally. Safe Mode is used to fix problems with your system—it essentially gets Windows up and running, but that’s about it. Most major XP features do not work in Safe Mode.

So, why would you use Safe Mode? Let’s consider an example. Let’s say you have installed Fly-By-Night’s Most Excellent Video Card (okay, it’s just an example). You install the card and driver for the card. When you restart Windows XP, it boots, but then you get a “fatal exception” blue screen just before your Desktop appears. You try this over and over with the same result. More than likely, the video card’s driver is not working correctly with Windows XP. You can boot the computer into Safe Mode, and Windows will load a basic VGA driver to use with the card. Once booted, you can use Device Manager to remove or update the bad driver.

A number of other repair tools (which we’ll explore later in this chapter) require you to boot your computer into Safe Mode in order to work. Before showing how to boot into Safe Mode, let me mention that there are some other boot options you can choose along with Safe Mode. You can access all of these options by using the Windows Startup menu, which you’ll see if you hold down the CTRL key on your keyboard when you turn on your computer (if CTRL doesn’t seem to work, press the F8 key on the keyboard when you start the computer). You’ll see a Startup menu that allows you to choose Safe Mode, Safe Mode with Networking, and some other options. When your computer boots into Safe Mode, you can access the tools and Help you need to try to solve the problem. When you’ve finished, just reboot the computer and it will boot into Normal Mode.

Using System Restore

As you have learned to use Windows XP, you no doubt have found several of its new features very helpful and fun, and maybe others less so. However, I can emphatically say that System Restore is a great feature of Windows XP and one that can get you out of all sorts of trouble. What if your computer won’t start?
What if you install a bad application that wrecks your computer? What if little Johnny decides to delete C:\Windows? No problem—just use System Restore and put your computer back just like it was before the problem, tragedy, or accident happened—with only a few mouse clicks from you. I’ve used System Restore numerous times after fouling up Windows XP with my experiments, and I must say, it has worked flawlessly for me without fail.

Are you intrigued? I know you are if you have ever worked with Windows, because bad configuration problems can be a serious troubleshooting problem. System Restore leaves that legacy behind, because you can easily restore your computer to a previous state. The following sections show you how to use System Restore.

**System Restore Requirements**

System Restore is automatically installed and configured on Windows XP if your computer has at least 200MB of free disk space after Windows XP is installed. If your computer does not have 200MB of free disk space, System Restore is installed, but it is not set up to run. System Restore functions by saving information about your system so that it can be restored in the event of a problem. In order for System Restore to function correctly, 200MB of free disk space is required, and, in reality, System Restore may need much more. Fortunately, if you are using a newer computer, you most likely have plenty of free disk space, and System Restore is already operational on your computer.

**Enabling System Restore**

If your computer did not have 200MB of free disk space upon initial installation, but you have made 200MB or more of free disk space available, you can enable System Restore so that it begins functioning on your Windows XP computer. To enable System Restore, just follow these steps:

1. In the Control Panel, double-click System, or just right-click My Computer and then click Properties.
2. Click the System Restore tab.
3. You can click the check box shown in Figure 20-19 to turn off system restore on all drives on your computer. If this check box is selected, just click to clear it so that System Restore is enabled.

4. Click OK, and OK again on the System Properties window.
Creating Restore Points

System Restore functions by creating restore points. A restore point is a “snapshot” of your computer’s configuration that is stored on your hard disk. If System Restore needs to be used, System Restore accesses a restore point to reconfigure your computer. This process brings your computer back to a stable state—a place where it was when the system was stable. Restore points enable your computer to travel back in time and be configured as it was when it was stable.

It is very important to note here that System Restore restores your operating system and applications only. It does not save and restore any files. For example, let’s say you accidentally delete the Great American Novel you are working on. System Restore cannot be used to get your novel back. Incidentally, System Restore does not affect other files, such as e-mail and Web pages. Performing a System Restore does not make you lose new e-mail or files—it only configures your system settings and application settings.

System Restore automatically creates restore points for you, so, in general, there is no need to manually create a restore point. However, what if you are about to try some configuration option or configure some software that you know may be risky or that has caused you problems in the past? Before trying the configuration

Adjust System Restore Disk Usage

By default, System Restore is given 12 percent of your hard disk space when you install Windows XP, assuming that 12 percent is at least 200MB. If you access System Properties and click the System Restore tab, and then click the Settings button, you see a slider bar on the Hard Disk tab that indicates the total amount of disk space System Restore is allowed to use. You can raise or lower this amount by moving the slider bar. However, keep in mind that System Restore must have at least 200MB, and if you want System Restore to function really well, you should leave this 12 percent setting at its default level.
or software, you can manually create a restore point so you can later restore your system to its present state. To create a restore point, just follow these easy steps:

1. Click Start | More Programs | Accessories | System Tools | System Restore.

2. In the System Restore window, click the Create a Restore Point button, and then click Next, as shown in Figure 20-20.

3. In the window that appears, enter a description. You may want to include information that will help you distinguish the restore point from others. The date and time of the restore point are added automatically so you don’t need to include those. Click Next.

4. The restore point is created. Click OK and you’re done.

![Welcome to System Restore](image-url)

**FIGURE 20-20** Creating a restore point
Running System Restore

The eventful day finally arrives and you (or someone else) has done something bad to your computer. Now it doesn’t boot or it acts erratically. Whatever the problem, you can use System Restore to bring your computer back to an earlier time when it was functioning appropriately. The following two sections show you how to use System Restore.

If You Can Boot Windows…

If you can boot into Windows, follow these steps:

1. Click Start | More Programs | Accessories | System Tools | System Restore.
2. Click the Restore My Computer to an Earlier Time radio button, and then click Next.
3. A calendar and selection list is presented to you, as shown in Figure 20-21. You can select different days to find a desired restore point. If you did not
create a restore point, you should choose to use the latest one available. The latest one will be listed first in the current or previous day window. Select a restore point and click Next.

4. A message appears telling you to save all files and close all open applications. Do so at this time, and then click the Next button.

5. Restoration takes place on your computer, and your computer automatically reboots once the restoration is complete. Click OK on the restoration message that appears once you reboot.

If You Cannot Boot Windows…

If you cannot boot Windows, follow these steps to run System Restore.

1. Turn on your computer and hold down the CTRL or the F8 key until you see the Startup menu options.

2. Choose Safe Mode, and then press the ENTER button.

3. Once Windows boots, the Help screen that appears gives you the option to restore your computer. Click the System Restore link.

4. Click the Restore My Computer to an Earlier Time radio button and then click Next.

5. A calendar and selection list is presented to you. You can select different days to find a desired restore point. If you did not create a restore point, you should choose to use the latest one available. The latest one will be listed first in the current or previous day window. Select a restore point and click Next.

6. A message appears telling you to save all files and close all open applications. Do so at this time, and then click the Next button.

7. Your computer automatically reboots once the restoration is complete. Click OK on the restoration message that appears after booting has taken place.

Current documents, files, e-mail, and similar items are not affected during a restoration. However, if you installed an application after the last restore point was made, you will need to reinstall that application.
Undoing a Restoration

As I have mentioned, I think System Restore is the best new feature of Windows XP. It can save you a world of pain and agony. But what happens if restore doesn’t go so well. What if there is a problem with restore that leaves Windows XP in worse shape, or even unbootable? Good news—restoration is completely reversible, and the following two sections show you how to reverse a restoration.

Reversing Restoration If You Can Boot Your Computer

To reverse a restoration if you can boot your computer, follow these steps:

1. Click Start | More Programs | Accessories | System Tools | System Restore.
2. In the System Restore window, click the “Undo my last restoration” radio button, and then click Next.

The “Undo my last restoration” option does not appear unless you have previously run a restoration.

3. Close any open files or applications, click OK, and then click Next.
4. The previous restoration is removed and your computer reboots. Click OK to the restoration message that appears after reboot.

Undoing a Restoration If You Cannot Boot into Windows

If you cannot boot into Windows and you need to undo a restoration, just follow these steps:

1. Turn on your computer and hold down the CTRL or the F8 key until you see the Startup menu options.
2. Choose Safe Mode and then press the ENTER button.
3. Once Windows boots, the Help screen that appears gives you the option to restore your computer. Click the System Restore link.
4. Click the Undo My Last Restoration radio button, and then click Next.
5. A message appears telling you to save all files and close all open applications. Do so at this time, and then click the Next button.
6. Your computer is rebooted once the restoration has been removed.
What to Do If You Selected the Wrong Restoration Point

What should you do if you run a restoration, but you selected the wrong restoration point? Let’s say you run a restoration to solve a problem, but the restore point was not early enough. In other words, Windows XP created a restore point while the current problem existed. What then? No problem. Simply undo the last restoration and then run the restoration again, but select an earlier restore point to fix the problem.
This page intentionally left blank.
This page intentionally left blank.
Appendix A

Installing Windows XP
How To…

- Prepare for a Windows XP Upgrade
- Upgrade to Windows XP
- Get a Computer with No Operating System Ready for Installation
- Clean-Install Windows XP
- Activate Windows XP

If you’re like me, you would almost rather have a root canal than install a new operating system. Why? The answer is simple. Any time you install an operating system, whether it be an upgrade or a clean install on a computer with no operating system, you stand the risk of experiencing problems. But you can relax—Windows XP is rather easy to install, and as long as you are sure that your computer’s hardware is ready for Windows XP, you are likely to experience no problems at all. This appendix is designed to help you plan and actually perform the installation. If you purchased your computer with Windows XP preinstalled, you should also check the manufacturer’s instructions for installations, as they may be different than the information presented in this appendix.

Upgrading to Windows XP

Most home users or office users who purchase Windows XP will do so to upgrade their existing PC. This means that you are likely to have a computer that runs Windows 98, Me, NT, 2000, or XP Personal (if you’re upgrading to Professional), and want to upgrade that system so that it runs Windows XP. Unless you are buying a new PC with Windows XP already preinstalled from the factory, you have purchased a Windows XP upgrade CD-ROM so you can have the latest and greatest from Microsoft.

In a perfect world, upgrading your home or office PC would be a piece of cake. You pop the installation CD-ROM into your CD drive, answer a few questions from the setup program, and setup installs Windows XP without any problem whatsoever. When you find that perfect world, let me know, so I can move there, too. The reality is that any number of problems can happen when upgrading to Windows XP. However, if you upgrade smartly, the likelihood of encountering installation failure or problems is low. The trick is to do a bit of homework before
installing Windows XP to make sure your existing PC and operating system are ready. It is all too tempting to start the installation and hope for the best; but in order to upgrade smartly, you need to play detective for a few minutes and make certain all is well in your computer’s environment before starting the upgrade. Upgrading smartly will help prevent a number of potential problems and help you find issues affecting the installation before you ever begin.

So, how do you upgrade smartly? The following sections explore the tasks you should perform before attempting an upgrade to Windows XP.

Check the System Requirements

One big mistake computer users often make when attempting an upgrade or install is not checking the system requirements. Every piece of software, whether it is an operating system or an application, has certain requirements that must be met before the software will function appropriately or before it can even be installed. An operating system is no exception. Your computer must have hardware that can handle Windows XP; so before ever attempting the installation, you should check out your computer to see whether there are any potential problems. Windows XP is very demanding, and one of the main causes of upgrade problems is the lack of proper system resources—so be careful! Check out the information in the following sections to make sure your computer is ready for Windows XP.

Did you know?

What to Do If You Have Windows 95 or 3.x

Windows 95 and earlier operating systems (including 3.x and NT 3.x) cannot be directly upgraded to XP. Windows XP will install on these computers, but it installs itself in a different folder. Thus, you have to reconfigure all of your settings and reinstall all software. If you want to upgrade to a computer running Windows 95 or earlier, I would first strongly recommend that you check the system’s hardware—the odds are good that the computer will not be able to handle the hardware demands of Windows XP. If you still want to try, I recommend a clean install (described later in this appendix), and make certain you back up any data that you do not want to lose in case things do not go so well. See the following sections for more information.
Processor

A computer’s processor can be thought of as the computer’s brain. The processor “processes” information that the operating system or an application needs. For example, if you want your computer to multiply 467 by 345, that request is sent to the processor for completion. Once the processor performs the computation, it is returned to the requesting application (such as your system’s calculator). In the past, processors were not very fast because operating systems and applications were not terribly complicated. However, with today’s operating systems and applications, your computer’s processor will have to be fast enough to handle Windows XP and all of the many tasks it can perform.

For a Windows XP installation, you need a processor that is at least a Pentium (or equivalent) 233 megahertz (MHz)—the megahertz number is the speed at which the processor can run. By today’s standards, 233 MHz is pretty slow. Most new PCs today contain a 400 or 500 megahertz processor, and 1 gigahertz processors are becoming common. It is important to note here that 233 MHz is the bare-bones minimum. Windows XP will run on this processor, but it will not work fast. In reality, you always want the fastest processor you can afford because you will see the best performance with a fast processor.

If your computer currently runs Windows 2000 and your system works well with Windows 2000 (in other words, if the computer does not slowly limp along), then your computer will be able to handle Windows XP just fine.

TIP

If your computer currently runs Windows 2000 and your system works well with Windows 2000 (in other words, if the computer does not slowly limp along), then your computer will be able to handle Windows XP just fine.

How to... Find Your Processor’s Speed

Don’t know what processor is hidden inside your computer? Here are two easy ways to find out:

- Dig around and find the documentation that came with your computer. It should tell you the processor speed (along with all kinds of other information you’ll need as well).

- If you can’t find your computer documentation, then (for Windows 98, Me, NT 4.0, or 2000) right-click the My Computer icon with your mouse, and then click Properties. You’ll see a System properties sheet. Look on the General tab. It should tell you the manufacturer of your computer’s processor and (hopefully) the speed.
If you check your computer’s processor and find that it is not at least a 233 MHz processor, what should you do? You have two options. First, you can buy a new processor for your computer and install it as an upgrade. This involves buying the processor and paying someone to install it (unless you know a thing or two about hardware). In some cases, this is a great solution, but be careful. You may be able to simply purchase a new computer for not much more money, so think carefully and shop smartly before deciding to upgrade your computer’s processor.

TIP
If your processor is too slow for Windows XP, the odds are good that other components are too old as well. In most cases, upgrading your processor usually means you’ll have to upgrade other components, such as RAM. This is why buying a new computer is often the best option.

Random Access Memory
You have probably heard the term Random Access Memory (RAM) plenty of times, even if you do not have your head stuck in the computer world. Random Access Memory is the amount of memory your computer contains for current applications and processes. RAM enables you to work with a Microsoft Word document while also surfing the Internet; it enables you to draw pictures and run programs—anything that you do on your computer requires RAM. Simply put, the more RAM you have, the faster and better your computer will run, and the happier you will be. For a Windows XP installation, you need at least 64 megabytes (MB) of RAM. As with your processor speed requirement, 64MB is a bare minimum, and Microsoft recommends that you have 128MB. Most computer systems today are sold with at least 64MB of RAM, and many with more than 100MB. As with the processor, think carefully before upgrading your RAM. Check your other system components and make certain they do not need to be upgraded as well. The odds are good that they do, and you may be able to buy a new computer with the same money you would spend on upgrades.

Hard Disk Space
Windows XP will need some of your hard disk space for storage during and after the installation. Your computer’s hard disk stores any data that you choose to save, as well as your operating system itself. In order to upgrade to Windows XP, you must have 650MB of free hard disk space. This means that you must have that much spare room on your hard disk so Windows XP can store its files. To check your computer’s hard disk space, double-click the My Computer icon on your Desktop. You see your C drive in the window. Right-click the C drive icon, and
then click Properties. The General tab of the properties sheet shows you the amount of used and free space your disk contains. In Figure A-1, you see that my disk has 1.29GB of hard disk space available, so I have plenty of room for a Windows XP upgrade.

What if you do not have enough free disk space? Then, you need to free up some disk space by removing data from your hard disk. Removed items can include files, Internet pages, and even applications that you no longer use. You’ll need to make some decisions about what you want to remove, but you must free up enough disk space for the installation to be successful.

In Figure A-1, notice the Disk Cleanup button. If you are using Windows 98/Me/2000, you can click this button and your system will help you remove old and unwanted items from your hard disk.

**TIP**

**FIGURE A-1** Check for free disk space on the General tab of the C drive’s properties sheet.
Other Requirements

Your processor, RAM, and disk space requirements are of utmost importance, but there are some other system requirements that should be met in order to make the most of Windows XP. These requirements are virtually a given (unless your computer was built in the ‘70s), so just take a minute to make sure you have these:

- VGA or higher-resolution monitor
- CD-ROM or DVD-ROM drive (Windows XP isn’t fussy about the drive speed)
- A mouse or other similar pointing device
- A keyboard

I told you those were easy. Now, you may also want to check a few other items. These are not required for a Windows XP installation, but they may impact how well your system works with Windows XP and how happy you will be with its functionality. Here they are:

- If you plan to access the Internet (which I hope you do), you need at least a 56 Kbps modem. The standard speed is 56 Kbps, and you now have a number of broadband options available, including ISDN, DSL, cable, wireless, and satellite. None of these are required, of course; but while you are upgrading your system, this is an excellent time to look at your Internet connectivity speed and consider upgrading to a faster service if necessary.

About Compressed Drives

There are several “drive compression” utilities on the market today that essentially shrink the information on your hard disk in order to save space. Although these utilities are great, they can cause you some problems during an upgrade. As a safety precaution, uncompress any compressed drives just to be certain. Check the README file on your installation CD-ROM for late breaking news about upgrade incompatibilities, and also check [http://www.microsoft.com/windowsxp](http://www.microsoft.com/windowsxp) for more incompatibility information.
To make use of all Windows XP has to offer, you should have a good sound card, speakers (or headphones), a good video card, and so forth. There is a plethora of video and sound card products compatible with Windows, so check your local computer store for information and pricing.

You may consider adding other components to your system, such as a DVD drive so you can run DVD games and movies on your computer. You can also use Windows XP to watch TV on your computer through a TV tuner card. You can always add these options to your system after installation, but now is a good time to consider them.

If you want to connect to a local area network, you need some kind of network adapter card. See Chapter 11 for more information.

Back Up Your Data
From painful, past experience, I have learned to always back up any data that I do not want to lose before ever tinkering with my operating system—and that includes an upgrade. If everything goes well during your upgrade, the computer will preserve all of your data and settings, and you will not need any data you have backed up because it will still reside on your computer. However, if things do not go so well, you will desperately need a backup of your critical data—the data you cannot afford to lose. This includes documents, spreadsheets, Internet information—you name it. Spend some time on your computer finding everything you can’t live without, and then back that data up.

You can back up your data in a number of ways. First, Windows 98, Me, and 2000 all include a backup utility found in Accessories. You can use the Backup utility to create a backup file. You must then save this backup file to another location, such as a tape drive or even the hard drive of another computer. You may also have other backup programs and backup media you have purchased as well. If not, backing up your data doesn’t have to be difficult. Simply copy any files you don’t want to lose to a floppy disk or to a Zip or Jaz drive, if your computer has one. If you have only a floppy drive, you may need several disks to make sure you save all of your data, but your time and effort will be well spent if something should happen during the installation.

Check Out Your Device Drivers
Every device attached to your computer, such as your printer, scanner, or modem, has a *driver*. A driver is a piece of software code that enables your computer to
interact with the hardware device. Think of a driver as a car steering wheel. In order to interact with your car and make it do what you want, you use a steering wheel to communicate with it, along with other controls like the brake and gas pedal. In order for your computer to communicate and control a device, a driver must be installed. When you install a device, you usually use a floppy disk or CD-ROM that comes from the factory with your device. This installation media installs a driver that Windows can use. Windows has its own driver database as well; and in many cases, Windows can install and use one of its drivers to manage a device.

Drivers are always changing. When a new device is released—for example, let’s say a printer—the driver ships with it. However, as operating systems change, new drivers are developed so your printer can work with the new operating systems. Before upgrading to Windows XP, you should visit the manufacturers’ Web sites for your computer’s devices. Look for new drivers for your particular models and see if there are any you can download. Download the drivers to a floppy disk and keep them. You may need these new drivers when you install Windows XP to ensure that your hardware works well with your new operating system. Check your device manufacturer’s documentation for more information about downloading updated drivers. Even if you do not need to get any updated drivers, you do need to round up your floppies and CD-ROMs so you have access to your existing drivers in case you need them during installation.

**Copy Items to a Floppy Disk**

You can easily copy items to a floppy disk by following these steps:

1. Insert a formatted floppy disk into your disk drive.
2. Right-click the item you want to copy to the floppy, point to Send To, and then click 3½ Floppy. Or, you can open the floppy disk by double-clicking its icon in My Computer, and then dragging the desired files or folders into the floppy disk window.

This action copies the files or folders to the floppy, but it does not remove them from your computer.
Check for Viruses and Disable Antivirus Software

Before upgrading to Windows XP, you should run a full virus check on your computer system using an antivirus program, such as one from McAfee or Symantec. You may currently have one of these programs, or you may need to buy one. If you use the Internet, you should certainly have virus detection software to make sure you can both detect and disinfect your computer in the case of a virus. Antivirus software is normally under $50 and well worth your investment. If you do not have antivirus software, you can purchase it both on the Internet and at any computer store in your area, and in many department stores as well.

Refer to your owner’s instructions and run a complete virus scan of your system. Make sure your software has current virus definitions so it can detect the presence of a newer virus. Current definitions can be downloaded from the manufacturer’s Web site. Once the virus scan is complete and you have removed any viruses, you need to disable your antivirus software before running setup. Antivirus software will interfere with Windows XP installation, so make certain you check the antivirus documentation and disable the software accordingly.

Shut Down All Programs

Before running Windows XP setup, make certain that you shut down all programs that are running and that you disconnect from the Internet. Also, if you have any programs that protect your Master Boot Record (MBR) by encrypting it, you need to uninstall that application. Some applications on the market today help protect your computer against sabotage or data theft by encrypting certain portions of your operating system so they cannot be read by unauthorized persons. This software is not normally installed as a part of a purchase package, but do check your original
documentation and make certain you do not have any applications like this installed. If you do, uninstall them before attempting to run setup. These applications will cause the Windows XP upgrade to fail if they are running.

**Upgrading Your Computer**

Finally, after doing your detective work, you are ready to begin the upgrade to Windows XP. Before you get started, make sure you have everything gathered that you will need. First, you’ll need the Windows XP CD-ROM and the product key. You can find the product key on a sticker on the back of your CD-ROM jewel case. You should also have any disks or CD-ROMs containing drivers for your hardware in case Windows XP cannot install one of the devices.

Now that you have your materials and you have taken some time to check out your computer and make certain it is ready for the upgrade, you are ready to begin. The following steps walk you through the upgrade and describe each piece of the upgrade process to you.

1. Insert your Windows XP CD-ROM into your computer’s CD-ROM drive. A message appears, asking “What do you want to do?” Click the option to install Windows XP. If the message does not appear, your computer is having problems reading the auto launcher, which is no big deal. Just open My Computer and double-click your CD-ROM drive icon. Your computer opens the CD-ROM and you see a folder called i386 and an icon called Setup inside the folder. Double-click this icon to start the installation.

2. Setup begins by checking your system and preparing the Setup Wizard. This will probably take less than one minute.

3. The Windows XP installation Welcome screen appears. The Welcome screen prompts you to select a type of installation, either upgrade or clean install. Use the clean install option if your operating system is not supported as an upgrade path (such as Windows 95). If your current operating system is supported, then choose the upgrade option, unless you simply want to get rid of all of your previous settings from Windows. Click the Next button to continue.

4. The Licensing Agreement window appears. This window gives you all the laws and rules about using your new software. It’s very interesting to read (yawn), but you should read it and you must click the I Accept This Agreement radio button for installation to continue. Click this button, and then click the Next button.
5. The Product Key window appears. Locate your product key found on your CD-ROM jewel case and type the key into the provided fields just as it appears on the CD-ROM case. Click the Next button when you’ve finished.

As you type your Product Key, you don’t have to worry about typing capital letters. The product key is not case sensitive.

6. A Windows setup window appears in which you can choose language options, advanced options, and accessibility options for your install. If you are interested in any of these features, just click the appropriate button to select the options that are available.

7. Next, XP asks whether you want to upgrade your file system to NTFS. You can learn more about NTFS in Chapter 19; as a general rule, you should choose to use the NTFS file system for best performance. Make your selection and click Next.

8. The Dynamic Update window appears. This feature enables XP to check Microsoft.com for updates that can be installed during your installation. Your computer must be currently configured with an Internet connection for this to work. If it is, choose the Yes button and click Next.

9. At this point, the interactive part of setup is over. This means that Windows XP will not need your assistance any longer to complete setup. The only exception is if Windows XP needs a hardware driver from you. Under most circumstances, however, you don’t have to do anything else and you can leave your computer unattended for the next half hour or so.

If installation does not go so well and you have problems starting Windows XP, see Chapter 20 for helpful troubleshooting tips.

Installing Windows XP on a Computer with No Operating System

You may need to install Windows XP on a computer that does not have an operating system. For example, let’s say you purchase a computer from a direct supplier or even over the Internet. These machines are often sold “unformatted” and without an operating system. Or, perhaps your Windows 98 computer has too many goofy system problems you don’t want to contend with and you want to clean-install Windows XP so that it does not use and keep all of those older operating system
files. No matter what your reason, you can clean-install Windows XP on a computer that has an operating system, as well as on systems that do not.

This discussion brings up an important question. Should you format an existing hard drive and blow away your old operating system so you can clean-install Windows XP? Not usually. It is best if you upgrade your existing operating system to Windows XP in order to preserve your system and hardware settings. However, in some cases, you may wish to clean-install in order to get away from problems in your older operating system. This is, of course, fine; but as a rule of thumb, always choose an upgrade over a clean install for Windows XP.

Preparing for a Clean Installation

Just like an upgrade, you need to spend a little time preparing for the clean installation. This means that you need to examine your computer’s hardware and make certain the computer meets at least the minimum hardware requirements. You also need to locate floppy disks and CD-ROMs that contain drivers for your computer’s hardware. The Windows XP CD-ROM is a bootable CD-ROM. This means that if you place the CD in the CD-ROM drive and turn on the computer, the installation CD can start the computer for you and begin installation automatically.

If your computer does not boot from CD-ROM (most all of them do these days), you can use a Windows 98/Me/2000 startup disk to start the computer so that you can begin installation. Refer to the appropriate Help files on those operating systems for more specific instructions. Beyond starting from a CD-ROM, the installation of Windows XP on a clean install functions in the same manner, so refer to the section earlier in this chapter for steps.
Activating Windows XP

Windows XP includes a new feature not found in previous versions of Windows called activation. In a nutshell, Windows activation is a new feature Microsoft uses to protect the licensing of software. The activation feature prevents someone from installing a bunch of computers using the same software CD-ROM. Essentially, activation is just a new step in the key and licensing agreement portion of setup.

Once you install Windows XP, you have 30 days to activate the operating system with Microsoft. The activation doesn’t need any information from you—so don’t worry, this isn’t like Big Brother or anything. The activation process records a serial number from your computer’s hardware and couples it with your CD-ROM installation code. This way, if someone tries to install a bunch of computers with a single CD-ROM, activation will recognize that the key has already been used and will not allow the activation to continue. Once the 30-day period expires, Windows XP will cease to function.

There are two ways to activate your Windows XP computer. You can do it over the Internet or by manually calling the Microsoft product activation call center. Depending on your version of Windows XP, you may have seen the Activation prompt during setup. If not, you can access the Activation tool found in Start | All Programs | Accessories | System Tools. Either way, the process is rather easy and straightforward. To activate your computer using a modem, just follow the onscreen prompts. If you need to call Microsoft to activate Windows, just refer to your Windows XP documentation that came with your installation CD-ROM. That’s all there is to it!
Are you tired of using your mouse so much? Then how about a few helpful keyboard shortcuts? Windows XP, like previous versions of Windows, includes a number of helpful keyboard shortcuts to save you time and energy. Also keep in mind that many of your applications have keyboard shortcuts as well. Check your applications’ documentation for details about those shortcuts. OK, here they are—in a few nice, easy-to-read tables.

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a file</td>
<td>Hold down CTRL while dragging the file to the desired location.</td>
</tr>
<tr>
<td>Create a shortcut</td>
<td>Hold down CTRL+SHIFT while dragging the file to the desired shortcut location.</td>
</tr>
<tr>
<td>Tab through pages in a properties sheet</td>
<td>CTRL+TAB</td>
</tr>
<tr>
<td>Close a folder</td>
<td>SHIFT and click the Close button.</td>
</tr>
<tr>
<td>Bypass a CD-ROM’s autorun</td>
<td>Hold down SHIFT when you insert the CD-ROM.</td>
</tr>
<tr>
<td>Switch between opening a new window and closing an existing window</td>
<td>Press CTRL and double-click a folder.</td>
</tr>
<tr>
<td>Copy a file</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Open a file</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>Print a file</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>Save a file</td>
<td>CTRL+S</td>
</tr>
<tr>
<td>Cut a file</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Paste a file</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Undo</td>
<td>CTRL+Z</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Show “What’s This?” help</td>
<td>SHIFT+F1</td>
</tr>
<tr>
<td>Show Help window</td>
<td>F1</td>
</tr>
<tr>
<td>Cancel</td>
<td>ESC</td>
</tr>
<tr>
<td>Select an item</td>
<td>SPACEBAR</td>
</tr>
<tr>
<td>Show pop-up menu</td>
<td>SHIFT+F10</td>
</tr>
<tr>
<td>Activate or inactivate menu bar mode</td>
<td>ALT</td>
</tr>
</tbody>
</table>

**TABLE B-1**  Shortcuts for Windows, Objects, and Folders
<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display next primary window</td>
<td>ALT+TAB</td>
</tr>
<tr>
<td>Display next window</td>
<td>ALT+ESC</td>
</tr>
<tr>
<td>Show pop-out menu for active window</td>
<td>ALT+SPACEBAR</td>
</tr>
<tr>
<td>Show pop-out menu for active child window</td>
<td>ALT+HYPHEN</td>
</tr>
<tr>
<td>Show Properties</td>
<td>SHIFT+ENTER</td>
</tr>
<tr>
<td>Close active window</td>
<td>ALT+F4</td>
</tr>
<tr>
<td>Switch to next window within an application</td>
<td>CTRL+F6</td>
</tr>
<tr>
<td>Capture window</td>
<td>ALT+PRINT SCREEN</td>
</tr>
<tr>
<td>Capture Desktop</td>
<td>PRINT SCREEN</td>
</tr>
<tr>
<td>Activate Start menu</td>
<td>CTRL+ESC</td>
</tr>
<tr>
<td>Rename an item</td>
<td>F2</td>
</tr>
<tr>
<td>Find an item</td>
<td>F3</td>
</tr>
<tr>
<td>Delete an item</td>
<td>DELETE</td>
</tr>
<tr>
<td>Delete an item without putting it in recycle bin</td>
<td>SHIFT+DELETE</td>
</tr>
<tr>
<td>Explore an item</td>
<td>SHIFT+double-click</td>
</tr>
</tbody>
</table>

**TABLE B-1**  Shortcuts for Windows, Objects, and Folders *(continued)*

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel current task</td>
<td>ESC</td>
</tr>
<tr>
<td>Click a button</td>
<td>SPACEBAR</td>
</tr>
<tr>
<td>Select or clear a check box</td>
<td>SPACEBAR</td>
</tr>
<tr>
<td>Carry out a following command</td>
<td>SPACEBAR</td>
</tr>
<tr>
<td>Click a selected button</td>
<td>ALT+underlined letter</td>
</tr>
<tr>
<td>Move forward through options</td>
<td>CTRL+SHIFT+TAB</td>
</tr>
<tr>
<td>Move backward through options</td>
<td>ENTER</td>
</tr>
<tr>
<td>Move forward through tabs</td>
<td>TAB</td>
</tr>
<tr>
<td>Move backward through tabs</td>
<td>SHIFT+TAB</td>
</tr>
<tr>
<td>Open a folder one level up</td>
<td>CTRL+TAB</td>
</tr>
</tbody>
</table>

**TABLE B-2**  Shortcuts within Dialog Boxes
<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Combo address box</td>
<td>F4</td>
</tr>
<tr>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td>Move focus between panes</td>
<td>F6</td>
</tr>
<tr>
<td>Go To command</td>
<td>CTRL+G</td>
</tr>
<tr>
<td>Go to parent folder</td>
<td>BACKSPACE</td>
</tr>
<tr>
<td>Expand everything under a selection</td>
<td>* on numeric keypad</td>
</tr>
<tr>
<td>Expand selection</td>
<td>+ on numeric keypad</td>
</tr>
<tr>
<td>Collapse selection</td>
<td>– on numeric keypad</td>
</tr>
<tr>
<td>Expand current selection</td>
<td>RIGHT ARROW</td>
</tr>
<tr>
<td>Collapse current selection</td>
<td>LEFT ARROW</td>
</tr>
<tr>
<td>Move backward</td>
<td>ALT+LEFT ARROW</td>
</tr>
<tr>
<td>Scroll without moving selection</td>
<td>CTRL+ARROW</td>
</tr>
<tr>
<td>Close folders</td>
<td>SHIFT+Close button</td>
</tr>
</tbody>
</table>

**TABLE B-3** Windows Explorer Shortcuts

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate a selected link</td>
<td>TAB+ENTER</td>
</tr>
<tr>
<td>Show a shortcut menu for a link</td>
<td>SHIFT+F10</td>
</tr>
<tr>
<td>Go to next page</td>
<td>ALT+RIGHT ARROW</td>
</tr>
<tr>
<td>Go to previous page</td>
<td>ALT+LEFT ARROW</td>
</tr>
<tr>
<td>Go to a new page</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>Move forward between frames</td>
<td>CTRL+TAB</td>
</tr>
<tr>
<td>Move back between frames</td>
<td>SHIFT+CTRL+TAB</td>
</tr>
<tr>
<td>Move to beginning of page</td>
<td>HOME</td>
</tr>
<tr>
<td>Move to end of page</td>
<td>END</td>
</tr>
<tr>
<td>Start a new window</td>
<td>CTRL+N</td>
</tr>
<tr>
<td>Print</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td>Scroll to beginning of page</td>
<td>UP ARROW</td>
</tr>
<tr>
<td>Scroll to end of page</td>
<td>DOWN ARROW</td>
</tr>
</tbody>
</table>

**TABLE B-4** Helpful Internet Explorer Shortcuts
<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll to beginning in page increments</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>Scroll to end in page increments</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>Stop downloading</td>
<td>ESC</td>
</tr>
<tr>
<td>Save</td>
<td>CTRL+S</td>
</tr>
</tbody>
</table>

**TABLE B-4**  Helpful Internet Explorer Shortcuts (*continued*)
This page intentionally left blank.
Windows Media Player can meet all of your media needs, and there are several keyboard shortcuts that help you use Media Player faster. Use the following tables as a quick reference, and make sure you check out Chapter 16 to learn more about Windows Media Player.

**Media Player Menu Shortcuts**

You can use a variety of keyboard shortcuts to access items in the Media Player menus. Table C-1 shows you these shortcuts.

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Menu</strong></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>Open URL</td>
<td>CTRL+U</td>
</tr>
<tr>
<td>Close</td>
<td>CTRL+W</td>
</tr>
<tr>
<td>Exit</td>
<td>ALT+F4</td>
</tr>
<tr>
<td><strong>View Menu</strong></td>
<td></td>
</tr>
<tr>
<td>Full mode</td>
<td>CTRL+1</td>
</tr>
<tr>
<td>Compact mode</td>
<td>CTRL+2</td>
</tr>
<tr>
<td><strong>Play Menu</strong></td>
<td></td>
</tr>
<tr>
<td>Play/pause</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>Stop</td>
<td>CTRL+S</td>
</tr>
<tr>
<td>Skip back</td>
<td>CTRL+B</td>
</tr>
<tr>
<td>Skip forward</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Shuffle</td>
<td>CTRL+H</td>
</tr>
<tr>
<td>Repeat</td>
<td>CTRL+T</td>
</tr>
<tr>
<td>Volume up</td>
<td>F10</td>
</tr>
<tr>
<td>Volume down</td>
<td>F9</td>
</tr>
<tr>
<td>Volume mute</td>
<td>F8</td>
</tr>
<tr>
<td><strong>Tools Menu</strong></td>
<td></td>
</tr>
<tr>
<td>Search computer for…</td>
<td>F3</td>
</tr>
<tr>
<td><strong>Help Menu</strong></td>
<td></td>
</tr>
<tr>
<td>Help topics</td>
<td>F1</td>
</tr>
</tbody>
</table>

**TABLE C-1** Media Player Menu Shortcuts
Media Player Features Shortcuts

For some Media Player features, there are additional shortcuts you can use to make your work and play easier. Tables C-2 and C-3 list these options.

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy music</td>
<td>ALT+C</td>
</tr>
<tr>
<td>Stop copy</td>
<td>ALT+S</td>
</tr>
<tr>
<td>Get names</td>
<td>ALT+G</td>
</tr>
<tr>
<td>Album details</td>
<td>ALT+A</td>
</tr>
<tr>
<td>Back</td>
<td>ALT+B</td>
</tr>
</tbody>
</table>

**TABLE C-2** CD Audio Features Shortcuts

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>New playlist</td>
<td>ALT+N</td>
</tr>
<tr>
<td>Add to playlist</td>
<td>ALT+A</td>
</tr>
<tr>
<td>Search</td>
<td>ALT+S</td>
</tr>
<tr>
<td>Media details</td>
<td>ALT+M</td>
</tr>
<tr>
<td>Back</td>
<td>ALT+B</td>
</tr>
<tr>
<td>Add</td>
<td>TAB+ENTER</td>
</tr>
<tr>
<td>Add currently playing</td>
<td>TAB+ENTER+T</td>
</tr>
<tr>
<td>Add file</td>
<td>TAB+ENTER+F</td>
</tr>
<tr>
<td>Add URL</td>
<td>TAB+ENTER+U</td>
</tr>
<tr>
<td>Delete</td>
<td>TAB+ENTER</td>
</tr>
<tr>
<td>Delete from playlist</td>
<td>TAB+ENTER+P</td>
</tr>
<tr>
<td>Delete from library</td>
<td>TAB+ENTER+L</td>
</tr>
<tr>
<td>Delete playlist</td>
<td>TAB+ENTER+A</td>
</tr>
</tbody>
</table>

**TABLE C-3** Media Library Features Shortcuts
Skin Shortcuts

When you use a skin with Media Player, you gain several keyboard shortcuts you can use when any skin is applied. See Table C-4 for details.

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access shortcut menu</td>
<td>SHIFT+F10</td>
</tr>
<tr>
<td>Navigate through menus</td>
<td>SHIFT+F10, arrow keys, ENTER</td>
</tr>
<tr>
<td>Close shortcut</td>
<td>ESC</td>
</tr>
<tr>
<td>Open</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>Open URL</td>
<td>CTRL+U</td>
</tr>
<tr>
<td>Shuffle</td>
<td>CTRL+H</td>
</tr>
<tr>
<td>Repeat</td>
<td>CTRL+T</td>
</tr>
<tr>
<td>Volume up</td>
<td>F10</td>
</tr>
<tr>
<td>Volume down</td>
<td>F9</td>
</tr>
<tr>
<td>Mute</td>
<td>F8</td>
</tr>
<tr>
<td>Play/pause</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>Stop</td>
<td>CTRL+S</td>
</tr>
</tbody>
</table>

**TABLE C-4** Skin Feature Shortcuts
Windows Movie Maker is one of the cool features of Windows XP. If you want to use Movie Maker quickly and efficiently, try using the keyboard shortcuts displayed in this table, and check out Chapter 17 for all the details about Movie Maker.

<table>
<thead>
<tr>
<th>To Do This…</th>
<th>Press This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new project</td>
<td>CTRL+N</td>
</tr>
<tr>
<td>Open a project</td>
<td>CTRL+O</td>
</tr>
<tr>
<td>Save a project</td>
<td>CTRL+S</td>
</tr>
<tr>
<td>Save project as</td>
<td>F12</td>
</tr>
<tr>
<td>Import source file</td>
<td>CTRL+I</td>
</tr>
<tr>
<td>Record source material</td>
<td>CTRL+R</td>
</tr>
<tr>
<td>Save a movie</td>
<td>CTRL+M</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Delete</td>
<td>DELETE</td>
</tr>
<tr>
<td>Select all</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Zoom in</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>Zoom out</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>Set start trim point</td>
<td>CTRL+SHIFT+LEFT ARROW</td>
</tr>
<tr>
<td>Set end trim point</td>
<td>CTRL+SHIFT+RIGHT ARROW</td>
</tr>
<tr>
<td>Clear trim points</td>
<td>CTRL+SHIFT+DELETE</td>
</tr>
<tr>
<td>Split clip</td>
<td>CTRL+SHIFT+S</td>
</tr>
<tr>
<td>Combine clips</td>
<td>CTRL+SHIFT+C</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>SPACEBAR</td>
</tr>
<tr>
<td>Stop playback</td>
<td>PERIOD</td>
</tr>
<tr>
<td>Previous frame</td>
<td>ALT+LEFT ARROW</td>
</tr>
<tr>
<td>Next frame</td>
<td>ALT+RIGHT ARROW</td>
</tr>
<tr>
<td>Previous clip</td>
<td>CTRL+LEFT ARROW</td>
</tr>
<tr>
<td>Next clip</td>
<td>CTRL+RIGHT ARROW</td>
</tr>
<tr>
<td>Full screen</td>
<td>ALT+ENTER</td>
</tr>
<tr>
<td>Return from full screen</td>
<td>ESC</td>
</tr>
<tr>
<td>To Do This…</td>
<td>Press This…</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Help topics</td>
<td>F1</td>
</tr>
<tr>
<td>Next pane</td>
<td>F6 OR TAB</td>
</tr>
<tr>
<td>Previous pane</td>
<td>SHIFT+F6 OR SHIFT+TAB</td>
</tr>
<tr>
<td>First clip</td>
<td>HOME</td>
</tr>
<tr>
<td>Last clip</td>
<td>END</td>
</tr>
</tbody>
</table>
This page intentionally left blank.
Application  A general term describing a type of program that is often used for some business or production purpose. Microsoft Word is an example of an application.

Browser  A program that enables your computer to download and interpret HTML pages. Browsers, such as Internet Explorer, enable you to surf the World Wide Web.

Capture  In Windows Movie Maker, the process of gathering film data that is converted from analog to digital media format.

Compatibility Mode  A Windows XP feature that enables Windows XP to act like an older operating system, such as Windows 2000 or Windows 98. You can then attempt to use older applications with Windows XP while it is acting like the older operating system.

Components  Window XP includes a few additional features that are not installed by default. These components can be installed using Add/Remove Programs in the Control Panel.

Compression  The act of reducing the size, in terms of KB or MB, of a file. Compression helps reduce disk storage space at the file or folder level. Windows XP supports folder compression natively.

Control Panel  Found in My Computer, the Control Panel gives you a number of features that enable you to control, or configure, Windows XP.

Desktop  The primary area of your Windows XP computer where you work. The Desktop contains the Recycle Bin, and possibly other icons as well.

Dial-up  A type of networking where your computer uses a telephone line to dial a connection number to another computer. Dial-up connections are used for both Internet connectivity and private networks.

Driver  A piece of software that enables Windows XP to interact with a hardware device. Windows XP contains an extensive database of drivers that can be used for plug-and-play devices.

Download  The process of transferring Web content from a Web server to your computer. The browser you are using then interprets the Web content and displays it to you.

E-mail  Electronic mail enables you to communicate with people all over the world by sending messages as well as attachments over the Internet.

E-mail Client  A program that enables you to send, receive, and manage e-mail and e-mail addresses. Outlook Express is an e-mail client.
**Explorer**  A Windows feature that enables you to manage files, folders, and network connections. As a result of the Windows XP Web integration, Explorer is now considered an accessory.

**File**  A file refers to any saved item, such as documents, pictures, videos, and so on. Various programs and applications are used to open files.

**File System**  A method of hard disk organization used by Windows XP that enables it to read and write data to the disk. Windows XP can use the NT File System (NTFS), the File Allocation Table (FAT), or the File Allocation Table 32 (FAT32) file systems. NTFS is preferred.

**Firewall**  A firewall is a hardware or software solution that protects a computer or a network from intruders from the Internet. Windows XP includes a personal firewall to help keep your computer safe from Internet hackers.

**Folder**  A storage item used to keep all kinds of files and programs. A folder in Windows XP essentially looks and works like a paper folder you would find in a filing cabinet.

**Fragmentation**  Over time, the data on hard disks becomes disorganized, or not stored in a contiguous format. This process is known as fragmentation. Disk Defragmenter in Windows XP is used to correct the problem.

**Hardware**  Any device found in your computer is considered hardware, as well as other devices that may connect to it. Common examples are video cards, keyboards, hard drives, printers, game controllers, and so on.

**Home Networking Wizard**  A wizard that configures your computer’s local area connection and Internet connection for sharing with other computers on your home or small office network. The Home Networking Wizard makes networking easy because all configuration is done for you.

**HTML**  HyperText Markup Language. Web pages are written using HTML and are downloaded and interpreted by browsers.

**HTTP**  HyperText Transfer Protocol. HTTP is the protocol that transfers HTML pages from Web sites to users’ computers.

**Icon**  A symbol that appears on your computer, usually in the form of a picture. Icons contain properties pages and other data that can be used for specific configuration purposes. My Computer, Recycle Bin, and most items found in the Control Panel are represented as icons.
ICS (Internet Connection Sharing)  A Windows XP feature that enables you to share an Internet connection from one computer and have other computers use the share on your home network.

Internet  A vast public computer network that enables people all over the world to freely exchange ideas and information.

Internet Connection  A type of connection that enables your computer to connect to the Internet. This may include dial-up, DSL, ISDN, or other connection options.

ISP (Internet Service Provider)  Although the Web itself is free, you must pay an ISP a fee in order to access and use the Web. MSN, AOL, and Earthlink are just a few examples of ISPs.

Media Player  A Windows XP application that enables you to listen to CDs and play virtually any multimedia file from your local machine or the Internet.

Movie Maker  A Windows XP application that enables you to record, edit, and manage home movies.

MSN  The Microsoft Network—MSN is both a Web search engine and an ISP. Visit MSN at www.msn.com.

Operating System  Computer code that operates a computer’s hardware. Operating systems are used in order to run applications and programs and manage a computer. Windows XP is an operating system.

Plug-and-Play  A technology that enables a computer to detect when a new hardware device has been installed or when one has been removed. This feature enables the computer to automatically manage hardware and adapt to changes. Windows XP is a plug-and-play–compliant system.

Program  A program is a general term that refers to some kind of computer code used for a specific purpose. Applications, games, and utilities are all programs.

Properties  Most features and programs within Windows XP have properties pages. Properties pages often enable you to configure various components for the specific feature or program.

Protocol  A protocol is a communication behavior rule that computers use to communicate with each other. A very common protocol today is TCP/IP.
Registry  A Windows XP database that contains all of the information about your Windows XP configuration and hardware. Windows XP reads and writes to the database in order to configure your system and adapt to changes.

Remote Desktop Connection  A Windows XP feature that allows you to connect with a remote computer. This feature allows you to use the remote computer as if you were actually sitting at the machine.

Restore Point  A place in time where System Restore can save your configuration settings to the hard disk so the system can be restored to that time in the event of a failure.

Safe Mode  A Windows XP feature that enables you to boot Windows using a minimal number of drivers. Safe Mode is used to repair Windows XP when you cannot boot normally due to some system or hardware problem.

Share  A folder, printer, application, or some other item that is available to other users on a network.

Skin  A Windows Media Player feature, skins are overlay graphics that enable Media Player to change its appearance as the user desires.

Split  In Movie Maker, the process of breaking a film clip into more manageable pieces.

Start Menu  The Start menu is your gateway to Windows XP. Found on the Taskbar, the Start menu gives you access to virtually all of the Windows XP components, as well as any programs you install.

System Restore  A Windows XP feature that enables Windows XP to reconfigure your computer to an earlier time in the event of some configuration error.

Taskbar  The Taskbar is a thin bar that runs along the bottom of the Desktop. The Taskbar contains the Start menu and a number of other program options.

Trimming  In Windows Movie Maker, the process of cutting movie footage that is unwanted out of the movie.

TCP/IP  Transmission Control Protocol/Internet Protocol. TCP/IP is the most common computer protocol today. TCP/IP is used on the Internet and in private networks. TCP/IP is considered a suite of protocols because it combines over 100 communication protocols that provide the vast functionality you find on the Internet.
A user is any person who has an account on a Windows XP computer. Windows XP provides rich support for user authentication and share-permissions.

**Windows Update**  A Windows XP feature that can automatically download operating system updates from the Internet so you can install them at your convenience. The downloads come directly from Microsoft.com, so you know they are safe and appropriate for your system.

**World Wide Web**  A part of the Internet that displays HTML pages that users download with a browser. Most Internet traffic and usage is Web based.
Index

A

Accessibility, Accessories menu, 112–118
  Accessibility Wizard, 112–114
  Magnifier, 114–116
  Narrator, 116–117
  onscreen keyboard, 117
  Utility Manager, 117–118

Accessibility Options, Control Panel, 24–30
  Display tab, 28
  General tab, 29
  Keyboard tab, 24–27
  Mouse tab, 29
  Sound tab, 27–28

Accessibility Wizard, 112–114

Accessories menu, 111–130
  Accessibility, 112–118
  Accessibility, Accessibility Wizard, 112–114
  Accessibility, Magnifier, 114–116
  Accessibility, Narrator, 116–117
  Accessibility, onscreen keyboard, 117
  Accessibility, Utility Manager, 117–118
  Address Book, 119
  Calculator, 119–120
  Command Prompt, 120
  Communications option, 118
  Entertainment menu, 118–119
  Games menu, 119
  Notepad, 120–121
  Paint, 121–122
  Synchronize tool, 123–127
  System Tools menu, 119
  Windows Explorer, 127–129
  WordPad, 129–130

accounts
  Outlook Express, 241–242
  Windows XP default, 274–275

accounts, administrator
  overview, 274–275
  password protection, 277–280

accounts, user, 274–275
  changing, 277–279
  creating, 276–277
  creating group, 282–284
  customizing with pictures, 280
  overview of, 274–275
  permissions, 284–288
  resetting passwords, 283
  User Accounts window, 275–276
  user logon/logoff, 280
  using Computer Management console, 280–282

ACPI (Advanced Configuration and Power Interface), 134
  activation, 473, 474
  Active Desktop Gallery, 71
  Active Directory, in corporate networks, 266
  Add Device Wizard, 172
  Add Hardware, 30, 137–139
  Add New Programs button, 89–92
  Add Printer Wizard, 155–159
Add/Remove Programs, 89–92
  avoiding disk errors, 381
  conserving disk space, 379
  Control Panel icon for, 31
  installing IIS components, 262
  installing Windows components, 99–100
  overview of, 89–90
  steps for using, 91–92
  uninstalling, 93–94
Add/Remove Windows, 262
Address Book, Outlook Express, 243–246
  adding contacts, 243–244
  adding members to group, 245
  managing addresses, 245–246
  overview of, 119
Address button, Internet Explorer
  overview of, 200–201
  using Go button, 201
Addresses icon, 243
Administrative Options, Control Panel, 30
Administrative Tools
  Computer Management console, 280–282
  Control Panel icon, 31
  IIS console, 263–264
  Performance monitor, 425
administrator accounts
  overview of, 274–275
  password protection for, 277–280
Advanced button, Settings tab, 77
Advanced Calling button, NetMeeting, 221
Advanced Configuration and Power
  Interface (ACPI), 134
Advanced Mode, backups, 411–412
Advanced Power Management (APM)
  tab, 75
Advanced Security Settings window, 287–288
Advanced tab
  configuring Internet Explorer, 209–210
  configuring modems, 188
  configuring printers, 163–165
  creating Internet connections via modem, 184
  customizing XP Start menu, 55–57
  enabling ICF, 293
  Power Options, 74
  System Properties, 433, 437–439
All Programs, configuring Start menu, 52
America Online (AOL), 252
Analyze button, Disk Defragmentation, 382
.ani extension, 40
antivirus software
  e-mail attachments and, 235
  installing Windows XP, 470
AOL (America Online), 252
APM (Advanced Power Management) tab, 75
Appearance tab, Display options, 75–76
applications
  defined, 490
  System Information, 423
Area Code Rules tab, 186–187
attachments, e-mail
  attaching files, 232–233
  computer viruses in, 235
  receiving, 234
audio files, 364–367
  adding to movie, 365–366
  adjusting levels, 366
  clips, 359
  keyboard shortcuts for Media Player, 483
  mixing, 366–367
Audio tab
  NetMeeting, 221
  Sounds and Audio Devices icon, 45–46
automated system recovery, 410
automatic updates, 437–438
B
Back button, Internet Explorer, 199
Background Tab, Display, 63–66
backslashes (\), UNC path, 105
Backup utility
  Advanced Mode, 411–412
disk maintenance with, 384
Windows XP installation and, 468
Backup Wizard, 407–410
backups, 406–412
  Advanced Mode, 411–412
  automated system recovery option, 410
  backup recovery, 410–411
  overview of, 407–410
  using Backup Wizard, 407–410
Windows XP installation and, 468
bandwidth
  accessing multimedia files, 367
NetMeeting, 216, 221
basic disks, see also Disk Management
  converting to dynamic disks, 398–399
  overview of, 397
Block setting, driver signing, 147
Blocked Senders option, Outlook Express, 238–239
boot sequence
  overview of, 5–6
  reversing restoration using, 456
  running System Restore, 454–455
broadband connections
  costs of, 180–181
  creating, 191–192
defined, 179
  Internet connections with, 179–180
  using ICS with, 251
browsers, 196, 490
Buttons tab, Mouse icon, 36–38

C
cable, Internet access, 179–180
cables, network
  creating Direct Cable Connections, 258
  overview of, 248–249
cache, IE configuration, 424
Calculator, 119–120
Call menu, NetMeeting, 218
Calling Card tab, modems, 187–189
cameras
  Control Panel icon for, 43
  overview of, 171–173
  Scanners and Cameras folder, 171, 172
capture, 490
Categories, Control Panel, 22
category view, 22–24
CD Audio, 331–335
  configuring, 333–334
  copyright law and, 335
  making copies, 332–333
  managing and saving songs, 332
CD-ROMs
  installing programs with, 89, 91–92
  preparing for clean installation of Windows XP, 473
  Removable Storage and, 412–413
  System Information and, 419
troubleshooting installation, 150
  upgrading computer for Windows XP installation, 471
  using uninstall option, 92–94
Certificates, Internet Explorer, 206–207
Change Password window, user accounts, 278–279
Change Picture window, user accounts, 278–280
check boxes, for getting help, 30
Classic Start menu, customizing, 57–59
Classic view, 23–24
clean installation, Windows XP, 473
click, defined, 8
ClickLock option, 37–38
clips, Movie Maker
   combining, 359–360
   creating storyboards, 361–362
   overview of, 357–358
   previewing, 362
   saving, 355
   splitting, 359–360
   trimming, 363–364
Clocks
   setting, 31–33
   using System Tray to change, 13
Collections area, Movie Maker
   overview of, 353
   splitting and combining clips in, 359
collections, Movie Maker, 357–358
Color quality drop-down menu, 77
Command Prompt, 120
Communications option, 118
compatibility mode
   defined, 490
   golden rules for, 135
   overview of, 96–98
Compatibility Mode Wizard, 97–98
components, 98–100
   defined, 490
   installing, 99–100
   removing, 100
   System Information for, 419–420
Compose tab, Outlook Express, 243
compression
   defined, 490
   drive, 467
   folder, conserving disk space, 379
   folder, overview of, 107–109
   folder, sending e-mail attachments, 233
Computer Management console
   converting to dynamic disks, 398–399
   Disk Management with, 396–397
   drives, 374–375
   group accounts, 282–284
resetting passwords, 283
user accounts, 275, 280–282
Conflicts/Sharing, System Information, 418
Connections tab
   Internet Explorer, 207–208
   Outlook Express, 243
Connectivity option, IE configuration, 423
Contact button, Outlook Express Address Book
   accessing Address Book, 200
   adding contacts, 243–244
   adding members to groups, 245
   Contacts pane, Outlook Express, 230
Content tab, IE
   configuration, 205–207
   configuration problems, 423
Control Panel, 19–48
   accessing, 21–24
   Add Hardware, 30
   Add/Remove Programs, 31
   Administrative Tools, 31
   configuring with View Tab, 80
   Date and Time, 31–33
   defined, 490
   Display, 34
   Folder Options, 34
   Fonts, 34
   Game Controllers, 34
   getting check box help, 30
   Internet Options, 34
   Keyboard, 35–36
   Network Connections, 42
   overview of, 21–22
   Phone and Modem Options, 42
   Power Options, 42
   Printers and Faxes, 42
   Regional and Language Options, 42
   Scheduled Tasks, 43
   Sounds and Audio Devices, 43–46
   Speech, 46–47
   System, 47
   Taskbar and Start menu, 48
   User Accounts, 48
Control Panel, Accessibility Options, 24–30
  Display tab, 28
  General tab, 29–30
  Keyboard tab, 24–27
  Mouse tab, 29
  Sound tab, 27–28
Control Panel, Mouse, 36–41
  Buttons tab, 36–38
  Hardware tab, 41
  Pointer Options tab, 40–41
  Pointers tab, 38–40
  Wheel tab, 41
convert command, disk volume to NTFS, 402
copies, CD Audio, 331–335
  Copy Music tab, 333–334
  copyright law and, 335
  making, 331–333
copy, Edit menu, 103
Copy Music tab, 344
Copy to CD or Device, 341
copyright laws
  movies, 368
  music, 335
counters, Performance monitor
  adding, 428–429
  Counter list, 427
  overview of, 427
  using and creating logs, 429–430
CTRL+ALT+DEL, 439–441
.cur extension, 40
Customize button, Start menu, 54–57
Customize Desktop button, 67
cut, Edit menu, 103

Desktop, 3–18
  defined, 490
  deleting items from, 8
  logging off computer, 15–16
  minimizing/maximizing windows, 14
  mouse terminology, 8
  My Network Places, 257
  overview of, 6–7
  Recycle Bin, 9–13
  restarting/turning off computer,
  16–17
  Start menu, 14–15
  starting computer, 4–6
  Taskbar, 13
Desktop Cleanup Wizard, 67–70
Desktop, customizing, 61–77
  Appearance tab, 75–76
  Desktop tab, see Desktop tab
  Remote Desktop Sharing, 220
  Screen Saver tab, 71–75
  Settings tab, 77
  Themes tab, 62–63
Desktop tab, 63–71
  Active Desktop Gallery, 71
  browsing for pictures, 66–67
  choosing desired background, 63–66
  Desktop Cleanup Wizard, 67–70
  Desktop Items, 67–68, 70
device drivers, Windows XP, 468–470
Device Manager, 139–146
  Driver tab, 142–145
  General tab, 141–142
  Resources tab, 145–146
  scanning for hardware changes, 147
  screen, 140
  understanding IRQ, 140
  using, 139–140
Device Settings tab, configuring
  printers, 165
devices, problem solving, 420
Devices tab, configuring Media Player,
  344–345

Date and Time icon, 31–33
DDERR_GENERIC, 319
defragmentation, disk, 381–383
Deleted Items folder, Outlook Express, 234
Diagnostics tab, Internet connections, 184
dial-up connections. see also modems,
configuring
    connecting with, 179
costs of, 180–181
defined, 179, 490
editing, 192–194
Dialing Rules tab, modems, 184–185
dialog boxes, keyboard shortcuts for, 477
digital signatures, 146
Digital Subscriber Line (DSL), 180
Direct Cable Connection, home networks,
    258–260
Direct Memory Access (DMA), 418
DirectX, 319, 424–425
Disconnect Network Drive option, 106
Discuss button, IE, 200
Disk Cleanup
    disk drive management, 376–378
    installing Windows XP, 465–466
Disk Defragmenter tool, 381–383
disk maintenance, 371–394
    adjusting usage with System
        Restore, 452
    avoiding disk errors, 381
    basics of, 372
    conserving disk space, 379
    file system basics, 373
    scheduling. see Scheduled Tasks
    understanding hard, 372
Disk Management, 395–414
    assigning drive letter and path to
        volume, 404
    converting drive to NTFS, 402
    creating new volumes, 402–404
    disk status and, 399–401
dynamic disks and, 396–399
    extending volume, 404
    formatting disks, 401–402
    overview of, 396
    Removable Storage, 412–413
    spanned volumes, 405
    striped volumes, 405
    Windows XP fault-tolerance support,
        405–406

Disk Quotas
    advanced networking and, 264–265
    overview of, 386
disk volumes
    assigning different drive letter and
        path to, 404
    converting to NTFS, 402
    creating new, 402–404
    defining, 402
    extending, 404
    fault-tolerant, 405–406
    spanned, 405
    striped, 405
disks
    floppy, copying items to, 469
    floppy, installing programs with,
        91–92
    fragmentation, 381–383, 491
    hard, 374–388
    hard, avoiding disk errors, 381
    hard, conserving disk space, 379,
        465–466
    hard, General tab, 375–378
    hard, Hardware tab, 384
    hard, Quota tab for NTFS drives,
        385–388
    hard, Security tab for NTFS
        drives, 385
    hard, Sharing tab, 385
    hard, Tools tab, 378–384
    hard, Tools tab, Backup utility, 384
    hard, Tools tab, Disk Defragmenter,
        381–383
    hard, Tools tab, Error Checking,
        378–381
    hard, viewing, 375
Display, 61–77
    Appearance tab, 75–76
    Desktop tab, 63–71
    Screen Saver tab, 71–75
    Settings tab, 77
    System Information, 420
    Themes tab, 62–63
Display icon
Accessibility Options and, 28
configuring Display with, 61
overview of, 34
Distribution List, Outlook Express, 245
DMA (Direct Memory Access), 418
Document menu, print jobs, 166–167
double-click, defined, 8
download, defined, 490
Dr. Watson, 425
drivers
defined, 132–133, 490
Driver Detail button, 143
installing, 144–145
new printer compatibility and, 155
sharing printers on networks and,
160–162
signing options, 146–147
software configuration of, 420
using Driver tab, 142–145
for Windows XP installation,
468–470
drives
compressed, 467
converting to NTFS, 402
sharing, 385
DSL (Digital Subscriber Line), 180
DVD features, Media Player
management options for, 346
overview of, 330
Windows XP installation and, 468
dynamic disks
converting basic disks to, 398–399
disk status and, 399–401
overview of, 396–399
Dynamic Update window, Windows XP
installation, 472

E
e-mail. see also Outlook Express
attachments, attaching files, 232–233
attachments, computer viruses in, 235
attachments, receiving, 234
clients, 490
defined, 490
sending movies over, 367
editing dial-up connections, 192–194
editing folders, 103–104
editing, Internet Explorer, 198, 200
editing, Magnifier setting for text, 115
editing, Movie Maker, 349
editing, Outlook Express, 229, 232
Empty Recycle Bin button, 9–10
Entertainment menu
overview of, 118–119
using Volume Controls and Sound Recorder, 319–321
environment variables, configuring, 420
Error Checking tool
after system lockups, 441
disk maintenance with, 378–381
Error Reporting, Microsoft Windows, 422
ESC key, halting games, 319
.exe extensions, 235
Explorer. see IE (Internet Explorer); MSN
Explorer; Windows Explorer
Extend Volume, disk volumes, 404
Extract All, removing compression, 109

F
Failed Redundancy state, disk status
reading, 401
Fast User Switching, 280
FAT32 file system, 373
fault tolerance
Movie Maker videos and, 348–349
overview of, 405–406
Favorites menu
Internet Explorer, 198–200
overview of, 104
Favorites, Microsoft Windows Help, 444
fax machines, 169–171
fax archiving, 171
Fax Console, 169
using Fax Wizard, 170–171
using Printers and Faxes folder, 154
file markers, Media Player, 330
File menu
   Internet Explorer, 198
   Outlook Express, 228–229
   overview of, 102–103
File Types tab, configuring folder views, 81–82
files. see also folders
   defined, 491
   extensions, 110
   FAT32 and NFTS file systems, 373
   IE configuration problems, 423
   making available offline, 123–124
   overview of, 110
FilterKeys option, 26
firewalls
   defined, 33, 491
   Internet access and, 208
   overview of, 290–291
firewalls, ICFs (Internet Connection Firewalls), 290–298
   configuring settings, 294–298
   default behavior of, 292–293
   enabling, 293
   overview of, 290–292
   security using, 296
floppy disks
   copying items to, 469
   installing programs with, 91–92
Folder Options, 78–86
   accessing Control Panel, 21
   customizing Explorer bar, 85
   customizing icon appearance, 86
   customizing Status bar, 85
   customizing Toolbars, 82–85
   defined, 34
   File Types tab, 81–82
   General tab, 78–80
   Offline Files tab, 82–83
   View tab, 80–81
folders, 101–110
   about files and, 110
   assigning permissions to, 284–288
   compression, conserving disk space, 379
   compression, overview of, 107–109
   compression, sending e-mail attachments, 233
   creating, renaming and deleting, 101–102
   defined, 491
   Edit menu, 103–104
   Favorites menu, 104
   file extensions and, 110
   File menu, 102–103
   Help menu, 106
   keyboard shortcuts for, 476–477
   making changes in C:\Windows, 101
   sharing, 106–107
   Tools menu, 104–106
   UNC path, 105
   uninstalling programs by deleting, 94
   View Menu, 104
   in Windows Explorer, 129
Folders pane, Outlook Express, 230
Follow Text Editing with Magnifier
   setting, 115
Fonts folder, 34
Forced Hardware, System Information, 418
Foreign state, disk status reading, 400
Format Volume window, 404
Format window, disks, 401–402
Formats tab, Media Player, 346
formatting
   disks, 401–402
   overview of, 373
Forward button, Internet Explorer, 199
fragmentation, disk, 381–383, 491
G

Game Controllers, Control Panel, 34
   games, 307–322
   DirectX Diagnostic tool for, 424–425
   Game Controllers, 34, 309–310
Game Options window, 309, 318–319
halting using ESC key, 319
installed with Windows XP, 311–312
installing and playing, 317–318
managing game controllers, 308–310
playing Internet, 313–317
troubleshooting, 318–319
using Volume Controls and Sound Recorder, 319–321
Games menu
configuring games in, 312
Internet options, 313–317
overview of, 119
gatekeeper, defined, 221
General tab
control options for accessibility, 30
desktop configuration, 67
device’s status information, 141–142
disk drive management, 375–378
editing dial-up connections, 193
folder view configuration, 78–80
Internet Explorer configuration, 201–203
modem configuration, 185–186
NetMeeting configuration, 221
Outlook Express customization, 242
printer configuration, 160
Start menu customization, 54
troubleshooting devices, 150
Get Names button, CD Audio, 332
GIF files, 65
Global tab, Recycle Bin Properties window, 11–12
Go button, Internet Explorer, 201
Group Policy, corporate networks, 266–267
groups, Address List, 245
guest accounts, 274–275

H
hard disk properties, 374–388
avoiding disk errors, 381
conserving disk space, 379
General tab, 375–378
Hardware tab, 384
Quota tab for NTFS drives, 385–388
Security tab for NTFS drives, 385
Sharing tab, 385
Tools tab, 378–384
Tools tab, Backup utility, 384
Tools tab, Disk Defragmenter, 381–383
Tools tab, Error Checking, 378–381
viewing, 375
hard disk space, Windows XP installation requirements, 465–466
hardware, 131–152
checking for Windows XP installation, 463–465
defined, 132, 491
driver signing, 146–147
golden rules of, 135
installing game controllers, 308–309
installing non-plug-and-play devices, 137–138
installing/removing plug-and-play devices, 136–137
overview of, 132–134
planning for home networks, 250
profiles, 148–150
troubleshooting tips, 150–151
using Have Disk option, 138
hardware, Device Manager, 139–146
Driver tab, 142–145
General tab, 141–142
Resources tab, 145–146
understanding IRQ, 140
using, 139–140
Hardware Profiles button, 148–149
Hardware Resources, System Information, 417–419
Hardware tab
disk properties, 384
Keyboard icon, 36
Mouse icon, 41
Sounds and Audio Devices icon, 46
Have Disk option, 138
Healthy (At Risk) state, disk status reading, 400
Healthy state, disk status reading, 400
Help menu
in Internet Explorer, 199
in Outlook Express, 229
overview of, 106
Help, Microsoft Windows, 442–448
Favorites, 444
History, 444
Home window, 443
Index, 443–444
Options, 444
overview of, 442
Search feature, 446–447
Support, 444–446
using troubleshooters, 447–448
Hibernate setting, 16, 75
History
using Internet Explorer, 200–203
using Windows Help, 444
Home button, Internet Explorer, 200
Home Networking Wizard
defined, 491
network bridging with, 303
overview of, 252–256
Home page, Internet Explorer, 201–202
Home window, Microsoft Windows
Help, 443
HTML (HyperText Markup Language)
customizing desktop with, 65, 67, 69–70
defined, 491
Web programming with, 196
HTTP (HyperText Transfer Protocol), 491
hubs, networks, 248–249
HyperTerminal, 271–272
HyperText Markup Language (HTML). see
HTML (HyperText Markup Language)
HyperText Transfer Protocol (HTTP), 491
I/O (Input/Output System), 418
ICFs (Internet Connection Firewalls), 290–298
configuring settings, 294–298
default behavior, 292–293
enabling, 293
overview of, 290–292
security using, 296
ICMP (Internet Control Message Protocol) tab, 296–298
icons
customizing appearance, 86
customizing user accounts, 280
defined, 491
ICS (Internet Connection Sharing)
defined, 492
enabling ICFs on, 292
overview of, 251–252
setting up clients for home networks, 256
Identities, Outlook Express, 238–241
accounts, 241
creating, 239–240
managing, 240–241
overview of, 238–239
IE (Internet Explorer)
configuration, 201–210
configuration, Advanced tab, 209–210
configuration, Connections tab, 207–208
configuration, Content tab, 205–207
configuration, General tab, 201–203
configuration, Privacy tab, 203–205
configuration, Programs tab, 208–209
configuration, Security tab, 203–204
configuring Start menu, 52–53
interface, 197–201
keyboard shortcuts, 478–479
Index

problem solving, 422–425
setting up ICS clients, 256
System Information for, 422–423
Ignore setting, driver signing, 147
IIS (Internet Information Services), 262–264
Import feature, video, 356–357
Index, Microsoft Windows Help, 443–444
Information area, Performance monitor, 427
Infrared devices, System Information, 420
inheritance, assigning permissions, 286–287
Initializing state, disk status reading, 400
input, component, 420
Input/Output System (I/O), 418
installation
  customizing at startup, 5
drivers, 144–145
modems, 181
non-plug-and-play devices, 137–138
plug-and-play devices, 136–137
purchased games, 317–318
scanners and printers, 172
troubleshooting hardware, 150
Windows components for, 99–100
installation, printers, 154–159, 158–159
installing Printer Software window, 157–158
selecting local or network printer, 156
selecting printer port, 157
setting up, 155
using Add Printer Wizard, 155–159
Windows XP compatibility check, 154–155
installation, programs, 88–96
defined, 88
downloading from Internet, 95–96
forcefully removing, 94–95
identifying unopened, 88
using Add/Remove Programs, 89–93
using compatibility mode, 96–98
using program’s uninstall option, 92–93
using setup feature, 89
Windows XP compatibility check, 89
installation, Windows XP, 461–474
activating Windows XP, 474
backing up data, 468
checking for viruses and antivirus software, 470
checking out device drivers, 468–470
checking system requirements, 463–468
on computer with no operating system, 472–473
shutting down all programs, 470–471
upgrading computer, 471–472
upgrading to Windows XP, 462–463
Internet, 195–222
browsers, 196
defined, 492
downloading programs from, 95–96
game options from, 313–317
importing and exporting playlists from, 339
terms and technology, 196–197
using Internet Explorer. see IE (Internet Explorer)
using MSN Explorer, 212–215
using NetMeeting. see NetMeeting
using Radio Tuner, 339–340
using Web Publishing Wizard, 222
using your movies on, 367–368
Web integration, 266
Web pages, customizing desktop with, 69–70
Web pages, View option for, 79–80
Web sites, MSN, 492
Web sites, Windows XP, 135
Windows Messenger and, 210–212
Internet Connection Firewalls. see ICFs
(Internet Connection Firewalls)
Internet Connection Sharing. see ICS
(Internet Connection Sharing)
Internet Connection Wizard
setting up Outlook Express, 225–227
using, 188–191
Internet connections, 177–194
automatic update problems, 438
broadband, 191–192
costs of, 180–181
creating, 188–189
defined, 492
editing dial-up connections, 192–194
modems, Advanced tab, 188
modems, Area Code Rules tab, 186–187
modems, Calling Card tab, 187–189
modems, Dialing Rules tab, 184–185
modems, General tab, 185–186
modems, installing, 181
modems, Modems tab, 182–184
modems, speed, 183–184
overview of, 178–181
using Network Connections folder, 189–192
using Remote Desktop Web Connection, 301–302
Windows XP installation and, 467
Internet Control Message Protocol (ICMP) tab, 296–298
Internet Explorer. see IE (Internet Explorer)
Internet Information Services (IIS), 262–264
Internet options, Control Panel, 34
Internet Service Providers. see ISPs
(Internet Service Providers)
Internet Time tab, 32–33
Interrupt Request Lines (IRQs)
overview of, 140
System Information, 418
Invert Selection option, 104
IP addresses, Home Networking Wizard, 255
IRQs (Interrupt Request Lines)
overview of, 140
System Information, 418
ISPs (Internet Service Providers)
affect on modem speed, 183
connecting with dial-up connections, 179
costs of, 180–181
defined, 492
editing dial-up connections and, 193–194
overview of, 178–179

J
JPEG files, 65

K
keyboard
Follow Keyboard Focus option, 115
Keyboard icon, 35–36
onscreen, 117
keyboard shortcuts, 475–479
within Dialog boxes, 477
Edit menu, 103
Internet Explorer, 478–479
Media Player, 481–484
Movie Maker, 485–487
Windows Explorer, 478
for windows, objects and folders,
476–477
Keyboard tab, Control Panel, 24–27
FilterKeys option, 26
StickyKeys option, 25–26
ToggleKeys option, 26–27

L
Layout window, Outlook Express views, 235–236
library features, Media Player, 483
Licensing Agreement window, Windows XP, 471
limited accounts, 275
Links button, Internet Explorer, 201
loaded modules, software configuration, 421
Local Area Connection Properties window, Home Networking Wizard, 254
Local Disk tab, Recycle Bin, 12–13
local users, 107
Lock desktop items, 69
lockups
troubleshooting game problems, 319
using CTRL+ALT+DEL for, 439–441
logging off computer, 15–16
Logon/Logoff tab
setting up synchronization, 124
User Accounts window, 280–281

M
Magnifier, 114–116
Main Identity, Outlook Express, 239
Maintenance tab, Outlook Express, 243
maintenance tools. see disk maintenance
Make Available Offline, Synchronize tool, 123–124
Make New Connection Wizard
configuring VPN incoming connection, 270–271
configuring XP computer for VPN connection, 268–270
Map Network Drive tool, 104–105
Master Boot Record (MBR), 470
Maximum Port Speed drop-down menu, 184
Maximum Speed option, 184
MBR (Master Boot Record), 470
Media Guide, 331
Media Library, 335–339
adding files to playlist, 337
adding item to, 336
configuring Media Player, 345
creating playlist, 336
importing and exporting playlists, 339
managing and playing, 337–338
mixing media files in playlist, 338
overview of, 335–336
Media Player 8. see Microsoft Windows Media Player 8
Memory, System Information, 418
Message menu, Outlook Express
defined, 229
message-editing features of, 232
sending high priority messages, 231
message rules, Outlook Express, 236–239
blocking senders, 238–239
creating, 237
managing, 238
Messenger, Microsoft Windows
changing profile of, 213
overview of, 210–212
using Internet Explorer, 200
Microsoft Network. see MSN (Microsoft Network)
Microsoft Windows
keyboard shortcuts for, 476–477
minimizing or maximizing, 14
Microsoft Windows 3.x, upgrading to Windows XP, 463
Microsoft Windows 95, upgrading to Windows XP, 463
Microsoft Windows Error Reporting, 422
Microsoft Windows Explorer
customizing settings for, 85
defined, 491
keyboard shortcuts for, 478
overview of, 127–129
Microsoft Windows Help, 442–448
Favorites, 444
History, 444
Home window, 443
Index, 443–444
Options, 444
overview of, 442
Search feature, 446–447
Support, 444–446
using troubleshooters, 447–448
Microsoft Windows Media Audio (WMA) file, 355
Microsoft Windows Media Player 8, 323–346
  CD Audio, 331–335
  configuration options, 344–346
  Copy to CD or Device, 341
  defined, 492
  keyboard shortcuts, 481–484
  Media Guide, 331
  Media Library, 335–339
  Movie Maker and, 350
  Now Playing, 325–330
  Radio Tuner, 339–340
  Skin Chooser, 342–344
  using, 324
Microsoft Windows Media Video (WMV) file, 349–350
Microsoft Windows Messenger
  changing profile of, 213
  overview of, 210–212
  using Internet Explorer, 200
Microsoft Windows Movie Maker, 347–368
  audio files, 364–367
  benefits and liabilities of, 348–350
  defined, 492
  files supported by, 351
  importing data into computer with capture devices, 352–353
  interface, 353–354
  keyboard shortcuts, 485–487
  managing videos with, 348–349
  recording and importing video, 354–357
  system requirements for, 350–351
  using collections and clips, 357–358
  using movies on Web, 367–368
Microsoft Windows Movie Maker, making movies, 358–364
  combining clips, 359–360
  creating storyboard, 361
  creating title slides, 362
  creating transitions, 364
  previewing clips or storyboards, 362
  splitting clips, 359–360
  trimming clips, 363–364
  using Workspace, 360–361
Microsoft Windows Movie (WMV) file, 355
Microsoft Windows Task Manager dialog box, 439–441
Microsoft Windows Update feature, 494
mirrored volumes, 406
Modems
  icon, 42
  System Information, 420
  tab, 182–184
modems, configuring, 181–188
  Advanced tab, 188
  Area Code Rules tab, 186–187
  Calling Card tab, 187–189
  Dialing Rules tab, 184–185
  General tab, 185–186
  Modems tab, 182–184
  speed, 183–184
Monitor area
  Movie Maker interface component, 353
  splitting clips in, 359
Motion option, mouse, 41
mouse
  configuring folders to jump to Internet, 80
  emptying Recycle Bin, 11
  Follow Mouse Cursor Magnifier option, 115
  terminology, 8
Mouse icon, Control Panel, 36–41
  Buttons tab, 36–38
  Hardware tab, 41
  Pointer Options tab, 40–41
  Pointers tab, 38–40
  Wheel tab, 41
Mouse tab, Control Panel, 29
Movie Maker. see Microsoft Windows Movie Maker
MSN Explorer, 212–215
MSN (Microsoft Network)
declared, 492
Internet Gaming Zone, 313–314
MSWMM (Microsoft Windows Movie Maker) file, 355
multimedia, System Information, 419
My Network Places, 257
My Pictures screen saver, 73

N

calling conventions
renaming folders, 101–102
Universal Naming Convention, 105
Narrator, 116–117
NetMeeting, 215–221
configuring NewMeeting options, 221
placing call, 218–220
setting up, 216–218
setting up Remote Desktop Sharing, 220
what you need to use, 216
network adapter cards
overview of, 248–249
Windows XP installation and, 468

networking, advanced, 261–272
disk quotas, 264–265
understanding IIS, 262–264
using HyperTerminal, 271–272
using VPN, 267–271
XP and corporate network, 265–267

networking, home, 247–247
basics, 248–249
creating Direct Cable Connection, 258–260
Internet Connection Firewalls, 292
Internet Connection Sharing, 251–252
planning, 250–251
setting up ICS clients, 256
using Home Networking Wizard, 252–256
using My Network Places, 257

networks
bridging, 303
Network Connections folder, 189–194
Network Connections icon, 42
Network tab, Media Player, 346
printers and, 159–162
Synchronize tool for, 61–65
System Information, 420–421
Tools menu options for, 104–106
New Group window, NTFS permissions, 285
New Identity dialog box, Outlook Express, 240
New Mail button
attaching file to e-mail, 232–233
sending e-mail in Outlook Express, 230–231
New Mail pane, 230
New Mail Rule window, 237–238
New Message pane, 233, 234
New Modem Wizard, 182–183
New Volume Wizard
creating new disk volumes with, 403–404
using spanned and striped volumes, 404–405
Notepad, 120–121
Notification area (System Tray)
customizing Taskbar, 61
overview of, 13
using to change clock settings, 32
Now Playing, 325–330
buttons, 326
View menu for, 327–331

NTFS file system
converting drive to, 402
overview of, 373
permissions support of, 284–285
Security and Quota tabs for, 385–388
upgrading for Windows XP installation, 472
Object Linking and Embedding (OLE) Registration, 422
objects, keyboard shortcuts for, 476–477
Offline Files tab, folder views, 82–83
Offline/Missing state, disk status, 400
OLE (Object Linking and Embedding) Registration, 422
On Idle tab, synchronization, 125
Online state, disk status reading, 400
onscreen keyboard, 117
operating system
defined, 492
Windows XP installation on computer with no, 472–473
Options tab
editing dial-up connections, 193–194
Windows Help, 444
Outlook Express, 223–246
advanced message-editing features, 232
attaching file to e-mail, 232–233
changing views in, 235–236
checking out interface for, 228–230
configuring Start menu, 52–53
creating message rules, 236–238
customizing, 242–243
e-mail viruses and, 235
how e-mail works, 224–225
ICF compatibility of, 292
managing accounts, 242
receiving attachments, 234
receiving messages, 233–234
sending e-mail, 230–232
sending high priority messages, 231
setting up, 225–227
setting up ICS clients, 256
using Address Book, 243–246
using Identities, 238–241
using MSN Explorer, 213

Paint, 121–122
passwords
changing for user accounts, 277–280
resetting, 283
using hints for, 278
paste, Edit menu, 103
performance alerts, creating, 429–430
Performance monitor, 425–432
adding counters, 428–429
creating logs, 429–430
creating performance alerts, 431–432
interface, 425–427
using, 427
Performance options, System Properties, 434–436
Performance tab, Media Player, 345
Permission Entries window, 288
permissions, 284–288
managing group accounts, 282–284
network permissions and access, 159
overview of, 284–288
Personal Information, configuring Internet Explorer, 206–207
Phone and Modem options, 181–188
Advanced tab, 188
Area Code Rules tab, 186–187
Calling Card tab, 187–189
Dialing Rules tab, 184–185
General tab, 185–186
Modems tab, 182–184
speed, 183–184
photo duration value, creating storyboards, 361
Player tab, Media Player, 344
playlists, Media Library, 336–339
adding files to, 337
creating, 336
importing and exporting, 339
managing and playing, 337–338
mixing media files in, 338
plug-and-play devices
defined, 492
development of, 134
installing non-plug-and-play devices, 137–138
installing/removing, 136–137
overview of, 133
rules for, 135
troubleshooting, 150
Point-to-Point Tunneling Protocol (PPTP), 268
Pointer Options tab, Mouse icon, 40–41
Pointers tab, Mouse icon, 38–40
POP3 mail, 213
Portable Devices feature, 341
ports
configuring printers, 161–162
selecting printer, 157
System Information, 420
troubleshooting printers, 167
Ports tab, 161–162
Power Options
Control Panel, 42
using, 73–75
power switch, starting computer, 4
PPTP (Point-to-Point Tunneling Protocol), 268
Preview pane, Outlook Express, 230
print jobs
Document menu, 166–167
software configuration of, 421
print queue window, 165–167
Print Test Page option, 160
Printer menu, 166
printer pooling, 162
Printer Software window, 157–158
printers, 154–168
configuring, Advanced tab, 163–165
configuring, General tab, 160
configuring, network permissions and access, 159
configuring, Ports tab, 161–162
configuring, printer pooling, 162
configuring, Security tab and Device Settings tab, 165
configuring, Sharing tab, 160–161
installing, 154–159, 154–159
installing, entering network path or queue name, 158–159
installing, installing Printer Software window, 157–158
installing, selecting local or network printer, 156
installing, selecting printer port, 157
installing, setting up, 155
installing, using Add Printer Wizard, 155–159
installing, Windows XP compatibility check, 154–155
managing print jobs, 165–167
Printers and Faxes folder, 154
System Information, 420
troubleshooting, 167–168
Printers and Faxes folder
fax archiving in, 171
overview of, 154–155
Printers folder, 42
Printing Preferences window, 160–161
Privacy tab
Internet Explorer configuration, 203–205
Internet game options, 316
problem solving, 415–458
automatic updates, 437–438
getting help. see Microsoft Windows Help
performance data. see Performance monitor
restoring computer to previous state. see System Restore
system information. see System Information
troubleshooting tips, 439–441
using Safe Mode, 449
using System Properties. see System Properties
processors
  finding speed of, 464–465
  installing Windows XP, 464
Product Key window, Windows XP installation, 472
Program Files, 94
programs
  defined, 492
  shutting down for Windows XP installation, 470–471
programs, installing, 88–96
  defined, 88
  downloading from Internet, 95–96
  forcefully removing, 94–95
  identifying unopened, 88
  using Add/Remove Programs, 89–93
  using compatibility mode, 96–98
  using program’s uninstall option, 92–93
  using setup feature, 89
  Windows XP compatibility check, 89
Programs tab, Internet Explorer configuration, 208–209
projects, Microsoft Windows Movie Maker, 355
properties
  changing Recycle Bin, 11–13
  defined, 492
  hard disks. see hard disk properties
  opening Device Manager for hard disk, 384
  system. see System Properties
protocols, defined, 492
proxy servers
  defined, 33
  Internet access for networks, 208
Q
  Quota Entries window, 386–387
  Quota tab, 265, 385–388
R
  Radio Tuner, 339–340
  RAID-5 volumes, 406
  RAM (Random Access Memory)
    installing Windows XP, 465
    overview of, 435–436
    versus virtual memory, 437
  Read tab, customizing Outlook Express, 242
  rebooting, 441
  Receipts tab, customizing Outlook Express, 242
  Recent Documents, removing items from, 58
  recovery, 410–411. see also backups;
    System Restore
  Recycle Bin, 9–13
    changing Properties of, 11–13
    using, 9–11
  Refresh button, Internet Explorer, 199
  Regenerating state, disk status reading, 401
  Regional and Language Options, Control Panel, 42
  registry, defined, 493
  Remote Assistance, 299–301
  Remote Desktop Connection, 298–302
    defined, 493
    enabling, 299–301
    installing Remote Desktop Web connection, 301–302
    overview of, 298–299
    Remote Assistance and, 299–301
  Remote Desktop Sharing
    configuring ICF settings for, 294–295
    setting up, 220
  Remote tab, 299–300
  Removable Storage, 412–413
  repeat delay slider bar, 35–36
  Resources tab
    Device Manager, 145–146
    troubleshooting devices with, 150
Restart setting, 16
restore. see System Restore
Restore All Items button, Recycle Bin, 10
Restore Defaults button, Internet Explorer configuration, 210
Restore Point
creating, 452–453
defined, 493
selecting wrong, 457
Resynching state, disk status reading, 400
right-click, mouse terminology, 8
Roll Back Driver button, 143–144

S
Safe Mode, 449, 493
satellite connections, 180
ScanDisk. see Error Checking tool
scanners
Control Panel icon, 43
overview of, 171–173
Scanners and Cameras folder, 171, 172
Schedule tab, using Scheduled Tasks, 392–393
Scheduled tab, setting up synchronization, 125–126
Scheduled Task Wizard, 389–390
Scheduled Tasks
Control Panel, 43
managing, 390–391
overview of, 389
Schedule tab, 392–393
Scheduled Task Wizard, 389–390
Settings tab, 393–394
Task tab, 391–392
scheme options, customizing mouse pointer, 39–40
Screen resolution slider bar, 77
Screen Saver tab, 71–75
3-D screen savers, 72
My Pictures screen saver, 73
Power Options, 73–75
Search button, Internet Explorer, 200
Search feature, Microsoft Windows Help, 446–447
security
Internet Connection Firewalls and, 296
Internet Explorer and, 423
Outlook Express and, 239
Signature Verification Utility and, 423–424
XP in corporate networks and, 266
Security Logging tab, configuring ICF settings, 296–297
Security tab
configuring printers, 165
customizing Outlook Express, 243
Disk Properties, 385
editing dial-up connections, 194
Internet Explorer configuration, 203–204
NTFS permissions, 285–287
providing advanced permission options, 287–288
using NetMeeting, 221
Select All option, Edit menu, 104
Send Mail button, Internet Explorer, 200
Send tab, Outlook Express, 242
SerialKey devices, 30
services, software configuration, 421
Services tab, configuring ICF settings, 294–296
Settings tab
Display options, 77
Scheduled Tasks, 393–394
setup feature, 89
Setup.exe file, 89–92
share, defined, 493
Sharing tab
drives, 385
folders, 106–107
printers, 160–161
shortcuts
  adding/removing desktop icons for, 6–7
  adding Start menu, 51, 59–60
  attaching files to e-mail, 232
  using Desktop Cleanup Wizard, 68–69
shortcuts, keyboard, 475–479
  within Dialog boxes, 477
Edit menu, 65
Internet Explorer, 478–479
Media Player, 481–484
Movie Maker, 485–487
Windows Explorer, 478
for windows, objects and folders, 476–477
Show/Hide Equalizer Settings button, Now Playing, 326
Show/Hide Playlist button, Now Playing, 326
ShowSounds option, 27–28
Shuffle button, Now Playing, 326
Signature Verification Utility, 423–424
Signatures tab, Outlook Express, 243
signed drivers, 420
skin feature
  defined, 493
  shortcuts for, 484
  Skin Chooser, 342–344
slides, inserting into storyboard, 362
SnapTo option, mouse, 41
Software Environment category, System Information, 420–422
sound, Control Panel
  Sound tab, 27–28
  Sounds and Audio Devices, 43–46
Sound Devices, System Information, 420
Sound Recorder, Entertainment menu, 320–321
Sounds tab, 43–45
SoundSentry option, 27
spanned volumes, 405
Speech icon, Control Panel, 46–47
speed
  configuring modems for, 183–184
  planning home networks for, 250
  Speed tab, Keyboard icon, 35–36
  troubleshooting slow printing, 168
Spelling tab, Outlook Express, 243
split
  defined, 493
  Movie Maker, 359–360
standard accounts, 275
Start menu, 50–60
  accessing Control Panel via, 21
  adding more shortcuts, 59–60
  avoiding disk errors by using, 381
  customizing Classic Start menu, 57–59
  customizing XP Start menu, 54–57
  defined, 493
  identifying unopened Windows XP programs, 88
  logging off computer, 15–16
  overview of, 14–15
  restarting/turning off computer, 16
  using, 50–53
startup programs
  freeing up system resources by removing, 434–437
  software configuration of, 421
startup sequence, 5–6
stateful firewalls, 291
Station Finder, Radio Tuner, 340
statistics option, Media Player, 330–331
status
  customizing Status bar for folder views, 85
  indications of disk, 399–401
StickyKeys option, 25–26
Stop button, Internet Explorer, 199
storage
  Removable Storage, 412–413
  System Information, 420
storyboards, Movie Maker
creating, 361
previewing, 362
streaming media
defined, 330
Radio Tuner using, 340
striped volumes, 405
summary option, IE configuration, 423
Support, Microsoft Windows Help, 444–446
Support Serial Key devices option, 30
Switch Identities dialog box, Outlook Express, 240–241
Synchronization Settings window, 124–126
Synchronize tool, 123–127
making files available offline, 123–124
overview of, 123–127
setting up, 124–126
using Scheduled Synchronization Wizard, 126–127
System icon, Control Panel, 47
System Information, 416–425
applications, 423
Components category, 419–420
Hardware Resources category, 417–419
Internet Explorer category, 422–423
overview of, 416–417
Software Environment category, 420–422
tools, 423–425
using System Summary, 417
System Properties, 432–437
overview of, 432–433
Performance options, 434–436
virtual memory versus RAM, 437
system resources
removing startup programs and, 434–437
for Windows XP installation, 463–465
System Restore, 449–458
adjusting disk usage, 452
creating restoration points, 452–453
defined, 493
enabling, 450–451
requirements, 450
selecting wrong restoration point, 457
undoing, 456
when you can boot Windows, 454–455
when you cannot boot Windows, 455
system settings, configuring, 49–86
Display, 61–77
Display, Appearance tab, 75–76
Display, Desktop tab, 63–71
Display, Screen Saver tab, 71–75
Display, Settings tab, 77
Display, Themes tab, 62–63
folder views, 78–82
folder views and Toolbars, 82–86
Start menu, adding more shortcuts, 59–60
Start menu, Classic, 57–59
Start menu, XP, 54–57
Taskbar, 60–61
System Summary, System Information, 417
System Tools menu, 119
System Tray (Notification area)
customizing Taskbar, 61
overview of, 13
using to change clock settings, 32
T
Task Manager dialog box, 439–441
Task tab, Scheduled Tasks, 391–392
Taskbar
Control Panel, 48
customizing, 60–61
defined, 493
overview of, 13
tasks, scheduled
Control Panel, 43
managing, 390–391
overview of, 389
Schedule tab, 392–393
Scheduled Task Wizard, 390
Settings tab, 393–394
Task tab, 391–392
tasks, software configuration of, 421
TCP/IP (Transmission Control Protocol/Internet Protocol)
defined, 493
overview of, 249
using Home Networking Wizard, 254–255
technology, Internet, 196–197
Temporary Internet files, 201–203
terminal services client, 299
terminology
Internet, 196–197
mouse, 8
text
formatting in WordPad, 130
troubleshooting garbled printer, 167
Themes tab, 62–63
3-D screen savers, 72
Timeline views
creating transitions, 364
defined, 360
title slides, creating, 362
ToggleKeys option, 26–27
toolbars
customizing folder views, 82–85
Internet Explorer, 199–201
Movie Maker, 353
Outlook Express, 229–230, 235–236
Performance monitor, 426–427
Tools menu
creating message rules, 237–238
Internet Explorer, 199
managing folders, 104–106
Media Player, 344–346
Outlook Express, 229
tools, System Information, 423–425
DirectX Diagnostic tool, 424–425
Dr. Watson, 425
Signature Verification Utility, 423–424
Tools tab, Disk Properties, 378–384
Backup utility, 384
Disk Defragmenter, 381–383
Error Checking, 378–381
transitions, Movie Maker, 364–365
trim feature, clips
defined, 493
overview of, 363–364
troubleshooters, Microsoft Windows Help, 447–448
troubleshooting. see also problem solving
customizing Settings tab, 77
drive problems, 384
games, 318–319
hardware, 150–151
printers, 167–168
tips, 439–441
Turn Off setting, 16

U
UNC (Universal Naming Convention)
path, 105
undo delete, Edit menu, 103
Uninstall button, removing drivers, 144
uninstall option
avoiding disk errors using, 381
conserving disk space with, 379
removing programs, 92–93
removing Windows components, 100
Uninterruptible Power Supply (UPS), 75
Universal Naming Convention (UNC), 105
Universal Serial Bus (USB), 420
Unreadable state, disk status reading, 400
Unrecognized state, disk status reading, 400
Update Driver button, 143
Update feature, Microsoft Windows, 494
upgrading, to Windows XP, 462–472
activating Windows XP, 474
backing up data, 468
checking for viruses and antivirus software, 470
checking out device drivers, 468–470
checking system requirements, 463–468
shutting down all programs, 470–471
upgrading computer, 471–472

UPS (Uninterruptible Power Supply), 75
USB (Universal Serial Bus), 420
user accounts, 274–282
  changing, 277–279
  creating, 276–277
  customizing with pictures, 280
  editing, 277–280
  group accounts, 282–284
  logon/logoff, 280
  managing with Computer Management console, 280–282
  overview of, 274–275
  permissions, 284–288
  resetting passwords, 283

User Accounts icon, Control Panel, 48
User Accounts window, 275–281
  creating new account, 276–277
  editing accounts, 277–280
  logon/logoff, 280–281
  overview of, 275–276
users
  defined, 494
  local, 107
  logging off computer, 15–16
  managing through disk quotas, 264–265
  starting computer, 5
  switching, 15–16
Users icon, 275
Utility Manager, 117–118

V
  .vbs extensions, 235
  Video/Audio area, Movie Maker, 359
video-card hardware
  managing, 77
  Windows XP installation and, 468
Video tab, NetMeeting, 221
videos. see Microsoft Windows Movie Maker
View menu
  choices within, 9
  customizing folder views and Toolbars, 82–86
  customizing for Outlook Express, 235–236
  Device Manager, 139
  Internet Explorer, 198
  managing folders, 104
  Now Playing, 327–331
  using regular or scientific calculator, 119
  Windows XP Control Panel, 22–23
View Report button, Disk Defragmentation, 383
views
  configuring folders with View Tab, 80–81
  Outlook Express, 228–230, 235–236
virtual memory
  overview of, 435–436
  RAM versus, 437
Virtual Private Networking (VPN), 267–271
viruses
  downloaded programs and, 96
  e-mail and, 235
  installing Windows XP and, 470
Visibility option, mouse, 41
Visual Effects tab, System Properties, 437
visualization options
  getting from Internet, 329–330
  Media Player, 329, 346
Voice tab, Sounds and Audio Devices icon, 46
Volume Controls, Entertainment menu, 319–320
Volume tab, Sounds and Audio Devices icon, 43–45
volumes, disk
assigning different drive letter and path to, 404
converting to NTFS, 402
creating, 402–404
defining, 402
extending, 404
fault-tolerant, 405–406
spanned, 405
striped, 405
VPN (Virtual Private Networking), 267–271

W
wallpaper, desktop, 66–67
Warn setting, driver signing, 147
Web. see Internet
Web pages
  customizing desktop with, 69–70
  View option for, 79–80
Web Publishing Wizard, 222
Web sites
  MSN, 492
  Windows XP, 135
Welcome screen, Windows XP
  upgrades, 471
Wheel tab, Mouse icon, 41
Windows. see Microsoft Windows
Windows Explorer
  customizing settings for, 85
  defined, 491
  keyboard shortcuts for, 478
  overview of, 127–129
Windows Setup window, XP installation, 472
WinZip technology, 109
wizards, defined, 31
WMA (Microsoft Windows Media Audio) file, 355
WMV (Microsoft Windows Media Video File), 349–350
WMV (Microsoft Windows Movie) file, 355
WordPad, 129–130
Workspace, Movie Maker
  creating storyboard, 361–362
  creating transitions, 364
  overview of, 353–354, 360–361
  trimming clips, 363
World Wide Web, 494. see also Internet
INTERNATIONAL CONTACT INFORMATION

AUSTRALIA
McGraw-Hill Book Company Australia Pty. Ltd.
TEL +61-2-9417-9899
FAX +61-2-9417-5687
http://www.mcgraw-hill.com.au
books-it_sydney@mcgraw-hill.com

CANADA
McGraw-Hill Ryerson Ltd.
TEL +905-430-5000
FAX +905-430-5020
http://www.mcgrawhill.ca

GREECE, MIDDLE EAST, NORTHERN AFRICA
McGraw-Hill Hellas
TEL +30-1-656-0990-3-4
FAX +30-1-654-5525

MEXICO (Also serving Latin America)
McGraw-Hill Interamericana Editores S.A. de C.V.
TEL +525-117-1583
FAX +525-117-1589
http://www.mcgraw-hill.com.mx
fernando_castellanos@mcgraw-hill.com

SINGAPORE (Serving Asia)
McGraw-Hill Book Company
TEL +65-863-1580
FAX +65-862-3354
http://www.mcgraw-hill.com.sg
mghasia@mcgraw-hill.com

SOUTH AFRICA
McGraw-Hill South Africa
TEL +27-11-622-7512
FAX +27-11-622-9045
robyn_swane@mcgraw-hill.com

UNITED KINGDOM & EUROPE (Excluding Southern Europe)
McGraw-Hill Education Europe
TEL +44-1-628-502500
FAX +44-1-628-770224
http://www.mcgraw-hill.co.uk
computing_neurope@mcgraw-hill.com

ALL OTHER INQUIRIES Contact:
Osborne/McGraw-Hill
TEL +1-510-549-6600
FAX +1-510-883-7600
http://www.osborne.com
omg_international@mcgraw-hill.com

Copyright 2001 The McGraw-Hill Companies, Inc. Click Here for Terms of Use.